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Introduction

An anechoic chamber is a measurement facility for antenna characterization, 
electromagnetic interference (EMI), and electromagnetic compatibility (EMC) tests. By 
absorbing electromagnetic waves inside the chamber and blocking the incoming signals 
from the outside, it creates a virtually infinite space that has almost zero internal reflection 
and does not suffer from unwanted external RF noises, so the device-under-test in the 
chamber can be accurately measured without any interference. This model simulates a 
biconical antenna, popularly used in EMI and EMC tests, which is located at the center of 
a small anechoic chamber. The computed far-field radiation pattern and S-parameter (S11) 
demonstrate that the microwave absorbers reduce reflection from the walls significantly 
without distorting antenna performance.

Figure 1: A state-of-the-art anechoic chamber built in a small room (3.9m × 3.9m × 3.3m). 
It consists of microwave absorbers on thin conductive walls. Two side walls are not included in 
this figure.

Model Definition

The shape of the absorbers is configured with the array of pyramidal objects to steer the 
propagation direction of the incident field on the absorbers reflected back not to the 
radiation source, but toward the surface of the adjacent absorbers. The radiation-
absorbent material (RAM), conductive carbon-loaded foam in the pyramidal shaped 

Conductive wallPyramidal microwave absorbers
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absorber, is modeled using a low conductive material (σ = 0.5 S/m). So the 
electromagnetic waves illuminated on the absorber has the process of partial reflection and 
partial transmission with subsequent attenuation that is repeated until the wave reaches the 
base of the pyramid. The amplitude of the field at the base of the pyramid is drastically 
reduced. Thus, the reflection from the absorbers at this point is marginal.

The exterior of the chamber is finished with a perfect electric conductor (PEC) to model 
metallic surfaces that insulate the chamber from the outside RF noises.

The imported biconical antenna geometry is identical to the one used in another 
application library example, Modeling a Biconical Antenna for EMI/EMC Testing 
(Ref. 1). This reference model is simulating the same antenna geometry but the antenna 
is enclosed by a numerical version of an anechoic chamber that is a perfectly matched layer 
(PML).

The metallic surfaces of the antenna are also configured by PEC. A lumped port with a 
50 Ω reference impedance is assigned to the gap located at the center of the two structures 
composed of hexagonal frames. All domains except for the absorbers is filled with the air.

The simulation frequency is set to 240 MHz.

Results and Discussion

The far-field polar plot as a function of azimuth angle is visualized in Figure 2. The 
plotting plane is perpendicular to the dominant polarization of the antenna so it is the H-
plane radiation pattern. Just like the radiation pattern of the biconical antenna surrounded 
by the PML in Ref. 1, it is isotropic since the reflection from the chamber walls ,that are 
made of the lossy conductive pyramidal form array, is negligible. The computed S-
parameter (S11) is around -10 dB that is very close to the value evaluated at 240 MHz in 
Ref. 1, which also indicates that the reflection from the chamber walls is marginal.

Figure 3 shows one way to enhance the quality of the results postprocessing by utilizing 
solution set selections and uniform custom colors. The contour of the norm of electric 
fields in a dB-scale is plotted in a realistic view of an anechoic chamber. The exterior 
metallic walls are visualized with the norm of electric fields using the GrayScale color table.
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Figure 2: The far-field radiation pattern on the H-plane of the biconical antenna at 
240 MHz. It is isotropic as expected.

Figure 3: The contour plot of the norm of the electric field (dB-scaled). The strength of the field 
is gradually decaying inside absorbers.
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References

1. Modeling a Biconical Antenna for EMI/EMC Testing, COMSOL Application 
Libraries.

Notes About the COMSOL Implementation

The example model is memory intensive and may require more than 20 GB RAM. The 
goal of this model is not to simulate an antenna but to design a state-of-the-art anechoic 
chamber and validate it based on the performance of the antenna. It is recommended to 
use a PML instead of absorber models to simulate antennas efficiently. The same biconical 
antenna with the PML (Ref. 1) may need less than 3 GB memory. Note that the anechoic 
model is not designed in full compliance with well-known standards such as CISPR and 
ANSI.

Application Library path: RF_Module/EMI_EMC_Applications/anechoic_chamber

Model Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Radio Frequency>Electromagnetic Waves,

Frequency Domain (emw).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Frequency Domain.

6 Click Done.
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S T U D Y  1

Step 1: Frequency Domain
1 In the Model Builder window, under Study 1 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 In the Frequencies text field, type 240[MHz].

G E O M E T R Y  1

Block 1 (blk1)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, locate the Size and Shape section.

3 In the Width text field, type 3.9.

4 In the Depth text field, type 3.9.

5 In the Height text field, type 3.3.

6 Locate the Position section. From the Base list, choose Center.

7 Click Build Selected.

8 Click the Wireframe Rendering button on the Graphics toolbar.

Pyramid 1 (pyr1)
1 On the Geometry toolbar, click More Primitives and choose Pyramid.

2 In the Settings window for Pyramid, locate the Size and Shape section.

3 In the Base length 1 text field, type 0.15.

4 In the Base length 2 text field, type 0.15.

5 In the Height text field, type 0.4.

6 In the Ratio text field, type 0.

7 Locate the Position section. In the x text field, type -1.425.

8 In the y text field, type -1.425.

9 In the z text field, type -1.6.

Block 2 (blk2)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, locate the Size and Shape section.

3 In the Width text field, type 0.15.

4 In the Depth text field, type 0.15.
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5 In the Height text field, type 0.05.

6 Locate the Position section. In the x text field, type -1.5.

7 In the y text field, type -1.5.

8 In the z text field, type -1.65.

Union 1 (uni1)
1 On the Geometry toolbar, click Booleans and Partitions and choose Union.

2 Select the objects blk2 and pyr1 only.

3 In the Settings window for Union, locate the Union section.

4 Clear the Keep interior boundaries check box.

Array 1 (arr1)
1 On the Geometry toolbar, click Transforms and choose Array.

2 Select the object uni1 only.

3 In the Settings window for Array, locate the Size section.

4 In the x size text field, type 20.

5 In the y size text field, type 20.

6 Locate the Displacement section. In the x text field, type 0.15.

7 In the y text field, type 0.15.
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Union 2 (uni2)
1 On the Geometry toolbar, click Booleans and Partitions and choose Union.

2 Click the Select Box button on the Graphics toolbar.

Select all objects in the array as shown in the below figure.

3 In the Settings window for Union, locate the Union section.

4 Clear the Keep interior boundaries check box.

Mirror 1 (mir1)
1 On the Geometry toolbar, click Transforms and choose Mirror.

2 Select the object uni2 only.

3 In the Settings window for Mirror, locate the Input section.

4 Select the Keep input objects check box.

Rotate 1 (rot1)
1 On the Geometry toolbar, click Transforms and choose Rotate.

2 Select the object uni2 only.

3 In the Settings window for Rotate, locate the Input section.

4 Select the Keep input objects check box.

5 Locate the Rotation Angle section. In the Rotation text field, type 90.

6 Locate the Point on Axis of Rotation section. In the x text field, type -0.15.

7 In the z text field, type 0.15.
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8 Locate the Axis of Rotation section. From the Axis type list, choose y-axis.

Rotate 2 (rot2)
1 On the Geometry toolbar, click Transforms and choose Rotate.

2 Select the object rot1 only.

3 In the Settings window for Rotate, locate the Rotation Angle section.

4 In the Rotation text field, type 0 90 180 270.

Union 3 (uni3)
1 On the Geometry toolbar, click Booleans and Partitions and choose Union.

2 Click the Select Box button on the Graphics toolbar.

3 Select the objects rot2(1), rot2(2), mir1, uni2, rot2(3), and rot2(4) only.

4 In the Settings window for Union, locate the Selections of Resulting Entities section.

5 Click New.

Create a set of absorber selections that will make easier to set up the physics and 
material.

6 In the New Cumulative Selection dialog box, type Absorbers in the Name text field.

7 Click OK.

Sphere 1 (sph1)
1 On the Geometry toolbar, click Sphere.

2 In the Settings window for Sphere, locate the Selections of Resulting Entities section.

3 Click New.

Create a set of far-field selections.

4 In the New Cumulative Selection dialog box, type Far-field in the Name text field.

5 Click OK.

Import 1 (imp1)
1 On the Geometry toolbar, click Import.

2 In the Settings window for Import, locate the Import section.

3 In the Filename text field, type anechoic_chamber_antenna.mphbin.

4 Locate the Selections of Resulting Entities section. Click New.

Create a set of antenna geometry selections.

5 In the New Cumulative Selection dialog box, type Antenna in the Name text field.

6 Click OK.
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7 On the Geometry toolbar, click Build All.

8 Click the Wireframe Rendering button on the Graphics toolbar.

9 Click the Transparency button on the Graphics toolbar.

Adjust the graphics window settings as you prefer for the remaining modeling steps.

10 Click the Transparency button on the Graphics toolbar.

11 Click the Wireframe Rendering button on the Graphics toolbar.

12 Click the Zoom In button on the Graphics toolbar.

M A T E R I A L S

On the Home toolbar, click Windows and choose Add Material from Library.

A D D  M A T E R I A L

1 Go to the Add Material window.

2 In the tree, select Built-In>Air.

3 Click Add to Component in the window toolbar.

M A T E R I A L S

Air (mat1)
On the Home toolbar, click Add Material to close the Add Material window.
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Material 2 (mat2)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, type Absorbers in the Label text field.

3 Locate the Geometric Entity Selection section. From the Selection list, choose Absorbers.

4 Locate the Material Contents section. In the table, enter the following settings:

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

Perfect Electric Conductor 2
1 In the Model Builder window, under Component 1 (comp1) right-click 

Electromagnetic Waves, Frequency Domain (emw) and choose Perfect Electric Conductor.

2 In the Settings window for Perfect Electric Conductor, locate the Boundary Selection 
section.

3 From the Selection list, choose Antenna.

4 In the Model Builder window, right-click Electromagnetic Waves,

Frequency Domain (emw) and choose Lumped Port.

Add a lumped port at the center of the antenna. Zoom in a few of times to get a clear 
view.

Lumped Port 1
1 In the Settings window for Lumped Port, locate the Boundary Selection section.

2 Click Paste Selection.

3 In the Paste Selection dialog box, type 6310 in the Selection text field.

Property Name Value Unit Property 
group

Relative permittivity epsilonr 1 1 Basic

Relative permeability mur 1 1 Basic

Electrical conductivity sigma 0.5 S/m Basic
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4 Click OK.

For the first port, wave excitation is on by default.

Far-Field Domain 1
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Far-

Field Domain.

2 In the Settings window for Far-Field Domain, locate the Domain Selection section.

3 From the Selection list, choose Far-field.

Far-Field Calculation 1
1 In the Model Builder window, expand the Far-Field Domain 1 node, then click Far-

Field Calculation 1.

2 In the Settings window for Far-Field Calculation, locate the Boundary Selection section.

3 Click Clear Selection.

4 From the Selection list, choose Far-field.

S T U D Y  1

Step 1: Frequency Domain
On the Home toolbar, click Compute.
12 |  A N E C H O I C  C H A M B E R  A B S O R B I N G  E L E C T R O M A G N E T I C  W A V E S



R E S U L T S

Electric Field (emw)
1 In the Model Builder window, under Results click Electric Field (emw).

2 In the Settings window for 3D Plot Group, locate the Plot Settings section.

3 Clear the Plot data set edges check box.

Multislice
1 In the Model Builder window, expand the Electric Field (emw) node, then click Multislice.

2 In the Settings window for Multislice, locate the Expression section.

3 In the Expression text field, type 20*log10(emw.normE).

4 Locate the Multiplane Data section. Find the X-planes subsection. In the Planes text field, 
type 1.

5 Find the Y-planes subsection. In the Planes text field, type 0.

6 Find the Z-planes subsection. In the Planes text field, type 0.

7 Click to expand the Range section. Select the Manual color range check box.

8 In the Minimum text field, type -70.

9 In the Maximum text field, type 40.

10 On the Electric Field (emw) toolbar, click Plot.
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2D Far Field (emw)
1 In the Model Builder window, under Results click 2D Far Field (emw).

2 In the Settings window for Polar Plot Group, locate the Axis section.

3 Select the Manual axis limits check box.

4 In the r minimum text field, type 0.

5 In the r maximum text field, type 1.

6 On the 2D Far Field (emw) toolbar, click Plot.

Compare the reproduced plot to Figure 2.

3D Far Field (emw)

3D Plot Group 4
1 On the Home toolbar, click Add Plot Group and choose 3D Plot Group.

2 In the Settings window for 3D Plot Group, locate the Color Legend section.

3 Clear the Show legends check box.

4 Locate the Plot Settings section. Clear the Plot data set edges check box.

Volume 1
1 Right-click 3D Plot Group 4 and choose Volume.

2 In the Settings window for Volume, locate the Expression section.
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3 In the Expression text field, type 1.

4 Locate the Coloring and Style section. From the Coloring list, choose Uniform.

5 From the Color list, choose Custom.

6 On Windows, click the colored bar underneath, or—if you are running the cross-
platform desktop—the Color button.

7 Click Define custom colors.

8 Set the RGB values to 0, 64, and 128, respectively.

9 Click Add to custom colors.

10 Click Show color palette only or OK on the cross-platform desktop.

Selection 1
1 Right-click Results>3D Plot Group 4>Volume 1 and choose Selection.

2 In the Settings window for Selection, locate the Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 4, 6, 10 in the Selection text field.

5 Click OK.

Surface 1
1 In the Model Builder window, under Results right-click 3D Plot Group 4 and choose 

Surface.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type 1.

4 Locate the Coloring and Style section. From the Coloring list, choose Uniform.

5 From the Color list, choose White.

Selection 1
1 Right-click Results>3D Plot Group 4>Surface 1 and choose Selection.

2 In the Settings window for Selection, locate the Selection section.

3 From the Selection list, choose Antenna.

Surface 2
1 In the Model Builder window, under Results right-click 3D Plot Group 4 and choose 

Surface.

2 In the Settings window for Surface, locate the Coloring and Style section.

3 From the Color table list, choose GrayScale.
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Selection 1
1 Right-click Results>3D Plot Group 4>Surface 2 and choose Selection.

2 In the Settings window for Selection, locate the Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 3, 485, 12215 in the Selection text field.

5 Click OK.

Cut Plane 1
1 On the Results toolbar, click Cut Plane.

2 In the Settings window for Cut Plane, locate the Plane Data section.

3 From the Plane list, choose ZX-planes.

Contour 1
1 In the Model Builder window, under Results right-click 3D Plot Group 4 and choose 

Contour.

2 In the Settings window for Contour, locate the Data section.

3 From the Data set list, choose Cut Plane 1.

4 Locate the Expression section. In the Expression text field, type 20*log10(emw.normE+
1e-5).

Adding 1e-5 to the log expression improves the color variation in the contour plot.

5 Locate the Levels section. In the Total levels text field, type 100.

6 On the 3D Plot Group 4 toolbar, click Plot.

See Figure 3 to compare the reproduced plot.

S-parameter, S11dB (emw)
1 In the Model Builder window, expand the Derived Values node, then click S-parameter,

S11dB (emw).

2 In the Settings window for Global Evaluation, click Evaluate.

The computed S11 should be around -10 dB.
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Introduction

A branch line coupler, also known as a quadrature (90°) hybrid, is a four-port network 
device with one input port, two output ports, with a 90° phase difference between them, 
and one isolated port. Due to its symmetry, any port can be used as the input port.

Figure 1: The geometry of a branch line coupler is symmetric.

Model Definition

The form of the branch line coupler is shown schematically in Figure 1. The layout design 
is based upon Ref. 1, and is tuned to operate at 3 GHz. The design is realized as microstrip 
lines patterned onto a 0.060 inch dielectric substrate. The microstrip lines are modeled as 
perfect electric conductor (PEC) surfaces, and another PEC surface on the bottom of the 
dielectric substrate acts as a ground plane. The entire modeling domain is bounded by 
PEC boundaries that represent the device packaging. The four ports are modeled as small 

λ/4

λ/4
Z0

Z0

Z0Z0

Z0

Z0

Z0/√2

Z0/√2

(1) (2)

(3)(4)

Isolated Output

OutputInput
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rectangular faces that bridge the gap between the PEC face that represents the ground 
plane, and the PEC faces that represent the microstrip line at each port.

Figure 2: The model of the branch line coupler. Some exterior faces are removed for 
visualization.

The model is shown in Figure 2. A small air domain bounded by a PEC surface around 
the device is also modeled. The model is meshed using a tetrahedral mesh. A good rule of 
thumb is to use approximately five elements per wavelength in each material.

Results and Discussion

The computed S-parameters are plotted in Figure 3. At a frequency of 3 GHz, the signal 
is evenly split between the two output ports with a very small amount of losses. The input 
signal is barely coupled to the isolation port where S41 is less than −30 dB at 3 GHz. The 
evaluated phase shift between the two output ports is 89.9°.

Lumped port 2

Lumped port 3

Lumped port 4

Lumped port 1

PEC enclosure

60 mil substrate

Air
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Figure 3: The frequency response of the branch line coupler shows good input matching (S11) 
and isolation (S41) around 3 GHz. The coupled signal at the two output ports (S21 and S31) 
is about -3 dB at 3 GHz.

Figure 4: The phases on the two output ports show approximately 90-degree shift at 3 GHz.
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Because the metallic housing works as a rectangular cavity, there is a resonance observed 
around 4.6 GHz. This is the dominant TE101 mode of the rectangular cavity resonator 
partially filled with a dielectric substrate. The resonance can easily be removed in the 
current frequency sweep range by adding a metallic post in the middle of the cavity.

Reference

1. D.M. Pozar, Microwave Engineering, John Wiley & Sons, 1998.

Application Library path: RF_Module/Couplers_and_Power_Dividers/
branch_line_coupler

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Radio Frequency>Electromagnetic Waves,

Frequency Domain (emw).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Frequency Domain.

6 Click Done.

S T U D Y  1

Step 1: Frequency Domain
1 In the Model Builder window, under Study 1 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 In the Frequencies text field, type range(1[GHz],100[MHz],5[GHz]).
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G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

Here, mil refers to the unit milliinch.

G E O M E T R Y  1

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose mm.

Work Plane 1 (wp1)
1 On the Geometry toolbar, click Work Plane, to add an xy-plane for the coupler layout’.

2 In the Settings window for Work Plane, click Show Work Plane.

Rectangle 1 (r1)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 2*w_line1+l_line3.

4 In the Height text field, type l_s.

5 Locate the Position section. From the Base list, choose Center.

6 Right-click Rectangle 1 (r1) and choose Build Selected.

Name Expression Value Description

thickness 60[mil] 0.001524 m Substrate thickness

l_s 40[mm] 0.04 m Length, substrate

w_line2 5[mm] 0.005 m Width, line 2

l_line2 13[mm] 0.013 m Length, line 2

l_line1 (l_s-l_line2)/2 0.0135 m Length, line 1

w_line1 3.2[mm] 0.0032 m Width, line 1

w_line3 3[mm] 0.003 m Width, line 3

l_line3 13.6[mm] 0.0136 m Length, line 3
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Rectangle 2 (r2)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type w_line2*2+l_line3.

4 In the Height text field, type l_line2.

5 Locate the Position section. From the Base list, choose Center.

6 On the Work Plane toolbar, click Build All.

Rectangle 3 (r3)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type l_line3.

4 In the Height text field, type l_line2.

5 Locate the Position section. In the xw text field, type -l_line3/2.

6 In the yw text field, type l_line2/2+w_line3.

7 Right-click Rectangle 3 (r3) and choose Build Selected.

8 Click the Zoom Extents button on the Graphics toolbar.

Array 1 (arr1)
1 On the Work Plane toolbar, click Transforms and choose Array.

2 Select the object r3 only.

3 In the Settings window for Array, locate the Size section.

4 From the Array type list, choose Linear.

5 In the Size text field, type 3.

6 Locate the Displacement section. In the yw text field, type -l_line2-w_line3.

7 On the Work Plane toolbar, click Build All.

Difference 1 (dif1)
1 On the Work Plane toolbar, click Booleans and Partitions and choose Difference.

2 Select the objects r2 and r1 only.

3 In the Settings window for Difference, locate the Difference section.

4 Find the Objects to subtract subsection. Select the Active toggle button.

5 Select the objects arr1(1), arr1(2), and arr1(3) only, the three rectangles belonging to the 
array object (arr1).
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6 Clear the Keep interior boundaries check box.

7 On the Work Plane toolbar, click Build All.

Work Plane 1 (wp1)
In the Model Builder window, under Component 1 (comp1)>Geometry 1 click 
Work Plane 1 (wp1).

Extrude the xy-plane with the thickness of the substrate. Additional rectangular 
boundaries at each end of the feed lines are created by this extrusion, too. Use these 
boundaries to assign lumped ports later.

Extrude 1 (ext1)
1 On the Geometry toolbar, click Extrude.

2 In the Settings window for Extrude, locate the Distances section.

3 In the table, enter the following settings:

4 Click Build All Objects.

5 Click the Zoom Extents button on the Graphics toolbar.

Choose wireframe rendering to get a better view of the interior parts.

6 Click the Wireframe Rendering button on the Graphics toolbar.

Distances (mm)

thickness
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Create a block for the substrate.

Block 1 (blk1)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, locate the Size and Shape section.

3 In the Width text field, type l_s.

4 In the Depth text field, type l_s.

5 In the Height text field, type thickness.

6 Locate the Position section. From the Base list, choose Center.

7 In the z text field, type thickness/2.

8 Click Build All Objects.

Union 1 (uni1)
1 On the Geometry toolbar, click Booleans and Partitions and choose Union.

2 In the Settings window for Union, type Substrate in the Label text field.

3 Locate the Union section. Clear the Keep interior boundaries check box.

4 Click in the Graphics window and then press Ctrl+A to select both objects.

5 Locate the Selections of Resulting Entities section. Select the Resulting objects selection 
check box.

6 Click Build All Objects.

Block 2 (blk2)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, type Package in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type l_s.

4 In the Depth text field, type l_s+l_s/8.

5 In the Height text field, type thickness*5.

6 Locate the Position section. From the Base list, choose Center.

7 In the z text field, type thickness*5/2.
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8 Click Build All Objects.

The completed geometry describes the microstrip line device on a substrate enclosed by 
a metal housing.

D E F I N I T I O N S

Create a selection for the microstrip lines.

Explicit 1
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Microstrip Line in the Label text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.
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4 Select Boundary 13 only.

View 1
Hide three boundaries to get a better view of the interior parts when reviewing the mesh.

Hide for Physics 1
1 In the Model Builder window, under Component 1 (comp1)>Definitions right-click View 1 

and choose Hide for Physics.

2 In the Settings window for Hide for Physics, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Boundary.

4 Select Boundaries 1, 2, and 4 only.

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

Now set up the physics. The default boundary condition is perfect electric conductor, 
which is applied to all exterior boundaries. Apply this condition also to the interior 
boundaries of the microstrip lines.

Perfect Electric Conductor 2
1 In the Model Builder window, under Component 1 (comp1) right-click 

Electromagnetic Waves, Frequency Domain (emw) and choose Perfect Electric Conductor.

2 In the Settings window for Perfect Electric Conductor, locate the Boundary Selection 
section.

3 From the Selection list, choose Microstrip Line.
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Lumped Port 1
1 In the Model Builder window, right-click Electromagnetic Waves,

Frequency Domain (emw) and choose Lumped Port.

2 Select Boundary 24 only.

For the first port, wave excitation is on by default.

Lumped Port 2
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Lumped Port.

2 Select Boundary 25 only.

Lumped Port 3
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Lumped Port.

2 Select Boundary 15 only.

Lumped Port 4
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Lumped Port.

2 Select Boundary 14 only.

Lumped ports are assigned at each end of the microstrip lines. Wave excitation is on only 
at the first port.
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M A T E R I A L S

Assign material properties to the model. First, apply air to all domains.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Built-In>Air.

4 Click Add to Component in the window toolbar.

M A T E R I A L S

1 On the Home toolbar, click Add Material to close the Add Material window.

Create a dielectric material of er = 3.38 overriding air in the substrate.

Material 2 (mat2)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, type Substrate in the Label text field.

3 Locate the Geometric Entity Selection section. From the Selection list, choose Substrate.

4 Locate the Material Contents section. In the table, enter the following settings:

M E S H  1

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.

Property Name Value Unit Property 
group

Relative permittivity epsilonr 3.38 1 Basic

Relative permeability mur 1 1 Basic

Electrical conductivity sigma 0 S/m Basic
13 |  B R A N C H - L I N E  C O U P L E R



2 In the Settings window for Mesh, click Build All.

Three exterior boundaries are hidden in this view.

S T U D Y  1

On the Home toolbar, click Compute.

R E S U L T S

Electric Field (emw)
Begin the results analysis and visualization by modifying the first default plot to show the 
E-field norm in the middle of the substrate at 3 GHz.

1 In the Model Builder window, under Results click Electric Field (emw).

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Parameter value (freq (GHz)) list, choose 3.

Multislice
1 In the Model Builder window, expand the Electric Field (emw) node, then click Multislice.

2 In the Settings window for Multislice, locate the Multiplane Data section.

3 Find the X-planes subsection. In the Planes text field, type 0.

4 Find the Y-planes subsection. In the Planes text field, type 0.

5 Find the Z-planes subsection. From the Entry method list, choose Coordinates.
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6 In the Coordinates text field, type thickness/2.

7 On the Electric Field (emw) toolbar, click Plot.

The input power is evenly split between the two output ports.

S-Parameter (emw)
1 In the Model Builder window, under Results click S-Parameter (emw).

2 In the Settings window for 1D Plot Group, click to expand the Title section.

3 From the Title type list, choose None.

4 Click to expand the Legend section. From the Position list, choose Lower right.

Compare the resulting plot with that shown in Figure 3.
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Smith Plot (emw)

Plot the phases on two output ports (Figure 4).

1D Plot Group 4
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, locate the Title section.

3 From the Title type list, choose None.

Global 1
1 Right-click 1D Plot Group 4 and choose Global.

2 In the Settings window for Global, locate the y-Axis Data section.

3 In the table, enter the following settings:

The unit is degree.

4 On the 1D Plot Group 4 toolbar, click Plot.

The phase difference between two output ports is approximately 90 degrees at 3 GHz.

Expression Unit Description

arg(emw.S21) deg S-parameter, 21 component, phase

arg(emw.S31) deg S-parameter, 31 component, phase
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Evaluate the phase difference between two output ports at 3 GHz.

Global Evaluation 1
1 On the Results toolbar, click Global Evaluation.

2 In the Settings window for Global Evaluation, locate the Data section.

3 From the Parameter selection (freq) list, choose From list.

4 In the Parameter values (freq (GHz)) list, select 3.

5 Locate the Expressions section. In the table, enter the following settings:

6 Click Evaluate.

Expression Unit Description

arg(emw.S21)-arg(emw.S31) °
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Introduction

Microwave filters serve to suppress unwanted frequencies in the output of microwave 
transmitters. Amplifiers are in general nonlinear and produce harmonics that must be 
suppressed using one or several narrow passband filters on the output. High-frequency 
stability can be hard to achieve in such filters because microwave systems may be subject 
to thermal drift caused by high-power loads or harsh environmental conditions like 
exposure to direct sunlight in the desert. Thus, system engineers need to estimate the drift 
of the passband frequency that arises due to thermal expansion of a filter.

Figure 1: The microwave filter in this example consists of a thin metallic box, made of copper 
that contains a cylindrical post. This configuration forms a closed air-filled electromagnetic 
cavity between the box walls and the post.

Note: This example requires the RF Module and the Structural Mechanics Module.

Model Definition

Figure 1 shows the filter geometry. It consists of a box with a cylindrical post centered on 
one face. It is made of copper covered with a thin layer of silver to minimize losses. The 
silver layer not modeled is sufficiently thin to have a negligible influence on the device’s 

Air-filled cavity
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thermal and mechanical properties. The all-copper design will be compared to a second 
design using both copper and steel.

Thermal expansion and the associated drift in eigenfrequency are caused by a uniform 
increase in the temperature of the cavity walls. The thermal expansion is readily computed 
using the Solid Mechanics physics interface from the Structural Mechanics Module. The 
eigenfrequency analysis of the cavity structure is easily performed using the 3D 
Electromagnetic Waves, Frequency Domain physics interface in the RF Module. 

The model uses the Deformed Geometry (dg) interface to address the distorted shape of 
the filter geometry due to the thermal expansion. The deformed shape is used for the 
electromagnetic analysis.

Results and Discussion

The filter’s temperature can rise due to power dissipation in the filter itself, in the 
surrounding electronics, or due to external heating. Figure 2 shows the thermal expansion 
results for a filter made entirely of copper.

Figure 2: Thermal expansion at 100 °C above the reference temperature.
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An actual filter usually consists of multiple cavities cascaded, but this discussion limits the 
analysis to one cell. Figure 3 shows the filter’s lowest eigenfrequency. The typical quarter-
wave resonance of the cylindrical post is clearly visible. A strong capacitive coupling 
between the top of the post and the nearby face of the box is also obvious.

Figure 3: Results from the electromagnetic mode analysis. The plot shows the electric field and 
surface current patterns of the fundamental mode.

By repeating the structural and electromagnetic analyses for a number of operating 
temperatures, an eigenfrequency-versus-temperature curve is obtained. The results for two 
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different designs appear in Figure 4.

Figure 4: Eigenfrequency (Hz) versus temperature (K) for two different designs.

The first design, where the entire filter is made of copper, has been discussed already. For 
the second design the post is made of steel. It is obvious that the combination of the steel 
post and copper box is superior to a design using copper alone. The reason is the reduced 
capacitive coupling between the top of the post and the nearby face of the box, which 
results from the different coefficients of thermal expansion for the two materials. This 
coupling has a strong influence on the resonant frequency and, when reduced, counteracts 
the effects of an overall increase in cavity size.

Model Library path: RF_Module/Filters/cavity_filter_thermal_expansion

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.
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M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Structural Mechanics>Solid Mechanics (solid).

3 Click Add.

4 In the Select Physics tree, select Mathematics>Deformed Mesh>Deformed Geometry (dg).

5 Click Add.

6 In the Select Physics tree, select Radio Frequency>Electromagnetic Waves,

Frequency Domain (emw).

7 Click Add.

8 Click Done.

In this model you use a parametric sweep to study thermal expansion as a function of the 
operating temperature. Begin by setting up a solver sequence for the three physics 
interfaces.

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Preset Studies.

4 Find the Physics interfaces in study subsection. In the table, clear the Solve check box for 
Deformed Geometry (dg) and Electromagnetic Waves, Frequency Domain (emw).

5 Find the Studies subsection. In the Select Study tree, select Preset Studies>Stationary.

6 Click Add Study in the window toolbar.

S T U D Y  1

Step 1: Stationary
On the Home toolbar, click Add Study to close the Add Study window.

Step 2: Stationary 2
1 On the Study toolbar, click Study Steps and choose Stationary>Stationary.

2 In the Settings window for Stationary, locate the Physics and Variables Selection section.

3 In the table, clear the Solve for check box for Solid Mechanics (solid) and Electromagnetic 

Waves, Frequency Domain (emw).

Step 3: Eigenfrequency
1 On the Study toolbar, click Study Steps and choose Eigenfrequency>Eigenfrequency.
6 |  T H E R M A L  D R I F T  I N  A  M I C R O W A V E  C A V I T Y  F I L T E R



2 In the Settings window for Eigenfrequency, locate the Physics and Variables Selection 
section.

3 In the table, clear the Solve for check box for Solid Mechanics (solid) and Deformed 

Geometry (dg).

4 Locate the Study Settings section. Select the Desired number of eigenfrequencies check 
box.

5 In the associated text field, type 1.

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

G E O M E T R Y  1

Block 1 (blk1)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, locate the Size and Shape section.

3 In the Width text field, type 0.02.

4 In the Depth text field, type 0.02.

5 In the Height text field, type 0.07.

6 Click Build Selected.

7 Click the Wireframe Rendering button on the Graphics toolbar.

Block 2 (blk2)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, locate the Size and Shape section.

3 In the Width text field, type 0.022.

4 In the Depth text field, type 0.022.

5 In the Height text field, type 0.072.

Name Expression Value Description

T0 0[degC] 273.2 K Reference temperature

T1 100[degC] 373.2 K Operating temperature
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6 Locate the Position section. In the x text field, type -0.001.

7 In the y text field, type -0.001.

8 In the z text field, type -0.001.

Cylinder 1 (cyl1)
1 On the Geometry toolbar, click Cylinder.

2 In the Settings window for Cylinder, locate the Size and Shape section.

3 In the Radius text field, type 0.004.

4 In the Height text field, type 0.067.

5 Locate the Position section. In the x text field, type 0.01.

6 In the y text field, type 0.01.

7 On the Geometry toolbar, click Build All.

D E F I N I T I O N S

View 1
1 In the Model Builder window, expand the Component 1 (comp1)>Definitions node.

2 Right-click View 1 and choose Hide for Geometry.

3 In the Settings window for Hide for Geometry, locate the Selection section.
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4 From the Geometric entity level list, choose Boundary.

5 On the object fin, select Boundaries 1, 2, 4, 6, 7, and 9 only.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Built-In>Copper.

4 Click Add to Component in the window toolbar.

M A T E R I A L S

Copper (mat1)
1 In the Model Builder window, under Component 1 (comp1)>Materials click Copper (mat1).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 In the  list, select 2.

4 Click Remove from Selection.
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5 Select Domains 1 and 3 only.

6 Click Create Selection.

7 In the Create Selection dialog box, type Metal in the Selection name text field.

8 Click OK.

A D D  M A T E R I A L

1 Go to the Add Material window.

2 In the tree, select Built-In>Air.

3 Click Add to Component in the window toolbar.

M A T E R I A L S

Air (mat2)
1 In the Model Builder window, under Component 1 (comp1)>Materials click Air (mat2).
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2 Select Domain 2 only.

3 On the Home toolbar, click Add Material to close the Add Material window.

4 In the Settings window for Material, locate the Geometric Entity Selection section.

5 Click Create Selection.

6 In the Create Selection dialog box, type Air in the Selection name text field.

7 Click OK.

S O L I D  M E C H A N I C S  ( S O L I D )

1 In the Model Builder window, under Component 1 (comp1) click Solid Mechanics (solid).

2 In the Settings window for Solid Mechanics, locate the Domain Selection section.

3 From the Selection list, choose Metal.

Thermal Expansion 1
1 In the Model Builder window, under Component 1 (comp1)>Solid Mechanics (solid) right-

click Linear Elastic Material 1 and choose Thermal Expansion.

2 In the Settings window for Thermal Expansion, locate the Model Input section.

3 In the T text field, type T1.

4 Locate the Thermal Expansion Properties section. In the Tref text field, type T0.
11 |  T H E R M A L  D R I F T  I N  A  M I C R O W A V E  C A V I T Y  F I L T E R



Prescribed Displacement 1
1 In the Model Builder window, right-click Solid Mechanics (solid) and choose Points>

Prescribed Displacement.

Appropriate prescribed displacement on points must be applied to eliminate any 
translation or rotation of the structure.

2 Select Point 1 only.

3 In the Settings window for Prescribed Displacement, locate the Prescribed Displacement 
section.

4 Select the Prescribed in x direction check box.

5 Select the Prescribed in y direction check box.

6 Select the Prescribed in z direction check box.

Prescribed Displacement 2
1 Right-click Solid Mechanics (solid) and choose Points>Prescribed Displacement.
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2 Select Point 3 only.

3 In the Settings window for Prescribed Displacement, locate the Prescribed Displacement 
section.

4 Select the Prescribed in x direction check box.

5 Select the Prescribed in z direction check box.

Prescribed Displacement 3
1 Right-click Solid Mechanics (solid) and choose Points>Prescribed Displacement.
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2 Select Point 21 only.

3 In the Settings window for Prescribed Displacement, locate the Prescribed Displacement 
section.

4 Select the Prescribed in y direction check box.

5 Select the Prescribed in z direction check box.

D E F O R M E D  G E O M E T R Y  ( D G )

Free Deformation 1
1 In the Model Builder window, under Component 1 (comp1) right-click 

Deformed Geometry (dg) and choose Free Deformation.

2 In the Settings window for Free Deformation, locate the Domain Selection section.

3 From the Selection list, choose Air.

Prescribed Mesh Displacement 2
1 In the Model Builder window, right-click Deformed Geometry (dg) and choose 

Prescribed Mesh Displacement.

2 Click the Select All button on the Graphics toolbar.

3 In the Settings window for Prescribed Mesh Displacement, locate the 
Prescribed Mesh Displacement section.

4 In the dX text field, type u.

5 In the dY text field, type v.
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6 In the dZ text field, type w.

Prescribed Deformation 1
1 Right-click Deformed Geometry (dg) and choose Prescribed Deformation.

2 In the Settings window for Prescribed Deformation, locate the Domain Selection section.

3 From the Selection list, choose Metal.

4 Locate the Prescribed Mesh Displacement section. In the dX text-field array, type u on the 
first row.

5 In the dY text-field array, type v on the second row.

6 In the dZ text-field array, type w on the third row.

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

The losses on metallic surfaces are negligible since the analysis frequency is low, so the 
boundaries are modeled as perfect electric conductors (PEC) by default.

1 In the Model Builder window, under Component 1 (comp1) click Electromagnetic Waves,

Frequency Domain (emw).

2 In the Settings window for Electromagnetic Waves, Frequency Domain, locate the 
Domain Selection section.

3 From the Selection list, choose Air.

M E S H  1

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.

2 In the Settings window for Mesh, locate the Mesh Settings section.

3 From the Element size list, choose Coarser.
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4 Click Build All.

S T U D Y  1

Parametric Sweep
1 On the Study toolbar, click Parametric Sweep.

2 In the Settings window for Parametric Sweep, locate the Study Settings section.

3 Click Add.

4 In the table, enter the following settings:

5 Click Range.

6 In the Range dialog box, choose Number of values from the Entry method list.

7 In the Start text field, type T0.

8 In the Stop text field, type T1.

9 In the Number of values text field, type 11.

10 Click Replace.

Parameter name Parameter value list Parameter unit

T1
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11 On the Study toolbar, click Compute.

Follow these instructions to reproduce the plot in Figure 2 that shows the structural 
deformation.

R E S U L T S

Stress (solid)
1 In the Model Builder window, under Results click Stress (solid).

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Data set list, choose Study 1/Parametric Solutions 1 (sol4).

Surface 1
1 In the Model Builder window, expand the Stress (solid) node, then click Surface 1.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type solid.disp.

4 On the Stress (solid) toolbar, click Plot.

Next, reproduce the electric field and surface current plot for the filter’s lowest 
eigenmode, shown in Figure 3.

Multislice
1 In the Model Builder window, expand the Electric Field (emw) node, then click Multislice.

2 In the Settings window for Multislice, locate the Multiplane Data section.

3 Find the Y-planes subsection. In the Planes text field, type 0.

4 Find the Z-planes subsection. In the Planes text field, type 0.

5 Locate the Coloring and Style section. From the Color table list, choose Thermal.

Surface 1
1 In the Model Builder window, under Results right-click Electric Field (emw) and choose 

Surface.

2 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 1>Electromagnetic Waves,

Frequency Domain>Currents and charge>emw.normJs - Surface current density norm.

3 On the Electric Field (emw) toolbar, click Plot.

Having confirmed the correctness of the model setup, compute the thermal drift over the 
operating temperature range of 0° C to 100° C.
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1D Plot Group 3
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, locate the Data section.

3 From the Data set list, choose Study 1/Parametric Solutions 1 (sol4).

4 Click to expand the Title section. From the Title type list, choose None.

Global 1
1 Right-click 1D Plot Group 3 and choose Global.

2 In the Settings window for Global, locate the y-Axis Data section.

3 In the table, enter the following settings:

4 Locate the x-Axis Data section. From the Axis source data list, choose Outer solutions.

5 Click to expand the Coloring and style section. Locate the Coloring and Style section. 
Find the Line markers subsection. From the Marker list, choose Cycle.

6 From the Positioning list, choose In data points.

7 Click to expand the Legends section. From the Legends list, choose Manual.

8 In the table, enter the following settings:

9 On the 1D Plot Group 3 toolbar, click Plot.

Compare the copper-only design with one in which the post is made of steel.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Built-In>Steel AISI 4340.

4 Click Add to Component in the window toolbar.

M A T E R I A L S

Steel AISI 4340 (mat3)
1 In the Model Builder window, under Component 1 (comp1)>Materials click 

Steel AISI 4340 (mat3).

Expression Unit Description

emw.freq Hz Frequency

Legends

Copper only
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2 Select Domain 3 only.

3 On the Home toolbar, click Add Material to close the Add Material window.

S T U D Y  1

On the Study toolbar, click Create Solution Copy.

R E S U L T S

Global 1
1 In the Model Builder window, under Results>1D Plot Group 3 click Global 1.

2 In the Settings window for Global, locate the Data section.

3 From the Data set list, choose Study 1/Parametric Solutions 1 - Copy 1 (sol16).

4 On the Study toolbar, click Compute.

Global 2
1 In the Model Builder window, right-click Global 1 and choose Duplicate.

2 In the Settings window for Global, locate the Data section.

3 From the Data set list, choose From parent.

4 Click to expand the Legends section. In the table, enter the following settings:

Legends

Copper + Steel
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5 On the 1D Plot Group 3 toolbar, click Plot.

This reproduces the plot in Figure 4.
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Introduction

A classic benchmark example in computational electromagnetics is to find the resonant 
frequency and Q-factor of a cavity with lossy walls. Here, models of rectangular, 
cylindrical, and spherical cavities are shown to be in agreement with analytic solutions.

Model Definition

This example considers three geometries:

• a rectangular cavity of dimensions 0.9 in-by-0.9 in-by-0.4 in;

• a cylindrical cavity of radius 0.48 in and height 0.4 in; and

• a spherical cavity of radius 1.35 cm.

The cavity walls are assumed to be a good conductor, such as copper, with an electric 
conductivity of 5.7·107 S/m, and relative permeability and permittivity of unity. The 
interior of the cavity is assumed to be vacuum, with zero electric conductivity, and unit 
permeability and permittivity. The analytic solutions to these three cases are given in 
Ref. 1.

The lossy walls of the cavity are represented via the impedance boundary condition. This 
boundary condition accounts for the frequency dependent losses on the walls of a cavity 
due to the non-zero electric conductivity, which makes the eigenvalue problem nonlinear. 
When solving any eigenvalue problem, it is necessary to provide a frequency around which 
to search for modes. In addition, when solving a nonlinear eigenvalue problem, it is also 
necessary to provide a frequency at which to initially evaluate the frequency-dependent 
surface losses. Although the guesses for these frequencies do not need to be very close, 
solution time is less the closer they are.

It is usually possible to estimate the resonant frequency of interest, and to use this as an 
initial guess. It is also possible to quickly estimate the resonant frequency by building a 
second model that uses the perfect electrical conductor (PEC) boundary condition instead 
of the impedance boundary condition. A model that uses only PEC boundaries results in 
a linear eigenvalue problem, and is less computationally intensive to solve. Such a model 
only requires a rough guess at the frequency of the mode, and does not require a frequency 
at which to evaluate the surface losses. Therefore, it is often convenient to also solve a 
version of a model without losses.

Q - F A C T O R  A N D  R E S O N A N T  F R E Q U E N C Y  I N  C A V I T Y  S T R U C T U R E S

Q-factor is one of important parameters characterizing a resonant structure and defined as 
Q = ω (average energy stored/dissipated power). The average energy stored can be 
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evaluated as a volume integral of Energy density time average (emw.Wav) and the dissipated 
power can be evaluated as a surface integral of Surface losses (emw.Qsh).

Another way to calculate Q-factor at the dominant mode is via equations in Ref. 1. For a 
rectangular cavity, the dominant mode is TE101, at which the cavity provides the lowest 
resonant frequency. The Q-factor and resonant frequency at this mode is

There are two dominant modes for a cylindrical cavity. One dominant mode of the 
cylindrical cavity is TE111 when the ratio between the height and radius is more than 2.03. 
The other dominant mode is TM010 when the ratio is less than 2.03. For this case, the Q-
factor and resonant frequency are given as

For a spherical cavity, TM mode provides the lowest resonant frequency.

In the above equations, Rs is surface resistance defined as

and η is the characteristic impedance of free space, .

These two analytical approaches are compared with the Q-factor obtained from 
Eigenfrequency analysis.

Results and Discussion

The analytic resonant frequencies and Q-factors for these three cases, and the results of the 
COMSOL model for various levels of mesh refinement, are shown below. These show that 
the solutions agree. As the mesh is refined, the polynomial basis functions used by the 
finite element method better approximate the analytic solutions, which are described by 
sinusoidal functions for the rectangular cavity and Bessel functions for the cylindrical and 
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spherical cavities. This difference between the numerical results and the analytic solution 
is discretization error, and is always reduced with mesh refinement.

Note that convergence with respect to the mesh is fastest for the rectangular cavity and 
slowest for the spherical cavity. This is because the isoparametric finite-element mesh 
represents curved surfaces approximately, via second order polynomials by default. This 
introduces some small geometric discretization error that is always reduced with mesh 
refinement. Although it is possible to use different element orders, the default second-
order curl element (also known as a vector or Nedelec element) is the best compromise 
between accuracy and memory requirements. Because memory requirements for three-
dimensional models increase exponentially with increasing element order, and increasing 
number of elements, there is strong motivation to use as coarse a mesh as reasonable. 
Figure 1 shows the fields within the cavities, as well as the surface currents and surface 
losses.

TABLE 1:  RESULTS FOR THE TE101 MODE OF A RECTANGULAR CAVITY

MAXIMUM 
MESH SIZE

RESONANT FREQUENCY, GHZ
(ANALYTIC=9.273)

Q-FACTOR
(ANALYTIC=7770)

h_max 9.706 7039

h_max/2 9.283 7687

h_max/4 9.273 7765

h_max/8 9.273 7770

TABLE 2:  RESULTS FOR THE TM010 MODE OF A CYLINDRICAL CAVITY

MAXIMUM 
MESH SIZE

RESONANT FREQUENCY, GHZ
(ANALYTIC=9.412)

Q-FACTOR
(ANALYTIC=8065)

h_max 9.458 7891

h_max/2 9.419 8004

h_max/4 9.411 8056

h_max/8 9.411 8065

TABLE 3:  RESULTS FOR THE TM011 MODE OF A SPHERICAL CAVITY

MAXIMUM 
MESH SIZE

RESONANT FREQUENCY, GHZ
(ANALYTIC=9.698)

Q-FACTOR
(ANALYTIC=14594)

h_max 9.752 14121

h_max/2 9.723 14430

h_max/4 9.701 14616

h_max/8 9.697 14641
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Figure 1: Arrow plots of electric and magnetic fields. Slice plot of electric field.
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Figure 2: Arrow plots of surface currents. Surface plot of surface losses.
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Notes About the COMSOL Implementation

Solve this example using an Eigenfrequency study. Search for a single eigenfrequency 
around 9·109 Hz. Because of the impedance boundary condition with a finite 
conductivity value, the model becomes a nonlinear eigenvalue problem and it is necessary 
to provide a frequency at which to initially evaluate the frequency-dependent surface 
losses. In the Eigenvalue Solver settings window you can see the linearization point is 
automatically specified to the value in “Search for eigenfrequencies around” in the study 
settings.

Reference

1. C.A. Balanis, Advanced Engineering Electromagnetics, John Wiley & Sons, 1989.

Application Library path: RF_Module/Verification_Examples/
cavity_resonators

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Radio Frequency>Electromagnetic Waves,

Frequency Domain (emw).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Eigenfrequency.

6 Click Done.
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G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
cavity_resonators_parameters.txt.

Here, mu0_const and epsilon0_const in the imported table are predefined 
COMSOL constants for the permeability and permittivity in free space. From the Value 
column you can read off the values f_TE101_analytic_r = 9.273 GHz, 
Q_TE101_analytic_r = 7770 for the rectangular cavity, f_TM010_analytic_c = 
9.412 GHz, Q_TM010_analytic_c = 8065 for the cylindrical cavity, 
f_TM011_analytic_s = 9.698 GHz, and Q_TM011_analytic_s = 14594 for the 
spherical cavity.

Since air and lossy wall materials will be used on multiple components, add them on the 
global material node. They will be linked to each individual component later on.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Built-In>Air.

4 Click Add to Global Materials.

G L O B A L  D E F I N I T I O N S

Air (mat1)
On the Home toolbar, click Add Material to close the Add Material window.

Material 2 (mat2)
1 In the Model Builder window, under Global Definitions right-click Materials and choose 

Blank Material.

2 In the Settings window for Material, type Lossy Wall in the Label text field.

3 Click to expand the Material properties section. Locate the Material Properties section. 
In the Material properties tree, select Basic Properties>Relative Permittivity.

4 Click Add to Material.

5 In the Material properties tree, select Basic Properties>Relative Permeability.
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6 Click Add to Material.

7 In the Material properties tree, select Basic Properties>Electrical Conductivity.

8 Click Add to Material.

9 Locate the Material Contents section. In the table, enter the following settings:

G E O M E T R Y  1

Create a block for the rectangular cavity.

Block 1 (blk1)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, locate the Size and Shape section.

3 In the Width text field, type a_r.

4 In the Depth text field, type a_r.

5 In the Height text field, type b_r.

6 Click Build All Objects.

Property Name Value Unit Property 
group

Relative permittivity epsilonr 1 1 Basic

Relative permeability mur 1 1 Basic

Electrical conductivity sigma sigma_wall S/m Basic
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E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

Now set up the physics. Override the default perfect electric conductor condition on the 
exterior boundaries by an impedance condition.

1 In the Model Builder window, under Component 1 (comp1) click Electromagnetic Waves,

Frequency Domain (emw).

2 In the Settings window for Electromagnetic Waves, Frequency Domain, locate the Physics-

Controlled Mesh section.

3 Clear the Enable check box.

Impedance Boundary Condition 1
1 Right-click Component 1 (comp1)>Electromagnetic Waves, Frequency Domain (emw) and 

choose Impedance Boundary Condition.

2 In the Settings window for Impedance Boundary Condition, locate the Boundary Selection 
section.

3 From the Selection list, choose All boundaries.

M A T E R I A L S

Assign material properties on the model by linking the global material already created. 
First, apply air to all domains.

Material Link 2 (matlnk2)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Material Link.

2 Right-click Component 1 (comp1)>Materials and choose Material Link.

Define a lossy conductive material for all exterior boundaries.

3 In the Settings window for Material Link, locate the Geometric Entity Selection section.

4 From the Geometric entity level list, choose Boundary.

5 From the Selection list, choose All boundaries.

6 Locate the Link Settings section. From the Material list, choose Lossy Wall (mat2).

D E F I N I T I O N S

Add variables for Q-factor calculation and visualization. For this Q-factor calculation, add 
two integration coupling operators: one for volume and the other for surface integration.

Integration 1 (intop1)
1 On the Definitions toolbar, click Component Couplings and choose Integration.

2 In the Settings window for Integration, type int_v in the Operator name text field.
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3 Locate the Source Selection section. From the Selection list, choose All domains.

Integration 2 (intop2)
1 On the Definitions toolbar, click Component Couplings and choose Integration.

2 In the Settings window for Integration, type int_s in the Operator name text field.

3 Locate the Source Selection section. From the Geometric entity level list, choose 
Boundary.

4 From the Selection list, choose All boundaries.

Variables 1
1 On the Definitions toolbar, click Local Variables.

2 In the Settings window for Variables, locate the Variables section.

3 Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
cavity_resonators_model1_variables.txt.

The emw. prefix is for the Electromagnetic Waves, Frequency Domain interface in the 
first model. Wav and Qsh are Energy density time average and Surface losses, 
respectively. Qfactor included in this text file shows up in orange indicating an 
unknown variable. It will be known after solving the model.

M E S H  1

The maximum mesh size is one dimension of the cavity scaled inversely by d_f, a 
discretization factor defined in Parameters. The discretization factor is also used as a 
parametric sweep variable to see the effect of the mesh refinement.

Size
1 In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 

Free Tetrahedral.

2 In the Settings window for Size, locate the Element Size section.

3 Click the Custom button.

4 Locate the Element Size Parameters section. In the Maximum element size text field, type 
h_max_r/d_f.

5 In the Maximum element growth rate text field, type 2.

6 In the Curvature factor text field, type 1.

7 In the Resolution of narrow regions text field, type 0.1.

8 Click Build All.
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S T U D Y  1

Provide the number of modes and a frequency around which to search for modes.

Step 1: Eigenfrequency
1 In the Model Builder window, expand the Study 1 node, then click Step 1: Eigenfrequency.

2 In the Settings window for Eigenfrequency, locate the Study Settings section.

3 Select the Desired number of eigenfrequencies check box.

4 In the associated text field, type 1.

5 Select the Search for eigenfrequencies around check box.

6 In the associated text field, type 9[GHz].

Add a Parametric Sweep over the discretization factor, d_f.

Parametric Sweep
1 On the Study toolbar, click Parametric Sweep.

2 In the Settings window for Parametric Sweep, locate the Study Settings section.

3 Click Add.

4 In the table, enter the following settings:

5 On the Study toolbar, click Compute.

R E S U L T S

Electric Field (emw)
The default plot shows the distribution of the norm of the electric field. Add arrow plots 
of the electric and magnetic fields.

Arrow Volume 1
1 In the Model Builder window, under Results right-click Electric Field (emw) and choose 

Arrow Volume.

2 In the Settings window for Arrow Volume, click Replace Expression in the upper-right 
corner of the Expression section. From the menu, choose Component 1>

Electromagnetic Waves, Frequency Domain>Electric>emw.Ex,emw.Ey,emw.Ez -

Electric field.

3 On the Electric Field (emw) toolbar, click Plot.

Parameter name Parameter value list Parameter unit

d_f 1 2 4 8
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Arrow Volume 2
1 Right-click Electric Field (emw) and choose Arrow Volume.

2 In the Settings window for Arrow Volume, click Replace Expression in the upper-right 
corner of the Expression section. From the menu, choose Component 1>

Electromagnetic Waves, Frequency Domain>Magnetic>emw.Hx,emw.Hy,emw.Hz -

Magnetic field.

3 Locate the Arrow Positioning section. Find the Z grid points subsection. In the Points text 
field, type 1.

4 Locate the Coloring and Style section. From the Color list, choose White.

5 On the Electric Field (emw) toolbar, click Plot.

6 Click the Zoom Extents button on the Graphics toolbar.

Compare the resulting plot with that shown in Figure 1, top. The exact numbers that 
you get may differ slightly.

Add a surface plot of the surface losses and an arrow plot of the surface current (Figure 2, 
top).

Surface 1
1 On the Home toolbar, click Add Plot Group and choose 3D Plot Group.

2 In the Model Builder window, right-click 3D Plot Group 2 and choose Surface.

3 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 1>Electromagnetic Waves,

Frequency Domain>Heating and losses>emw.Qsh - Surface losses.

4 Locate the Coloring and Style section. From the Color table list, choose 
ThermalEquidistant.

3D Plot Group 2
1 In the Model Builder window, under Results click 3D Plot Group 2.

2 In the Settings window for 3D Plot Group, type Surface Losses (emw) in the Label text 
field.

Arrow Surface 1
1 Right-click Results>Surface Losses (emw) and choose Arrow Surface.

2 In the Settings window for Arrow Surface, click Replace Expression in the upper-right 
corner of the Expression section. From the menu, choose Component 1>

Electromagnetic Waves, Frequency Domain>Currents and charge>emw.Jsx,...,emw.Jsz -

Surface current density.
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3 Locate the Coloring and Style section. From the Color list, choose Blue.

4 On the Surface Losses (emw) toolbar, click Plot.

R O O T

Next, set up a model for the cylindrical cavity.

1 On the Home toolbar, click Component and choose Add Component>3D.

G E O M E T R Y  2

In the Model Builder window, under Component 2 (comp2) click Geometry 2.

A D D  P H Y S I C S

1 On the Home toolbar, click Add Physics to open the Add Physics window.

2 Go to the Add Physics window.

3 In the tree, select Radio Frequency>Electromagnetic Waves, Frequency Domain (emw).

4 Click Add to Component in the window toolbar.

5 On the Home toolbar, click Add Physics to close the Add Physics window.

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Empty Study.

You will copy the settings from the existing study later on.

4 Click Add Study in the window toolbar.

5 On the Home toolbar, click Add Study to close the Add Study window.

G E O M E T R Y  2

Cylinder 1 (cyl1)
1 On the Geometry toolbar, click Cylinder.

2 In the Settings window for Cylinder, locate the Size and Shape section.

3 In the Radius text field, type a_c.

4 In the Height text field, type height_c.
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5 Click Build All Objects.

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  2  ( E M W 2 )

Set up the second physics interface. The steps are same as for the first model.

Impedance Boundary Condition 1
1 In the Model Builder window, under Component 2 (comp2) right-click 

Electromagnetic Waves, Frequency Domain 2 (emw2) and choose 
Impedance Boundary Condition.

2 In the Settings window for Impedance Boundary Condition, locate the Boundary Selection 
section.

3 From the Selection list, choose All boundaries.

M A T E R I A L S

Assign material properties on the second model. Apply air to all domains.

Material Link 4 (matlnk4)
1 In the Model Builder window, under Component 2 (comp2) right-click Materials and 

choose Material Link.

2 Right-click Component 2 (comp2)>Materials and choose Material Link.

Define a lossy conductive material for all exterior boundaries.

3 In the Settings window for Material Link, locate the Geometric Entity Selection section.
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4 From the Geometric entity level list, choose Boundary.

5 From the Selection list, choose All boundaries.

6 Locate the Link Settings section. From the Material list, choose Lossy Wall (mat2).

D E F I N I T I O N S

Add variables and two integration coupling operators. The purpose of these is same as in 
the first model.

Integration 3 (intop3)
1 On the Definitions toolbar, click Component Couplings and choose Integration.

2 In the Settings window for Integration, type int_v in the Operator name text field.

3 Locate the Source Selection section. From the Selection list, choose All domains.

Integration 4 (intop4)
1 On the Definitions toolbar, click Component Couplings and choose Integration.

2 In the Settings window for Integration, type int_s in the Operator name text field.

3 Locate the Source Selection section. From the Geometric entity level list, choose 
Boundary.

4 From the Selection list, choose All boundaries.

Variables 2
1 On the Definitions toolbar, click Local Variables.

2 In the Settings window for Variables, locate the Variables section.

3 Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
cavity_resonators_model2_variables.txt.

The emw2. prefix refers to the Electromagnetic Waves, Frequency Domain interface for 
the second model.

M E S H  2

Apply the same logic in the mesh set up as you have done in the first model.

Size
1 In the Model Builder window, under Component 2 (comp2) right-click Mesh 2 and choose 

Free Tetrahedral.

2 In the Settings window for Size, locate the Element Size section.

3 Click the Custom button.
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4 Locate the Element Size Parameters section. In the Maximum element size text field, type 
h_max_c/d_f.

5 In the Maximum element growth rate text field, type 2.

6 In the Curvature factor text field, type 1.

7 In the Resolution of narrow regions text field, type 0.1.

8 Click Build All.

S T U D Y  1

Parametric Sweep
Select both Study 1> Step 1: Eigenfrequency 1 and Study 1> Parametric Sweep 1 using shift-
key. Copy them and Paste on Study 2.

S T U D Y  2

Step 1: Eigenfrequency 1
1 In the Model Builder window, under Study 2 click Step 1: Eigenfrequency 1.

2 In the Settings window for Eigenfrequency, locate the Physics and Variables Selection 
section.

3 In the table, enter the following settings:

4 On the Home toolbar, click Compute.

R E S U L T S

Arrow Volume 1
1 In the Model Builder window, under Results right-click Electric Field (emw2) and choose 

Arrow Volume.

2 In the Settings window for Arrow Volume, click Replace Expression in the upper-right 
corner of the Expression section. From the menu, choose Component 2>

Electromagnetic Waves, Frequency Domain 2>Electric>emw2.Ex,emw2.Ey,emw2.Ez -

Electric field.

3 On the Electric Field (emw2) toolbar, click Plot.

Physics interface Solve for Discretization

Electromagnetic Waves, Frequency Domain physics

Electromagnetic Waves, Frequency Domain 2 √ physics
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Arrow Volume 2
1 Right-click Electric Field (emw2) and choose Arrow Volume.

2 In the Settings window for Arrow Volume, click Replace Expression in the upper-right 
corner of the Expression section. From the menu, choose Component 2>

Electromagnetic Waves, Frequency Domain 2>Magnetic>emw2.Hx,emw2.Hy,emw2.Hz -

Magnetic field.

3 Locate the Arrow Positioning section. Find the Z grid points subsection. In the Points text 
field, type 1.

4 Locate the Coloring and Style section. From the Color list, choose White.

5 On the Electric Field (emw2) toolbar, click Plot.

6 Click the Zoom Extents button on the Graphics toolbar.

The plot should now look like that in Figure 1, middle.

Again, add a surface plot of the surface losses and an arrow plot of the surface current 
(Figure 2, middle).

3D Plot Group 4
1 On the Home toolbar, click Add Plot Group and choose 3D Plot Group.

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Data set list, choose Study 2/Parametric Solutions 2 (6) (sol8).

Surface 1
1 Right-click 3D Plot Group 4 and choose Surface.

2 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 2>Electromagnetic Waves,

Frequency Domain 2>Heating and losses>emw2.Qsh - Surface losses.

3 Locate the Coloring and Style section. From the Color table list, choose 
ThermalEquidistant.

3D Plot Group 4
1 In the Model Builder window, under Results click 3D Plot Group 4.

2 In the Settings window for 3D Plot Group, type Surface Losses (emw2) in the Label 
text field.

Arrow Surface 1
1 Right-click Results>Surface Losses (emw2) and choose Arrow Surface.

2 In the Settings window for Arrow Surface, click Replace Expression in the upper-right 
corner of the Expression section. From the menu, choose Component 2>
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Electromagnetic Waves, Frequency Domain 2>Currents and charge>emw2.Jsx,...,emw2.Jsz -

Surface current density.

3 Locate the Coloring and Style section. From the Color list, choose Blue.

4 On the Surface Losses (emw2) toolbar, click Plot.

R O O T

Now add a model for the spherical cavity.

1 On the Home toolbar, click Component and choose Add Component>3D.

G E O M E T R Y  3

In the Model Builder window, under Component 3 (comp3) click Geometry 3.

A D D  P H Y S I C S

1 On the Home toolbar, click Add Physics to open the Add Physics window.

2 Go to the Add Physics window.

3 In the tree, select Radio Frequency>Electromagnetic Waves, Frequency Domain (emw).

4 Click Add to Component in the window toolbar.

5 On the Home toolbar, click Add Physics to close the Add Physics window.

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.
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2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Empty Study.

4 Click Add Study in the window toolbar.

5 On the Home toolbar, click Add Study to close the Add Study window.

G E O M E T R Y  3

Sphere 1 (sph1)
1 On the Geometry toolbar, click Sphere.

2 In the Settings window for Sphere, locate the Size section.

3 In the Radius text field, type a_s.

4 Click Build All Objects.

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  3  ( E M W 3 )

Set up the third physics interface.

Impedance Boundary Condition 1
1 In the Model Builder window, under Component 3 (comp3) right-click 

Electromagnetic Waves, Frequency Domain 3 (emw3) and choose 
Impedance Boundary Condition.

2 In the Settings window for Impedance Boundary Condition, locate the Boundary Selection 
section.
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3 From the Selection list, choose All boundaries.

M A T E R I A L S

Assign material properties on the third model. Apply air to all domains.

Material Link 6 (matlnk6)
1 In the Model Builder window, under Component 3 (comp3) right-click Materials and 

choose Material Link.

2 Right-click Component 3 (comp3)>Materials and choose Material Link.

Define a lossy conductive material for all exterior boundaries.

3 In the Settings window for Material Link, locate the Geometric Entity Selection section.

4 From the Geometric entity level list, choose Boundary.

5 From the Selection list, choose All boundaries.

6 Locate the Link Settings section. From the Material list, choose Lossy Wall (mat2).

D E F I N I T I O N S

Add variables and two integration coupling operators.

Integration 5 (intop5)
1 On the Definitions toolbar, click Component Couplings and choose Integration.

2 In the Settings window for Integration, type int_v in the Operator name text field.

3 Locate the Source Selection section. From the Selection list, choose All domains.

Integration 6 (intop6)
1 On the Definitions toolbar, click Component Couplings and choose Integration.

2 In the Settings window for Integration, type int_s in the Operator name text field.

3 Locate the Source Selection section. From the Geometric entity level list, choose 
Boundary.

4 From the Selection list, choose All boundaries.

Variables 3
1 On the Definitions toolbar, click Local Variables.

2 In the Settings window for Variables, locate the Variables section.

3 Click Load from File.
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4 Browse to the model’s Application Libraries folder and double-click the file 
cavity_resonators_model3_variables.txt.

The emw3. prefix in the imported table is for the physics interface, Electromagnetic 

Waves, Frequency Domain, in the third model.

M E S H  3

Size
1 In the Model Builder window, under Component 3 (comp3) right-click Mesh 3 and choose 

Free Tetrahedral.

2 In the Settings window for Size, locate the Element Size section.

3 Click the Custom button.

4 Locate the Element Size Parameters section. In the Maximum element size text field, type 
h_max_s/d_f.

5 In the Maximum element growth rate text field, type 2.

6 In the Curvature factor text field, type 1.

7 In the Resolution of narrow regions text field, type 0.1.

8 Click Build All.

S T U D Y  2

Parametric Sweep 1
Select both Study 2> Step 1: Eigenfrequency 1 and Study 2> Parametric Sweep 1 using shift-
key. Copy them and Paste on Study 3.

S T U D Y  3

Step 1: Eigenfrequency 1
1 In the Model Builder window, under Study 3 click Step 1: Eigenfrequency 1.

2 In the Settings window for Eigenfrequency, locate the Physics and Variables Selection 
section.

3 In the table, enter the following settings:

Physics interface Solve for Discretization

Electromagnetic Waves, Frequency Domain physics

Electromagnetic Waves, Frequency Domain 2 physics

Electromagnetic Waves, Frequency Domain 3 √ physics
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Solution 13 (sol13)
1 On the Study toolbar, click Show Default Solver.

2 Click Compute.

R E S U L T S

Arrow Volume 1
1 In the Model Builder window, under Results right-click Electric Field (emw3) and choose 

Arrow Volume.

2 In the Settings window for Arrow Volume, click Replace Expression in the upper-right 
corner of the Expression section. From the menu, choose Component 3>

Electromagnetic Waves, Frequency Domain 3>Electric>emw3.Ex,emw3.Ey,emw3.Ez -

Electric field.

Arrow Volume 2
1 Right-click Electric Field (emw3) and choose Arrow Volume.

2 In the Settings window for Arrow Volume, click Replace Expression in the upper-right 
corner of the Expression section. From the menu, choose Component 3>

Electromagnetic Waves, Frequency Domain 3>Magnetic>emw3.Hx,emw3.Hy,emw3.Hz -

Magnetic field.

3 Locate the Arrow Positioning section. Find the Z grid points subsection. In the Points text 
field, type 1.

4 Locate the Coloring and Style section. From the Color list, choose White.

5 On the Electric Field (emw3) toolbar, click Plot.

6 Click the Zoom Extents button on the Graphics toolbar.

Compare the resulting plot with that shown in Figure 1, bottom.

Again, add a surface plot of the surface losses and an arrow plot of the surface current 
(Figure 2, bottom).

3D Plot Group 6
1 On the Home toolbar, click Add Plot Group and choose 3D Plot Group.

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Data set list, choose Study 3/Parametric Solutions 3 (12) (sol14).

Surface 1
1 Right-click 3D Plot Group 6 and choose Surface.
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2 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 3>Electromagnetic Waves,

Frequency Domain 3>Heating and losses>emw3.Qsh - Surface losses.

3 Locate the Coloring and Style section. From the Color table list, choose 
ThermalEquidistant.

3D Plot Group 6
1 In the Model Builder window, under Results click 3D Plot Group 6.

2 In the Settings window for 3D Plot Group, type Surface Losses (emw3) in the Label 
text field.

Arrow Surface 1
1 Right-click Results>Surface Losses (emw3) and choose Arrow Surface.

2 In the Settings window for Arrow Surface, click Replace Expression in the upper-right 
corner of the Expression section. From the menu, choose Component 3>

Electromagnetic Waves, Frequency Domain 3>Currents and charge>emw3.Jsx,...,emw3.Jsz -

Surface current density.

3 Locate the Coloring and Style section. From the Color list, choose Blue.

4 On the Surface Losses (emw3) toolbar, click Plot.

Derived Values
Finish by evaluating the Q-factor and resonant frequency. Compare them with those 
values in Table 1, Table 2 and Table 3.
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Global Evaluation 1
1 On the Results toolbar, click Global Evaluation.

2 In the Settings window for Global Evaluation, locate the Data section.

3 From the Data set list, choose Study 1/Parametric Solutions 1 (sol2).

4 From the Eigenfrequency selection list, choose First.

5 From the Table columns list, choose Inner solutions.

6 Click Replace Expression in the upper-right corner of the Expressions section. From the 
menu, choose Component 1>Definitions>Variables>Q_computed - Q-factor,

computed from eigenvalue.

7 Click Evaluate.

8 Locate the Data section. From the Data set list, choose Study 2/

Parametric Solutions 2 (6) (sol8).

9 Click Evaluate.

10 From the Data set list, choose Study 3/Parametric Solutions 3 (12) (sol14).

11 Click Evaluate.

Global Evaluation 2
1 Right-click Global Evaluation 1 and choose Duplicate.

2 In the Settings window for Global Evaluation, locate the Data section.

3 From the Data set list, choose Study 1/Parametric Solutions 1 (sol2).

4 Click Replace Expression in the upper-right corner of the Expressions section. From the 
menu, choose Component 1>Definitions>Variables>Q_definition - Q-factor, definition.

5 Click New Table.

6 Locate the Data section. From the Data set list, choose Study 2/

Parametric Solutions 2 (6) (sol8).

7 Click Evaluate.

8 From the Data set list, choose Study 3/Parametric Solutions 3 (12) (sol14).

9 Click Evaluate.

Global Evaluation 3
1 In the Model Builder window, under Results>Derived Values right-click 

Global Evaluation 1 and choose Duplicate.

2 In the Settings window for Global Evaluation, locate the Data section.

3 From the Data set list, choose Study 1/Parametric Solutions 1 (sol2).
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4 Click Replace Expression in the upper-right corner of the Expressions section. From the 
menu, choose Component 1>Definitions>Variables>frequency - Frequency, simulated.

5 Click New Table.

6 Locate the Data section. From the Data set list, choose Study 2/

Parametric Solutions 2 (6) (sol8).

7 Click Evaluate.

8 From the Data set list, choose Study 3/Parametric Solutions 3 (12) (sol14).

9 Click Evaluate.
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Introduction

An application built with the RF Module can be connected to an electrical circuit 
equivalent, if there is some structure outside of the model space that you wish to 
approximate as a circuit equivalent. An example is shown in Figure 1, the 3D model of a 
coaxial cable is connected to a voltage source, in series with a matched impedance, and sees 
a load, also of matched impedance.

Figure 1: Schematic of a section of a coaxial transmission line connected to a voltage source, 
source impedance, and load. 

Model Definition

The geometry in this example is a short section of a air-filled coaxial transmission line, 
shown schematically in Figure 1. A 3D modeling space is used to model the coaxial cable. 
The walls of the coax are treated as perfect electric conductors. This is appropriate when 
the skin depth, and the losses in the conductors, are insignificant.

At one end of the coaxial cable, Lumped Port boundary condition is used to connect the 
model to nodes 0 and 2 of the Electrical Circuit. A Voltage Source between circuit nodes 
0 and 1 excites the system, and a Resistor representing the source impedance is added 
between nodes 1 and 2. Node 0 is specified as the Ground Node by default, which fixes 
the absolute voltage. The connection from the Electrical Circuit model to the 
Electromagnetic Waves interface is via the External I Vs. U features.

At the other end of the coaxial cable, another Lumped Port boundary condition is used to 
connect the model to nodes 3 and 0 of the Electrical Circuit. A Resistor which works as a 
matched load is added between nodes 3 and 0. At any non-zero frequency, the absolute 
voltage has no well-defined meaning, voltage only has a meaning as the path integral of 

0

1 2 3

0FE model of a coaxial cable

Zsource Zload

VAC
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electric field between two points, so any arbitrary point in the model can be chosen to have 
zero voltage. If you are working with a purely RF model, without an electrical circuit, it is 
not even possible to fix the absolute voltage. However, when using the Electrical Circuit 
interface, it requires that the absolute voltage be fixed at one node (Node 0) in the model.

Results and Discussion

Figure 2 is a combined plot of the default electric field norm, magnetic field, and power 
flow.

Figure 2: Electric field norm (multislices) and magnetic field, and power flow (green, blue 
arrows) inside the coaxial cable.

The fields and power flow plot shows the TEM wave propagation inside the coaxial cable, 
which is excited by the Electrical Circuit interface.

Notes About the COMSOL Implementation

The Electrical Circuit interface is located under the AD/DC Module branch, but it is 
included with the RF Module.
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Application Library path: RF_Module/Transmission_Lines_and_Waveguides/
coaxial_cable_circuit

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Radio Frequency>Electromagnetic Waves,

Frequency Domain (emw).

3 Click Add.

4 In the Select Physics tree, select AC/DC>Electrical Circuit (cir).

5 Click Add.

6 Click Study.

7 In the Select Study tree, select Preset Studies for Selected Physics Interfaces>

Frequency Domain.

8 Click Done.

S T U D Y  1

Step 1: Frequency Domain
1 In the Model Builder window, under Study 1 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 In the Frequencies text field, type 10[GHz].

Parameters
On the Home toolbar, click Parameters.

G L O B A L  D E F I N I T I O N S

Parameters
1 In the Settings window for Parameters, locate the Parameters section.
4 |  C O N N E C T I N G  A  3 D  E L E C T R O M A G N E T I C  W A V E  M O D E L  T O  A N  E L E C T R I C A L  



2 In the table, enter the following settings:

Here, Z0_const is a predefined COMSOL constant for the speed of the light and the 
wave impedance in vacuum, respectively.

G E O M E T R Y  1

Create the geometry of the coaxial cable using two cylinders.

Cylinder 1 (cyl1)
1 On the Geometry toolbar, click Cylinder.

2 In the Settings window for Cylinder, type Coax outer in the Label text field.

3 Locate the Size and Shape section. In the Radius text field, type R_coax.

4 In the Height text field, type L_coax.

5 Locate the Axis section. From the Axis type list, choose x-axis.

Cylinder 2 (cyl2)
1 On the Geometry toolbar, click Cylinder.

2 In the Settings window for Cylinder, type Coax inner in the Label text field.

3 Locate the Size and Shape section. In the Radius text field, type r_coax.

4 In the Height text field, type L_coax.

5 Locate the Axis section. From the Axis type list, choose x-axis.

Difference 1 (dif1)
1 On the Geometry toolbar, click Booleans and Partitions and choose Difference.

2 Select the object cyl1 only.

3 In the Settings window for Difference, locate the Difference section.

4 Find the Objects to subtract subsection. Select the Active toggle button.

5 Select the object cyl2 only.

Name Expression Value Description

r_coax 1[mm] 0.001 m Coax inner radius

R_coax 2[mm] 0.002 m Coax outer radius

L_coax 20[mm] 0.02 m Length of coax core 
into cavity

Z_coax Z0_const/(2*pi)*
log(R_coax/r_coax)

41.56 Ω Analytical impedance
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6 Click Build All Objects.

7 Click the Wireframe Rendering button on the Graphics toolbar.

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

Lumped Port 1
1 In the Model Builder window, under Component 1 (comp1) right-click 

Electromagnetic Waves, Frequency Domain (emw) and choose Lumped Port.
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2 Select Boundary 1 only.

3 In the Settings window for Lumped Port, locate the Lumped Port Properties section.

4 From the Type of lumped port list, choose Coaxial.

5 From the Terminal type list, choose Circuit.

Lumped Port 2
1 In the Model Builder window, right-click Electromagnetic Waves,

Frequency Domain (emw) and choose Lumped Port.
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2 Select Boundary 10 only.

3 In the Settings window for Lumped Port, locate the Lumped Port Properties section.

4 From the Type of lumped port list, choose Coaxial.

5 From the Terminal type list, choose Circuit.

E L E C T R I C A L  C I R C U I T  ( C I R )

Voltage Source V1
1 In the Model Builder window, under Component 1 (comp1) right-click 

Electrical Circuit (cir) and choose Voltage Source.

2 In the Settings window for Voltage Source, locate the Node Connections section.

3 In the table, enter the following settings:

4 Locate the Device Parameters section. From the Source type list, choose AC-source.

Resistor R1
1 In the Model Builder window, right-click Electrical Circuit (cir) and choose Resistor.

2 In the Settings window for Resistor, locate the Node Connections section.

Label Node names

p 1

n 0
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3 In the table, enter the following settings:

4 Locate the Device Parameters section. In the R text field, type Z_coax.

Resistor R2
1 Right-click Electrical Circuit (cir) and choose Resistor.

2 In the Settings window for Resistor, locate the Node Connections section.

3 In the table, enter the following settings:

4 Locate the Device Parameters section. In the R text field, type Z_coax.

External I Vs. U 1
1 Right-click Electrical Circuit (cir) and choose External Couplings>External I Vs. U.

2 In the Settings window for External I Vs. U, locate the Node Connections section.

3 In the table, enter the following settings:

4 Locate the External Device section. From the V list, choose Lumped port voltage (emw/

lport1).

External I Vs. U 2
1 Right-click Electrical Circuit (cir) and choose External Couplings>External I Vs. U.

2 In the Settings window for External I Vs. U, locate the Node Connections section.

3 In the table, enter the following settings:

Label Node names

p 1

n 2

Label Node names

p 3

n 0

Label Node names

p 2

n 0

Label Node names

p 3

n 0
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4 Locate the External Device section. From the V list, choose Lumped port voltage (emw/

lport2).

M A T E R I A L S

Next, assign material properties on the model. Specify air for the coaxial cable.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Built-In>Air.

4 Click Add to Component in the window toolbar.

M A T E R I A L S

On the Home toolbar, click Add Material to close the Add Material window.

M E S H  1

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.

2 In the Settings window for Mesh, locate the Mesh Settings section.

3 From the Element size list, choose Fine.

4 Click Build All.
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S T U D Y  1

On the Home toolbar, click Compute.

R E S U L T S

Electric Field (emw)
The default plot shows the E-field norm inside the coaxial cable. Add arrow plots for the 
electric field, magnetic field, and power flow.

Arrow Volume 2
1 In the Model Builder window, under Results right-click Electric Field (emw) and choose 

Arrow Volume.

2 Right-click Electric Field (emw) and choose Arrow Volume.

3 In the Settings window for Arrow Volume, click Replace Expression in the upper-right 
corner of the Expression section. From the menu, choose Component 1>

Electromagnetic Waves, Frequency Domain>Magnetic>emw.Hx,emw.Hy,emw.Hz -

Magnetic field.

4 Locate the Coloring and Style section. From the Color list, choose Green.

Arrow Volume 3
1 In the Model Builder window, under Results right-click Electric Field (emw) and choose 

Arrow Volume.

2 In the Settings window for Arrow Volume, click Replace Expression in the upper-right 
corner of the Expression section. From the menu, choose Component 1>

Electromagnetic Waves, Frequency Domain>Energy and power>emw.Poavx,...,emw.Poavz -

Power flow, time average.

3 Locate the Coloring and Style section. From the Color list, choose Blue.
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4 On the Electric Field (emw) toolbar, click Plot.

Compare the resulting plot with that shown in Figure 2.
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Introduction

The coaxial cable (coax) is one of the most ubiquitous transmission line structures. It is 
composed of a central circular conductor, surrounded by an annular dielectric and shielded 
by an outer conductor; see Figure 1. In this example, you compute the electric and 
magnetic field distributions inside the coax. Using these fields, you then compute the 
characteristic impedance and compare the result with the known analytic expression.

Figure 1: Cross section of a coaxial cable. The arrows visualize the magnetic field.

Model Definition

Because a coax operates in TEM mode—with the electric and magnetic fields normal to 
the direction of propagation along the cable—modeling a 2D cross section suffices to 
compute the fields and the impedance. For this example, assume perfect conductors and a 
lossless dielectric with relative permittivity εr = 2.4. The inner and outer radii are 0.5 mm 
and 3.43 mm, respectively.

The characteristic impedance, Z0 = V/I, of a transmission line relates the voltage between 
the conductors to the current through the line. Although the model does not involve 
computing the potential field, the voltage of the TEM waveguide can be evaluated as a line 
integral of the electric field between the conductors:

Outer conductor

Center conductor

Dielectric
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 (1)

Similarly, the current is obtained as a line integral of the magnetic field along the boundary 
of either conductor or any closed contour, C, bisecting the space between the conductors:

The voltage and current in the direction out of the plane are positive for integration paths 
oriented as in Figure 2.

Figure 2: The impedance of a coaxial cable can be found from the voltage, V, and current, I, 
which are computed via line integrals as shown.

The value of Z0 obtained in this way, should be compared with the analytic result

V Vi Vo– E rd⋅

ro

ri

–= =

I H dr⋅
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Results and Discussion

Figure 3 is a combined plot of the electric field magnitude and the magnetic field 
visualized as an arrow plot.

Figure 3: Electric field magnitude (surface) and magnetic field (arrows) inside the coaxial 
cable.

The impedance computed with the default mesh is Z0 = 74.65 Ω. When the mesh is 
refined, the result approaches the analytic value of 74.5 Ω.

Notes About the COMSOL Implementation

Solve this example using a Mode Analysis study. The effective mode index for the 
propagating TEM mode is . Use the default frequency, f = 1 GHz, which 
is well below the cut-off frequency for TE modes and TM modes for the chosen cable 
diameter.

Application Library path: RF_Module/Verification_Examples/
coaxial_cable_impedance

neff εr 1.5≈=
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Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 2D.

2 In the Select Physics tree, select Radio Frequency>Electromagnetic Waves,

Frequency Domain (emw).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Mode Analysis.

6 Click Done.

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

Here Z0_const is a predefined COMSOL constant for the characteristic impedance of 
vacuum, Z0 = sqrt(μ0/ε0). From the Value column you can read off the value Z0,
analytic = 74.53 Ω.

G E O M E T R Y  1

Create the geometry using a single circle node with the radius of the outer conductor and 
an extra layer representing the inner conductor.

Name Expression Value Description

r_i 0.5[mm] 5E-4 m Coax inner radius

r_o 3.43[mm] 0.00343 m Coax outer radius

eps_r 2.4 2.4 Relative dielectric 
constant

Z0_analytic (Z0_const/(2*pi*
sqrt(eps_r)))*
log(r_o/r_i)

74.53 Ω Characteristic 
impedance, analytic
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Circle 1 (c1)
1 On the Geometry toolbar, click Primitives and choose Circle.

2 In the Settings window for Circle, locate the Object Type section.

3 From the Type list, choose Curve.

4 Locate the Size and Shape section. In the Radius text field, type r_o.

5 Click to expand the Layers section. In the table, enter the following settings:

6 Right-click Circle 1 (c1) and choose Build Selected.

An advantage of using layers is that you automatically get a radial line to use for 
computing the voltage as a line integral of the electric field.

7 Click the Zoom Extents button on the Graphics toolbar.

M A T E R I A L S

Define a dielectric material for the region between the conductors.

Layer name Thickness (m)

Layer 1 r_o-r_i
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Material 1 (mat1)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, type Insulator in the Label text field.

3 Locate the Material Contents section. In the table, enter the following settings:

D E F I N I T I O N S

Add a variable for the characteristic impedance computed as the voltage between the 
conductors divided by the current through the cable. For this purpose, you need two 
integration coupling operators.

Integration 1 (intop1)
1 On the Definitions toolbar, click Component Couplings and choose Integration.

2 In the Settings window for Integration, type int_rad in the Operator name text field.

3 Locate the Source Selection section. From the Geometric entity level list, choose 
Boundary.

Property Name Value Unit Property 
group

Relative permittivity epsilonr eps_r 1 Basic

Relative permeability mur 1 1 Basic

Electrical conductivity sigma 0 S/m Basic
7 |  F I N D I N G  T H E  I M P E D A N C E  O F  A  C O A X I A L  C A B L E



4 Select Boundary 1 only.

Any of the four interior boundaries that connect the two conductors would do.

Integration 2 (intop2)
1 On the Definitions toolbar, click Component Couplings and choose Integration.

2 In the Settings window for Integration, type int_circ in the Operator name text field.

3 Locate the Source Selection section. From the Geometric entity level list, choose 
Boundary.
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4 Select Boundaries 5, 6, 9, and 12 only, (the outer conductor boundaries).

Now define the variable for the characteristic impedance computed from the simulation.

Variables 1
1 On the Definitions toolbar, click Local Variables.

2 In the Settings window for Variables, locate the Variables section.

3 In the table, enter the following settings:

Here, t1x and t1y are the tangential vector components along the integration 
boundaries (1 refers to the boundary dimension). Shortly, you will determine the 
tangential vector directions along the boundaries using an arrow plot of t1. The signs 
in the definitions above are chosen such that V = Vi - Vo (see Equation 1) and to have 
a positive current value correspond to a current in the positive z direction. The emw. 

Name Expression Unit Description

V int_rad(-emw.Ex*t1x-
emw.Ey*t1y)

V Voltage

I -int_circ(emw.Hx*
t1x+emw.Hy*t1y)

A Current

Z0_model V/I Ω Characteristic impedance
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prefix gives the correct physics-interface scope for the electric and magnetic field vector 
components.

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

Keep the default physics settings, which include perfect electric conductor conditions for 
the outer boundaries.

1 In the Model Builder window, under Component 1 (comp1) click Electromagnetic Waves,

Frequency Domain (emw).

2 In the Settings window for Electromagnetic Waves, Frequency Domain, locate the Physics-

Controlled Mesh section.

3 Clear the Enable check box.

M E S H  1

Use the default mesh.

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.

2 In the Settings window for Mesh, click Build All.
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S T U D Y  1

Step 1: Mode Analysis
1 In the Settings window for Mode Analysis, locate the Study Settings section.

2 Select the Desired number of modes check box.

3 In the associated text field, type 1.

4 Select the Search for modes around check box.

5 In the associated text field, type sqrt(eps_r).

6 On the Home toolbar, click Compute.

R E S U L T S

Electric Field (emw)
The default plot shows the distribution of the norm of the electric field. Add an arrow plot 
of the magnetic field.

Arrow Surface 1
1 In the Model Builder window, under Results right-click Electric Field (emw) and choose 

Arrow Surface.

2 In the Settings window for Arrow Surface, locate the Arrow Positioning section.

3 Find the X grid points subsection. In the Points text field, type 21.

4 Find the Y grid points subsection. In the Points text field, type 21.

5 Locate the Coloring and Style section. Select the Scale factor check box.

6 In the associated text field, type 7e-6.

You can use the slider to adjust the arrow lengths.

7 From the Color list, choose White.

8 On the Electric Field (emw) toolbar, click Plot.

9 Click the Zoom Extents button on the Graphics toolbar.

Compare the resulting plot with that shown in Figure 2.

To find out the integration contour orientations, plot the tangent vector, t1, along the 
boundaries as follows:

Arrow Line 1
1 Right-click Electric Field (emw) and choose Arrow Line.
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2 In the Settings window for Arrow Line, click Replace Expression in the upper-right corner 
of the Expression section. From the menu, choose Component 1>Geometry>tx,ty -

Tangent.

3 Locate the Coloring and Style section. In the Number of arrows text field, type 50.

4 On the Electric Field (emw) toolbar, click Plot.

A comparison with Equation 1 reveals that the line integral for the voltage computes 
the potential difference Vi - Vo. When computing the line integral for the current, the 
clockwise orientation of the integration contour would mean that a positive current is 
directed in the negative z direction, that is, into the modeling plane. The minus sign 
added in the definition of I reverses this direction.

5 Right-click Results>Electric Field (emw)>Arrow Line 1 and choose Disable, to retrieve the 
result plot.

Finish by computing the characteristic impedance.

Global Evaluation 1
1 On the Results toolbar, click Global Evaluation.

2 In the Settings window for Global Evaluation, click Replace Expression in the upper-right 
corner of the Expressions section. From the menu, choose Component 1>Definitions>

Variables>Z0_model - Characteristic impedance.

3 Click Evaluate.
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TA B L E

1 Go to the Table window.

The result, roughly 74.65 Ω, is within 0.2% of the analytic value, 74.53 Ω.
13 |  F I N D I N G  T H E  I M P E D A N C E  O F  A  C O A X I A L  C A B L E



14 |  F I N D I N G  T H E  I M P E D A N C E  O F  A  C O A X I A L  C A B L E



Created in COMSOL Multiphysics 5.3
T r a n s i e n t  Mode l i n g  o f  a  Coa x i a l  C ab l e
This model is licensed under the COMSOL Software License Agreement 5.3.
All trademarks are the property of their respective owners. See www.comsol.com/trademarks.

http://www.comsol.com/sla
http://www.comsol.com/trademarks/


Introduction

Time-domain simulations of Maxwell’s equations are useful for

• observing transient phenomena,

• finding the time it takes for a signal to propagate, or

• modeling materials that are nonlinear with respect to the electric or magnetic field 
strength.

This example considers a pulse propagating down a coaxial transmission line for three 
different termination types: short, open, and matched. The signal propagation time is 
deduced from the reflected waves detected at the input port.

Model Definition

The model setup, schematically shown in Figure 1, is a short section of an air-filled coaxial 
transmission line. The symmetry of the structure allows for a 2D axisymmetric model 
geometry.

Figure 1: Schematic of a section of a coaxial transmission line connected to a transient voltage 
source and a load.

At one end of the coaxial cable, or coax for short, a lumped port boundary condition 
excites the structure; specify a transient excitation pulse, V0(t), by using a Gaussian pulse-
windowed sine function. Apply the excitation as a current of magnitude I(t) = V0(t) / Zref 
flowing tangentially to the excitation boundary. Here Zref refers to the specified 
characteristic impedance between the voltage generator and the model.

At the other end of the coax, consider, in turn, three different boundary conditions:

1 perfect electric conductor (PEC)—to simulate the short condition;

2 perfect magnetic conductor (PMC)—to simulate an open condition; and

3 lumped port—to simulate a matched load.

Model space

Zref Zref

V0 (t)
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On the walls of the coax, apply a PEC boundary condition; this condition is appropriate 
when both skin depth and losses in the conductors are very small.

Use a triangular mesh with the maximum element size chosen such that there are at least 
two elements in the radial direction and at least eight elements per wavelength.

The only changes required to the default solver settings are to tighten the relative tolerance 
from the default value, and to adjust the timespan and output time steps. The internal time 
steps taken by the solver are auto-selected based on the specified relative tolerance.

Results and Discussion

Figure 2 shows the results of the transient simulation for the three different termination 
types. The figure plots the radial component of the electric field at the input port as a 
function of time for the three different termination conditions. The short (PEC) and open 
(PMC) terminations reflect waves that are 180° out of phase, and the matched load 
produces almost no reflections. From the reflected waves in the plot, you can read off an 
approximate signal propagation time through the air-filled transmission line of (0.37 −
0.10) / 2 ns = 0.135 ns. This matches the expected value of Lcoax / c, where 
Lcoax = 40 mm is the length of the line and c is the speed of light in air.
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Figure 2: Radial component of electric field at the input port versus time for three different 
termination conditions: short (blue), open (green), and matched load (red).

Application Library path: RF_Module/Verification_Examples/
coaxial_cable_transient

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 2D Axisymmetric.

2 In the Select Physics tree, select Radio Frequency>Electromagnetic Waves,

Transient (temw).

PEC PMC

Matched load
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3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Time Dependent.

6 Click Done.

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

Next, define the excitation, V0(t), in terms of a Gaussian pulse and a sine function.

Define a Gaussian pulse.

Gaussian Pulse 1 (gp1)
1 On the Home toolbar, click Functions and choose Global>Gaussian Pulse.

2 In the Settings window for Gaussian Pulse, type gauss_pulse in the Function name text 
field.

3 Locate the Parameters section. In the Location text field, type 2*T.

4 In the Standard deviation text field, type T/2.

Now use this pulse in an analytic function for V0(t):

Analytic 1 (an1)
1 On the Home toolbar, click Functions and choose Global>Analytic.

Name Expression Value Description

r_coax 1[mm] 0.001 m Coax inner radius

R_coax 2[mm] 0.002 m Coax outer radius

L_coax 40[mm] 0.04 m Length of coax core 
into cavity

f 20[GHz] 2E10 Hz Pulse frequency

L c_const/f 0.01499 m Wavelength, free 
space

T 1/f 5E-11 s Period

h_max min(L/8,(R_coax-
r_coax)/2)

5E-4 m Maximum element size
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2 In the Settings window for Analytic, type V0 in the Function name text field.

3 Locate the Definition section. In the Expression text field, type gauss_pulse(t)*
sin(2*pi*f*t).

4 In the Arguments text field, type t.

5 Locate the Units section. In the Arguments text field, type s.

6 In the Function text field, type V.

To plot the function, you need to specify a suitable time interval.

7 Locate the Plot Parameters section. In the table, enter the following settings:

8 Click to collapse the Plot parameters section. Click Plot.

G E O M E T R Y  1

An elongated rectangle offset from the symmetry axis represents the straight coaxial cable.

Rectangle 1 (r1)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type R_coax-r_coax.

4 In the Height text field, type L_coax.

Argument Lower limit Upper limit

t 0 0.2[ns]
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5 Locate the Position section. In the r text field, type r_coax.

6 Click Build All Objects.

D E F I N I T I O N S

Set up a point probe for plotting the electric field component Er while solving. You will 
also use this plot to reproduce Figure 2.

Domain Point Probe 1
1 On the Definitions toolbar, click Probes and choose Domain Point Probe.

2 In the Settings window for Domain Point Probe, locate the Point Selection section.

3 In row Coordinates, set r to r_coax.

4 Select the Snap to closest boundary check box.

5 In the Model Builder window, expand the Domain Point Probe 1 node, then click 
Point Probe Expression 1 (ppb1).

6 In the Settings window for Point Probe Expression, locate the Expression section.

7 Click temw.Er - Electric field, r component in the upper-right corner of the section.

E L E C T R O M A G N E T I C  WA V E S ,  TR A N S I E N T  ( T E M W )

Now set up the physics. Begin by defining the Lumped port input condition.

Lumped Port 1
1 In the Model Builder window, under Component 1 (comp1) right-click 

Electromagnetic Waves, Transient (temw) and choose Lumped Port.

2 Select Boundary 2 only, (the bottom boundary).

For the first port, wave excitation is on by default.

3 In the Settings window for Lumped Port, locate the Lumped Port Properties section.

4 In the V0 text field, type V0(t).

5 Locate the Settings section. In the Zref text field, type (Z0_const/2/pi)*
log(R_coax/r_coax).

The open case uses a PMC condition at the termination.

Perfect Magnetic Conductor 1
1 In the Model Builder window, right-click Electromagnetic Waves, Transient (temw) and 

choose Perfect Magnetic Conductor.

2 Select Boundary 3 only, (the top boundary).

Finally, define a lumped port condition to use for the matched load case.
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Lumped Port 2
1 Right-click Electromagnetic Waves, Transient (temw) and choose Lumped Port.

2 Select Boundary 3 only.

3 In the Settings window for Lumped Port, locate the Settings section.

4 In the Zref text field, type (Z0_const/2/pi)*log(R_coax/r_coax).

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Built-In>Air.

4 Click Add to Component in the window toolbar.

M A T E R I A L S

On the Home toolbar, click Add Material to close the Add Material window.

M E S H  1

Size
1 In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 

Free Triangular.

2 In the Settings window for Size, locate the Element Size section.

3 Click the Custom button.

4 Locate the Element Size Parameters section. In the Maximum element size text field, type 
h_max.
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5 Click Build All.

S T U D Y  1

Step 1: Time Dependent
1 In the Settings window for Time Dependent, locate the Study Settings section.

2 In the Times text field, type range(0,T/24,10*T).

3 From the Tolerance list, choose User controlled.

4 In the Relative tolerance text field, type 0.0001.

To study the short termination case first, disable the PMC and lumped port conditions 
so that the default PEC condition is activated on the termination boundary.

5 Locate the Physics and Variables Selection section. Select the 
Modify physics tree and variables for study step check box, disable Perfect Magnetic 

Conductor 1 and Lumped Port 2.

6 On the Home toolbar, click Compute.

R E S U L T S

2D Plot Group 1
Click on the Probe Plot 1 tab to place it in focus.
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Probe Plot Group 2
When the solver finishes the plot should look like that in the figure below.

2D Plot Group 1
The default surface plot shows the electric field in the coax at the end of the simulation 
interval. Because the transient has died out, the solution you see is only noise. Modify the 
time to get a more interesting plot.

1 In the Model Builder window, under Results click 2D Plot Group 1.

2 In the Settings window for 2D Plot Group, locate the Data section.

3 From the Time (s) list, choose 1.5E-10.
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4 On the 2D Plot Group 1 toolbar, click Plot.

Now turn to the open termination case.

D E F I N I T I O N S

1 In the Model Builder window, under Component 1 (comp1)>Definitions>

Domain Point Probe 1 click Point Probe Expression 1 (ppb1).

2 In the Settings window for Point Probe Expression, click to expand the 
Table and window settings section.

3 Locate the Table and Window Settings section. From the Output table list, choose 
New table.

With these settings you get a plot for the short and open termination cases in the same 
plot window.

E L E C T R O M A G N E T I C  WA V E S ,  TR A N S I E N T  ( T E M W )

Perfect Magnetic Conductor 1
In the Model Builder window, under Component 1 (comp1)>Electromagnetic Waves,

Transient (temw) right-click Perfect Magnetic Conductor 1 and choose Enable.
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S T U D Y  1

1 In the Model Builder window, click Study 1.

2 In the Settings window for Study, locate the Study Settings section.

3 Clear the Generate default plots check box.

4 On the Home toolbar, click Compute.

R E S U L T S

Probe Plot Group 2
The reflected waves for the short and open terminations are 180 degrees out of phase.

Finally, activate the matched load case.

D E F I N I T I O N S

1 In the Model Builder window, under Component 1 (comp1)>Definitions>

Domain Point Probe 1 click Point Probe Expression 1 (ppb1).

2 In the Settings window for Point Probe Expression, click to expand the 
Table and window settings section.

3 Locate the Table and Window Settings section. From the Output table list, choose 
New table.
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E L E C T R O M A G N E T I C  WA V E S ,  TR A N S I E N T  ( T E M W )

Lumped Port 2
1 In the Model Builder window, under Component 1 (comp1)>Electromagnetic Waves,

Transient (temw) right-click Lumped Port 2 and choose Enable.

Note that you do not need to disable the PMC condition because it is overridden by 
the lumped port.

S T U D Y  1

On the Home toolbar, click Compute.

R E S U L T S

Probe Plot Group 2
1 In the Model Builder window, under Results click Probe Plot Group 2.

2 In the Settings window for 1D Plot Group, locate the Plot Settings section.

3 Select the x-axis label check box.

4 In the associated text field, type t (s).

5 Select the y-axis label check box.

6 In the associated text field, type Electric field, r component (V/m).

7 On the Probe Plot Group 2 toolbar, click Plot.

The plot should now look like that in Figure 2, with the red graph corresponding to the 
matched case.
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Introduction

Conical antennas are useful for many applications due to their broadband characteristics 
and relative simplicity. This example includes an analysis of the antenna impedance and the 
radiation pattern as functions of the frequency for a monoconical antenna with a finite 
ground plane and a 50 Ω coaxial feed. The rotational symmetry makes it possible to model 
this in axially symmetric 2D. When modeling in 2D, you can use a dense mesh, giving an 
excellent accuracy for a wide range of frequencies.

Model Definition

The antenna geometry consists of a 0.2 m tall metallic cone with a top angle of 90 degrees 
on a finite ground plane of a 0.282 m radius. The coaxial feed has a central conductor of 
1.5 mm radius and an outer conductor (screen) of 4.916 mm radius separated by a Teflon 
dielectric of relative permittivity of 2.07. The central conductor of the coaxial cable is 
connected to the cone, and the screen is connected to the ground plane.

Figure 1: The geometry of the antenna. The central conductor of the coaxial cable is connected 
to the metallic cone, and the cable screen is connected to the finite ground plane.

The model takes advantage of the rotational symmetry of the problem, which allows 
modeling in 2D using cylindrical coordinates. You can then use a very fine mesh to achieve 
an excellent accuracy.

D O M A I N  E Q U A T I O N S

An electromagnetic wave propagating in a coaxial cable is characterized by transverse 
electromagnetic (TEM) fields. Assuming time-harmonic fields with complex amplitudes 
containing the phase information, you have:
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where z is the direction of propagation and r, , and z are cylindrical coordinates centered 
on axis of the coaxial cable. Z is the wave impedance in the dielectric of the cable, and C 
is an arbitrary constant. The angular frequency is denoted by ω. The propagation constant, 
k, relates to the wavelength in the medium λ as

In the air, the electric field also has a finite axial component whereas the magnetic field is 
purely azimuthal. Thus it is possible to model the antenna using an axisymmetric 
transverse magnetic (TM) formulation, and the wave equation becomes scalar in :

B O U N D A R Y  C O N D I T I O N S

The boundary conditions for the metallic surfaces are:

At the feed point, a matched coaxial port boundary condition is used to make the 
boundary transparent to the wave. The antenna is radiating into free space, but you can 
only discretize a finite region. Therefore, truncate the geometry some distance from the 
antenna using a scattering boundary condition allowing for outgoing spherical waves to 
pass with very little reflections. A symmetry boundary condition is automatically applied 
on boundaries at r = 0.

Results and Discussion

Figure 2 shows the antenna impedance as a function of frequency. Ideally, the antenna 
impedance should be matched to the characteristic impedance of the feed, 50 Ω, to obtain 
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maximum transmission into free space. This is quite well fulfilled in the high frequency 
range.

Figure 2: The antenna impedance in Ω as a function of frequency from 200 MHz to 1.5 GHz. 
The solid line shows the radiation resistance and the dotted line represents the reactance.

Figure 3 shows the antenna radiation pattern in the near-field for three different 
frequencies. The effect of the finite diameter of the ground plane is to lift the main lobe 
from the horizontal plane. For an infinite ground plane or in the high-frequency limit, the 
radiation pattern is symmetric around zero elevation. This is easy to understand, as an 
infinite ground plane can be replaced by a mirror image of the monocone below the plane. 
Such a biconical antenna is symmetric around zero elevation and has its main lobe in the 
horizontal direction. The decreased lobe lifting at higher frequencies is just about visible 
in Figure 3.

Figure 4 shows the antenna radiation pattern in the far field for the same frequencies as 
the radiation pattern at the boundary in Figure 3.
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Figure 3: Polar plot of the antenna radiation pattern in the near field versus the elevation 
angle for 200 MHz, 800 MHz, and 1.5 GHz. The scale is logarithmic.

Figure 4: Polar plot of the antenna radiation pattern for the far field versus the elevation 
angle for 200 MHz, 800 MHz, and 1.5 GHz. This plot is normalized differently but has a 
shape resembling the near field.
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As the frequency increases the antenna impedance gets closer to 50 Ω, which means that a 
voltage generator connected to the input of the antenna should have an output impedance 
of 50 Ω.

Application Library path: RF_Module/Antennas/conical_antenna

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 2D Axisymmetric.

2 In the Select Physics tree, select Radio Frequency>Electromagnetic Waves,

Frequency Domain (emw).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Frequency Domain.

6 Click Done.

G E O M E T R Y  1

Import 1 (imp1)
1 On the Home toolbar, click Import.

2 In the Settings window for Import, locate the Import section.

3 Click Browse.

4 Browse to the model’s Application Libraries folder and double-click the file 
conical_antenna.mphbin.
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5 Click Import.

The imported geometry is effectively a half circle with the metal areas removed. You 
model the electromagnetic waves in the air and the dielectric material inside the coaxial 
cable. There is no need to include the metal as a domain in the model because the fields 
in it are essentially zero except on its surface.

G L O B A L  D E F I N I T I O N S

Prepare for the impedance computation by making a few definitions.

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

Name Expression Value Description

Z_tl 50[ohm] 50 Ω Characteristic transmission line 
impedance
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D E F I N I T I O N S

Variables 1
1 On the Home toolbar, click Variables and choose Local Variables.

2 In the Settings window for Variables, locate the Variables section.

3 In the table, enter the following settings:

emw.S11 is the name of the automatically computed reflection S-parameter.

Define the following selections in order to get easy access to some frequently used domains 
and boundaries.

Explicit 1
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Air in the Label text field.

3 Select Domain 1 only.

Explicit 2
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Dielectric in the Label text field.

The dielectric domain is inside the coaxial cable just below the cone. It is easier to select 
it if you zoom in a little.

3 Select Domain 2 only.

Explicit 3
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Outer Air Boundaries in the Label text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.

4 Select Boundaries 14 and 15 only.

With all selections and expressions now defined, it is time to set up the materials and the 
physics of the model.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

Name Expression Unit Description

Z Z_tl*(1+emw.S11)/(1-emw.S11) Antenna impedance
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3 In the tree, select Built-In>Air.

4 Click Add to Component in the window toolbar.

M A T E R I A L S

On the Home toolbar, click Add Material to close the Add Material window.

Air (mat1)
1 In the Model Builder window, under Component 1 (comp1)>Materials click Air (mat1).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Air.

Material 2 (mat2)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Dielectric.

4 Locate the Material Contents section. In the table, enter the following settings:

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

Port 1
1 In the Model Builder window, under Component 1 (comp1) right-click 

Electromagnetic Waves, Frequency Domain (emw) and choose Port.

Set up Boundary 6, at the bottom of the coaxial cable, to be a Port. You can zoom in 
on this part of the geometry to easier find and select this boundary.

2 Select Boundary 6 only.

3 In the Settings window for Port, locate the Port Properties section.

4 From the Type of port list, choose Coaxial.

For the first port, wave excitation is on by default.

Property Name Value Unit Property 
group

Relative permittivity epsilonr 2.07 1 Basic

Relative permeability mur 1 1 Basic

Electrical conductivity sigma 0 S/m Basic
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Scattering Boundary Condition 1
1 In the Model Builder window, right-click Electromagnetic Waves,

Frequency Domain (emw) and choose Scattering Boundary Condition.

2 In the Settings window for Scattering Boundary Condition, locate the Boundary Selection 
section.

3 From the Selection list, choose Outer Air Boundaries.

The Scattering boundary condition is a simple way of letting the waves undergo only 
minor artificial reflections as they leave the computational domain through the exterior 
boundaries. To minimize these reflections, but at a greater computational cost, you can 
use Perfectly Matched Layers).

Perfect Electric Conductor 1
As you can see if you click the Perfect Electric Conductor node under Electromagnetic 
Waves, the physical boundaries to which you have not assigned any boundary condition 
will by default be considered perfect electric conductors. This is a good approximation for 
most metals throughout the frequency range considered in this model.

Far-Field Domain 1
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Far-

Field Domain.

2 Select Domain 1 only.

Far-Field Calculation 1
1 In the Model Builder window, expand the Far-Field Domain 1 node, then click Far-

Field Calculation 1.

2 In the Settings window for Far-Field Calculation, locate the Boundary Selection section.

3 From the Selection list, choose Outer Air Boundaries.

Adding a Far Field Calculation feature does not affect the physics of the model, but 
makes it possible to study the far field generated by the antenna. Select the boundaries 
to use for this computation so that, in the physical (3D) geometry, they surround all 
sources and reflecting objects. The outer air boundaries are a convenient choice.

M E S H  1

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.
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2 In the Settings window for Mesh, click Build All.

S T U D Y  1

Step 1: Frequency Domain
1 In the Settings window for Frequency Domain, locate the Study Settings section.

2 In the Frequencies text field, type range(200[MHz],25[MHz],1.5[GHz]).

The frequency range you just entered runs from 200 MHz to 1.5 GHz in steps of 25 
MHz.

3 On the Home toolbar, click Compute.

R E S U L T S

Electric Field (emw)
The plot that appears once the solution process is finished shows the norm of the electric 
field at 1.5 GHz. The reason it is mostly dark blue is because the range is dominated by 
the high values in and near the coaxial cable. To better see how the wave propagates, try 
plotting the instantaneous value of the H-field using a manual range.

Surface
1 In the Model Builder window, expand the Electric Field (emw) node, then click Surface.
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2 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 1>Electromagnetic Waves,

Frequency Domain>Magnetic>Magnetic field>emw.Hphi - Magnetic field, phi component.

3 Click to expand the Range section. Select the Manual color range check box.

4 In the Minimum text field, type -0.5.

5 In the Maximum text field, type 0.5.

6 Locate the Coloring and Style section. From the Color table list, choose Wave.

7 On the Electric Field (emw) toolbar, click Plot.

8 Click the Zoom Extents button on the Graphics toolbar.
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Smith Plot (emw)

Far Field 1
1 In the Model Builder window, expand the 2D Far Field (emw) node, then click Far Field 1.

2 In the Settings window for Far Field, locate the Evaluation section.

3 Find the Angles subsection. In the Number of angles text field, type 100.

4 Find the Reference direction subsection. In the x text field, type -1.

5 In the z text field, type 0.

6 On the 2D Far Field (emw) toolbar, click Plot.

To plot the impedance as a function of the frequency, set up a 1D plot.

Global 1
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Model Builder window, right-click 1D Plot Group 6 and choose Global.

3 In the Settings window for Global, locate the y-Axis Data section.
13 |  C O N I C A L  A N T E N N A



4 In the table, enter the following settings:

5 Click to expand the Coloring and style section. Locate the Coloring and Style section. 
Find the Line style subsection. From the Line list, choose Cycle.

6 On the 1D Plot Group 6 toolbar, click Plot.

You have now reproduced Figure 2. Next, visualize the near-field and far-field radiation 
patterns using polar plots.

Polar Plot Group 7
1 On the Home toolbar, click Add Plot Group and choose Polar Plot Group.

Select a few of the frequencies from the list of parameter values. Showing the radiation 
pattern for all of them would take a bit of time and lead to a cluttered plot.

2 In the Settings window for Polar Plot Group, locate the Data section.

3 From the Parameter selection (freq) list, choose From list.

4 In the Parameter values (freq (GHz)) list, choose 0.2, 0.8, and 1.5.

Use Ctrl-key to select multiple frequencies.

Line Graph 1
1 Right-click Polar Plot Group 7 and choose Line Graph.

2 In the Settings window for Line Graph, locate the Selection section.

3 From the Selection list, choose Outer Air Boundaries.

4 Click Replace Expression in the upper-right corner of the r-axis data section. From the 
menu, choose Component 1>Electromagnetic Waves, Frequency Domain>

Energy and power>emw.nPoav - Power outflow, time average.

5 Locate the r-Axis Data section. In the Expression text field, type 10*log10(emw.nPoav).

The variable emw.nPoav represents the outgoing power flow through the boundaries 
where it is evaluated. The expression you just entered gives you the same in a 
logarithmic scale.

6 Select the Description check box.

7 In the associated text field, type Near-field radiation pattern.

8 Locate the θ Angle Data section. From the Parameter list, choose Expression.

9 In the Expression text field, type atan2(z,r).

Expression Unit Description

real(Z) Ω Resistance

imag(Z) Ω Reactance
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10 Click to expand the Coloring and style section. Locate the Coloring and Style section. 
Find the Line style subsection. From the Line list, choose Cycle.

11 Click to collapse the Coloring and style section. Click to expand the Legends section. 
Select the Show legends check box.

12 From the Legends list, choose Manual.

13 In the table, enter the following settings:

14 Click to collapse the Legends section. On the Polar Plot Group 7 toolbar, click Plot.

15 Click the Zoom Extents button on the Graphics toolbar.

Your near-field radiation plot should look like that in Figure 3.

Finally, visualize the far-field radiation pattern.

Line Graph 1
1 In the Model Builder window, under Results right-click Polar Plot Group 7 and choose 

Duplicate.

2 In the Model Builder window, expand the Polar Plot Group 8 node, then click 
Line Graph 1.

3 In the Settings window for Line Graph, click Replace Expression in the upper-right corner 
of the r-axis data section. From the menu, choose Component 1>Electromagnetic Waves,

Frequency Domain>Far field>emw.normdBEfar - Far-field norm, dB.

4 Locate the r-Axis Data section. In the Description text field, type Far-field radiation 
pattern.

5 On the Polar Plot Group 8 toolbar, click Plot.

The plot should look like that in Figure 4.

Legends

200 MHz

800 MHz

1.5 GHz
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Introduction

An evanescent mode cavity filter is resonant at a frequency lower than the dominant 
resonant frequency of a metallic cavity. Such evanescent mode resonance can be realized 
by creating a discontinuity or reactance inside the cavity.

Figure 1: An evanescent mode cavity filter. The signal fed from a microstrip line is slot coupled 
into the cylindrical cavity loaded with a PTFE ring.

Model Definition

The resonant frequency of the empty cylindrical waveguide cavity TE111 mode can be 
calculated from the equation

where a and d are the radius and length of the cylinder, respectively, and p'nm is the mth 
root of the Bessel function J'n(x). The TE111 mode is the dominant TE mode of the 
cylindrical cavity resonator, and for a cavity of 25 mm radius and 100 mm height this 
resonance is at 3.823 GHz. The starting point of this example was a computation (not 
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presented here) of the TE111 mode resonant frequency of an empty cylindrical cavity and 
a subsequent verification of agreement with the analytic solution.

This basic model was then modified by the addition of a metal box at either end 
representing a housing. Inside is a dielectric substrate and a microstrip line which is slot 
coupled into the cavity. This represents the input and output of the device.

The slots are located on the center of the cavity ends to induce symmetric fields and they 
are also parallel to each other to couple the injected fields maximally. The size of the slots 
are tuned to provide a better matching to the reference characteristic impedance assigned 
on ports. The model uses lumped ports to excite the structure. The end of each microstrip 
line over the slots is shorted to couple the fields from the microstrip lines through the slots 
and vice versa. The cavity is partially filled with a ring of PTFE, εr = 2.1, which causes the 
resonant frequency to shift down.

Results and Discussion

Figure 2 shows the frequency response of the cavity. The dielectric ring causes the resonant 
frequency to shift down to 3.53 GHz. This example shows that the center frequency of 
the device can be lowered without increasing the size, while the insertion loss is still as 
good as for an air-filled cavity. The electric field distribution in Figure 3 shows a basic 
resonant mode and the dielectric tube inside the cavity does not distort the distribution 
significantly.
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Figure 2: The frequency response of the filter shows bandpass filter characteristics. The center 
frequency is lower than the dominant mode resonant frequency of the metallic cavity.

Figure 3: The dielectric tube inside the cavity does not distort the electric field distribution at 
resonance significantly.
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1. D.M. Pozar, Microwave Engineering, John Wiley & Sons, 1998.

Application Library path: RF_Module/Filters/
cylindrical_cavity_filter_evanescent

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Radio Frequency>Electromagnetic Waves,

Frequency Domain (emw).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Frequency Domain.

6 Click Done.

S T U D Y  1

Step 1: Frequency Domain
1 In the Model Builder window, under Study 1 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 In the Frequencies text field, type range(3.45[GHz],5[MHz],3.61[GHz]).

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.
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3 In the table, enter the following settings:

Here mil refers to the unit milliinch, that is 1 mil = 0.0254 mm.

G E O M E T R Y  1

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose mm.

Create a cylindrical cavity.

Cylinder 1 (cyl1)
1 On the Geometry toolbar, click Cylinder.

2 In the Settings window for Cylinder, type Cavity in the Label text field.

3 Locate the Size and Shape section. In the Radius text field, type 25.

4 In the Height text field, type 100.

5 Right-click Cavity and choose Build Selected.

Create a coupling slot.

Work Plane 1 (wp1)
1 On the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, click Show Work Plane.

Rectangle 1 (r1)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type l_slot.

4 In the Height text field, type w_slot.

5 Locate the Position section. From the Base list, choose Center.

6 Right-click Rectangle 1 (r1) and choose Build Selected.

7 In the Model Builder window, click Geometry 1.

Create a substrate.

Name Expression Value Description

d 60[mil] 0.001524 m Substrate thickness

l_slot 42[mm] 0.042 m Slot length

w_slot 3[mm] 0.003 m Slot width
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Block 1 (blk1)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, type Bottom_plate in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type 60.

4 In the Depth text field, type 60.

5 In the Height text field, type d.

6 Locate the Position section. From the Base list, choose Center.

7 In the z text field, type -d/2.

8 Right-click Bottom_plate and choose Build Selected.

Create a 50Ω microstrip line.

Block 2 (blk2)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, type Bottom_feed in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type 3.2.

4 In the Depth text field, type 25.

5 In the Height text field, type d.

6 Locate the Position section. From the Base list, choose Center.

7 In the y text field, type 25/2-w_slot/2.

8 In the z text field, type -d/2.

9 Right-click Bottom_feed and choose Build Selected.

Create a metallic housing.

Block 3 (blk3)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, type Housing in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type 60.

4 In the Depth text field, type 60.

5 In the Height text field, type 20.

6 Locate the Position section. From the Base list, choose Center.

7 In the z text field, type -10.

8 Right-click Housing and choose Build Selected.

9 Click the Zoom Extents button on the Graphics toolbar.
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10 Click the Wireframe Rendering button on the Graphics toolbar, to see the interior.

Create a pair of slots, substrates, microstrip lines, and metallic housings.

Rotate 1 (rot1)
1 On the Geometry toolbar, click Transforms and choose Rotate.

2 Select the objects blk1, blk2, blk3, and wp1 only.

3 In the Settings window for Rotate, locate the Rotation Angle section.

4 In the Rotation text field, type 0,180.

5 Locate the Point on Axis of Rotation section. In the z text field, type 50.

6 Locate the Axis of Rotation section. From the Axis type list, choose Cartesian.

7 In the x text field, type 1.

8 In the z text field, type 0.

9 Right-click Rotate 1 (rot1) and choose Build Selected.

10 Click the Zoom Extents button on the Graphics toolbar.

Create a dielectric ring.

Cylinder 2 (cyl2)
1 On the Geometry toolbar, click Cylinder.

2 In the Settings window for Cylinder, locate the Size and Shape section.

3 In the Radius text field, type 25.
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4 In the Height text field, type 20.

5 Locate the Position section. In the z text field, type 40.

Cylinder 3 (cyl3)
1 On the Geometry toolbar, click Cylinder.

2 In the Settings window for Cylinder, locate the Size and Shape section.

3 In the Radius text field, type 15.

4 In the Height text field, type 20.

5 Locate the Position section. In the z text field, type 40.

Difference 1 (dif1)
1 On the Geometry toolbar, click Booleans and Partitions and choose Difference.

2 Select the object cyl2 only.

3 In the Settings window for Difference, locate the Difference section.

4 Find the Objects to subtract subsection. Select the Active toggle button.

5 Select the object cyl3 only.

6 Click Build All Objects.
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E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

The default boundary condition is perfect electric conductor, which applies to all exterior 
boundaries. Assign a perfect electric conductor condition to the remaining boundaries of 
the cavity.

Perfect Electric Conductor 2
1 In the Model Builder window, under Component 1 (comp1) right-click 

Electromagnetic Waves, Frequency Domain (emw) and choose Perfect Electric Conductor.

2 Select Boundaries 21, 28, 35, and 42 only.

You can do this most easily by copying the text ’21, 28, 35, and 42’, clicking in the 
selection box, and then pressing Ctrl+V, or by using the Paste Selection dialog box.

Proceed to define boundary condition for the shorted microstrip lines.

Perfect Electric Conductor 3
1 In the Model Builder window, right-click Electromagnetic Waves,

Frequency Domain (emw) and choose Perfect Electric Conductor.
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2 Select Boundaries 36, 38, 39, and 43 only.

Lumped Port 1
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Lumped Port.

2 Select Boundary 44 only.

For the first port, wave excitation is on by default.

Lumped Port 2
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Lumped Port.

2 Select Boundary 34 only.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Built-In>Air.

4 Click Add to Component in the window toolbar.

M A T E R I A L S

1 On the Home toolbar, click Add Material to close the Add Material window.

Create a substrate material.
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Material 2 (mat2)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, type Substrate in the Label text field.

3 Select Domains 2, 3, 7, and 8 only.

4 Locate the Material Contents section. In the table, enter the following settings:

Create a dielectric ring material.

Material 3 (mat3)
1 Right-click Materials and choose Blank Material.

2 In the Settings window for Material, type PTFE in the Label text field.

3 Select Domain 6 only.

4 Locate the Material Contents section. In the table, enter the following settings:

M E S H  1

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.

Property Name Value Unit Property 
group

Relative permittivity epsilonr 3.38 1 Basic

Relative permeability mur 1 1 Basic

Electrical conductivity sigma 0 S/m Basic

Property Name Value Unit Property 
group

Relative permittivity epsilonr 2.1 1 Basic

Relative permeability mur 1 1 Basic

Electrical conductivity sigma 0 S/m Basic
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2 In the Settings window for Mesh, click Build All.

S T U D Y  1

On the Home toolbar, click Compute.

R E S U L T S

Electric Field (emw)
The default plot shows the norm of the electric field for the highest frequency. Follow the 
instructions to reproduce Figure 3.

1 In the Model Builder window, under Results click Electric Field (emw).

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Parameter value (freq (GHz)) list, choose 3.53.

Multislice
1 In the Model Builder window, expand the Electric Field (emw) node, then click Multislice.

2 In the Settings window for Multislice, locate the Multiplane Data section.

3 Find the X-planes subsection. In the Planes text field, type 0.

4 Find the Z-planes subsection. In the Planes text field, type 0.

5 On the Electric Field (emw) toolbar, click Plot.

6 Click the Zoom Extents button on the Graphics toolbar.
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S-Parameter (emw)
1 In the Model Builder window, under Results click S-Parameter (emw).

2 In the Settings window for 1D Plot Group, click to expand the Legend section.

3 From the Position list, choose Lower right.

Smith Plot (emw)

Analyze the same model with a much finer frequency resolution using asymptotic 
waveform evaluation (AWE). When a device presents a bandpass frequency response, the 
AWE provides a faster solution time when running the simulation on many frequency 
points. The following example with the AWE can be computed 50 times faster than regular 
Frequency Domain sweeps.

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

Lumped Port 1
1 In the Model Builder window, under Component 1 (comp1)>Electromagnetic Waves,

Frequency Domain (emw) click Lumped Port 1.

2 In the Settings window for Lumped Port, locate the Boundary Selection section.

3 Click Create Selection.

4 In the Create Selection dialog box, click OK.
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Lumped Port 2
1 In the Model Builder window, under Component 1 (comp1)>Electromagnetic Waves,

Frequency Domain (emw) click Lumped Port 2.

2 In the Settings window for Lumped Port, locate the Boundary Selection section.

3 Click Create Selection.

4 In the Create Selection dialog box, click OK.

R O O T

On the Home toolbar, click Windows and choose Add Study.

A D D  S T U D Y

1 Go to the Add Study window.

2 Find the Studies subsection. In the Select Study tree, select Preset Studies>

Frequency Domain.

3 Click Add Study in the window toolbar.

4 On the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  2

Step 1: Frequency Domain
1 In the Model Builder window, under Study 2 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 In the Frequencies text field, type range(3.45[GHz],(3.61[GHz]-3.45[GHz])/32/
50,3.6[GHz]).

Use a 50 times finer frequency resolution.

4 Click to expand the Values of dependent variables section. Locate the 
Values of Dependent Variables section. Find the Store fields in output subsection. From 
the Settings list, choose For selections.

5 Under Selections, click Add.

6 In the Add dialog box, In the Selections list, choose Explicit 1 and Explicit 2.

7 Click OK.

It is necessary to include the lumped port boundaries to calculate S-parameters. By 
choosing only the lumped port boundaries for Store fields in output settings, it is 
possible to reduce the size of a model file a lot.

8 In the Settings window for Frequency Domain, click to expand the Study extensions 
section.
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9 Locate the Study Extensions section. Select the Use asymptotic waveform evaluation 
check box.

10 In the AWE expressions text field, type abs(comp1.emw.S21).

For two port bandpass-type devices, use abs(emw.S21) for AWE expression.

11 On the Home toolbar, click Compute.

R E S U L T S

S-Parameter (emw) 1
1 In the Model Builder window, under Results click S-Parameter (emw) 1.

2 In the Settings window for 1D Plot Group, locate the Legend section.

3 From the Position list, choose Lower right.

Global 1
1 In the Model Builder window, expand the S-Parameter (emw) 1 node, then click Global 1.

2 In the Settings window for Global, locate the y-Axis Data section.

3 In the table, enter the following settings:

Global 2
1 Right-click Results>S-Parameter (emw) 1>Global 1 and choose Duplicate.

2 In the Settings window for Global, locate the y-Axis Data section.

3 In the table, enter the following settings:

4 In the Settings window for Global, locate the Data section.

5 From the Data set list, choose Study 1/Solution 1 (sol1).

6 Click to expand the Coloring and style section. Locate the Coloring and Style section. 
Find the Line style subsection. From the Line list, choose Dotted.

7 Find the Line markers subsection. From the Marker list, choose Cycle.

8 From the Positioning list, choose In data points.

Expression Unit Description

emw.S11dB dB S-parameter, dB, 11 AWE

emw.S21dB dB S-parameter, dB, 21 AWE

Expression Unit Description

emw.S11dB dB S-parameter, dB, 11 regular sweep

emw.S21dB dB S-parameter, dB, 21 regular sweep
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9 On the S-Parameter (emw) 1 toolbar, click Plot.
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Smith Plot (emw) 1
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Introduction

The dipole antenna is one of the most straightforward antenna configurations. It can be 
realized with two thin metallic rods that have a sinusoidal voltage difference applied 
between them. The length of the rods is chosen such that they are quarter wavelength 
elements at the operating frequency. Such an antenna has a well-known torus-like radiation 
pattern.

Figure 1: A dipole antenna. The model consists of two cylindrical arms of conductive material 
with a voltage source in between. A region of free space bounded by a perfectly matched layer 
(PML) surrounds the antenna.

Model Definition

The model of the antenna consists of two cylinders representing each of the dipole arms. 
The free space wavelength at the antenna’s operating frequency is 4 m. Thus, each of the 
antenna arms is 1 m long and aligned with the z-axis. The arm radius is chosen to be 
0.05 m. In the limit as the radius approaches zero, this antenna approaches the analytic 
solution.

A small cylindrical gap of size 0.01 m between the antenna arms represents the voltage 
source. The power supply and feed structure are not modeled explicitly, and it is assumed 

Perfectly matched layer (PML)

Lumped port

Conductive radiator

λ/4
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that a uniform voltage difference is applied across these faces. This source induces 
electromagnetic fields and surface currents on the adjacent conductive faces.

The dipole arm surfaces are modeled using the Impedance Boundary Condition, which is 
appropriate for conductive surfaces that have dimensions much larger than the skin depth. 
This boundary condition introduces a finite conductivity at the surface as well as resistive 
losses.

The air domain around the antenna is modeled as sphere of free space of radius 2 m, which 
is approximately the boundary between the near-field and the far-field. This sphere of air 
is truncated with a perfectly matched layer (PML) that acts as an absorber of outgoing 
radiation. The far-field pattern is computed on the boundary between the air and the PML 
domains.

The mesh is manually adjusted such that there are five elements per free space wavelength 
and that the boundaries of the antenna are meshed more finely. The PML is swept with a 
total of five elements along the radial direction.

Results and Discussion

The magnitude of the electric field around the antenna is shown in Figure 2. The fields 
appear artificially high near the excitation, as well as at the ends of the arms. These peaks 
in the intensity are due to local singularities; the fields at sharp transitions in the model are 
locally artificially high, but they do not affect the results some distance (1~2 elements) 
away from these regions.

The polar plot in Figure 3 of the far-field pattern in the xy-plane shows the expected 
isotropic radiation pattern. The 3D visualization of the far-field intensity in Figure 4 shows 
the expected torus-shaped pattern.

The impedance as seen by the port is evaluated to be 121 + 28i Ω, which agrees reasonably 
with expectations. In the limit as the antenna radius and gap height go to zero and in the 
limit of mesh refinement, the model approaches the analytic solution for a dipole antenna.
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Figure 2: A slice plot of the electric field magnitude around the antenna.

Figure 3: The polar plot of the far field pattern in the xy-plane is isotropic.
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Figure 4: A 3D visualization of the far-field pattern of the dipole shows the expected torus-
shaped pattern.

Application Library path: RF_Module/Antennas/dipole_antenna

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Radio Frequency>Electromagnetic Waves,

Frequency Domain (emw).

3 Click Add.

4 Click Study.
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5 In the Select Study tree, select Preset Studies>Frequency Domain.

6 Click Done.

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

S T U D Y  1

Step 1: Frequency Domain
1 In the Model Builder window, under Study 1 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 In the Frequencies text field, type c_const/lambda0.

G E O M E T R Y  1

Create a sphere with a layer. The outer layer presents the PML.

Sphere 1 (sph1)
1 On the Geometry toolbar, click Sphere.

2 In the Settings window for Sphere, locate the Size section.

3 In the Radius text field, type 2.4*arm_length.

4 Click to expand the Layers section. In the table, enter the following settings:

5 Right-click Sphere 1 (sph1) and choose Build Selected.

Choose wireframe rendering to get a better view of the interior parts.

6 Click the Wireframe Rendering button on the Graphics toolbar.

Name Expression Value Description

lambda0 4[m] 4 m Operating wavelength

arm_length lambda0/4 1 m Dipole antenna arm length

r_antenna arm_length/20 0.05 m Dipole antenna arm radius

gap_size arm_length/100 0.01 m Gap between arms

Layer name Thickness (m)

Layer 1 0.5*arm_length
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Then, add a cylinder with layers. The top and bottom parts are the antenna radiators. A 
small gap between the antenna radiators is for the voltage source.

Cylinder 1 (cyl1)
1 On the Geometry toolbar, click Cylinder.

2 In the Settings window for Cylinder, locate the Size and Shape section.

3 In the Radius text field, type r_antenna.

4 In the Height text field, type 2*arm_length+gap_size.

5 Locate the Position section. In the z text field, type -(arm_length+gap_size/2).

6 Click to expand the Layers section. In the table, enter the following settings:

7 Clear the Layers on side check box.

8 Select the Layers on bottom check box.

9 Select the Layers on top check box.

10 Right-click Cylinder 1 (cyl1) and choose Build Selected.

The domain inside the antenna radiators is not part of the model analysis.

Difference 1 (dif1)
1 On the Geometry toolbar, click Booleans and Partitions and choose Difference.

2 Select the object sph1 only.

3 In the Settings window for Difference, locate the Difference section.

4 Find the Objects to subtract subsection. Select the Active toggle button.

5 Select the object cyl1 only.

Layer name Thickness (m)

Layer 1 arm_length
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6 Click Build All Objects.

D E F I N I T I O N S

Create a set of selections to be used when setting up the physics. First, create a selection 
for the antenna radiator surface.

Explicit 1
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Antenna in the Label text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.

4 Click Paste Selection.

5 In the Paste Selection dialog box, type 13-15, 18-20, 28, 30, 39, 41 in the Selection 
text field.
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6 Click OK.

Add a perfectly matched layer on the outermost domain of the sphere.

Perfectly Matched Layer 1 (pml1)
1 On the Definitions toolbar, click Perfectly Matched Layer.

2 Select Domains 1–4 and 6–9 only.

3 In the Settings window for Perfectly Matched Layer, locate the Geometry section.
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4 From the Type list, choose Spherical.

View 1
Suppress some domains and boundaries. This helps to see the interior parts when setting 
up the physics and reviewing the mesh.

Hide for Physics 1
1 In the Model Builder window, under Component 1 (comp1)>Definitions right-click View 1 

and choose Hide for Physics.
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2 Select Domains 1 and 2 only.

Hide for Physics 2
1 Right-click View 1 and choose Hide for Physics.

2 In the Settings window for Hide for Physics, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Boundary.

4 Select Boundaries 9 and 10 only.
11 |  D I P O L E  A N T E N N A



E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

Set up the physics for the model. Add an Impedance Boundary Condition that overrides 
the default PEC boundary condition on the antenna radiator surface.

Impedance Boundary Condition 1
1 In the Model Builder window, under Component 1 (comp1) right-click 

Electromagnetic Waves, Frequency Domain (emw) and choose 
Impedance Boundary Condition.

2 In the Settings window for Impedance Boundary Condition, locate the Boundary Selection 
section.

3 From the Selection list, choose Antenna.

Lumped Port 1
1 In the Model Builder window, right-click Electromagnetic Waves,

Frequency Domain (emw) and choose Lumped Port.

2 Click the Zoom In button on the Graphics toolbar, a couple of times to see the small gap 
between antenna radiators clearly.

3 Select Boundaries 16, 17, 29, and 40 only.

4 In the Settings window for Lumped Port, locate the Lumped Port Properties section.

5 From the Type of lumped port list, choose User defined.

6 In the hport text field, type gap_size.

7 In the wport text field, type 2*pi*r_antenna.
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8 Specify the ah vector as

For the first port, wave excitation is on by default.

9 Click the Zoom Extents button on the Graphics toolbar.

10 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Far-
Field Domain.

M A T E R I A L S

Assign air as the material for all domains and override the antenna radiator surface with 
copper.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Built-In>Air.

4 Click Add to Component in the window toolbar.

A D D  M A T E R I A L

1 Go to the Add Material window.

2 In the tree, select Built-In>Copper.

3 Click Add to Component in the window toolbar.

M A T E R I A L S

Copper (mat2)
1 In the Model Builder window, under Component 1 (comp1)>Materials click Copper (mat2).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Boundary.

4 From the Selection list, choose Antenna.

5 On the Home toolbar, click Add Material to close the Add Material window.

M E S H  1

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.

0 x

0 y

1 z
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2 In the Settings window for Mesh, click Build All.

S T U D Y  1

On the Home toolbar, click Compute.

R E S U L T S

Electric Field (emw)
The default plot shows the E-field norm, 2D far-field polar plot, and 3D far-field radiation 
pattern.

Multislice
1 In the Model Builder window, expand the Electric Field (emw) node, then click Multislice.

2 In the Settings window for Multislice, locate the Multiplane Data section.

3 Find the X-planes subsection. In the Planes text field, type 0.

4 Find the Z-planes subsection. In the Planes text field, type 0.

5 Click to expand the Range section. Select the Manual color range check box.

6 In the Maximum text field, type 20.

7 On the Electric Field (emw) toolbar, click Plot.
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8 Click the Zoom In button on the Graphics toolbar.

The results show the E-field norm distribution on the antenna radiators. It is plotted in 
Figure 2.

2D Far Field (emw)
Adjust the axis range.

1 In the Model Builder window, under Results click 2D Far Field (emw).

2 In the Settings window for Polar Plot Group, click to expand the Axis section.

3 Select the Manual axis limits check box.

4 In the r minimum text field, type 0.

5 In the r maximum text field, type 1.

6 On the 2D Far Field (emw) toolbar, click Plot.

The plotted H-plane pattern is omni-directional (isotropic) on the xy-plane as shown 
in Figure 3. The E- and H-plane of a linearly polarized antenna are defined by the 
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antenna main polarization. The E-plane includes the main polarization that is Ez in this 
model while the H-plane is perpendicular to the main polarization.
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3D Far Field (emw)
Compare the reproduced plot with Figure 4.

Derived Values
Finish the result analysis by evaluating the port impedance.

Global Evaluation 2
1 On the Results toolbar, click Global Evaluation.

2 In the Settings window for Global Evaluation, click Replace Expression in the upper-right 
corner of the Expressions section. From the menu, choose Component 1>

Electromagnetic Waves, Frequency Domain>Ports>emw.Zport_1 -

Lumped port impedance.

3 Click Evaluate.
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Introduction

Plasmonic hole arrays have attracted a lot of scientific interest, since the discovery of 
extraordinary transmission through sub-wavelength hole arrays (c.f. Ref. 1). The classical 
Bethe theory predicts that transmittance through a sub-wavelength circular hole of 
diameter d in a PEC screen scales as (d/λ)4, where λ is the wavelength. Yet, transmission 
through holes in realistic metallic films can exceed 50% and even approach 100%. This 
phenomenon was attributed to surface plasmon polaritons that can tunnel electromagnetic 
energy through the hole even if it is very much smaller than the wavelength.

This particular model is intended as a tutorial that shows how to model the full time-
dependent wave equation in dispersive media, such as plasmas and semiconductors (and 
any linear medium describable by a sum of Drude-Lorentz resonant terms). The 
dispersion of the medium in the frequency domain is assumed to be of the form

,  (1)

where the constant ε∞ > 1 absorbs contributions from high-frequency contributions that 
are not modeled explicitly, ωp is the plasma frequency, Γi is a damping coefficient, and ωi 
is a resonance frequency, The particular case when the resonance frequency ωi is zero is 
known as plasma (or Drude medium), and it covers most metals in the optical frequency 
range, from mid-IR to visible. For lossless plasmas, when the damping coefficient also is 
zero (ωi = Γi = 0), modeling simplifies significantly since then the polarization density is 
linearly related to the magnetic vector potential.

In this model, the wave equation for the magnetic vector potential

,  (2)

where the electric displacement field is defined by

,  (3)

is solved together with an ordinary differential equation for the polarization field, obtained 
by a Fourier transformation of Equation 1,

.  (4)

Here f is an oscillator strength (normally set to 1).
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Notice that this model is not primarily intended to demonstrate the anomalously high 
transmission through hole arrays, but rather to demonstrate temporal dispersion 
modeling.

Model Definition

The geometry consists of a single dispersive slab of thickness 1 μm with a slit of width 
0.5 μm in it. The wavelength used is 1 μm. Periodic boundary conditions are applied to 
make the structure physically appear as an array of slits. The source of electromagnetic 
radiation is a plane wave pulse with flat front and Gaussian temporal shape.

Results and Discussion

Figure 1 shows the probe plot of the y-component of the electric field at the input 
boundary. The left part of the curve represents the incoming wave, whereas the right part 
shows the reflected wave returning to the input boundary.

Figure 1: The y-component of the electric field at the input boundary. The left part shows the 
incident pulse and the right part shows the reflected pulse.

Figure 2 shows the probe plot of the y-component of the polarization at a point in the 
entrance of the slit. Notice the propagation delay between the incident field, shown in 
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Figure 1, and the onset of the polarization oscillations at this point.

Figure 2: The y-component of the polarization at a point at the entrance of the slit.
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Figure 3 shows the probe plot of the y-component of the polarization field at a point at 
the rear end of the slit.

Figure 3: The y-component of the polarization at a point at the exit of the slit.
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Figure 4 shows a field plot of the y-component of the polarization field after the last time 
step (100 fs).

Figure 4: The y-component of the polarization field after 100 fs.
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Finally, the out-of-plane component of the magnetic field and, as an overlaid contour plot, 
the y-component of the polarization field are shown in Figure 5, after 100 fs.

Figure 5: The out-of-plane component of the magnetic field and the y-component of the 
polarization field (contours) after 100 fs.

Reference

1. T. W. Ebbesen H. J. Lezec, H. F. Ghaemi, T. Thio, and P. A. Wolff, “Extraordinary 
Optical Transmission Through Sub-wavelength Hole Arrays,” Nature, vol. 391, pp. 667-
9, 1998.

Application Library path: RF_Module/Tutorials/drude_lorentz_media

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.
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M O D E L  W I Z A R D

1 In the Model Wizard window, click 2D.

2 In the Select Physics tree, select Radio Frequency>Electromagnetic Waves,

Transient (temw).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Time Dependent.

6 Click Done.

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

Add some parameters that will define the geometry and the properties of the incident 
field.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

D E F I N I T I O N S

Variables 1
1 In the Model Builder window, under Component 1 (comp1) right-click Definitions and 

choose Variables.

Now add some variables that defines the incident field and the material properties.

2 In the Settings window for Variables, locate the Variables section.

Name Expression Value Description

lambda0 1[um] 1E-6 m Wavelength

E0 1[V/m] 1 V/m Electric field amplitude

k0 2*pi/lambda0 6.283E6 1/m Wave number in vacuum

t0 25[fs] 2.5E-14 s Time delay

dt 10[fs] 1E-14 s Pulse duration
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3 In the table, enter the following settings:

G E O M E T R Y  1

The geometry is simple, consisting of only three centered rectangles.

Rectangle 1 (r1)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type lambda0.

4 In the Height text field, type 6*lambda0.

5 Locate the Position section. From the Base list, choose Center.

Rectangle 2 (r2)
1 In the Model Builder window, right-click Rectangle 1 (r1) and choose Duplicate.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 20*lambda0.

Rectangle 3 (r3)
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 right-click 

Rectangle 1 (r1) and choose Duplicate.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Height text field, type 0.5*lambda0.

4 Click Build All Objects.

Name Expression Unit Description

omega0 2*pi[rad]*c_const/
lambda0

rad/s Angular frequency

E_bnd E0*cos(omega0*t-k0*x) V/m Plane-wave factor for 
electric field

E_pulse exp(-(t-t0)^2/dt^2) Temporal factor for 
electric field

omega_p 1.5*omega0 rad/s Plasma frequency

omega_1 0.5*omega_p rad/s Resonance frequency

gamma_1 0.1*omega_1 rad/s Damping coefficient
9 |  T I M E - D O M A I N  M O D E L I N G  O F  D I S P E R S I V E  D R U D E - L O R E N T Z  M E D I A



5 Click the Zoom Extents button on the Graphics toolbar.

D E F I N I T I O N S

Now, add three integration operator that will be used for probing the field and the 
polarization in three different points.

Integration 1 (intop1)
1 On the Definitions toolbar, click Component Couplings and choose Integration.

2 In the Settings window for Integration, locate the Source Selection section.

3 From the Geometric entity level list, choose Point.
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4 Select Point 2 only.

Integration 2 (intop2)
1 On the Definitions toolbar, click Component Couplings and choose Integration.

2 In the Settings window for Integration, locate the Source Selection section.

3 From the Geometric entity level list, choose Point.
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4 Select Point 5 only.

Integration 3 (intop3)
1 On the Definitions toolbar, click Component Couplings and choose Integration.

2 In the Settings window for Integration, locate the Source Selection section.

3 From the Geometric entity level list, choose Point.
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4 Select Point 9 only.

E L E C T R O M A G N E T I C  WA V E S ,  TR A N S I E N T  ( T E M W )

1 In the Model Builder window, under Component 1 (comp1) click Electromagnetic Waves,

Transient (temw).

2 In the Settings window for Electromagnetic Waves, Transient, locate the Components 
section.

3 From the Electric field components solved for list, choose In-plane vector, to solve only 
for the in-plane components of the field.

Wave Equation, Electric 1
Define the first wave equation feature to use the Drude-Lorentz dispersion model. Later 
you will add another wave equation feature for the air domain.

1 In the Model Builder window, under Component 1 (comp1)>Electromagnetic Waves,

Transient (temw) click Wave Equation, Electric 1.

2 In the Settings window for Wave Equation, Electric, locate the Electric Displacement Field 
section.

3 From the Electric displacement field model list, choose Drude-Lorentz dispersion model.

4 From the Relative permittivity, high frequency list, choose User defined. From the list, 
choose Diagonal.
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5 In the Relative permittivity, high frequency table, enter 4 for the two first diagonal 
elements.

6 In the ωP text field, type omega_p.

7 Locate the Magnetic Field section. From the μr list, choose User defined. Accept the 
default value 1.

8 Locate the Conduction Current section. From the σ list, choose User defined. Accept the 
default value 0.

Next, you add a Drude-Lorentz Polarization feature, as a subfeature to the wave 
equation. There, more material parameters will be defined for the polarization field.

Drude-Lorentz Polarization 1
1 Right-click Component 1 (comp1)>Electromagnetic Waves, Transient (temw)>

Wave Equation, Electric 1 and choose Drude-Lorentz Polarization.

2 In the Settings window for Drude-Lorentz Polarization, locate the Drude-

Lorentz Dispersion Model section.

3 In the fn text field, type 1.

4 In the ωn text field, type omega_1.

5 In the Γn text field, type gamma_1.

Wave Equation, Electric 2
1 In the Model Builder window, right-click Electromagnetic Waves, Transient (temw) and 

choose Wave Equation, Electric.
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2 Select Domains 1, 3, and 5 only.

3 In the Settings window for Wave Equation, Electric, locate the Electric Displacement Field 
section.

4 From the εr list, choose User defined. Locate the Magnetic Field section. From the μr list, 
choose User defined. Locate the Conduction Current section. From the σ list, choose 
User defined. Use scattering boundary conditions to excite the wave and to absorb it.

Scattering Boundary Condition 1
1 Right-click Electromagnetic Waves, Transient (temw) and choose 

Scattering Boundary Condition.

2 In the Settings window for Scattering Boundary Condition, locate the 
Scattering Boundary Condition section.

3 From the Incident field list, choose Wave given by E field.
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4 Select Boundary 1 only.

5 Specify the E0 vector as

Scattering Boundary Condition 2
1 Right-click Electromagnetic Waves, Transient (temw) and choose 

Scattering Boundary Condition.

0 x

E_pulse*E_bnd y

0 z
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2 Select Boundary 16 only.

To model a hole array, periodic boundary conditions will be used.

Periodic Condition 1
1 Right-click Electromagnetic Waves, Transient (temw) and choose Periodic Condition.
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2 Select Boundaries 2, 3, 5, 10, 12, and 15 only.

M E S H  1

Since a periodic boundary condition is used, the mesh should also be the same on the top 
and bottom edge. Thus, add first an edge mesh and copy the mesh points to the opposite 
edge. Then add a triangular mesh.

Edge 1
1 In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 

More Operations>Edge.
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2 Select Boundaries 3, 10, and 15 only.

Copy Edge 1
1 In the Model Builder window, right-click Mesh 1 and choose More Operations>Copy Edge.

2 Select Boundary 3 only.

3 In the Settings window for Copy Edge, locate the Destination Boundaries section.

4 Select the Active toggle button.
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5 Select Boundary 2 only.

Copy Edge 2
1 Right-click Mesh 1 and choose More Operations>Copy Edge.

2 Select Boundary 10 only.

3 In the Settings window for Copy Edge, locate the Destination Boundaries section.

4 Select the Active toggle button.
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5 Select Boundary 5 only.

Copy Edge 3
1 Right-click Mesh 1 and choose More Operations>Copy Edge.

2 Select Boundary 15 only.

3 In the Settings window for Copy Edge, locate the Destination Boundaries section.

4 Select the Active toggle button.
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5 Select Boundary 12 only.

Size
1 Right-click Mesh 1 and choose Free Triangular.

2 In the Settings window for Size, locate the Element Size section.

3 Click the Custom button.

4 Locate the Element Size Parameters section. In the Maximum element size text field, type 
lambda0/6.
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5 Click Build All.

S T U D Y  1

Step 1: Time Dependent
1 In the Settings window for Time Dependent, locate the Study Settings section.

2 In the Times text field, type range(0,10[fs],100[fs]).

Solution 1 (sol1)
1 On the Study toolbar, click Show Default Solver, to be able to make some modifications 

of the solver settings.

Force the solver to use a fixed small step size that resolves the temporal field oscillations.

2 In the Model Builder window, expand the Solution 1 (sol1) node, then click Time-

Dependent Solver 1.

3 In the Settings window for Time-Dependent Solver, click to expand the Time stepping 
section.

4 Locate the Time Stepping section. From the Steps taken by solver list, choose Manual.

5 In the Time step text field, type 0.1[fs].
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D E F I N I T I O N S

Before computing the solution, define the three Global Variable Probes that can be used 
for monitoring the computation progress.

Global Variable Probe 1 (var1)
1 On the Definitions toolbar, click Probes and choose Global Variable Probe.

2 In the Settings window for Global Variable Probe, locate the Expression section.

3 In the Expression text field, type intop1(temw.Ey).

4 Click to expand the Table and window settings section.

Global Variable Probe 2 (var2)
1 On the Definitions toolbar, click Probes and choose Global Variable Probe.

2 In the Settings window for Global Variable Probe, locate the Expression section.

3 In the Expression text field, type intop2(temw.Poscy).

4 Locate the Table and Window Settings section. From the Plot window list, choose 
New window.

Global Variable Probe 3 (var3)
1 On the Definitions toolbar, click Probes and choose Global Variable Probe.

2 In the Settings window for Global Variable Probe, locate the Expression section.

3 In the Expression text field, type intop3(temw.Poscy).

4 Locate the Table and Window Settings section. From the Plot window list, choose 
New window.

5 On the Home toolbar, click Compute.

R E S U L T S

Surface 1
Modify this surface plot to show the y component of the Drude-Lorentz polarization.

1 In the Model Builder window, expand the 2D Plot Group 1 node, then click Surface 1.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type temw.Poscy.

4 On the 2D Plot Group 1 toolbar, click Plot.
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5 Click the Zoom Extents button on the Graphics toolbar.
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Probe Plot Group 2

The first probe plot should look like the one above.
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Probe Plot Group 3

The second probe plot should look like the one above.
27 |  T I M E - D O M A I N  M O D E L I N G  O F  D I S P E R S I V E  D R U D E - L O R E N T Z  M E D I A



Probe Plot Group 4

Finally, the third probe plot should look like the one above.

Now, add a surface plot of the z component of the magnetic field and overlay a contour 
plot of the y component of the Drude-Lorentz polarization.

Surface 1
1 On the Home toolbar, click Add Plot Group and choose 2D Plot Group.

2 In the Model Builder window, right-click 2D Plot Group 5 and choose Surface.

3 In the Settings window for Surface, locate the Expression section.

4 In the Expression text field, type temw.Hz.

5 Locate the Coloring and Style section. From the Color table list, choose Cyclic.

Contour 1
1 In the Model Builder window, under Results right-click 2D Plot Group 5 and choose 

Contour.

2 In the Settings window for Contour, locate the Expression section.

3 In the Expression text field, type temw.Poscy.

4 On the 2D Plot Group 5 toolbar, click Plot.
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5 Click the Zoom Extents button on the Graphics toolbar.
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Introduction

Frequency selective surfaces (FSS) are periodic structures with a bandpass or a bandstop 
frequency response. This example shows that only signals around the center frequency can 
pass through the periodic complementary split ring resonator layer.

Figure 1: One unit cell of the complementary split ring resonator is modeled with periodic 
boundary conditions to simulate an infinite 2D array. Perfectly matched layers at the top and 
bottom of the unit cell absorb the excited and higher order modes.

Model Definition

A split ring slot is patterned on a geometrically thin copper layer that sits on a 2 mm PTFE 
substrate (Figure 1). The copper layer is much thicker than the skin depth in the simulated 
frequency range, so it is modeled as a perfect electric conductor (PEC). The rest of the 
simulation domain is filled with air.

Floquet-periodic boundary conditions are used on four sides of the unit cell to simulate 
the infinite 2D array. Perfectly matched layers (PMLs) on the top and bottom of the unit 
cell absorb the excited mode from the source port and any higher order modes generated 
by the periodic structure. The PMLs attenuate the wave as it propagates in the direction 
perpendicular to the PML boundary. Since the model is solved for a range of incident 

Thin copper layer

Perfectly matched layers

Perfectly matched layers

Virtual infinite array

Listener port

Source port

Split ring slot

Unit cell with 
periodic conditions

2 mm PTFE substrate
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angles, the wavelength in the PMLs is set to 2π/|k0cosθ|. This accounts for the angular 
dependence of the normal component of the wave vector inside the PMLs.

Port boundary conditions are placed on the interior boundaries of the PMLs, adjacent to 
the air domains. The Port boundary conditions automatically determine the reflection and 
transmission characteristics in terms of S-parameters. The interior port boundaries with 
PML backing require the slit condition. The port orientation is specified to define the 
inward direction for the S-parameter calculation. Since higher order diffraction modes are 
not of particular interest in this example, the combination of Domain-backed type slit port 
and PMLs is used instead of adding a Diffraction order port for each diffraction order and 
polarization.

The periodic boundary condition requires identical surface meshes on paired boundaries. 
This is accomplished in two steps: first by creating a mesh on only one of the boundaries 
and then using the Copy Face operation for the mesh on the other boundary. This mesh 
configuration is automatically set when using the physics-controlled mesh as shown in the 
step-by-step instructions. If you are interested in seeing more details about the mesh, build 
the physics-controlled mesh once and then change the mesh sequence type to the user-
controlled mesh in the mesh settings. Then you can inspect the generated mesh sequence.

Results and Discussion

The modified multislice default plot (Figure 2) shows the electric field norm on the 
complimentary split ring resonator. Strong fields are observed inside the slot. The S-
parameter plot in Figure 3 shows that this periodic structure functions as a bandpass filter 
near 4.6 GHz. In Figure 4, the S-parameters appear as a function of incident angle and 
show that the periodic structure is penetrable at 4.6 GHz over the simulated range, except 
for grazing angles.

The resonance frequency of this periodic structure can be quickly evaluated as 4.59 GHz 
using an Eigenfrequency study, which is not included in this example.
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Figure 2: The fields are confined in the split ring slot.
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Figure 3: The S-parameter plot shows a bandpass resonance near 4.6 GHz

Figure 4: The S-parameter plot is shown as a function of incident angle.
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Application Library path: RF_Module/EMI_EMC_Applications/
frequency_selective_surface_csrr

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Radio Frequency>Electromagnetic Waves,

Frequency Domain (emw).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Frequency Domain.

6 Click Done.

S T U D Y  1

Step 1: Frequency Domain
1 In the Model Builder window, under Study 1 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 In the Frequencies text field, type range(3.8[GHz],0.1[GHz],5.4[GHz]).

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

Name Expression Value Description

theta 0[deg] 0 rad Elevation angle
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G E O M E T R Y  1

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose mm.

Block 1 (blk1)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, locate the Size and Shape section.

3 In the Width text field, type 15.

4 In the Depth text field, type 15.

5 In the Height text field, type 45.

6 Locate the Position section. From the Base list, choose Center.

7 Right-click Block 1 (blk1) and choose Build Selected.

8 Click the Wireframe Rendering button on the Graphics toolbar.

Circle 1 (c1)
1 On the Geometry toolbar, click Work Plane.

2 On the Work Plane toolbar, click Primitives and choose Circle.

3 In the Settings window for Circle, locate the Size and Shape section.

4 In the Radius text field, type 5.

5 Right-click Circle 1 (c1) and choose Build Selected.

6 Click the Zoom Extents button on the Graphics toolbar.

Circle 2 (c2)
1 On the Work Plane toolbar, click Primitives and choose Circle.

2 In the Settings window for Circle, locate the Size and Shape section.

3 In the Radius text field, type 3.5.

Rectangle 1 (r1)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 4.

4 Locate the Position section. From the Base list, choose Center.

5 In the xw text field, type 4.
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Difference 1 (dif1)
1 On the Work Plane toolbar, click Booleans and Partitions and choose Difference.

2 Select the object c1 only.

3 In the Settings window for Difference, locate the Difference section.

4 Find the Objects to subtract subsection. Select the Active toggle button.

5 Click the Select Box button on the Graphics toolbar.

6 Select the objects r1 and c2 only.

7 Right-click Difference 1 (dif1) and choose Build Selected.

8 In the Model Builder window, click Geometry 1.

Block 2 (blk2)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, locate the Size and Shape section.

3 In the Width text field, type 15.

4 In the Depth text field, type 15.

5 In the Height text field, type 2.

6 Locate the Position section. From the Base list, choose Center.

7 In the z text field, type -1.

Block 3 (blk3)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, locate the Size and Shape section.

3 In the Width text field, type 15.

4 In the Depth text field, type 15.

5 In the Height text field, type 80.

6 Locate the Position section. From the Base list, choose Center.

7 Click Build All Objects.
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8 Click the Zoom Extents button on the Graphics toolbar.

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

Set up the physics. First, define physics-controlled mesh maximum element size. Use 
Floquet-periodic conditions on all side boundaries.

Perfect Electric Conductor 2
1 In the Model Builder window, right-click Electromagnetic Waves,

Frequency Domain (emw) and choose Perfect Electric Conductor.

2 Select Boundary 12 only.

Periodic Condition 1
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Periodic Condition.
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2 Select Boundaries 4, 7, 10, and 24–26 only.

3 In the Settings window for Periodic Condition, locate the Periodicity Settings section.

4 From the Type of periodicity list, choose Floquet periodicity.

5 From the k-vector for Floquet periodicity list, choose From periodic port.

Periodic Condition 2
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Periodic Condition.
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2 Select Boundaries 1, 13, 23, and 27 only.

3 In the Settings window for Periodic Condition, locate the Periodicity Settings section.

4 From the Type of periodicity list, choose Floquet periodicity.

5 From the k-vector for Floquet periodicity list, choose From periodic port.

Periodic Condition 3
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Periodic Condition.
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2 Select Boundaries 5, 8, 11, and 18–20 only.

3 In the Settings window for Periodic Condition, locate the Periodicity Settings section.

4 From the Type of periodicity list, choose Floquet periodicity.

5 From the k-vector for Floquet periodicity list, choose From periodic port.

Periodic Condition 4
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Periodic Condition.
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2 Select Boundaries 2, 14, 17, and 21 only.

3 In the Settings window for Periodic Condition, locate the Periodicity Settings section.

4 From the Type of periodicity list, choose Floquet periodicity.

5 From the k-vector for Floquet periodicity list, choose From periodic port.

The wave is excited from the port on the top.

Port 1
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Port.

2 Select Boundary 15 only.

3 In the Settings window for Port, locate the Port Properties section.

4 From the Type of port list, choose Periodic.

For the first port, wave excitation is on by default.

5 Select the Activate slit condition on interior port check box.

6 From the Slit type list, choose Domain-backed.

7 From the Port orientation list, choose Reverse.

8 Locate the Port Mode Settings section. From the Input quantity list, choose 
Magnetic field.
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9 Specify the H0 vector as

10 In the α1 text field, type theta.

The maximum frequency in the setting window will be used only when Compute 

Diffraction Order button is clicked to generate Diffraction Order features handling 
higher order mode individually. In this model, PML absorbs all higher order modes, so 
this setting is ineffective.

Port 2
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Port.

2 Select Boundary 6 only.

3 In the Settings window for Port, locate the Port Properties section.

4 From the Type of port list, choose Periodic.

5 Select the Activate slit condition on interior port check box.

6 From the Slit type list, choose Domain-backed.

7 From the Port orientation list, choose Reverse.

8 Locate the Port Mode Settings section. From the Input quantity list, choose 
Magnetic field.

9 Specify the H0 vector as

Scattering Boundary Condition 1
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Scattering Boundary Condition.

2 Select Boundary 3 only.

D E F I N I T I O N S

Perfectly Matched Layer 1 (pml1)
1 On the Definitions toolbar, click Perfectly Matched Layer.

0 x

1 y

0 z

0 x

1 y

0 z
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2 Select Domain 5 only.

3 In the Settings window for Perfectly Matched Layer, locate the Scaling section.

4 From the Typical wavelength from list, choose User defined.

5 In the Typical wavelength text field, type 2*pi/abs(emw.k0*cos(theta)).

Perfectly Matched Layer 2 (pml2)
1 On the Definitions toolbar, click Perfectly Matched Layer.

2 Select Domain 1 only.

3 In the Settings window for Perfectly Matched Layer, locate the Scaling section.

4 From the Typical wavelength from list, choose User defined.

5 In the Typical wavelength text field, type 2*pi/abs(emw.k0*cos(theta)).

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Built-In>Air.

4 Click Add to Component in the window toolbar.

M A T E R I A L S

On the Home toolbar, click Add Material to close the Add Material window.

Material 2 (mat2)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.
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2 Select Domain 3 only.

3 In the Settings window for Material, locate the Material Contents section.

4 In the table, enter the following settings:

M E S H  1

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.

2 In the Settings window for Mesh, click Build All.

3 Click the Zoom Extents button on the Graphics toolbar.

4 Locate the Mesh Settings section. From the Element size list, choose Extremely fine.

5 Click Build All.

D E F I N I T I O N S

Hide for Physics 1
1 In the Model Builder window, under Component 1 (comp1)>Definitions right-click View 1 

and choose Hide for Physics.

Property Name Value Unit Property 
group

Relative permittivity epsilonr 2.1 1 Basic

Relative permeability mur 1 1 Basic

Electrical conductivity sigma 0 S/m Basic
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2 In the Settings window for Hide for Physics, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Boundary.

4 Select Boundaries 10, 11, 13, and 14 only.

M E S H  1

In the Model Builder window, click Mesh 1.

S T U D Y  1

On the Home toolbar, click Compute.

R E S U L T S

Electric Field (emw)
1 In the Model Builder window, under Results click Electric Field (emw).

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Parameter value (freq (GHz)) list, choose 4.6.

Multislice
1 In the Model Builder window, expand the Electric Field (emw) node, then click Multislice.

2 In the Settings window for Multislice, locate the Multiplane Data section.

3 Find the X-planes subsection. In the Planes text field, type 0.
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4 Find the Y-planes subsection. In the Planes text field, type 0.

5 Find the Z-planes subsection. From the Entry method list, choose Coordinates.

6 In the Coordinates text field, type -1.

7 On the Electric Field (emw) toolbar, click Plot.

8 Click the Zoom In button on the Graphics toolbar.

9 Click the Zoom In button on the Graphics toolbar.

This reproduces Figure 2.
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S-Parameter (emw)

Smith Plot (emw)
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Identify the resonant frequency of the periodic structure from the S-parameter plot 
Figure 3.

Next, evaluate the reflectivity and transmittivity performance of the model with different 
incident angles.

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

S T U D Y  1

1 Find the Studies subsection. In the Select Study tree, select Preset Studies>

Frequency Domain.

2 Click Add Study in the window toolbar.

If you want to clear the Add Study window after adding, click Add Study again on the 
Home toolbar.

R O O T

On the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  2

Parametric Sweep
1 On the Study toolbar, click Parametric Sweep.

2 In the Settings window for Parametric Sweep, locate the Study Settings section.

3 Click Add.

4 In the table, enter the following settings:

Step 1: Frequency Domain
1 In the Model Builder window, under Study 2 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 In the Frequencies text field, type 4.6[GHz].

4 On the Study toolbar, click Compute.

Parameter name Parameter value list Parameter unit

theta range(0[deg],5[deg],85[deg])
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R E S U L T S

Multislice
1 In the Model Builder window, expand the Electric Field (emw) 1 node, then click 

Multislice.

2 In the Settings window for Multislice, locate the Multiplane Data section.

3 Find the X-planes subsection. In the Planes text field, type 0.

4 Find the Y-planes subsection. In the Planes text field, type 0.

5 Find the Z-planes subsection. From the Entry method list, choose Coordinates.

6 In the Coordinates text field, type -1.

7 On the Electric Field (emw) 1 toolbar, click Plot.

Add a 1D plot.

1D Plot Group 5
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, locate the Data section.

3 From the Data set list, choose Study 2/Solution 2 (sol2).

Global 1
1 Right-click 1D Plot Group 5 and choose Global.

2 In the Settings window for Global, click Add Expression in the upper-right corner of the 
y-axis data section. From the menu, choose Component 1>Electromagnetic Waves,

Frequency Domain>Ports>S-parameter, dB>emw.S11dB - S11.

3 Click Add Expression in the upper-right corner of the y-axis data section. From the 
menu, choose Component 1>Electromagnetic Waves, Frequency Domain>Ports>S-

parameter, dB>emw.S21dB - S21.
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4 On the 1D Plot Group 5 toolbar, click Plot.

This is the S-parameter plot as a function of incident angle shown in Figure 4.
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Introduction

A plane electromagnetic wave propagating through free space is incident at an angle upon 
an infinite dielectric medium. This model computes the reflection and transmission 
coefficients and compares the results to the Fresnel equations.

Model Definition

A plane wave propagating through free space (n = 1) as shown in Figure 1 is incident upon 
an infinite dielectric medium (n = 1.5) and is partially reflected and partially transmitted. 
If the electric field is p-polarized—that is, if the electric field vector is in the same plane as 
the Poynting vector and the surface normal—then there are no reflections at an incident 
angle of roughly 56°, known as the Brewster angle.

Figure 1: A plane wave propagating through free space incident upon an infinite dielectric 
medium.

Although, by assumption, space extends to infinity in all directions, it is sufficient to model 
a small unit cell, as shown in Figure 1; a Floquet-periodic boundary condition applies on 
the top and bottom unit-cell boundaries because the solution is periodic along the 
interface. This model uses a 3D unit cell, and applies perfect electric conductor and perfect 
magnetic conductor boundary conditions as appropriate to model out-of-plane symmetry. 
The angle of incidence ranges between 0–90° for both polarizations.

Reflected
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Unit cell
Transmitted

θ

n1 n2
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For comparison, Ref. 1 and Ref. 2 provide analytic expressions for the reflectance and 
transmittance1. Reflection and transmission coefficients for s-polarization and p-
polarization are defined respectively as 

Reflectance and transmittance are defined as

The Brewster angle at which rp = 0 is defined as

1. Note that depending on the sign convention for what is defined as a positive polarization for the reflected wave
with in-plane (p-polarization), the sign for the reflection coefficient rp can differ for different authors. However,
the total field solution will always be the same.

rs
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Results and Discussion

Figure 2 is a combined plot of the y component of the electric-field distribution and the 
power flow visualized as an arrow plot for the TE case.

Figure 2: Electric field, Ey (slice) and power flow (arrows) for TE incidence at 70° inside the 
unit cell.
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For the TM case, Figure 3 visualizes the y component of the magnetic-field distribution 
instead, again in combination with the power flow.

Figure 3: Magnetic field, Hy (slice) and power flow (arrows) for TM incidence at 70° inside 
the unit cell.

Note that the sum of reflectance and transmittance in Figure 4 and Figure 5 equals 1, 
showing conservation of power. Figure 5 also shows that the reflectance around 56°—the 
Brewster angle in the TM case—is close to zero.
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Figure 4: The reflectance and transmittance for TE incidence agree well with the analytic 
solutions.

Figure 5: The reflectance and transmittance for TM incidence agree well with the analytic 
solutions. The Brewster angle is also observed at the expected location.
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Application Library path: RF_Module/Verification_Examples/
fresnel_equations

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Radio Frequency>Electromagnetic Waves,

Frequency Domain (emw).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Frequency Domain.

6 Click Done.

G L O B A L  D E F I N I T I O N S

Define some parameters that are useful when setting up the mesh and the study.

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.
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3 In the table, enter the following settings:

The angle of incidence is updated while running the parametric sweep. The refraction 
(transmitted) angle is defined by Snell’s law with the updated angle of incidence. The 
Brewster angle exists only for TM incidence, p-polarization, and parallel polarization.

S T U D Y  1

Step 1: Frequency Domain
1 In the Model Builder window, under Study 1 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 In the Frequencies text field, type f0.

Name Expression Value Description

n_air 1 1 Refractive index, 
air

n_slab 1.5 1.5 Refractive index, 
slab

lda0 1[m] 1 m Wavelength

f0 c_const/lda0 2.998E8 1/s Frequency

alpha 70[deg] 1.222 rad Angle of 
incidence

beta asin(n_air*sin(alpha)/
n_slab)

0.677 rad Refraction angle

alpha_brewster atan(n_slab/n_air) 0.9828 rad Brewster angle, 
TM only

r_s (n_air*cos(alpha)-
n_slab*cos(beta))/
(n_air*cos(alpha)+
n_slab*cos(beta))

-0.5474 Reflection 
coefficient, TE

r_p (n_slab*cos(alpha)-
n_air*cos(beta))/
(n_air*cos(beta)+
n_slab*cos(alpha))

-0.2061 Reflection 
coefficient, TM

t_s (2*n_air*cos(alpha))/
(n_air*cos(alpha)+
n_slab*cos(beta))

0.4526 Transmission 
coefficient, TE

t_p (2*n_air*cos(alpha))/
(n_air*cos(beta)+
n_slab*cos(alpha))

0.5292 Transmission 
coefficient, TM
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G E O M E T R Y  1

First, create a block composed of two domains. Use layers to split the block.

Block 1 (blk1)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, locate the Size and Shape section.

3 In the Width text field, type 0.2.

4 In the Depth text field, type 0.2.

5 In the Height text field, type 0.8.

6 Click to expand the Layers section. In the table, enter the following settings:

7 Click Build All Objects.

8 Click the Zoom Extents button on the Graphics toolbar.

Choose wireframe rendering to get a better view of each boundary.

9 Click the Wireframe Rendering button on the Graphics toolbar.

Layer name Thickness (m)

Layer 1 0.4
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E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

Set up the physics based on the direction of propagation and the E-field polarization. First, 
assume a TE-polarized wave which is equivalent to s-polarization and perpendicular 
polarization. Ex and Ez are zero while Ey is dominant.

1 In the Model Builder window, expand the Component 1 (comp1)>Electromagnetic Waves,

Frequency Domain (emw) node.

Port 1
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Port.

2 Select Boundary 7 only.

3 In the Settings window for Port, locate the Port Properties section.

4 From the Type of port list, choose Periodic.

For the first port, wave excitation is on by default.

5 Locate the Port Mode Settings section. Specify the E0 vector as

6 Locate the Automatic Diffraction Order Calculation section. In the n text field, type 
n_air.

7 Locate the Port Mode Settings section. In the α1 text field, type alphaThe maximum 
frequency in the setting window will be used only when Compute Diffraction Order 
button is clicked to generate Diffraction Order features handling higher order mode 
individually. In this model, no diffraction is expected from the given geometry, so this 
setting is ineffective.

Port 2
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Port.

2 Select Boundary 3 only.

3 In the Settings window for Port, locate the Port Properties section.

4 From the Type of port list, choose Periodic.

5 Locate the Port Mode Settings section. Specify the E0 vector as

0 x

1 y

0 z

0 x

1 y

0 z
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6 Locate the Automatic Diffraction Order Calculation section. In the n text field, type 
n_slab.

The bottom surface is an observation port. The S21-parameter from Port 1 and Port 2 
provides the transmission characteristics.

Periodic Condition 1
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Periodic Condition.

2 Select Boundaries 1, 4, 10, and 11 only.

3 In the Settings window for Periodic Condition, locate the Periodicity Settings section.

4 From the Type of periodicity list, choose Floquet periodicity.

5 From the k-vector for Floquet periodicity list, choose From periodic port.

Periodic Condition 2
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Periodic Condition.

2 Select Boundaries 2, 5, 8, and 9 only.

3 In the Settings window for Periodic Condition, locate the Periodicity Settings section.

4 From the Type of periodicity list, choose Floquet periodicity.
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5 From the k-vector for Floquet periodicity list, choose From periodic port.

Wave Equation, Electric 1
1 In the Model Builder window, under Component 1 (comp1)>Electromagnetic Waves,

Frequency Domain (emw) click Wave Equation, Electric 1.

2 In the Settings window for Wave Equation, Electric, locate the Electric Displacement Field 
section.

3 From the Electric displacement field model list, choose Refractive index.

M A T E R I A L S

Now set up the material properties based on refractive index. The top half is filled with air.

Material 1 (mat1)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, type Air in the Label text field.

3 Select Domain 2 only.

4 Locate the Material Contents section. In the table, enter the following settings:

The bottom half is glass.

Property Name Value Unit Property group

Refractive index n n_air 1 Refractive index
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Material 2 (mat2)
1 Right-click Materials and choose Blank Material.

2 In the Settings window for Material, type Glass in the Label text field.

3 Select Domain 1 only.

4 Locate the Material Contents section. In the table, enter the following settings:

M E S H  1

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.

2 In the Settings window for Mesh, click Build All.

S T U D Y  1

Parametric Sweep
1 On the Study toolbar, click Parametric Sweep.

2 In the Settings window for Parametric Sweep, locate the Study Settings section.

3 Click Add.

Property Name Value Unit Property group

Refractive index n n_slab 1 Refractive index
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4 In the table, enter the following settings:

5 On the Study toolbar, click Compute.

R E S U L T S

Electric Field (emw)
The default plot is the E-field norm for the last solution, which corresponds to tangential 
incidence. Replace the expression with Ey, add an arrow plot of the power flow (Poynting 
vector), and choose a more interesting angle of incidence for the plot.

Multislice
1 In the Model Builder window, expand the Electric Field (emw) node, then click Multislice.

2 In the Settings window for Multislice, click Replace Expression in the upper-right corner 
of the Expression section. From the menu, choose Component 1>Electromagnetic Waves,

Frequency Domain>Electric>Electric field>emw.Ey - Electric field, y component.

3 Locate the Multiplane Data section. Find the X-planes subsection. In the Planes text field, 
type 0.

4 Find the Z-planes subsection. In the Planes text field, type 0.

5 Locate the Coloring and Style section. From the Color table list, choose Wave.

Arrow Volume 1
1 In the Model Builder window, under Results right-click Electric Field (emw) and choose 

Arrow Volume.

2 In the Settings window for Arrow Volume, click Replace Expression in the upper-right 
corner of the Expression section. From the menu, choose Component 1>

Electromagnetic Waves, Frequency Domain>Energy and power>emw.Poavx,...,emw.Poavz -

Power flow, time average.

3 Locate the Arrow Positioning section. Find the Y grid points subsection. In the Points text 
field, type 1.

4 Locate the Coloring and Style section. From the Color list, choose Green.

Electric Field (emw)
1 In the Model Builder window, under Results click Electric Field (emw).

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Parameter value (alpha (1)) list, choose 1.222.

Parameter name Parameter value list Parameter unit

alpha range(0,2[deg],88[deg])
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4 On the Electric Field (emw) toolbar, click Plot.

5 Click the Zoom Extents button on the Graphics toolbar.

The plot should look like that in Figure 2.

1D Plot Group 2
Add a 1D plot to see the reflection and transmission versus the angle of incidence.

1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, locate the Plot Settings section.

3 Select the x-axis label check box.

4 In the associated text field, type Angle of Incidence.

5 Select the y-axis label check box.

6 In the associated text field, type Reflectance and Transmittance.

7 Click to expand the Legend section. From the Position list, choose Upper left.

8 Click to expand the Title section. From the Title type list, choose None.

Global 1
1 Right-click 1D Plot Group 2 and choose Global.

2 In the Settings window for Global, locate the y-Axis Data section.
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3 In the table, enter the following settings:

4 Click to expand the Coloring and style section. Locate the Coloring and Style section. 
Find the Line style subsection. From the Line list, choose None.

5 Find the Line markers subsection. From the Marker list, choose Cycle.

1D Plot Group 2
1 In the Model Builder window, under Results click 1D Plot Group 2.

2 In the Settings window for 1D Plot Group, type Reflection and Transmission in the 
Label text field.

Global 2
1 Right-click Results>Reflection and Transmission and choose Global.

2 In the Settings window for Global, locate the y-Axis Data section.

3 In the table, enter the following settings:

Expression Unit Description

abs(emw.S11)^2 1 Reflectance

abs(emw.S21)^2 1 Transmittance

Expression Unit Description

abs(r_s)^2 Reflectance, analytic

n_slab*cos(beta)/(n_air*
cos(alpha))*abs(t_s)^2

Transmittance, analytic
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4 On the Reflection and Transmission toolbar, click Plot.

Compare the resulting plots with Figure 4.

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

The remaining instructions are for the case of TM-polarized wave, p-polarization, and 
parallel polarization. In this case, Ey is zero while Ex and Ez characterize the wave. In other 
words, Hy is dominant while Hx and Hz have no effect. Thus, the H-field is perpendicular 
to the plane of incidence and it is convenient to specify the port mode fields as the H-field.

Port 1
1 In the Model Builder window, under Component 1 (comp1)>Electromagnetic Waves,

Frequency Domain (emw) click Port 1.

2 In the Settings window for Port, locate the Port Mode Settings section.

3 From the Input quantity list, choose Magnetic field.

4 Specify the H0 vector as

0 x

1 y

0 z
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Port 2
1 In the Model Builder window, under Component 1 (comp1)>Electromagnetic Waves,

Frequency Domain (emw) click Port 2.

2 In the Settings window for Port, locate the Port Mode Settings section.

3 From the Input quantity list, choose Magnetic field.

4 Specify the H0 vector as

S T U D Y  1

Solution 1 (sol1)
1 In the Model Builder window, expand the Study 1>Solver Configurations node.

2 Right-click Solution 1 (sol1) and choose Solution>Copy.

R E S U L T S

Electric Field (emw)
Ctrl-click to select both Results>Electric Field (emw) and Results>Reflection and 

Transmission, then right-click and choose Duplicate.

1 In the Model Builder window, click Electric Field (emw).

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Data set list, choose Study 1/Solution 1 - Copy 1 (sol2).

Reflection and Transmission
1 In the Model Builder window, under Results click Reflection and Transmission.

2 In the Settings window for 1D Plot Group, locate the Data section.

3 From the Data set list, choose Study 1/Solution 1 - Copy 1 (sol2).

S T U D Y  1

On the Home toolbar, click Compute.

0 x

1 y

0 z
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R E S U L T S

Multislice 1
1 In the Model Builder window, expand the Results>Electric Field (emw) 1 node, then click 

Multislice 1.

2 In the Settings window for Multislice, click Replace Expression in the upper-right corner 
of the Expression section. From the menu, choose Component 1>Electromagnetic Waves,

Frequency Domain>Magnetic>Magnetic field>emw.Hy - Magnetic field, y component.

3 On the Electric Field (emw) 1 toolbar, click Plot.

This reproduces Figure 3.

Global 2
1 In the Model Builder window, expand the Results>Reflection and Transmission 1 node, 

then click Global 2.

2 In the Settings window for Global, locate the y-Axis Data section.

3 In the table, enter the following settings:

Expression Unit Description

abs(r_p)^2 Reflectance, analytic

n_slab*cos(beta)/(n_air*
cos(alpha))*abs(t_p)^2

Transmittance, analytic
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4 On the Reflection and Transmission 1 toolbar, click Plot.

The plot should look like Figure 5. The Brewster angle is observed around 56 degrees, 
which is close to the analytic value.
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Introduction

This example is a 2D version of H-Bend Waveguide 3D, which shows how to model a 
bending rectangular waveguide for microwaves. For a general introduction, see the model 
H-Bend Waveguide 3D.

The dimensions of the waveguide and the frequency range used in this example are such 
that TE10 is the single propagating mode. In this mode, if the bend is in the xy-plane, the 
electric field only has a z-component, which furthermore is independent of the z-
coordinate. This makes it possible to set up and solve the model in a 2D geometry.

Model Definition

The considered geometry is an xy-plane cross-section of the 3D geometry, as seen in 
Figure 1. This figure also sums up the material and boundary settings, which are the same 
as in the 3D model. The main advantage with setting up the model in 2D is that it solves 
much faster and uses less memory. As a consequence, this version of the example does not 
stress the need to adapt the mesh to the wavelength, but simply lets you apply a mesh that 
is more than fine enough.

Figure 1: The geometry of the example.

Ez=cos((π/2)(y/a))

n=1.44
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Results and Discussion

Figure 2 shows the norm of the electric field at one of the frequencies where the bend has 
a resonance. The absence of a wave pattern in the input section indicates that the 
transmission is nearly perfect.

Figure 2: The electric field norm at a frequency of 4.225 GHz.

Figure 3 shows the S-parameters in a dB scale. The result agrees very well with that of the 
3D model.
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Figure 3: The S-parameters, in a dB scale, as functions of the frequency.

Application Library path: RF_Module/Transmission_Lines_and_Waveguides/
h_bend_waveguide_2d

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 2D.

2 In the Select Physics tree, select Radio Frequency>Electromagnetic Waves,

Frequency Domain (emw).

3 Click Add.
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4 Click Study.

5 In the Select Study tree, select Preset Studies>Frequency Domain.

6 Click Done.

S T U D Y  1

Step 1: Frequency Domain
1 In the Model Builder window, under Study 1 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 In the Frequencies text field, type range(4[GHz],25[MHz],5.2[GHz]).

G E O M E T R Y  1

Circle 1 (c1)
1 On the Geometry toolbar, click Primitives and choose Circle.

2 In the Settings window for Circle, locate the Size and Shape section.

3 In the Radius text field, type 0.08.

Circle 2 (c2)
1 On the Geometry toolbar, click Primitives and choose Circle.

2 In the Settings window for Circle, locate the Size and Shape section.

3 In the Radius text field, type 0.04.

Square 1 (sq1)
1 On the Geometry toolbar, click Primitives and choose Square.

2 In the Settings window for Square, locate the Size section.

3 In the Side length text field, type 0.08.

4 Locate the Position section. In the y text field, type -0.08.

Compose 1 (co1)
1 On the Geometry toolbar, click Booleans and Partitions and choose Compose.

2 Click in the Graphics window and then press Ctrl+A to select all objects.

3 In the Settings window for Compose, locate the Compose section.

4 In the Set formula text field, type sq1*(c1-c2).

Rectangle 1 (r1)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.
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3 In the Width text field, type 0.04.

4 In the Height text field, type 0.1.

5 Locate the Position section. In the x text field, type 0.04.

Rectangle 2 (r2)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 0.1.

4 In the Height text field, type 0.04.

5 Locate the Position section. In the x text field, type -0.1.

6 In the y text field, type -0.08.

7 Click Build All Objects.

8 Click the Zoom Extents button on the Graphics toolbar.

M A T E R I A L S

Material 1 (mat1)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.
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2 In the Settings window for Material, type Air in the Label text field.

3 Select Domains 1 and 3 only.

4 Click to expand the Material properties section. Locate the Material Properties section. 
In the Material properties tree, select Electromagnetic Models>Refractive Index>

Refractive index, real part (n).

5 Click Add to Material.

6 Locate the Material Contents section. In the table, enter the following settings:

Material 2 (mat2)
1 Right-click Materials and choose Blank Material.

2 In the Settings window for Material, type Silica Glass in the Label text field.

3 Select Domain 2 only.

4 Click to expand the Material properties section. Locate the Material Properties section. 
In the Material properties tree, select Electromagnetic Models>Refractive Index>

Refractive index, real part (n).

5 Click Add to Material.

6 Locate the Material Contents section. In the table, enter the following settings:

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

With TE waves, only the z component of the electric field needs to be solved for

1 In the Model Builder window, under Component 1 (comp1) click Electromagnetic Waves,

Frequency Domain (emw).

2 In the Settings window for Electromagnetic Waves, Frequency Domain, locate the 
Components section.

3 From the Electric field components solved for list, choose Out-of-plane vector.

Wave Equation, Electric 1
1 In the Model Builder window, under Component 1 (comp1)>Electromagnetic Waves,

Frequency Domain (emw) click Wave Equation, Electric 1.

Property Name Value Unit Property group

Refractive index n 1 1 Refractive index

Property Name Value Unit Property group

Refractive index n 1.44 1 Refractive index
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2 In the Settings window for Wave Equation, Electric, locate the Electric Displacement Field 
section.

3 From the Electric displacement field model list, choose Refractive index.

The default boundary condition is perfect electric conductor, which is fine for all 
exterior boundaries except the ports. The software automatically imposes continuity on 
interior boundaries.

Port 1
1 In the Model Builder window, right-click Electromagnetic Waves,

Frequency Domain (emw) and choose Port.

2 Select Boundary 1 only.

3 In the Settings window for Port, locate the Port Properties section.

4 From the Type of port list, choose Rectangular.

For the first port, wave excitation is on by default.

Port 2
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Port.

2 Select Boundary 7 only.

3 In the Settings window for Port, locate the Port Properties section.

4 From the Type of port list, choose Rectangular.

M E S H  1

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.
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2 In the Settings window for Mesh, click Build All.

S T U D Y  1

On the Home toolbar, click Compute.
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R E S U L T S

Electric Field (emw)

The default plot shows the norm of the electric field for the highest frequency, 5.2 GHz. 
To verify that the solution resembles the 3D version, try plotting a frequency where you 
expect a transmission peak.

1 In the Model Builder window, under Results click Electric Field (emw).

2 In the Settings window for 2D Plot Group, locate the Data section.

3 From the Parameter value (freq (GHz)) list, choose 4.225.
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4 On the Electric Field (emw) toolbar, click Plot.

Finally, plot the S-parameters.

Global 1
1 In the Model Builder window, expand the Results>S-Parameter (emw) node, then click 

Global 1.

2 In the Settings window for Global, click to expand the Coloring and style section.

3 Locate the Coloring and Style section. Find the Line markers subsection. From the Marker 
list, choose Cycle.
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4 On the S-Parameter (emw) toolbar, click Plot.
12 |  H - B E N D  W A V E G U I D E  2 D



Smith Plot (emw)
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Introduction

This example shows how to model a rectangular waveguide for microwaves. A single 
hollow waveguide can conduct two kinds of electromagnetic waves: transversal magnetic 
(TM) or transversal electric (TE) waves. This example examines a TE wave, one that has 
no electric field component in the direction of propagation. More specifically, for this 
example you select the frequency and waveguide dimension so that TE10 is the single 
propagating mode. In that mode the electric field has only one nonzero component—a 
sinusoidal with two nodes, one at each of the walls of the waveguide. This makes it possible 
to set up and solve the model in 2D, which is done in a separate version; see H-Bend 
Waveguide 2D.

One important design aspect is how to shape a waveguide to go around a corner without 
incurring unnecessary losses in signal power. Unlike in wires, these losses usually do not 
result from ohmic resistance but instead arise from unwanted reflections. You can 
minimize these reflections by keeping the bend smooth with a large enough radius. In the 
range of operation the transmission characteristics (the ability of the waveguide to transmit 
the signal) must be reasonably uniform for avoiding signal distortions.

With air as the inside medium of the waveguide, the transmission is nearly perfect 
throughout the range of operation. In this example, to make the simulation and the results 
more interesting, the bend is filled with silica glass, a dielectric medium.

The model also shows how to systematically compute and export all S-parameters to a 
Touchstone file.

Model Definition

This example illustrates how to create a model that computes the electromagnetic fields 
and transmission characteristics of a 90° bend for a given radius. This type of waveguide 
bends changes the direction of the H field components and leaves the direction of the E 
field unchanged. The waveguide is therefore called an H-bend. The H-bend design used 
in this example is well-proven in real-world applications and you can buy similar waveguide 
bends online from a number of manufacturers. This particular bend performs optimally in 
the ideal case of perfectly conducting walls. 

The waveguide walls are typically plated with a very good conductor, such as silver. In this 
example the walls are considered to be made of a perfect conductor, which means that the 
tangential component of the electric field is zero, or that n × E = 0 on the boundaries. 
This boundary condition is referred to as a perfect electric conductor (PEC) boundary 
condition.
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The geometry is as follows:

The waveguide is considered to continue indefinitely before and after the bend. This 
means that the input wave needs to have the form of a wave that has been traveling 
through a straight waveguide. The shape of such a wave is determined by the boundary 
conditions of Maxwell’s equations on the sides of the metallic boundaries, that is, the PEC 
boundary condition. If polarized according to a TE10 mode, the shape is known 
analytically to be E = (0, 0, sin(π(a − y)/(2a)))cos(ωt) given that the entrance boundary is 
centered around the y = 0 axis, and that the width of the waveguide, in the y direction, is 
2a.

The model is set up using the time-harmonic Electromagnetic Waves interface. This means 
that only the phasor component of the field is modeled. The incident field then has the 
form E = (0, 0, E0z) = (0, 0, sin(π(a − y)/(2a))), and is considered as part of the 
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expression E = Re{(0, 0, sin(π(a − y)/(2a))ejωt)} = Re{Eejωt}, where complex-valued 
arithmetic has been used (also referred to as the jω method).

The width of the waveguide is chosen so that it has a cutoff frequency of 3.7 GHz. This 
makes the waveguide operational up to 7.5 GHz. At higher frequencies other modes than 
the TE10 appear, causing a “dirty” signal. The input wave then splits into several modes 
that are hard to control without having large power losses. Below the cutoff frequency, no 
waves can propagate through the waveguide. This is an intrinsic property of microwave 
waveguides.

The cutoff frequency of different modes in a straight waveguide is given by the relation

where m and n are the mode numbers (m = 1, n = 0 for the TE10 mode), a and b are the 
lengths of the sides of the waveguide cross-section, and c is the speed of light.

For this waveguide, a = 2b and b = 2 cm.

The first few cutoff frequencies are (νc)10 = 3.7 GHz, (νc)01 = 7.5 GHz, 
(νc)11 = 8.4 GHz. The frequencies used in this example are from 4.0 GHz to 5.2 GHz, 
and hence entirely within the single-mode range.

PEC

Ez=cos((π/2)(y/a))

νc( )mn
c
2
--- m

a
----- 
  2 n

b
--- 
  2

+=
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On the input boundary, the Port boundary condition lets you choose which mode to send 
in. Any reflected waves having the same shape are transmitted back through this same 
boundary. The output boundary also uses a Port condition, but without field excitation, 
to specify the shape of the wave that it lets pass through. Using port boundary conditions 
means that you automatically gain access to postprocessing variables for the S-parameters.

Results and Discussion

The wave is found to propagate through the bend with a varying amount of reflection 
depending on the frequency.

Figure 1: The z-component of the electric field for a frequency of 5.1 GHz.

The S-parameters are shown as functions of the frequency in Figure 2.
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Figure 2: The S-parameters, on a dB scale, as a function of the frequency. 

The two dips in S21 closely correspond to cavity resonances of the dielectric region in the 
bend. At these frequencies, the transmission is almost perfect. (Without the dielectric, the 
transmission would be nearly as good throughout the frequency range.)

Application Library path: RF_Module/Transmission_Lines_and_Waveguides/
h_bend_waveguide_3d

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.
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2 In the Select Physics tree, select Radio Frequency>Electromagnetic Waves,

Frequency Domain (emw).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Frequency Domain.

6 Click Done.

S T U D Y  1

Step 1: Frequency Domain
1 In the Model Builder window, under Study 1 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 In the Frequencies text field, type range(4[GHz],25[MHz],5.2[GHz]).

G E O M E T R Y  1

Work Plane 1 (wp1)
1 On the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, click Show Work Plane.

Circle 1 (c1)
1 On the Work Plane toolbar, click Primitives and choose Circle.

2 In the Settings window for Circle, locate the Size and Shape section.

3 In the Radius text field, type 0.08.

Circle 2 (c2)
1 On the Work Plane toolbar, click Primitives and choose Circle.

2 In the Settings window for Circle, locate the Size and Shape section.

3 In the Radius text field, type 0.04.

Square 1 (sq1)
1 On the Work Plane toolbar, click Primitives and choose Square.

2 In the Settings window for Square, locate the Size section.

3 In the Side length text field, type 0.08.

4 Locate the Position section. In the yw text field, type -0.08.

Compose 1 (co1)
1 On the Work Plane toolbar, click Booleans and Partitions and choose Compose.
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2 Click in the Graphics window and then press Ctrl+A to select all objects.

3 In the Settings window for Compose, locate the Compose section.

4 In the Set formula text field, type sq1*(c1-c2).

Rectangle 1 (r1)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 0.04.

4 In the Height text field, type 0.1.

5 Locate the Position section. In the xw text field, type 0.04.

Rectangle 2 (r2)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 0.1.

4 In the Height text field, type 0.04.

5 Locate the Position section. In the xw text field, type -0.1.

6 In the yw text field, type -0.08.

7 On the Work Plane toolbar, click Build All.

Work Plane 1 (wp1)
In the Model Builder window, under Component 1 (comp1)>Geometry 1 click 
Work Plane 1 (wp1).

Extrude 1 (ext1)
1 On the Geometry toolbar, click Extrude.

2 In the Settings window for Extrude, locate the Distances section.

3 In the table, enter the following settings:

4 Click Build All Objects.

Distances (m)

0.02
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5 Click the Zoom Extents button on the Graphics toolbar.

M A T E R I A L S

Material 1 (mat1)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, type Air in the Label text field.

3 Select Domains 1 and 3 only.

4 Click to expand the Material properties section. Locate the Material Properties section. 
In the Material properties tree, select Electromagnetic Models>Refractive Index>

Refractive index, real part (n).

5 Click Add to Material.

6 Locate the Material Contents section. In the table, enter the following settings:

Material 2 (mat2)
1 Right-click Materials and choose Blank Material.

Property Name Value Unit Property group

Refractive index n 1 1 Refractive index
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2 In the Settings window for Material, type Silica Glass in the Label text field.

3 Select Domain 2 only.

4 Click to expand the Material properties section. Locate the Material Properties section. 
In the Material properties tree, select Electromagnetic Models>Refractive Index>

Refractive index, real part (n).

5 Click Add to Material.

6 Locate the Material Contents section. In the table, enter the following settings:

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

Wave Equation, Electric 1
1 In the Model Builder window, under Component 1 (comp1)>Electromagnetic Waves,

Frequency Domain (emw) click Wave Equation, Electric 1.

2 In the Settings window for Wave Equation, Electric, locate the Electric Displacement Field 
section.

3 From the Electric displacement field model list, choose Refractive index.

Port 1
1 In the Model Builder window, right-click Electromagnetic Waves,

Frequency Domain (emw) and choose Port.

2 Select Boundary 1 only.

3 In the Settings window for Port, locate the Port Properties section.

4 From the Type of port list, choose Rectangular.

For the first port, wave excitation is on by default.

Port 2
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Port.

2 Select Boundary 15 only.

3 In the Settings window for Port, locate the Port Properties section.

4 In the Port name text field, type 2.

Property Name Value Unit Property group

Refractive index n 1.44 1 Refractive index
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5 From the Type of port list, choose Rectangular.

The default boundary condition is perfect electric conductor, which is fine for all 
exterior boundaries except the ports. The software automatically imposes continuity on 
interior boundaries.

M E S H  1

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.

2 In the Settings window for Mesh, click Build All.

If you look closely at the mesh, you can see that it is indeed a bit finer in the bend than 
elsewhere.

S T U D Y  1

On the Home toolbar, click Compute.
11 |  H - B E N D  W A V E G U I D E  3 D



R E S U L T S

Electric Field (emw)

The default plot shows the distribution of the electric field norm on slices of the 
waveguide, for the highest frequency in the sweep. Note the wave pattern in the bend and 
the rectangular input section. This indicates standing waves caused by reflections in the 
bend. In contrast, the pattern beyond the bend is independent of the y-coordinate, 
showing that the output port does a good job of transmitting the wave.

An S-parameter plot gives you a quantitative measure of how much of the wave is 
transmitted and reflected at different frequencies.

Global 1
1 In the Model Builder window, expand the Results>S-Parameter (emw) node, then click 

Global 1.

2 In the Settings window for Global, click to expand the Coloring and style section.

3 Locate the Coloring and Style section. Find the Line markers subsection. From the Marker 
list, choose Cycle.
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4 On the S-Parameter (emw) toolbar, click Plot.

The result, which should look like Figure 2, shows that the transmission varies 
throughout the frequency range. Note in particular that S21 has two deep dips, 
corresponding to almost perfect transmission. This is the result of resonances in the 
bend. To confirm this, try looking at the field distribution for the frequency where the 
upper peak is located, 5.1 GHz.
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Smith Plot (emw)

Electric Field (emw)
1 In the Model Builder window, under Results click Electric Field (emw).

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Parameter value (freq (GHz)) list, choose 5.1.
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4 On the Electric Field (emw) toolbar, click Plot.

The standing wave pattern still remains in the bend, but at this frequency it is almost 
completely gone in the input section.

For an alternative view, you can plot the instantaneous value of the electric field inside the 
waveguide. Only the z component will be substantially non-zero. For a better view, add 
also deformation. Replace the Multislice with a single horizontal slice plot.

Multislice
In the Model Builder window, expand the Electric Field (emw) node.

Slice 1
1 Right-click Multislice and choose Delete.

2 In the Model Builder window, under Results right-click Electric Field (emw) and choose 
Slice.

3 In the Settings window for Slice, click Replace Expression in the upper-right corner of the 
Expression section. From the menu, choose Component 1>Electromagnetic Waves,

Frequency Domain>Electric>Electric field>emw.Ez - Electric field, z component.

4 Locate the Plane Data section. From the Plane list, choose XY-planes.

5 In the Planes text field, type 1.

6 Locate the Coloring and Style section. From the Color table list, choose Wave.
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7 On the Electric Field (emw) toolbar, click Plot.

The Wave color table looks its best using a symmetric range. You can also play with a 
deformed shape plot to make the waves appear more clearly.

8 Click to expand the Range section. Locate the Coloring and Style section. Select the 
Symmetrize color range check box.

Deformation 1
1 Right-click Results>Electric Field (emw)>Slice 1 and choose Deformation.

2 In the Settings window for Deformation, click Replace Expression in the upper-right 
corner of the Expression section. From the menu, choose Component 1>

Electromagnetic Waves, Frequency Domain>Electric>emw.Ex,emw.Ey,emw.Ez -

Electric field.

3 On the Electric Field (emw) toolbar, click Plot.

The remaining instructions show you how to systematically solve with one port active at a 
time, and save the results in the Touchstone format.

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

1 In the Model Builder window, under Component 1 (comp1) click Electromagnetic Waves,

Frequency Domain (emw).
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2 In the Settings window for Electromagnetic Waves, Frequency Domain, locate the 
Port Sweep Settings section.

3 Select the Activate port sweep check box.

Click the Browse button and select a file to which you want to export the results. If the 
file does not exist, it will be created.

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

S T U D Y  1

Parametric Sweep
1 On the Study toolbar, click Parametric Sweep.

2 In the Settings window for Parametric Sweep, locate the Study Settings section.

3 Click Add.

4 In the table, enter the following settings:

The parameter is the same as the name suggested by the port sweep. The parameter 
values should be the same as your port numbers.

5 On the Study toolbar, click Compute.

R E S U L T S

The Touchstone file should now contain the complete output from the model. The new 
solution data set contains two frequency sweeps, one for each port.

Name Expression Value Description

PortName 1 1 Port name

Parameter name Parameter value list Parameter unit

PortName 1 2
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Global 1
As you can see, after performing the parametric sweep over the ports, the S-parameter plot 
you created previously is empty. To restore the plot, you need to change the data set and 
specify the inner parameter - that is, the frequency - as the quantity to display along the 
horizontal axis.

1 In the Model Builder window, under Results>S-Parameter (emw) click Global 1.

2 In the Settings window for Global, locate the Data section.

3 From the Data set list, choose Study 1/Parametric Solutions 1 (sol2).

To verify the reciprocity of the waveguide, you can add the S-parameters S12dB and 
S22dB to the Expressions table and change the parameter selection for PortName:

4 Click Add Expression in the upper-right corner of the y-axis data section. From the 
menu, choose Component 1>Electromagnetic Waves, Frequency Domain>Ports>S-

parameter, dB>emw.S12dB - S12.

5 Click Add Expression in the upper-right corner of the y-axis data section. From the 
menu, choose Component 1>Electromagnetic Waves, Frequency Domain>Ports>S-

parameter, dB>emw.S22dB - S22.

6 Locate the Data section. From the Parameter selection (PortName) list, choose Last.

7 On the S-Parameter (emw) toolbar, click Plot.
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Smith Plot (emw)
1 In the Model Builder window, under Results click Smith Plot (emw).

2 In the Settings window for Smith Plot Group, locate the Data section.

3 From the Data set list, choose Study 1/Parametric Solutions 1 (sol2).

4 From the Parameter selection (PortName) list, choose Last.

Reflection Graph 1
1 In the Model Builder window, expand the Smith Plot (emw) node, then click 

Reflection Graph 1.

2 In the Settings window for Reflection Graph, locate the Expressions section.

3 Click emw.S22 - S22 in the upper-right corner of the section. On the Smith Plot (emw) 
toolbar, click Plot.

Reflection Graph 1
1 In the Model Builder window, expand the Smith Plot (emw) 1 node, then click 

Reflection Graph 1.

2 In the Settings window for Reflection Graph, click to expand the Coloring and style 
section.
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3 Locate the Coloring and Style section. Find the Line markers subsection. From the Marker 
list, choose Cycle.

Finish by verifying the reciprocity of the waveguide on the Smith plot.
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Introduction

A microwave circulator is a nonreciprocal multiport device. It has the property that a wave 
incident on port 1 is routed into port 3 yet a wave incident on port 3 is not routed back 
into port 1 but is instead routed into port 2, and so on. This property of a circulator is 
used to isolate microwave components from each other, for example, when connecting a 
transmitter and a receiver to a common antenna. By connecting the transmitter, receiver, 
and antenna to different ports of a circulator, the transmitted power is routed to the 
antenna whereas any power received by the antenna goes into the receiver. Circulators 
typically rely on the use of ferrites, a special type of highly permeable and low-loss 
magnetic material that is anisotropic for a small RF signal when biased by a much larger 
static magnetic field. In the example, a three-port circulator is constructed from three 
rectangular waveguide sections joining at 120° and with a ferrite post inserted at the center 
of the joint.

Figure 1: The post is magnetized by a static H0 bias field along its axis. The bias field is 
supplied by external permanent magnets which are not explicitly modeled in this example. 

I M P E D A N C E  M A T C H I N G

An important step in the design of any microwave device is to match its input impedance 
for a given operating frequency. Impedance matching is equivalent to minimizing the 
reflections back to the inport. The parameters that need to be determined are the size of 

Port 3

Ferrite post 

Port 1

Port 2
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the ferrite post and the width of the wider waveguide section surrounding the ferrite. In 
this tutorial, these are varied in order to minimize the reflectance. The scattering 
parameters (S-parameters) used as measures of the reflectance and transmittance of the 
circulator are automatically computed.

The nominal frequency for the design of the device is chosen as 3 GHz. The circulator can 
be expected to perform reasonably well in a narrow frequency band around 3 GHz, and 
so a frequency range of 2.8 − 3.2 GHz is studied. It is desired that the device operates in 
single mode. Thus a rectangular waveguide cross section of 6.67 cm by 3.33 cm is selected 
to set the cut-off frequency for the fundamental TE10 mode to 2.25 GHz. The cut-off 
frequencies for the two nearest higher modes, the TE20 and TE01 modes, are both at 
4.5 GHz, leaving a reasonable safety margin.

Model Definition

One of the rectangular ports is excited by the fundamental TE10 mode. At the ports, the 
boundaries are transparent to the TE10 mode. The following equation applies to the 
electric field vector E inside the circulator:

where μr denotes the relative permeability tensor, ω is the angular frequency, σ is the 
conductivity tensor, ε0 is the permittivity of vacuum, εr is the relative permittivity tensor, 
and k0 is the free space wave number. In this particular model, the conductivity is zero 
everywhere. Losses in the ferrite are introduced as complex-valued permittivity and 
permeability tensors. The magnetic permeability is of key importance as it is the anisotropy 
of this parameter that is responsible for the nonreciprocal behavior of the circulator. For 
simplicity, the rather complicated material expressions are predefined in a text file that is 
imported into the model. The expressions are also included in the next section for 
reference.

T H E  L O S S Y  F E R R I T E  M A T E R I A L  M O D E L

Complete treatises on the theory of magnetic properties of ferrites can be found in Ref. 1 
and Ref. 2. The model assumes that the static magnetic bias field, H0, is much stronger 
than the alternating magnetic field of the microwaves, so the quoted expressions are a 
linearization for a small-signal analysis around this operating point. Under these 
assumptions, and including losses, the anisotropic permeability of a ferrite magnetized in 
the positive z direction is given by:

∇ μr
1– ∇ E×( )× k0

2 εr
jσ

ωε0
---------– 

 E– 0=
3 |  I M P E D A N C E  M A T C H I N G  O F  A  L O S S Y  F E R R I T E  3 - P O R T  C I R C U L A T O R



where

and the unique elements of the magnetic susceptibility tensor χ are given by:

where

Here μ0 denotes the permeability of free space; ω is the angular frequency of the 
microwave field; ω0 is the precession resonance frequency (Larmor frequency) of a 
spinning electron in the applied magnetic bias field, H0; ωm is the electron Larmor 
frequency at the saturation magnetization of the ferrite, Ms; and γ is the gyromagnetic ratio 
of the electron. For a lossless ferrite (α = 0), the permeability becomes infinite at ω = ω0. 
In a lossy ferrite (α ≠ 0), this resonance becomes finite and is broadened. The loss factor, 
α, is related to the line width, ΔH, of the susceptibility curve near the resonance as given 
by the last expression above. The material data, 

Ms = 5.41·104 A/m, εr = 14.5

with an effective loss tangent of 2·10-4 and ΔH = 3.18·103 A/m, are taken for aluminum 
garnet from Ref. 2. The applied bias field is set to H0 = 7.96·103 A/m. The electron 
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gyromagnetic ratio taken from Ref. 2 is 1.759·1011 C/kg.

Results and Discussion

The default multislice plot shows the electric field norm. The electric field norm gives a 
good indication of where the main power is flowing and where there are standing waves 
due to reflections from the impedance mismatch at the center.

Figure 2: The default electric field norm plot shown on xy-plane.
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The plot of the S-parameter from the parametric sweep of sc_ferrite indicates a 
minimum for a scale factor of 0.518.

Figure 3: S-parameter as a function of sc_ferrite parameter
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The plot of the S-parameter from the parametric sweep of sc_chamfer indicates a 
minimum for a scale factor of about 3.0.

Figure 4: S-parameter as a function of sc_chamfer parameter
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At the center frequency most of the standing waves are gone with the optimized values of 
sc_ferrite and sc_chamfer.

Figure 5: Electric field norm plot with the optimized sc_ferrite and sc_chamfer values.
8 |  I M P E D A N C E  M A T C H I N G  O F  A  L O S S Y  F E R R I T E  3 - P O R T  C I R C U L A T O R



This is the frequency response of the final design.

Figure 6: S-parameter as a function of frequency with the optimized sc_ferrite and sc_chamfer 
values.
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From the below plot, it should be possible to identify the model at first glance so it has to 
display the geometry and some characteristic simulation results.

Figure 7: 3D plot used for model thumbnail generation

Reference

1. R.E. Collin, Foundations for Microwave Engineering, 2nd ed., IEEE Press/Wiley-
Interscience, 2000.

2. D.M. Pozar, Microwave Engineering, 3rd ed., John Wiley & Sons Inc, 2004.

Application Library path: RF_Module/Ferrimagnetic_Devices/
lossy_circulator_3d

Modeling Instructions

From the File menu, choose Open.

Browse to the model’s Application Libraries folder and double-click the file 
lossy_circulator_3d_geom.mph.
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G E O M E T R Y  1

Form Union (fin)
Next add material settings to the model. The lossy ferrite does not fit easily into the 
material settings so it will be taken care of later. Air is the only material to enter here.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Built-In>Air.

4 Click Add to Component in the window toolbar.

M A T E R I A L S

On the Home toolbar, click Add Material to close the Add Material window.

Air (mat1)
In the Electromagnetic Waves interface, the ferrite is entered as a separate, user-defined 
equation model referring to the global variables defined above.

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

In the Model Builder window, expand the Component 1 (comp1)>Electromagnetic Waves,

Frequency Domain (emw) node.

Wave Equation, Electric 2
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Wave Equation,

Electric.

2 Select Domain 2 only.

3 In the Settings window for Wave Equation, Electric, locate the Electric Displacement Field 
section.

4 From the Electric displacement field model list, choose Dielectric loss.

5 From the ε′ list, choose User defined. In the associated text field, type eps_r_p.

6 From the ε′′ list, choose User defined. In the associated text field, type eps_r_b.

7 Locate the Magnetic Field section. From the μr list, choose User defined. From the list, 
choose Anisotropic.

8 In the μr table, enter the following settings:

murxx murxy murxz
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9 Locate the Conduction Current section. From the σ list, choose User defined. In the 
Model Builder window, click Electromagnetic Waves, Frequency Domain (emw).

10 In the Settings window for Electromagnetic Waves, Frequency Domain, locate the Physics-

Controlled Mesh section.

11 Clear the Enable check box.

One inport for excitation and two outports need to be added next.

Port 1
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Port.

2 Select Boundary 1 only.

3 In the Settings window for Port, locate the Port Properties section.

4 From the Type of port list, choose Rectangular.

For the first port, wave excitation is on by default.

Port 2
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Port.

2 Select Boundary 18 only.

3 In the Settings window for Port, locate the Port Properties section.

4 From the Type of port list, choose Rectangular.

Port 3
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Port.

2 Select Boundary 19 only.

3 In the Settings window for Port, locate the Port Properties section.

4 From the Type of port list, choose Rectangular.

The mesh needs to resolve the local wavelength and, for lossy domains, the skin depth. 
The skin depth in the ferrite is large so the main concern is to resolve the local wavelength. 
This is done by providing maximum mesh sizes per domain. The rule of thumb is to use a 
maximum element size that is one fifth of the local wavelength (at the maximum 
frequency) or smaller.

muryx muryy muryz

murzx murzy murzz
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M E S H  1

Size 1
1 In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 

Free Tetrahedral.

2 Right-click Free Tetrahedral 1 and choose Size.

3 In the Settings window for Size, locate the Geometric Entity Selection section.

4 From the Geometric entity level list, choose Domain.

5 Select Domain 1 only.

6 Locate the Element Size section. Click the Custom button.

7 Locate the Element Size Parameters section. Select the Maximum element size check box.

8 In the associated text field, type 1.5e-2.

Size 2
1 Right-click Free Tetrahedral 1 and choose Size.

2 In the Settings window for Size, locate the Element Size section.

3 Click the Custom button.

4 Locate the Geometric Entity Selection section. From the Geometric entity level list, 
choose Domain.

5 Select Domain 2 only.

6 Locate the Element Size Parameters section. Select the Maximum element size check box.

7 In the associated text field, type 4.5e-3.

8 In the Model Builder window, click Mesh 1.
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9 In the Settings window for Mesh, click Build All.

The mesh should now look as in the above figure.

The final step in the model set up is to solve it for the nominal frequency and inspect the 
results for possible modeling errors.

S T U D Y  1

Step 1: Frequency Domain
1 In the Model Builder window, expand the Study 1 node, then click 

Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 In the Frequencies text field, type 3[GHz].

4 On the Home toolbar, click Compute.

R E S U L T S

Electric Field (emw)
The default plot shows a slice plot of the electric field norm. It is best viewed from above.
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1 Click the Go to XY View button on the Graphics toolbar.

The electric field norm gives a good indication on where the main power is flowing and 
where there are standing waves due to reflections from the impedance mismatch at the 
center. See Figure 2.

The remaining work is to vary the two design parameters in order to minimize reflections 
at the nominal frequency. To do this, perform parametric sweeps over the design 
parameters (scale factors). To avoid accumulating a lot of data while solving, throw away 
the solution and log only the S-parameter representing reflection in a table. For this 
purpose, add a global probe to the model.

D E F I N I T I O N S

Global Variable Probe 1 (var1)
1 On the Definitions toolbar, click Probes and choose Global Variable Probe.

2 In the Settings window for Global Variable Probe, click Replace Expression in the upper-
right corner of the Expression section. From the menu, choose Component 1 (comp1)>

Electromagnetic Waves, Frequency Domain>Ports>S-parameter, dB>emw.S11dB - S11.

S T U D Y  1

Modify the study in order to vary the scale factor determining the size of the ferrite post. 
The study type is still Frequency Domain.

The parametric sweep over the scale factor is added as an extension to the frequency 
domain study.

Parametric Sweep
1 On the Study toolbar, click Parametric Sweep.

2 In the Settings window for Parametric Sweep, locate the Study Settings section.

3 Click Add.

4 In the table, enter the following settings:

5 Locate the Output While Solving section. Select the Accumulated probe table check box.

6 Find the Memory settings for jobs subsection. From the Keep solutions in memory list, 
choose Only last.

7 On the Study toolbar, click Compute.

Parameter name Parameter value list Parameter unit

sc_ferrite range(0.5,3e-3,0.53)
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R E S U L T S

Probe Plot Group 2
The probe with the reflection coefficient versus the scale parameter is automatically logged 
to a table and plotted while solving. A dedicated 1D plot group is also created, but it plots 
the S-parameter versus frequency. To plot versus the geometry parameter, proceed as 
follows.

TA B L E

1 Go to the Table window.

In Accumulated Probe Table 1, delete column number 2 from the left with heading 
freq.

2 Click Table Graph in the window toolbar.

R E S U L T S

Table Graph 1
Compare with the plot shown Figure 3. The plot of the S-parameter indicates a minimum 
for a scale factor of 0.518, so freeze the parameter at this value and add a new study for 
varying the next scale factor.

1 In the Model Builder window, expand the Results>Tables node.

G L O B A L  D E F I N I T I O N S

Parameters
1 In the Model Builder window, expand the Global Definitions node, then click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

S T U D Y  1

Parametric Sweep
1 In the Model Builder window, under Study 1 click Parametric Sweep.

2 In the Settings window for Parametric Sweep, locate the Study Settings section.

Name Expression Value Description

sc_ferrite 0.518 0.518 Geometry scale factor
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3 In the table, enter the following settings:

4 On the Study toolbar, click Compute.

R E S U L T S

Probe Plot Group 2
Again, the probe with the reflection coefficient versus the frequency is automatically 
logged to a table and plotted while solving. To get the desired plot versus the geometry 
parameter, proceed as follows.

TA B L E

1 Go to the Table window.

In Accumulated Probe Table 1, delete column number 2 from the left with heading 
freq.

2 Click Table Graph in the window toolbar.

R E S U L T S

Table Graph 1
See Figure 4. The plot of the S-parameter indicates a minimum for a scale factor of about 
3.0, so leave the parameter at this value and add a study for the frequency response.

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

1 In the Model Builder window, expand the Results>Tables node, then click 
Component 1 (comp1)>Electromagnetic Waves, Frequency Domain (emw).

2 In the Settings window for Electromagnetic Waves, Frequency Domain, locate the 
Port Sweep Settings section.

3 Select the Activate port sweep check box.

G L O B A L  D E F I N I T I O N S

Parameters
1 In the Model Builder window, under Global Definitions click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

Parameter name Parameter value list Parameter unit

sc_chamfer range(2.8,0.04,3.2)
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3 In the table, enter the following settings:

A D D  S T U D Y

1 On the Study toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Preset Studies>

Frequency Domain.

4 Click Add Study in the window toolbar.

5 On the Study toolbar, click Add Study to close the Add Study window.

S T U D Y  2

Step 1: Frequency Domain
1 In the Model Builder window, under Study 2 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 In the Frequencies text field, type range(2.8[GHz],20[MHz],3.2[GHz]).

4 On the Study toolbar, click Compute.

R E S U L T S

Electric Field (emw) 1
At the final frequency, there are pronounced standing waves. Change to the center 
frequency.

1 In the Model Builder window, under Results click Electric Field (emw) 1.

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Parameter value (freq (GHz)) list, choose 3.

4 On the Electric Field (emw) 1 toolbar, click Plot.

In the reproduced Figure 5 most of the standing waves are gone at the center frequency.

Finally plot all the S-parameters as a function of frequency.

Global 1
1 In the Model Builder window, expand the S-Parameter (emw) node, then click Global 1.

2 In the Settings window for Global, locate the y-Axis Data section.

Name Expression Value Description

PortName 1 1 Port name
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3 Click to select row number 2 in the table.

4 Click Delete.

5 Click Delete.

6 Click to select row number 3 in the table.

7 Click Delete.

8 Click Delete.

9 Click to select row number 4 in the table.

10 Click Delete.

11 Click Delete.

The table should now only contain emw.S11dB, emw.S21dB and emw.S31dB.

12 On the S-Parameter (emw) toolbar, click Plot.

Reproduce Figure 6. This is the frequency response of the final design.

Now, let the solver excite one port at a time in order to get the full S-parameter matrix 
exported to a Touchstone file for potential use in a system simulation tool. The necessary 
steps are as follows:

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

1 In the Model Builder window, under Component 1 (comp1) click Electromagnetic Waves,

Frequency Domain (emw).

2 In the Settings window for Electromagnetic Waves, Frequency Domain, locate the 
Port Sweep Settings section.

3 In the Touchstone file export text field, type lossy_circulator_3d.s3p.
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R E S U L T S

Smith Plot (emw)

Reuse the first study for the port sweep. The study is solved for a single frequency to keep 
down simulation time though it is possible to solve for a range of frequencies.

S T U D Y  1

Parametric Sweep
The parametric sweep is used to control which port is excited. It overrides the settings on 
individual port features and drives one port at a time using 1 W of input power.

1 In the Model Builder window, under Study 1 click Parametric Sweep.

2 In the Settings window for Parametric Sweep, locate the Study Settings section.

3 In the table, enter the following settings:

4 Locate the Output While Solving section. Find the Memory settings for jobs subsection. 
From the Keep solutions in memory list, choose All.

5 On the Home toolbar, click Compute.

Parameter name Parameter value list Parameter unit

PortName 1 2 3
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R E S U L T S

Electric Field (emw) 2
Display the S-parameter matrix in a table.

Global Matrix Evaluation 1
1 On the Results toolbar, click More Derived Values and choose Other>

Global Matrix Evaluation.

2 In the Settings window for Global Matrix Evaluation, locate the Data section.

3 From the Data set list, choose Study 1/Parametric Solutions 1 (sol3).

4 Click Replace Expression in the upper-right corner of the Expression section. From the 
menu, choose Component 1>Electromagnetic Waves, Frequency Domain>Ports>S-

parameter, dB>emw.SdB - S-parameter, dB.

5 Click Evaluate.

Electric Field (emw) 2
As a final step, create a nice plot to use as a thumbnail. First change to the default 3D view 
and switch off grid.

1 In the Model Builder window, under Results click Electric Field (emw) 2.

2 In the Settings window for 3D Plot Group, click Go to Default View.

D E F I N I T I O N S

View 3
1 In the Model Builder window, under Component 1 (comp1) right-click Definitions and 

choose View.

2 In the Settings window for View, locate the View section.

3 Clear the Show grid check box.

R E S U L T S

Electric Field (emw) 2
1 In the Model Builder window, under Results click Electric Field (emw) 2.

2 In the Settings window for 3D Plot Group, locate the Plot Settings section.

3 From the View list, choose View 3.

4 On the Electric Field (emw) 2 toolbar, click Plot.

Next, delete the Multislice plot and add a single slice.
21 |  I M P E D A N C E  M A T C H I N G  O F  A  L O S S Y  F E R R I T E  3 - P O R T  C I R C U L A T O R



Multislice
In the Model Builder window, expand the Electric Field (emw) 2 node.

Electric Field (emw) 2
Right-click Multislice and choose Delete.

Slice 1
In the Model Builder window, under Results right-click Electric Field (emw) 2 and choose 
Slice.

Add deformation proportional to the electric field to the remaining slice.

Slice 1
1 In the Model Builder window, expand the Electric Field (emw) 2 node, then click Slice 1.

2 In the Settings window for Slice, locate the Plane Data section.

3 From the Plane list, choose XY-planes.

4 In the Planes text field, type 1.

Deformation 1
1 Right-click Results>Electric Field (emw) 2>Slice 1 and choose Deformation.

2 In the Settings window for Deformation, locate the Expression section.

3 Click emw.Ex,emw.Ey,emw.Ez - Electric field in the upper-right corner of the section. 
Select the Description check box.

Electric Field (emw) 2
Display the magnetic field as arrows. Use logarithmic length scaling to make sure that the 
arrows are clearly visible everywhere. Place the arrows well above the slice.

Arrow Volume 1
1 In the Model Builder window, under Results right-click Electric Field (emw) 2 and choose 

Arrow Volume.

2 In the Settings window for Arrow Volume, click Replace Expression in the upper-right 
corner of the Expression section. From the menu, choose Component 1>

Electromagnetic Waves, Frequency Domain>Magnetic>emw.Hx,emw.Hy,emw.Hz -

Magnetic field.

3 Locate the Expression section. Select the Description check box.

4 Locate the Arrow Positioning section. Find the X grid points subsection. In the Points text 
field, type 30.

5 Find the Y grid points subsection. In the Points text field, type 30.
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6 Find the Z grid points subsection. From the Entry method list, choose Coordinates.

7 In the Coordinates text field, type 0.1/3.

8 Locate the Coloring and Style section. From the Arrow length list, choose Logarithmic.

9 From the Color list, choose Black.

The port excitation can now be selected on the plot group. For the model thumbnail, 
select the second port.

Electric Field (emw) 2
1 In the Model Builder window, under Results click Electric Field (emw) 2.

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Parameter value (PortName) list, choose 2.

4 On the Electric Field (emw) 2 toolbar, click Plot.

By plotting Figure 7, conclude this modeling session.
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Introduction

This is a template MPH-file containing the physics interfaces and the parameterized 
geometry for the model Impedance Matching of a Lossy Ferrite 3-port Circulator. For a 
description of that application, see the book Introduction to the RF Module or the 
application documentation Impedance Matching of a Lossy Ferrite 3-Port Circulator.

Application Library path: RF_Module/Ferrimagnetic_Devices/
lossy_circulator_3d_geom

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Radio Frequency>Electromagnetic Waves,

Frequency Domain (emw).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Frequency Domain.

6 Click Done.

G L O B A L  D E F I N I T I O N S

The geometry is set up using a parameterized approach. This allows you to match the 
input impedance to that of the connecting waveguide sections by variation of two 
geometric design parameters. Before starting to build the geometry the geometric design 
parameters need to be entered. These are two dimensionless numbers used to scale 
selected geometric building blocks.

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.
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3 In the table, enter the following settings:

The lossy ferrite material model is set up by referring to global variables. For convenience 
the definitions are stored in an external text file that is imported into the model. The 
external text file also contains comments.

Variables 1
1 On the Home toolbar, click Variables and choose Global Variables.

2 In the Settings window for Variables, locate the Variables section.

3 Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
lossy_circulator_3d_parameters.txt.

The geometry is built by first defining a 2D cross section of the 3D geometry in a work 
plane. The 2D geometry is then extruded into 3D.

G E O M E T R Y  1

Work Plane 1 (wp1)
1 On the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, click Show Work Plane.

Plane Geometry
Start by defining one arm of the circulator, then twice copy and rotate it to build all three 
arms.

Rectangle 1 (r1)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 0.2-0.1/(3*sqrt(3)).

4 In the Height text field, type 0.2/3.

5 Locate the Position section. In the xw text field, type -0.2.

6 In the yw text field, type -0.1/3.

7 Right-click Rectangle 1 (r1) and choose Build Selected.

Name Expression Value Description

sc_chamfer 3 3 Geometry scale factor

sc_ferrite 0.5 0.5 Geometry scale factor
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Copy 1 (copy1)
1 On the Work Plane toolbar, click Transforms and choose Copy.

2 Select the object r1 only.

Rotate 1 (rot1)
1 On the Work Plane toolbar, click Transforms and choose Rotate.

2 Select the object copy1 only.

3 In the Settings window for Rotate, locate the Rotation Angle section.

4 In the Rotation text field, type 120.

5 Right-click Rotate 1 (rot1) and choose Build Selected.

Copy 2 (copy2)
1 On the Work Plane toolbar, click Transforms and choose Copy.

2 Select the object r1 only.

Rotate 2 (rot2)
1 On the Work Plane toolbar, click Transforms and choose Rotate.

2 Select the object copy2 only.

3 In the Settings window for Rotate, locate the Rotation Angle section.

4 In the Rotation text field, type -120.

5 Right-click Rotate 2 (rot2) and choose Build Selected.

6 Click the Zoom Extents button on the Graphics toolbar.
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Plane Geometry
The geometry should now look as in the below figure.

Unite the three arms to one object.

Union 1 (uni1)
1 On the Work Plane toolbar, click Booleans and Partitions and choose Union.

2 Click in the Graphics window and then press Ctrl+A to select all objects.

3 Right-click Union 1 (uni1) and choose Build Selected.

Plane Geometry
Next build the central connecting region and add the ferrite domain. During these stages, 
the geometric design parameters will be used. First build/add a triangle connecting the 
arms by subtracting a copy of what has already been drawn from a circle of proper radius.

Circle 1 (c1)
1 On the Work Plane toolbar, click Primitives and choose Circle.

2 In the Settings window for Circle, locate the Size and Shape section.

3 In the Radius text field, type 0.2/(3*sqrt(3)).

4 Right-click Circle 1 (c1) and choose Build Selected.
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Copy 3 (copy3)
1 On the Work Plane toolbar, click Transforms and choose Copy.

2 Select the object uni1 only.

Difference 1 (dif1)
1 On the Work Plane toolbar, click Booleans and Partitions and choose Difference.

2 Select the object c1 only.

3 In the Settings window for Difference, locate the Difference section.

4 Find the Objects to subtract subsection. Select the Active toggle button.

5 Select the object copy3 only.

6 Right-click Difference 1 (dif1) and choose Build Selected.

Plane Geometry
The geometry should now look as in the below figure.

Rotate the newly created triangle 180 degrees and use one scaled copy of it to create linear 
fillets for impedance matching. Use another scaled copy to define the ferrite.

Rotate 3 (rot3)
1 On the Work Plane toolbar, click Transforms and choose Rotate.

2 Select the object dif1 only.
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3 In the Settings window for Rotate, locate the Rotation Angle section.

4 In the Rotation text field, type 180.

5 Right-click Rotate 3 (rot3) and choose Build Selected.

Copy 4 (copy4)
1 On the Work Plane toolbar, click Transforms and choose Copy.

2 Select the object rot3 only.

Plane Geometry
Apply the scaling for the impedance matching.

Scale 1 (sca1)
1 On the Work Plane toolbar, click Transforms and choose Scale.

2 In the Settings window for Scale, locate the Scale Factor section.

3 In the Factor text field, type sc_chamfer.

4 Select the object copy4 only.

5 Right-click Scale 1 (sca1) and choose Build Selected.

Union 2 (uni2)
1 On the Work Plane toolbar, click Booleans and Partitions and choose Union.

2 Select the objects sca1 and uni1 only.

3 In the Settings window for Union, locate the Union section.

4 Clear the Keep interior boundaries check box.

5 Right-click Union 2 (uni2) and choose Build Selected.
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Plane Geometry
The geometry should now look as in the below figure.

Apply the scaling for the ferrite region.

Scale 2 (sca2)
1 On the Work Plane toolbar, click Transforms and choose Scale.

2 Select the object rot3 only.

3 In the Settings window for Scale, locate the Scale Factor section.

4 In the Factor text field, type sc_ferrite.

5 Right-click Scale 2 (sca2) and choose Build Selected.

Work Plane 1 (wp1)
In the Model Builder window, under Component 1 (comp1)>Geometry 1 click 
Work Plane 1 (wp1).

Extruding the 2D cross-section into a 3D solid geometry finalizes the geometry 
definition.

Extrude 1 (ext1)
1 On the Geometry toolbar, click Extrude.

2 In the Settings window for Extrude, locate the Distances section.
8 |  P A R A M E T E R I Z E D  C I R C U L A T O R  G E O M E T R Y



3 In the table, enter the following settings:

4 Right-click Extrude 1 (ext1) and choose Build Selected.

5 Click the Zoom Extents button on the Graphics toolbar.

Form Union (fin)
1 On the Geometry toolbar, click Build All.

The geometry should now look as in the below figure.

Distances (m)

0.1/3
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Introduction

This example demonstrates how to set up a spatially varying dielectric distribution, such as 
might be engineered with a metamaterial. Here, a convex lens shape is defined via a known 
deformation of a rectangular domain. The dielectric distribution is defined on the 
undeformed, original rectangular domain and is mapped onto the deformed shape of the 
lens. Although the lens shape defined here is convex, the dielectric distribution causes the 
incident beam to diverge.

Figure 1: A convex metamaterial lens. Both the shape and the dielectric distribution are 
defined on a rectangular domain, and mapped into the deformed state.

(x, y) = F(Xg, Yg)εr(Xg, Yg)
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Model Definition

Consider a 2D model geometry as shown in Figure 2. A square air domain, bounded by a 
perfectly matched layer (PML) on all sides, encloses a rectangular region in which the 
metamaterial lens is defined. 

Figure 2: The modeling domain consists of the metamaterial lens in an air domain, and a 
surrounding PML. A Gaussian beam is incident from the left.

Model a Gaussian beam entering the domain from the left side, via a surface current 
excitation at an interior boundary. The surface current, Js0,can also be thought of as a 
displacement current excitation. The waist of the beam is at the boundary, so the excitation 
at this boundary can be specified as

where w0 is the waist size. The excitation is at the boundary between a domain of free 
space and the PML, and excites a wave propagating in both directions—into the PML and 
into the modeling domain. The wave propagating into the PML is completely absorbed, 
and the wave propagating into the domain is diffracted by the lens.

PML

Js0
y

w0
------- 
  2

– 
 exp=
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Both the shape and the dielectric distribution of the metamaterial lens are defined with 
respect to the original Cartesian coordinate system, as shown in Figure 1. The true shape 
of the lens is described by the relationship

where Xg, Yg are the Cartesian coordinates of the undeformed frame.

The dielectric distribution is defined on the original Cartesian domain as:

The above expression introduces a variation in the dielectric in the y-coordinate of the 
undeformed lens. On the deformed lens, the dielectric varies in both directions.

The Deformed Geometry uses the above expressions to define the shape of the lens and 
maps the Cartesian coordinates of the undeformed frame onto the deformed frame. The 
dielectric distribution is defined with respect to the undeformed frame, and then mapped 
onto the deformed shape using the above expressions.

Results and Discussion

The model is solved for the out-of-plane electric field. Figure 3 plots the electric field 
norm, showing a Gaussian beam with minimal divergence incident upon the lens from the 
left. The beam is diffracted by the convex lens and spreads out.

Figure 4 displays the dielectric distribution, and shows variation in both directions defined 
via the mapping described above.

x
y

Fx Xg Yg,( )

Fy Xg Yg,( )

1
2
---Xg 2 Yg

2
–( )

Yg 1 1
2
---x2

+ 
 

= =

εr 1 1
2
---Yg

2
+ 

  2
=
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Figure 3: The norm of the electric field shows the Gaussian beam diffracted by the 
metamaterial lens.

Figure 4: Contour plot of the dielectric distribution.
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Application Library path: RF_Module/Tutorials/
mapped_dielectric_distribution

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 2D.

2 In the Select Physics tree, select Mathematics>Deformed Mesh>Deformed Geometry (dg).

3 Click Add.

4 In the Select Physics tree, select Radio Frequency>Electromagnetic Waves,

Frequency Domain (emw).

5 Click Add.

6 Click Study.

7 In the Select Study tree, select Custom Studies>

Preset Studies for Some Physics Interfaces>Stationary.

8 Click Done.

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

Here, c_const is a predefined COMSOL constant for the speed of light in vacuum.

Name Expression Value Description

f0 3[GHz] 3E9 Hz Operating frequency

lda0 c_const/f0 0.09993 m Free space wavelength

w0 lda0*4 0.3997 m Gaussian beam waist size
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G E O M E T R Y  1

First, create a square for the entire model domain. Add a layer on each side of the square.

Square 1 (sq1)
1 On the Geometry toolbar, click Primitives and choose Square.

2 In the Settings window for Square, locate the Size section.

3 In the Side length text field, type 3.

4 Locate the Position section. From the Base list, choose Center.

5 Click to expand the Layers section. In the table, enter the following settings:

6 Select the Layers to the left check box.

7 Select the Layers to the right check box.

8 Select the Layers on top check box.

9 Right-click Square 1 (sq1) and choose Build Selected.

Add a rectangle for the lens.

Rectangle 1 (r1)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Height text field, type 2.

4 Locate the Position section. From the Base list, choose Center.

Layer name Thickness (m)

Layer 1 lda0
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5 Click Build All Objects.

D E F I N I T I O N S

Add a selection for the lens domain which will be recalled frequently while setting up the 
model properties.

Explicit 1
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Lens in the Label text field.
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3 Select Domain 7 only.

Next, add a set of variables for the shape and the dielectric distribution of the lens.

Variables 1
1 On the Definitions toolbar, click Local Variables.

2 In the Settings window for Variables, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Domain.

4 From the Selection list, choose Lens.

5 Locate the Variables section. In the table, enter the following settings:

Here, Xg and Yg are predefined Deformed Geometry physics variables representing the 
Cartesian coordinates of the undeformed frame.

Add a perfectly matched layer (PML).

Perfectly Matched Layer 1 (pml1)
1 On the Definitions toolbar, click Perfectly Matched Layer.

Name Expression Unit Description

xp 0.5[m]*Xg[1/m]*(2-(Yg[1/
m])^2)

m Mapping of Xg -> x

yp Yg*(1+(0.5*(xp[1/m])^2)) m Mapping of Yg -> y

erp (1+0.5*(Yg[1/m])^2)^2 Dielectric distribution
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2 Select Domains 1–4, 6, and 8–10 only.

D E F O R M E D  G E O M E T R Y  ( D G )

Set up Deformed Geometry. You need to specify Free Deformation, Prescribed Mesh 
Displacement and Prescribed Deformation.

1 In the Model Builder window, under Component 1 (comp1) click Deformed Geometry (dg).

2 In the Settings window for Deformed Geometry, locate the Frame Settings section.

3 From the Geometry shape order list, choose 1.

Free Deformation 1
1 Right-click Component 1 (comp1)>Deformed Geometry (dg) and choose 

Free Deformation.
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2 Select Domain 5 only.

Prescribed Mesh Displacement 2
1 In the Model Builder window, right-click Deformed Geometry (dg) and choose 

Prescribed Mesh Displacement.

2 Select Boundaries 15–18 only.
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3 In the Settings window for Prescribed Mesh Displacement, locate the 
Prescribed Mesh Displacement section.

4 In the dX text field, type xp-Xg.

5 In the dY text field, type yp-Yg.

Prescribed Deformation 1
1 Right-click Deformed Geometry (dg) and choose Prescribed Deformation.

2 In the Settings window for Prescribed Deformation, locate the Domain Selection section.

3 From the Selection list, choose Lens.

4 Locate the Prescribed Mesh Displacement section. In the dX text-field array, type xp-Xg 
on the first row.

5 In the dY text-field array, type yp-Yg on the second row.

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

In Electromagnetic Waves, Frequency Domain, the dielectric distribution is configured via 
the user-defined variable erp and the Gaussian beam is modeled as entering the domain 
from the left side, via a surface current excitation.

1 In the Model Builder window, under Component 1 (comp1) click Electromagnetic Waves,

Frequency Domain (emw).

2 In the Settings window for Electromagnetic Waves, Frequency Domain, locate the 
Components section.

3 From the Electric field components solved for list, choose Out-of-plane vector, to only 
perform the calculation for the out-of-plane component. The in-plane components are 
both zero.

4 Locate the Physics-Controlled Mesh section. Clear the Enable check box.

Wave Equation, Electric 2
1 Right-click Component 1 (comp1)>Electromagnetic Waves, Frequency Domain (emw) and 

choose Wave Equation, Electric.

2 In the Settings window for Wave Equation, Electric, locate the Domain Selection section.

3 From the Selection list, choose Lens.

4 Locate the Electric Displacement Field section. From the εr list, choose User defined. In 
the associated text field, type erp.

5 Locate the Magnetic Field section. From the μr list, choose User defined, (Leave the 
default value 1).
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6 Locate the Conduction Current section. From the σ list, choose User defined, (Leave the 
default value 0).

Surface Current Density 1
1 In the Model Builder window, right-click Electromagnetic Waves,

Frequency Domain (emw) and choose the boundary condition More>

Surface Current Density.

2 Select Boundary 10 only.

3 In the Settings window for Surface Current Density, locate the Surface Current Density 
section.

4 Specify the Js0 vector as

M A T E R I A L S

Set all domain with vacuum. The lens domain material properties are explicitly configured 
by Wave Equation, Electric 2 in Electromagnetic Waves, Frequency Domain.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

0 x

0 y

exp(-(y/w0)^2) z
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2 Go to the Add Material window.

3 In the tree, select Built-In>Air.

4 Click Add to Component in the window toolbar.

M A T E R I A L S

On the Home toolbar, click Add Material to close the Add Material window.

M E S H  1

Size
1 In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 

Free Triangular.

2 In the Settings window for Size, locate the Element Size section.

3 Click the Custom button.

4 Locate the Element Size Parameters section. In the Maximum element size text field, type 
lda0/10.

5 In the Minimum element size text field, type 0.0012.

6 In the Model Builder window, click Mesh 1.

7 In the Settings window for Mesh, click Build All.

You may zoom in a few times to check the quality of the mesh.

S T U D Y  1

The model is analyzed with two study steps. First, make sure that Stationary study step is 
solved only for Deformed Geometry.

Step 1: Stationary
1 In the Model Builder window, under Study 1 click Step 1: Stationary.

2 In the Settings window for Stationary, locate the Physics and Variables Selection section.

3 In the table, clear the Solve for check box for the Electromagnetic Waves, Frequency 

Domain interface.

Add a Frequency Domain study step and set as solved only for Electromagnetic Waves, 

Frequency Domain.

Step 2: Frequency Domain
1 On the Study toolbar, click Study Steps and choose Frequency Domain>

Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.
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3 In the Frequencies text field, type f0.

4 Locate the Physics and Variables Selection section. In the table, clear the Solve for check 
box for the Deformed Geometry interface.

5 On the Study toolbar, click Compute.

R E S U L T S

Electric Field (emw)
The default plot shows the magnitude of electric fields. Change the default color pattern 
and add a contour plot for the magnitude.

Surface
1 In the Model Builder window, expand the Electric Field (emw) node, then click Surface.

2 In the Settings window for Surface, locate the Coloring and Style section.

3 From the Color table list, choose RainbowLight.

Contour 1
1 In the Model Builder window, under Results right-click Electric Field (emw) and choose 

Contour.

2 In the Settings window for Contour, locate the Levels section.

3 In the Total levels text field, type 14.

4 Locate the Coloring and Style section. From the Coloring list, choose Uniform.

5 From the Color list, choose Black.

6 Clear the Color legend check box.

7 On the Electric Field (emw) toolbar, click Plot.

See Figure 3 to compare the reproduced plot.

Add a filled contour plot describing the dielectric distribution over the lens.

Contour 1
1 On the Home toolbar, click Add Plot Group and choose 2D Plot Group.

2 In the Model Builder window, right-click 2D Plot Group 2 and choose Contour.

3 In the Settings window for Contour, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 1>Electromagnetic Waves,

Frequency Domain>Material properties>emw.epsrAv - Relative permittivity, average.

4 Locate the Levels section. In the Total levels text field, type 12.

5 Locate the Coloring and Style section. From the Contour type list, choose Filled.
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6 From the Color table list, choose GrayScale.

7 Select the Reverse color table check box.

8 On the 2D Plot Group 2 toolbar, click Plot.

The plot for the dielectric distribution is shown in Figure 4.
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Introduction

The signal integrity (SI) analysis gives an overview of the quality of an electrical signal 
transmitted through electrical circuits such as high-speed interconnects, cables, and 
printed circuit boards. The quality of the received signal can be distorted by noise from 
outside the circuit, and can be degraded by impedance mismatch, insertion loss, and 
crosstalk; in practice, EMC/EMI analyses are run to estimate the susceptibility of a device 
or a network to an undesired coupling. In this example model, we examine the crosstalk 
effect between two adjacent microstrip lines on a microwave substrate. The simulated 
results provide the time-domain reflectometry (TDR) response at the coupled ports and 
show increased distortion of a signal at higher data rates.

Figure 1: A microstrip line crosstalk model is composed of 20 mil microwave substrate with a 
ground plane and two adjacent microstrip lines 1.8 mm apart.

Model Definition

Two parallel 50 Ω microstrip lines are patterned on 20 mil substrate with a dielectric 
constant εr = 3.38. All metallic parts, including the patterned lines and bottom ground 
plane, are configured using perfect electric conductor (PEC) boundary conditions. The 
small rectangular surfaces, bridging between two parallel lines and the ground plane, are 
used to model lumped ports with which the microstrip lines are excited or terminated by 

20 mil Substrate εr = 3.38

Ground on the bottom

Lumped port 1 Lumped port 3

Lumped port 2 and 4

Air

Microstrip lines

Scattering (absorbing) boundary
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50 Ω. The air domain on top of the circuit board is defined using vacuum material 
properties. The exterior surfaces of the air are finished by a scattering boundary condition 
that is an absorbing boundary to describe an open space.

One bit of a single rectangular pulse is used to excite the circuit board. The widths of the 
two pulses are set to half of the 300 MHz and 600 MHz signals. The corresponding data 
rates for each frequency are 600 Mbit/s and 1.2 Gbit/s, respectively. A parametric sweep 
switches the frequency of the pulse during the simulation. It is necessary to apply 
smoothing to the transition zone of the pulse to remove undesirable high-frequency 
components from the signal. 

The maximum simulation time is calculated using an approximated traveling time of a 
wave through a microstrip line based on the phase velocity. The effective dielectric 
constant for the phase velocity calculation is obtained using an equation in Ref. 1

 (1)

where d is the thickness of the substrate and W is the width of the line.

It is assumed that a frequency about ten times greater than the input pulse signal frequency 
is enough to describe the highest frequency component in the smoothed rectangular 
pulse. The maximum mesh element size is set to 0.2 wavelengths in the dielectric 
substrate. 

It is also important to define a time step that resolves the wave well in time as the mesh 
does in space. Any longer time steps would not optimally utilize the fine mesh, and any 
shorter time steps would unnecessarily lead to a longer simulation time without gaining 
significant accurate results. While running a simulation, the time step is continuously 
adjusted to meet the specified tolerances by the time-dependent solver. If there is an exact 
time step the solver needs to take, it can be manually set. In the Settings window of the 
Time-Dependent Solver node, the time step can be specified manually. See the step by step 
instructions to learn how to access this setting.

Results and Discussion

Figure 2 shows the input pulse signal as well as the voltage at lumped port 1 with a data 
rate of 600 Mbit/s (300 MHz) and 1.2 Gbit/s (600 MHz), respectively. Since the input 
signal is flowing through a straight 50 Ω line terminated with a 50 Ω resistor without 
discontinuity on the line, no distortion is evident on the port voltage.

εr 1+

2
--------------

εr 1–

2 1 12 d
W
-----+

------------------------------+
3 |  S I G N A L  I N T E G R I T Y  A N D  T D R  A N A L Y S I S  O F  A D J A C E N T  M I C R O S T R I P  L I N E S



Figure 2: The input pulse and the voltage at lumped port 1 (the excitation port) with a data 
rate of 600 Mbit/s and 1.2 Gbit/s.

Figure 3: The delayed input pulse and the voltage at lumped port 2 (the through port) with a 
data rate of 600 Mbit/s and 1.2 Gbit/s.
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Figure 4: Voltage for the coupled signals at lumped ports 3 and 4. The voltage of a coupled 
signal increases at a higher data rate.

Figure 5: The spectrum of input pulses up to 10 GHz. The signal strength decreases as 
frequency increases.
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Figure 6: The impedance of lumped port 1 with data rates of 600 Mbit/s and 1.2 Gbit/s

Figure 3 shows the delayed input pulse and the received signals with two data rates at 
lumped port 2. The time domain response of the 1.2 Gbit/s signal is slightly distorted in 
the beginning when it reaches 1 V while that of the 600 Mbit/s signal seems to remain 
undistorted.

The crosstalk between two microstrip lines is observed in Figure 4. The coupled signal 
level between two data rates is quite similar at lumped port 3, which is next to the 
excitation port. The time domain response at lumped port 4 next to the through port, 
shows that the higher data rate signal causes the stronger crosstalk on another signal path. 

Figure 5 works as a reference to define the effective highest frequency component in the 
smoothed rectangular pulse since it provides the spectrum of results for 600 Mbit/s and 
1.2 Gbit/s. A periodic rectangular pulse can be decomposed into a sum of sinusoidal 
functions. By estimating the level of a particular frequency, a proper frequency range can 
be defined for efficient simulations. The estimated highest frequency is used to choose the 
mesh size. With a finer mesh size, higher frequency components can be analyzed more 
accurately but it will increase the computation time. In this model, we set the maximum 
frequency component to 5 GHz that is two orders of magnitude smaller than the level of 
the DC component of each rectangular pulse.
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In Figure 6, the TDR at lumped port 1 is presented in terms of impedance. The computed 
port impedance is around 50 Ω while the signal level is 1 V.

Notes About the COMSOL Implementation

Changing the number of output times in the Step 1: Time Dependent node configures the 
output times for the results analysis but has a minimal effect on the time steps taken by the 
solver.

Reference

1. D.M. Pozar, Microwave Engineering, John Wiley & Sons, 1998.

Application Library path: RF_Module/EMI_EMC_Applications/
microstrip_line_crosstalk

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Radio Frequency>Electromagnetic Waves,

Transient (temw).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Time Dependent.

6 Click Done.

Parameters
On the Home toolbar, click Parameters.
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G L O B A L  D E F I N I T I O N S

Parameters
1 In the Settings window for Parameters, locate the Parameters section.

2 Click Load from File.

3 Browse to the model’s Application Libraries folder and double-click the file 
microstrip_line_crosstalk_parameters.txt.

G E O M E T R Y  1

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose in.

Block 1 (blk1)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, locate the Size and Shape section.

3 In the Width text field, type blength+0.5.

4 In the Depth text field, type bwidth.

5 In the Height text field, type tsub*15.

6 Locate the Position section. In the x text field, type -0.25.

7 In the y text field, type -bwidth/2.

8 Click to expand the Layers section. Find the Layer position subsection. Select the Left 
check box.

9 Select the Right check box.

10 Clear the Bottom check box.

11 In the table, enter the following settings:

12 Click the Wireframe Rendering button on the Graphics toolbar.

Block 2 (blk2)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, locate the Size and Shape section.

3 In the Width text field, type blength.

Layer name Thickness (in)

Layer 1 0.25
8 |  S I G N A L  I N T E G R I T Y  A N D  T D R  A N A L Y S I S  O F  A D J A C E N T  M I C R O S T R I P  L I N E S



4 In the Depth text field, type bwidth.

5 In the Height text field, type tsub.

6 Locate the Position section. In the y text field, type -bwidth/2.

Block 3 (blk3)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, locate the Size and Shape section.

3 In the Width text field, type blength.

4 In the Depth text field, type lwidth.

5 In the Height text field, type tsub.

6 Locate the Position section. In the y text field, type -spacing/2-lwidth.

Mirror 1 (mir1)
1 On the Geometry toolbar, click Transforms and choose Mirror.

2 Select the object blk3 only.

3 In the Settings window for Mirror, locate the Input section.

4 Select the Keep input objects check box.

5 Locate the Normal Vector to Plane of Reflection section. In the y text field, type 1.

6 In the z text field, type 0.

7 Click Build All Objects.
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Rectangle 1 (rect1)
On the Home toolbar, click Functions and choose Global>Rectangle.

G L O B A L  D E F I N I T I O N S

Rectangle 1 (rect1)
1 In the Settings window for Rectangle, locate the Parameters section.

2 In the Lower limit text field, type 0.

3 In the Upper limit text field, type Tb-Tb/4.

4 Click to expand the Smoothing section. In the Size of transition zone text field, type Tb/
4.

Analytic 1 (an1)
1 On the Home toolbar, click Functions and choose Global>Analytic.

2 In the Settings window for Analytic, locate the Definition section.

3 In the Expression text field, type rect1((t-Tb/8)/1[s]).

4 In the Arguments text field, type t.

5 Locate the Units section. In the Arguments text field, type s.

6 In the Function text field, type V.

7 Locate the Plot Parameters section. In the table, enter the following settings:

Argument Lower limit Upper limit

t 0 2*Tb
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8 Click Plot.

M A T E R I A L S

Material 1 (mat1)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, locate the Material Contents section.

3 In the table, enter the following settings:

Material 2 (mat2)
1 Right-click Materials and choose Blank Material.

Property Name Value Unit Property 
group

Relative permittivity epsilonr 1 1 Basic

Relative permeability mur 1 1 Basic

Electrical conductivity sigma 0 S/m Basic
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2 Select Domains 2 and 4–7 only.

3 In the Settings window for Material, locate the Material Contents section.

4 In the table, enter the following settings:

E L E C T R O M A G N E T I C  WA V E S ,  TR A N S I E N T  ( T E M W )

Perfect Electric Conductor 2
1 In the Model Builder window, under Component 1 (comp1) right-click 

Electromagnetic Waves, Transient (temw) and choose Perfect Electric Conductor.

Property Name Value Unit Property 
group

Relative permittivity epsilonr er_sub 1 Basic

Relative permeability mur 1 1 Basic

Electrical conductivity sigma 0 S/m Basic
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2 Select Boundaries 16 and 24 only.

Scattering Boundary Condition 1
1 In the Model Builder window, right-click Electromagnetic Waves, Transient (temw) and 

choose Scattering Boundary Condition.

2 Select Boundaries 1, 2, 4, 5, 7, 10, 12, 30, 32, 35, 40, and 41 only.
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Lumped Port 1
1 Right-click Electromagnetic Waves, Transient (temw) and choose Lumped Port.

2 Select Boundary 21 only.

For the first port, wave excitation is on by default.

3 In the Settings window for Lumped Port, locate the Lumped Port Properties section.

4 In the V0 text field, type an1(t).

Lumped Port 2
1 Right-click Electromagnetic Waves, Transient (temw) and choose Lumped Port.

2 Select Boundary 38 only.

Lumped Port 3
1 Right-click Electromagnetic Waves, Transient (temw) and choose Lumped Port.

2 Select Boundary 13 only.

Lumped Port 4
1 Right-click Electromagnetic Waves, Transient (temw) and choose Lumped Port.

2 Select Boundary 36 only.

M E S H  1

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.

2 In the Settings window for Mesh, locate the Mesh Settings section.

3 From the Sequence type list, choose User-controlled mesh.

Size
1 In the Model Builder window, under Component 1 (comp1)>Mesh 1 click Size.

2 In the Settings window for Size, locate the Element Size section.

3 Click the Custom button.

4 Locate the Element Size Parameters section. In the Maximum element size text field, type 
hm.

Edge 1
1 In the Model Builder window, right-click Mesh 1 and choose More Operations>Edge.
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2 Select Edges 18, 20, 23, 25, 28, and 30 only.

Distribution 1
1 Right-click Component 1 (comp1)>Mesh 1>Edge 1 and choose Distribution.

2 Select Edges 18, 20, 28, and 30 only.

3 In the Settings window for Distribution, locate the Distribution section.

4 From the Distribution properties list, choose Predefined distribution type.
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5 In the Number of elements text field, type 3.

6 In the Element ratio text field, type 4.

7 Select the Symmetric distribution check box.

Distribution 2
1 Right-click Edge 1 and choose Distribution.

2 Select Edges 23 and 25 only.

3 In the Settings window for Distribution, locate the Distribution section.

4 From the Distribution properties list, choose Predefined distribution type.

5 In the Number of elements text field, type 4.

6 In the Element ratio text field, type 4.

7 Select the Symmetric distribution check box.

Mapped 1
1 In the Model Builder window, right-click Mesh 1 and choose More Operations>Mapped.
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2 Select Boundaries 13, 17, and 21 only.

Distribution 1
1 Right-click Component 1 (comp1)>Mesh 1>Mapped 1 and choose Distribution.

2 Select Edges 17 and 32 only.

3 In the Settings window for Distribution, locate the Distribution section.

4 In the Number of elements text field, type 2.
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Free Triangular 1
1 In the Model Builder window, right-click Mesh 1 and choose More Operations>

Free Triangular.

2 Select Boundaries 6, 9, and 25 only.

3 Right-click Mesh 1 and choose Swept.

4 Click the Zoom Extents button on the Graphics toolbar.

Swept 1
1 In the Settings window for Swept, locate the Domain Selection section.

2 From the Geometric entity level list, choose Domain.
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3 Select Domains 2–7 only.

Free Tetrahedral 1
1 Right-click Mesh 1 and choose Swept.

2 In the Model Builder window, under Component 1 (comp1)>Mesh 1 right-click 
Free Tetrahedral 1 and choose Delete.

M E S H  1

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.

2 In the Settings window for Mesh, click Build All.

3 Click the Click and Hide button on the Graphics toolbar.

4 Click the Select Boundaries button on the Graphics toolbar.

5 Select Boundary 12 only.

6 Select Boundary 10 only.

7 Select Boundary 4 only.

8 Select Boundary 1 only.

9 Select Boundary 2 only.

10 Click the Click and Hide button on the Graphics toolbar.
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Free Triangular 1
Click the Zoom to Selection button on the Graphics toolbar.

S T U D Y  1

Step 1: Time Dependent
1 In the Model Builder window, under Study 1 click Step 1: Time Dependent.

2 In the Settings window for Time Dependent, locate the Study Settings section.

3 In the Times text field, type range(0,sim_time_step,sim_time_max).

Solution 1 (sol1)
1 On the Study toolbar, click Show Default Solver.

2 In the Model Builder window, expand the Solution 1 (sol1) node, then click Time-

Dependent Solver 1.

3 In the Settings window for Time-Dependent Solver, click to expand the Time stepping 
section.

4 Locate the Time Stepping section. From the Steps taken by solver list, choose Manual.

5 In the Time step text field, type sim_time_step.

6 In the Model Builder window, expand the Study 1>Solver Configurations>

Solution 1 (sol1)>Time-Dependent Solver 1 node, then click Direct.
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7 In the Settings window for Direct, locate the General section.

8 From the Solver list, choose PARDISO.

Parametric Sweep
1 On the Study toolbar, click Parametric Sweep.

2 In the Settings window for Parametric Sweep, locate the Study Settings section.

3 Click Add.

4 Click to select row number 1 in the table.

5 In the table, enter the following settings:

6 On the Study toolbar, click Compute.

R E S U L T S

3D Plot Group 1
1 In the Model Builder window, under Results click 3D Plot Group 1.

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Time (s) list, choose 6E-10.

Multislice 1
1 In the Model Builder window, expand the 3D Plot Group 1 node, then click Multislice 1.

2 In the Settings window for Multislice, locate the Multiplane Data section.

3 Find the X-planes subsection. In the Planes text field, type 0.

4 Find the Y-planes subsection. In the Planes text field, type 0.

5 Find the Z-planes subsection. From the Entry method list, choose Coordinates.

6 In the Coordinates text field, type 0.

Parameter name Parameter value list Parameter unit

f0 300[MHz] 600[MHz]
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7 On the 3D Plot Group 1 toolbar, click Plot.

1D Plot Group 2
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, locate the Data section.

3 From the Data set list, choose Study 1/Parametric Solutions 1 (sol2).

4 Click to expand the Title section. From the Title type list, choose Manual.

5 In the Title text area, type Time domain response at the input port.

Global 1
1 Right-click 1D Plot Group 2 and choose Global.

2 In the Settings window for Global, locate the y-Axis Data section.

3 In the table, enter the following settings:

4 Click to expand the Coloring and style section. Locate the Coloring and Style section. 
Find the Line markers subsection. From the Marker list, choose Cycle.

Expression Unit Description

temw.Vport_1 V Lumped port 1 voltage

an1(t) Input pulse
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5 On the 1D Plot Group 2 toolbar, click Plot.

Figure 2 shows the input pulse and the voltage at lumped port 1.

1D Plot Group 3
1 In the Model Builder window, under Results right-click 1D Plot Group 2 and choose 

Duplicate.

2 In the Settings window for 1D Plot Group, locate the Title section.

3 In the Title text area, type Time domain response at the through port.

4 Locate the Legend section. From the Position list, choose Middle left.

Global 1
1 In the Model Builder window, expand the 1D Plot Group 3 node, then click Global 1.

2 In the Settings window for Global, locate the y-Axis Data section.

3 In the table, enter the following settings:

4 On the 1D Plot Group 3 toolbar, click Plot.

Figure 3 shows the delayed input pulse and the voltage at lumped port 2.

1D Plot Group 4
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, locate the Data section.

3 From the Data set list, choose Study 1/Parametric Solutions 1 (sol2).

4 Locate the Title section. From the Title type list, choose Manual.

5 In the Title text area, type Time domain response at the coupled ports.

6 Locate the Legend section. From the Position list, choose Upper left.

Global 1
1 Right-click 1D Plot Group 4 and choose Global.

2 In the Settings window for Global, locate the y-Axis Data section.

Expression Unit Description

temw.Vport_2 V Lumped port 2 voltage

an1(t-delay) V Delayed input pulse
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3 In the table, enter the following settings:

4 Locate the Coloring and Style section. Find the Line markers subsection. From the Marker 
list, choose Cycle.

5 On the 1D Plot Group 4 toolbar, click Plot.

The coupled signals at lumped port are shown in Figure 4.

1D Plot Group 5
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, locate the Data section.

3 From the Data set list, choose Study 1/Parametric Solutions 1 (sol2).

4 Locate the Title section. From the Title type list, choose Manual.

5 In the Title text area, type Frequency domain response of the input pulse.

Global 1
1 Right-click 1D Plot Group 5 and choose Global.

2 In the Settings window for Global, locate the y-Axis Data section.

3 In the table, enter the following settings:

4 Locate the x-Axis Data section. From the Parameter list, choose Frequency spectrum.

5 Select the Frequency range check box.

6 In the Maximum text field, type 10[GHz].

7 Locate the Coloring and Style section. Find the Line markers subsection. From the Marker 
list, choose Cycle.

8 On the 1D Plot Group 5 toolbar, click Plot.

Expression Unit Description

temw.Vport_3 V Lumped port 3 voltage

temw.Vport_4 V Lumped port 4 voltage

Expression Unit Description

an1(t) V Input pulse spectrum
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9 Click the y-Axis Log Scale button on the Graphics toolbar.

Compare to the spectra of input pulses in Figure 5.

1D Plot Group 6
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, locate the Data section.

3 From the Data set list, choose Study 1/Parametric Solutions 1 (sol2).

4 Right-click 1D Plot Group 6 and choose Global.

5 In the Settings window for 1D Plot Group, locate the Data section.

6 From the Data set list, choose Study 1/Parametric Solutions 1 (sol2).

Global 1
1 In the Model Builder window, under Results>1D Plot Group 6 click Global 1.

2 In the Settings window for Global, click Add Expression in the upper-right corner of the 
y-axis data section. From the menu, choose Component 1>Electromagnetic Waves,

Transient>Ports>temw.Zport_1 - Lumped port impedance.

3 Locate the Coloring and Style section. Find the Line markers subsection. From the Marker 
list, choose Cycle.
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4 On the 1D Plot Group 6 toolbar, click Plot.

Figure 6 describes the impedance of lumped port 1 with two data rates as a function of 
time.
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Introduction

The microstrip patch antenna is used in a wide range of applications because it is easy to 
design and fabricate. The antenna is attractive due to its low-profile conformal design, 
relatively low cost, and very narrow bandwidth. This example uses an inset feeding strategy 
that does not need any additional matching parts.

Figure 1: Microstrip patch antenna. The model consists of a PEC ground plane, a 50 Ω 
microstrip line fed by a lumped port, a region of free space, and a perfectly matched layer 
(PML) domain.

Model Definition

Feeding a patch antenna from the edge leads to a very high input impedance, causing an 
undesirable impedance mismatch if a conventional 50 Ω line is directly connected. One 
solution to this problem is to use a matching network of quarter-wave transformers 
between the feed point of the 50 Ω line and the patch. However, this approach has two 
drawbacks. First, the quarter-wave transformers would be realized as microstrip lines that 
would have to extend beyond the patch antenna, significantly increasing the overall 
structure size. Second, these microstrip lines should have a high characteristic impedance 
and thus would have to be narrower than practical for fabrication. Therefore, a better 
approach is desired.

Perfectly matched layer

Lumped port

Substrate with PEC ground

PEC patch
2 |  M I C R O S T R I P  P A T C H  A N T E N N A



This example uses a different feed point for the patch antenna to improve matching 
between the 50 Ω feed and the antenna. It is known that the antenna impedance is higher 
than 50 Ω if fed from the edge, and lower if fed from the center. Therefore, an optimum 
feed point exists between the center and the edge. The matching strategy is shown in 
Figure 2. A 50 Ω microstrip line, fed from the end, extends into the patch antenna 
structure. The width of the cutout region, W, is chosen to be large enough so that there 
is minimal coupling between the antenna and the microstrip, but not so large as to 
significantly affect the antenna characteristics. The length of the microstrip line, L, is 
chosen to minimize the reflected power, S11. These optimal dimensions can be found via 
a parametric sweep; this example only treats the final design.

Figure 2: The matching strategy between a 50 Ω line and a patch antenna. A microstrip line 
of length L extends into a slot of with W cut into the patch antenna.

Results and Discussion

Figure 3 shows the radiation pattern in the E-plane; the E-plane is defined by the direction 
of the antenna polarization and may include the direction of maximum radiation. 3D far-
field radiation pattern is visualized in Figure 4 showing the directive beam pattern due to 
the ground plane that blocks the radiation toward the bottom side. With the choice of feed 
point used in this example, the S11 parameter is better than −10 dB, and the front-to-back 
ratio in the radiation pattern is more than 15 dB.

W

L

Feed point on a 50 Ω microstrip line
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Figure 3: Far-field radiation pattern at E-plane. Because of the bottom ground plane, the 
radiation pattern is directed toward the top.

Figure 4: 3D Far-field radiation pattern is directed toward the top.
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Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Radio Frequency>Electromagnetic Waves,

Frequency Domain (emw).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Frequency Domain.

6 Click Done.

S T U D Y  1

Step 1: Frequency Domain
1 In the Model Builder window, under Study 1 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 In the Frequencies text field, type 1.575[GHz].
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G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

Here mil refers to the unit milliinch, that is 1 mil = 0.0254 mm.

G E O M E T R Y  1

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose mm.

First, create the substrate block.

Block 1 (blk1)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, type Substrate in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type w_sub.

4 In the Depth text field, type l_sub.

5 In the Height text field, type d.

6 Locate the Position section. From the Base list, choose Center.

7 Right-click Substrate and choose Build Selected.

Now add the patch antenna.

Name Expression Value Description

d 60[mil] 0.001524 m Substrate thickness

w_line 3.2[mm] 0.0032 m 50 ohm line width

w_patch 53[mm] 0.053 m Patch width

l_patch 52[mm] 0.052 m Patch length

w_stub 7[mm] 0.007 m Tuning stub width

l_stub 16[mm] 0.016 m Tuning stub length

w_sub 100[mm] 0.1 m Substrate width

l_sub 100[mm] 0.1 m Substrate length
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Block 2 (blk2)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, type Patch in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type w_patch.

4 In the Depth text field, type l_patch.

5 In the Height text field, type d.

6 Locate the Position section. From the Base list, choose Center.

7 Right-click Patch and choose Build Selected.

Create impedance matching parts and a 50Ω feed line.

Block 3 (blk3)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, type Stub in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type w_stub.

4 In the Depth text field, type l_stub.

5 In the Height text field, type d.

6 Locate the Position section. From the Base list, choose Center.

7 In the x text field, type w_stub/2+w_line/2.

8 In the y text field, type l_stub/2-w_patch/2.

9 Right-click Stub and choose Build Selected.

Copy 1 (copy1)
1 On the Geometry toolbar, click Transforms and choose Copy.

2 Select the object blk3 only.

3 In the Settings window for Copy, locate the Displacement section.

4 In the x text field, type -w_stub-w_line.

5 Right-click Copy 1 (copy1) and choose Build Selected.

Difference 1 (dif1)
1 On the Geometry toolbar, click Booleans and Partitions and choose Difference.

2 Select the object blk2 only.

3 In the Settings window for Difference, locate the Difference section.

4 Find the Objects to subtract subsection. Select the Active toggle button.

5 Select the objects blk3 and copy1 only.
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6 Right-click Difference 1 (dif1) and choose Build Selected.

Choose wireframe rendering to get a better view of the interior parts.

7 Click the Wireframe Rendering button on the Graphics toolbar.

Continue with the surrounding air and the PML regions.

Sphere 1 (sph1)
1 On the Geometry toolbar, click Sphere.

2 In the Settings window for Sphere, locate the Size section.

3 In the Radius text field, type l_sub.

4 Click to expand the Layers section. In the table, enter the following settings:

5 Click Build All Objects.

6 Click the Zoom Extents button on the Graphics toolbar.

D E F I N I T I O N S

Perfectly Matched Layer 1 (pml1)
1 On the Definitions toolbar, click Perfectly Matched Layer.

Layer name Thickness (mm)

Layer 1 l_sub/5
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2 Select Domains 1–4 and 8–11 only.

These are all of the outermost domains of the sphere.

3 In the Settings window for Perfectly Matched Layer, locate the Geometry section.

4 From the Type list, choose Spherical.

View 1
Suppress some domains and boundaries. This helps to see the interior parts when setting 
up the physics and reviewing the mesh.

Hide for Physics 1
1 In the Model Builder window, under Component 1 (comp1)>Definitions right-click View 1 

and choose Hide for Physics.
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2 Select Domains 2 and 9 only.

Hide for Physics 2
1 Right-click View 1 and choose Hide for Physics.

2 In the Settings window for Hide for Physics, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Boundary.
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4 Select Boundaries 10 and 33 only.

Hidden domains and boundaries can be shown by pressing the Reset Hiding button in 
the Graphic Window toolbar.

Before creating the materials for the model, specify the physics. Using this information, 
the software can detect which material properties are needed.

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

Perfect Electric Conductor 2
1 In the Model Builder window, under Component 1 (comp1) right-click 

Electromagnetic Waves, Frequency Domain (emw) and choose Perfect Electric Conductor.

2 Select Boundaries 15, 20, and 21 only.

Lumped Port 1
1 In the Model Builder window, right-click Electromagnetic Waves,

Frequency Domain (emw) and choose Lumped Port.

2 Click the Zoom In button on the Graphics toolbar.
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3 Select Boundary 26 only.

For the first port, wave excitation is on by default.

4 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Far-
Field Domain.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Built-In>Air.

4 Click Add to Component in the window toolbar.

M A T E R I A L S

On the Home toolbar, click Add Material to close the Add Material window.

Material 2 (mat2)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, type Substrate in the Label text field.
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3 Select Domains 6 and 7 only.

4 Locate the Material Contents section. In the table, enter the following settings:

M E S H  1

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.

Property Name Value Unit Property 
group

Relative permittivity epsilonr 3.38 1 Basic

Relative permeability mur 1 1 Basic

Electrical conductivity sigma 0 S/m Basic
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2 In the Settings window for Mesh, click Build All.

S T U D Y  1

On the Home toolbar, click Compute.

R E S U L T S

Multislice
1 In the Model Builder window, expand the Results>Electric Field (emw) node, then click 

Multislice.

2 In the Settings window for Multislice, locate the Multiplane Data section.

3 Find the X-planes subsection. In the Planes text field, type 0.

4 Find the Y-planes subsection. In the Planes text field, type 0.
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5 On the Electric Field (emw) toolbar, click Plot.

Strong electric fields are observed on the radiating edges.

Far Field 1
1 In the Model Builder window, expand the Results>2D Far Field (emw) node, then click 

Far Field 1.

2 In the Settings window for Far Field, locate the Evaluation section.

3 Find the Reference direction subsection. In the x text field, type 0.

4 In the y text field, type 1.

5 Find the Normal subsection. In the x text field, type 1.

6 In the z text field, type 0.

7 On the 2D Far Field (emw) toolbar, click Plot.

This is the far-field radiation patterns on the E-plane (Figure 3).

3D Far Field (emw)
Compare the 3D far-field radiation pattern plot with Figure 4.

Derived Values
Evaluate the input matching property (S11) at the simulated frequency.
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S-parameter, S11dB (emw)
1 In the Model Builder window, expand the Derived Values node, then click S-parameter,

S11dB (emw).

2 In the Settings window for Global Evaluation, click Evaluate.
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Introduction

This is a model of the heating process in a microwave oven. The distributed heat source is 
computed in a stationary, frequency-domain electromagnetic analysis followed by a 
transient heat transfer simulation showing how the heat redistributes in the food.

Model Definition

The microwave oven is a metallic box connected to a 2.45 GHz microwave source via a 
rectangular waveguide operating in the TE10 mode. Near the bottom of the oven there is 
a cylindrical glass plate with a spherical potato placed on top of it. The microwave operates 
at 1 kW, but when we use symmetry to reduce the model size by one half, we only input 
500 W in simulation. The symmetry cut is applied vertically through the oven, waveguide, 
potato, and plate. Figure 1 below shows both the full and reduced size geometry.

Figure 1: Geometry of the microwave oven, potato, and waveguide feed. Full size (left) and 
half size (right).

The model uses copper for the walls of the oven and the waveguide. Although resistive 
metals losses are expected to be small, the impedance boundary condition on these walls 
ensures that they get accounted for. For more information on this boundary condition, see 
the section Impedance Boundary Condition in the RF Module User’s Guide. The 
symmetry cut has mirror symmetry for the electric field and is represented by the boundary 
condition n × H = 0.

The rectangular port is excited by a transverse electric (TE) wave, which is a wave that has 
no electric field component in the direction of propagation. At an excitation frequency of 
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2.45 GHz, the TE10 mode is the only propagating mode through the rectangular 
waveguide. The cutoff frequencies for the different modes are given analytically from the 
relation

where m and n are the mode numbers and c denotes the speed of light. For the TE10 
mode, m = 1 and n = 0. With the dimensions of the rectangular cross section (a = 7.8 cm 
and b = 1.8 cm), the TE10 mode is the only propagating mode for frequencies between 
1.92 GHz and 3.84 GHz.

The port condition requires a propagation constant β, which at the frequency ν is given 
by the expression

With the stipulated excitation at the rectangular port, the following equation is solved for 
the electric field vector E inside the waveguide and oven:

where μr denotes the relative permeability, j the imaginary unit, σ the conductivity, ω the 
angular frequency, εr the relative permittivity, and ε0 the permittivity of free space. The 
model uses material parameters for air: σ = 0 and μr = εr = 1. In the potato the same 
parameters are used except for the permittivity which is set to εr = 65 − 20j where the 
imaginary part accounts for dielectric losses. The glass plate has σ = 0, μr = 1 and εr = 2.55.

Results and Discussion

Figure 2 below shows the distributed microwave heat source as a slice plot through the 
center of the potato. The rather complicated oscillating pattern, which has a strong peak 
in the center, shows that the potato acts as a resonant cavity for the microwave field. The 
power absorbed in the potato is evaluated and amounts to about 60% of the input 
microwave power. Most of the remaining power is reflected back through the port.

Figure 3 shows the temperature in the center of the potato as a function of time for the 
first 5 seconds. Due to the low thermal conductivity of the potato, the heat distributes 
rather slowly, and the temperature profile after 5 seconds has a strong peak in the center 
(see Figure 4). When heating the potato further, the temperature in the center eventually 
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reaches 100 °C and the water contents start boiling, drying out the center and 
transporting heat as steam to outer layers. This also affects the electromagnetic properties 
of the potato. The simple microwave absorption and heat conduction model used here 
does not capture these nonlinear effects. However, the model can serve as a starting point 
for a more advanced analysis.
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Figure 2: Dissipated microwave power distribution (W/m3). Full size (top) and half size 
(bottom).
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Figure 3: Temperature in the center of the potato during the first 5 seconds of heating. Full 
size (top) and half size (bottom).
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Figure 4: Deformed electric field and Temperature distribution after 5 seconds of heating. 
Full size (top) and half size (bottom).
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Notes About the COMSOL Implementation

In this example model, the material properties of the potato are assumed to be constant as 
temperature rises, for a simpler and faster numerical modeling. It uses manually configured 
multiple study steps to perform one-way physics coupling from electromagnetics in the 
frequency domain to heat transfer in the time domain. Two-way bidirectional physics 
coupling between electromagnetics and heat transfer, using a predefined multiphysics 
study step, is addressed in another Application Libraries example, RF Heating.

Application Library path: RF_Module/Microwave_Heating/microwave_oven

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Heat Transfer>Electromagnetic Heating>

Microwave Heating.

3 Click Add.

4 In the Added physics interfaces tree, select Electromagnetic Waves,

Frequency Domain (emw).

5 Click Study.

Add a Frequency Domain study type for the Electromagnetic Waves, Frequency Domain 
interface.

6 In the Select Study tree, select Custom Studies>

Preset Studies for Some Physics Interfaces>Frequency Domain.

7 Click Done.

S T U D Y  1

Step 1: Frequency Domain
1 In the Model Builder window, under Study 1 click Step 1: Frequency Domain.
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2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 In the Frequencies text field, type 2.45[GHz].

4 In the Model Builder window, click Study 1.

5 In the Settings window for Study, locate the Study Settings section.

6 Select the Store solution for all intermediate study steps check box.

Add a Time Dependent study for the Heat Transfer in Solids interface.

Step 2: Time Dependent
1 On the Study toolbar, click Study Steps and choose Time Dependent>Time Dependent.

The Frequency Domain study is only used for the Electromagnetic Waves, Frequency 

Domain interface, whereas the Time Dependent study is only applicable for theHeat 

Transfer in Solids interface in this model. Notice that the electromagnetic heat source 
will be computed first, and then used in the time-dependent heat transfer study step.

2 In the Settings window for Time Dependent, locate the Physics and Variables Selection 
section.

3 In the table, clear the Solve for check box for the Electromagnetic Waves, Frequency 

Domain (emw) interface.

Step 1: Frequency Domain
1 In the Model Builder window, under Study 1 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Physics and Variables Selection 
section.

3 In the table, clear the Solve for check box for the Heat Transfer in Solids (ht) interface.

Parameters
On the Home toolbar, click Parameters.

G L O B A L  D E F I N I T I O N S

Parameters
1 In the Settings window for Parameters, locate the Parameters section.

2 Click Load from File.

3 Browse to the model’s Application Libraries folder and double-click the file 
microwave_oven_parameters.txt.

Block 1 (blk1)
On the Geometry toolbar, click Block.
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G E O M E T R Y  1

Block 1 (blk1)
1 In the Settings window for Block, locate the Size and Shape section.

2 In the Width text field, type wo.

3 In the Depth text field, type do.

4 In the Height text field, type ho.

5 Locate the Position section. In the y text field, type -do/2.

Block 2 (blk2)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, locate the Size and Shape section.

3 In the Width text field, type wg.

4 In the Depth text field, type dg.

5 In the Height text field, type hg.

6 Locate the Position section. In the x text field, type -wg.

7 In the y text field, type -dg/2.

8 In the z text field, type ho-hg.

Cylinder 1 (cyl1)
1 On the Geometry toolbar, click Cylinder.

2 In the Settings window for Cylinder, locate the Size and Shape section.

3 In the Radius text field, type rp.

4 In the Height text field, type hp.

5 Locate the Position section. In the x text field, type wo/2.

6 In the z text field, type bp.

Sphere 1 (sph1)
1 On the Geometry toolbar, click Sphere.

2 In the Settings window for Sphere, locate the Size section.

3 In the Radius text field, type rpot.

4 Locate the Position section. In the x text field, type wo/2.

5 In the z text field, type rpot+bp+hp.

6 Click Build All Objects.
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Now, it is possible exploit the mirror symmetry of the model by chopping the geometry 
and only simulating one half of the model. For this purpose, form a union of all geometric 
and build an intersection with a block that includes only half of the model.

Union 1 (uni1)
1 On the Geometry toolbar, click Booleans and Partitions and choose Union.

2 Click the Select All button on the Graphics toolbar.

Block 3 (blk3)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, locate the Size and Shape section.

3 In the Width text field, type 0.4.

4 In the Depth text field, type 0.4.

5 In the Height text field, type 0.4.

6 Locate the Position section. In the x text field, type -0.1.

7 Click Build Selected.

Intersection 1 (int1)
1 On the Geometry toolbar, click Booleans and Partitions and choose Intersection.

2 Click the Select All button on the Graphics toolbar.

3 In the Settings window for Intersection, click Build All Objects.
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If 1 (if1)
1 On the Geometry toolbar, click Programming and choose If + End If.

2 In the Settings window for If, type If Full Geometry in the Label text field.

3 Locate the If section. In the Condition text field, type full_geometry.

Mirror 1 (mir1)
1 On the Geometry toolbar, click Transforms and choose Mirror.

2 Select the object int1 only.

3 In the Settings window for Mirror, locate the Input section.

4 Select the Keep input objects check box.

5 Locate the Normal Vector to Plane of Reflection section. In the y text field, type 1.

6 In the z text field, type 0.

7 Click Build All Objects.

8 Click the 
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Introduction

This example involves designing and optimizing a birdcage coil so it can provide a 
homogeneous magnetic field distribution for a Magnetic Resonance Imaging (MRI) 
system. This is usually done to MRI systems so they can generate higher resolution images. 

The homogeneous magnetic field is obtained by quadrature excitation and an optimal 
value of lumped elements in the coil. To find the optimal value at the desired Larmor 
frequency with an air phantom, a parametric sweep is carried out for the capacitance of the 
coil’s lumped elements. The performance of the coil, loaded with a human head phantom, 
is also studied. 

Figure 1: The birdcage coil is shielded by a cylindrical conductive shell. The front part of the 
shield is removed for visualization purposes. Absorbing boundaries are not included in this 
figure. 

Model Definition

Figure 1 shows the geometry of the example, which consists of a bird cage coil placed 
around a human head phantom. Noticeably, there are a number of capacitors on the coil. 
These determine the resonant frequency of the coil and the homogeneity of the field it 
produces. The coil is placed inside an RF shield. The coil surfaces and the shield around 

Conductive shell

Human head 
phantom

Two lumped ports for quadrature excitation

Capacitor

Coil
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the coil are assigned a Perfect Electric Conductor (PEC) condition. Lumped ports are 
used to provide quadrature excitation for the coil, while the coil's capacitors are defined 
using lumped elements. 

The air domain around the coil is modeled using an air sphere. Scattering boundary 
conditions are used along the sphere's boundaries to prevent any reflections into the 
modeling domain from the outermost boundaries. 

To obtain a homogeneous field at the Larmor frequency for an air phantom, the 
capacitance of the lumped elements in the coil are tuned using a parametric sweep. The 
circularity of the field is evaluated by estimating the axial ratio of the magnetic field around 
the phantom. The sum of the axial ratio in dB is evaluated by the line integration of the 
following quantity:

20log10((Bright+Bleft)/(Bright−Bleft))

Here, Bright and Bleft are the right- and left-hand rotating components of the magnetic 
field, respectively. The homogeneity of the field is quantified by evaluating the standard 
deviation of the electric field around the phantom. 

The automatic mesh control option in the Electromagnetic Waves, Frequency Domain 
interface is used with the maximum mesh element size as 1/6 of free space wavelength. 
This example also estimates the homogeneity and circularity of the field in the coil when 
loaded with a human head phantom.

Results and Discussion 

Figure 2 shows the magnetic field around the air phantom with an optimum value for the 
capacitance of the lumped elements at the Larmor frequency. The real part of the magnetic 
flux density is almost orthogonal to the imaginary part of it, which indicates the flux is 
rotating circularly.
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Figure 2: Magnetic density norm distribution with an arrow plot of the real (red) and 
imaginary (blue) part of the magnetic flux density for the coil only.

Figure 3 shows the field for the coil loaded with the human head phantom. Compared to 
the case with an air phantom, the uniformity and circularity of the field is distorted, due 
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to the high dielectric loading in the middle of the coil. The coil’s capacitors can be tuned 
further for this loaded case.

Figure 3: Magnetic density norm distribution with an arrow plot that shows the real (red) and 
imaginary (blue) part of the magnetic flux density when loaded with the human head 
phantom 

Figure 4 and Figure 5 show the integration of the axial ratio of the magnetic flux density 
and the standard deviation of the electric field norm around the head model for different 
values of the lumped elements' capacitances. To achieve a homogeneous circularly-
polarized magnetic field, it can be seen that the optimal value of the capacitance is around 
28.5 pF.
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Figure 4: The integration of the axial ratio of the magnetic flux density around the head 
model

Figure 5: The standard deviation of the electric field norm around the head model
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Application Library path: RF_Module/Passive_Devices/mri_coil

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Radio Frequency>Electromagnetic Waves,

Frequency Domain (emw).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Frequency Domain.

6 Click Done.

S T U D Y  1

Step 1: Frequency Domain
1 In the Model Builder window, under Study 1 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 In the Frequencies text field, type 63.87[MHz].

G E O M E T R Y  1

Parameters
On the Home toolbar, click Parameters.

G L O B A L  D E F I N I T I O N S

Parameters
1 In the Settings window for Parameters, locate the Parameters section.
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2 In the table, enter the following settings:

G E O M E T R Y  1

The model geometry is available as a parameterized geometry sequence in a separate 
MPH-file. If you want to build it from scratch, follow the instructions in the section 
Appendix: Geometry Modeling Instructions. Otherwise load it from file with the 
following steps.

1 On the Geometry toolbar, click Insert Sequence.

2 Browse to the model’s Application Libraries folder and double-click the file 
mri_coil_geom_sequence.mph.

3 In the Model Builder window, under Component 1 (comp1) right-click Geometry 1 and 
choose Build All Objects.

4 Click the Zoom Extents button on the Graphics toolbar.

5 Click the Wireframe Rendering button on the Graphics toolbar.

Import 1 (imp1)
1 On the Geometry toolbar, click Import.

2 In the Settings window for Import, locate the Import section.

3 Click Browse.

4 Browse to the model’s Application Libraries folder and double-click the file 
mri_coil.mphbin.

Form Union (fin)
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 click 

Form Union (fin).

2 In the Settings window for Form Union/Assembly, locate the Form Union/Assembly section.

3 In the Relative repair tolerance text field, type 2.0E-9.

Adjusting the tolerance is required only if you build the geometry with CAD kernel. 
The default tolerance is fine if you use COMSOL kernel.

Name Expression Value Description

c_value 10[pF] 1E-11 F Capacitance used on the rungs

r_coil 0.24[m] 0.24 m Radius of the coil

h_coil 0.3[m] 0.3 m Height of the coil

l_element 0.01[m] 0.01 m Length of the capacitive 
elements
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4 On the Geometry toolbar, click Build All.

5 Click Build All.

Create a set of selections to be used when setting up the physics. First, create a selection 
for the coil surfaces.

Explicit 1
On the Definitions toolbar, click Explicit.

D E F I N I T I O N S

Explicit 1
1 Click the Zoom In button on the Graphics toolbar.

2 In the Settings window for Explicit, type Coil in the Label text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.

4 Click Paste Selection.

5 In the Paste Selection dialog box, type 9 10 11 12 14 16 19 21 31 33 36 38 66 
67 76 77 85 87 90 92 95 97 100 102 in the Selection text field.
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6 Click OK.

Add a selection for the edges around the coil to evaluate the average field.

Explicit 2
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Circle in the Label text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Edge.

4 Select Edge 61 only.
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5 Select the Group by continuous tangent check box.

Add a selection for the absorbing boundaries surrounding the model domain.

Explicit 3
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Absorbing boundaries in the Label text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.

4 Select Boundary 4 only.
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5 Select the Group by continuous tangent check box.

Define the operators to evaluate the average field around the coil.

Average 1 (aveop1)
1 On the Definitions toolbar, click Component Couplings and choose Average.

2 In the Settings window for Average, locate the Source Selection section.

3 From the Geometric entity level list, choose Edge.

4 From the Selection list, choose Circle.

Integration 1 (intop1)
1 On the Definitions toolbar, click Component Couplings and choose Integration.

2 In the Settings window for Integration, locate the Source Selection section.

3 From the Geometric entity level list, choose Edge.

4 From the Selection list, choose Circle.

Define the variables to evaluate the axial ratio of the magnetic field and the standard 
deviation of the electric field.

Variables 1
1 On the Definitions toolbar, click Local Variables.

2 In the Settings window for Variables, locate the Variables section.
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3 In the table, enter the following settings:

View 1
Hide the outermost boundaries to view the interior parts when setting up the physics.

Hide for Physics 1
1 In the Model Builder window, under Component 1 (comp1)>Definitions right-click View 1 

and choose Hide for Physics.

2 In the Settings window for Hide for Physics, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Boundary.

4 Click Paste Selection.

5 In the Paste Selection dialog box, type 1-5, 8, 23, 26, 29, 63-65, 68-71 in the 
Selection text field.

6 Click OK.

M A T E R I A L S

Use the material properties of air for all the domains in the model.

Material 1 (mat1)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

Name Expression Unit Description

Bleft abs(emw.Bx+j*emw.By) T Left hand 
rotating 
component of 
magnetic flux

Bright abs(emw.Bx-j*emw.By) T Right hand 
rotating 
component of 
magnetic flux

BaxialratiodB 20*log10((Bright+Bleft)/
(Bright-Bleft))

Magnetic flux 
axial ratio

intBaxialratiodB intop1(abs(BaxialratiodB)) m Integration of 
magnetic flux 
circularity 
around the 
phantom

stdev sqrt(aveop1(emw.normE^2)-
aveop1(emw.normE)^2)

V/m Standard 
deviation of E 
norm
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2 In the Settings window for Material, locate the Material Contents section.

3 In the table, enter the following settings:

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

Set up the physics for the model. Define PEC condition for the coil boundaries and 
provide quadrature excitation for the coil using lumped ports. Make use of lumped 
elements to model the capacitors in the coil.

Perfect Electric Conductor 2
1 In the Model Builder window, under Component 1 (comp1) right-click 

Electromagnetic Waves, Frequency Domain (emw) and choose Perfect Electric Conductor.

2 In the Settings window for Perfect Electric Conductor, locate the Boundary Selection 
section.

3 From the Selection list, choose Coil.

Perfect Electric Conductor 3
1 In the Model Builder window, right-click Electromagnetic Waves,

Frequency Domain (emw) and choose Perfect Electric Conductor.

2 Select Boundaries 5, 6, 65, and 78 only.

Lumped Port 1
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Lumped Port.

2 Click the Zoom In button on the Graphics toolbar.

Property Name Value Unit Property 
group

Relative permittivity epsilonr 1 1 Basic

Relative permeability mur 1 1 Basic

Electrical conductivity sigma 0 S/m Basic
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3 Select Boundary 37 only.

For the first port, wave excitation is on by default.

4 In the Settings window for Lumped Port, locate the Lumped Port Properties section.

5 In the V0 text field, type 5000.

Lumped Port 2
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Lumped Port.

2 Select Boundary 101 only.

3 In the Settings window for Lumped Port, locate the Lumped Port Properties section.

4 From the Wave excitation at this port list, choose On.

5 In the V0 text field, type 5000.

6 In the θin text field, type pi/2.

Lumped Element 1
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Lumped Element.
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2 Select Boundary 91 only.

3 In the Settings window for Lumped Element, locate the Settings section.

4 From the Lumped element device list, choose Capacitor.

5 In the Celement text field, type c_value.

Lumped Element 2
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Lumped Element.

2 Select Boundary 96 only.

3 In the Settings window for Lumped Element, locate the Settings section.

4 From the Lumped element device list, choose Capacitor.

5 In the Celement text field, type c_value.

Lumped Element 3
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Lumped Element.

2 Select Boundary 86 only.

3 In the Settings window for Lumped Element, locate the Settings section.

4 From the Lumped element device list, choose Capacitor.

5 In the Celement text field, type c_value.
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Lumped Element 4
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Lumped Element.

2 Select Boundary 32 only.

3 In the Settings window for Lumped Element, locate the Settings section.

4 From the Lumped element device list, choose Capacitor.

5 In the Celement text field, type c_value.

Lumped Element 5
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Lumped Element.

2 Select Boundary 15 only.

3 In the Settings window for Lumped Element, locate the Settings section.

4 From the Lumped element device list, choose Capacitor.

5 In the Celement text field, type c_value.

Lumped Element 6
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Lumped Element.

2 Select Boundary 20 only.

3 In the Settings window for Lumped Element, locate the Settings section.

4 From the Lumped element device list, choose Capacitor.

5 In the Celement text field, type c_value.

Lumped Element 7
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Lumped Element.

2 Select Boundary 35 only.

3 In the Settings window for Lumped Element, locate the Settings section.

4 From the Lumped element device list, choose Capacitor.

5 In the Celement text field, type c_value.

Lumped Element 8
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Lumped Element.

2 Select Boundary 89 only.
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3 In the Settings window for Lumped Element, locate the Settings section.

4 From the Lumped element device list, choose Capacitor.

5 In the Celement text field, type c_value.

Lumped Element 9
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Lumped Element.

2 Select Boundary 99 only.

3 In the Settings window for Lumped Element, locate the Settings section.

4 From the Lumped element device list, choose Capacitor.

5 In the Celement text field, type c_value.

Lumped Element 10
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Lumped Element.

2 Select Boundary 94 only.

3 In the Settings window for Lumped Element, locate the Settings section.

4 From the Lumped element device list, choose Capacitor.

5 In the Celement text field, type c_value.

Lumped Element 11
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Lumped Element.

2 Select Boundary 84 only.

3 In the Settings window for Lumped Element, locate the Settings section.

4 From the Lumped element device list, choose Capacitor.

5 In the Celement text field, type c_value.

Lumped Element 12
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Lumped Element.

2 Select Boundary 30 only.

3 In the Settings window for Lumped Element, locate the Settings section.

4 From the Lumped element device list, choose Capacitor.

5 In the Celement text field, type c_value.
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Lumped Element 13
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Lumped Element.

2 Select Boundary 13 only.

3 In the Settings window for Lumped Element, locate the Settings section.

4 From the Lumped element device list, choose Capacitor.

5 In the Celement text field, type c_value.

Lumped Element 14
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Lumped Element.

2 Select Boundary 18 only.

3 In the Settings window for Lumped Element, locate the Settings section.

4 From the Lumped element device list, choose Capacitor.

5 In the Celement text field, type c_value.

Lumped Element 15
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Lumped Element.

2 Select Boundary 39 only.

3 In the Settings window for Lumped Element, locate the Settings section.

4 From the Lumped element device list, choose Capacitor.

5 In the Celement text field, type c_value.

Lumped Element 16
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Lumped Element.

2 Select Boundary 93 only.

3 In the Settings window for Lumped Element, locate the Settings section.

4 From the Lumped element device list, choose Capacitor.

5 In the Celement text field, type c_value.

Lumped Element 17
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Lumped Element.

2 Select Boundary 103 only.
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3 In the Settings window for Lumped Element, locate the Settings section.

4 From the Lumped element device list, choose Capacitor.

5 In the Celement text field, type c_value.

Lumped Element 18
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Lumped Element.

2 Select Boundary 98 only.

3 In the Settings window for Lumped Element, locate the Settings section.

4 From the Lumped element device list, choose Capacitor.

5 In the Celement text field, type c_value.

Lumped Element 19
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Lumped Element.

2 Select Boundary 88 only.

3 In the Settings window for Lumped Element, locate the Settings section.

4 From the Lumped element device list, choose Capacitor.

5 In the Celement text field, type c_value.

Lumped Element 20
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Lumped Element.

2 Select Boundary 34 only.

3 In the Settings window for Lumped Element, locate the Settings section.

4 From the Lumped element device list, choose Capacitor.

5 In the Celement text field, type c_value.

Lumped Element 21
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Lumped Element.

2 Select Boundary 17 only.

3 In the Settings window for Lumped Element, locate the Settings section.

4 From the Lumped element device list, choose Capacitor.

5 In the Celement text field, type c_value.
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Lumped Element 22
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Lumped Element.

2 Select Boundary 22 only.

3 In the Settings window for Lumped Element, locate the Settings section.

4 From the Lumped element device list, choose Capacitor.

5 In the Celement text field, type c_value.

Scattering Boundary Condition 1
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Scattering Boundary Condition.

2 In the Settings window for Scattering Boundary Condition, locate the Boundary Selection 
section.

3 From the Selection list, choose Absorbing boundaries.

S T U D Y  1

Add a parametric sweep for the capacitance of the lumped elements in the coil.

Parametric Sweep
1 On the Study toolbar, click Parametric Sweep.

2 In the Settings window for Parametric Sweep, locate the Study Settings section.

3 Click Add.

4 In the table, enter the following settings:

5 Click Range.

6 In the Range dialog box, type 20 in the Start text field.

7 In the Step text field, type 0.5.

8 In the Stop text field, type 30.

9 Click Replace.

10 In the Settings window for Parametric Sweep, locate the Study Settings section.

Parameter name Parameter value list Parameter unit

c_value
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11 In the table, enter the following settings:

12 On the Study toolbar, click Compute.

R E S U L T S

Electric Field (emw)
Click the Zoom Extents button on the Graphics toolbar.

Study 1/Solution 1 (sol1)
Add a selection for the domains around the phantom to visualize the fields.

1 In the Model Builder window, expand the Results>Data Sets node, then click Study 1/

Solution 1 (sol1).

Selection
1 On the Results toolbar, click Selection.

2 In the Settings window for Selection, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Domain.

4 Select Domains 3–6 only.

Add a slice plot for the magnetic field and arrow plots to view the direction of the magnetic 
field.

3D Plot Group 2
1 On the Results toolbar, click 3D Plot Group.

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Parameter value (c_value (pF)) list, choose 28.5.

4 On the 3D Plot Group 2 toolbar, click Slice.

Slice 1
1 In the Model Builder window, under Results>3D Plot Group 2 click Slice 1.

2 In the Settings window for Slice, locate the Plane Data section.

3 From the Plane list, choose XY-planes.

4 In the Planes text field, type 1.

Parameter name Parameter value list Parameter unit

c_value range(20,0.5,30) pF
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5 Click Replace Expression in the upper-right corner of the Expression section. From the 
menu, choose Component 1>Electromagnetic Waves, Frequency Domain>Magnetic>

emw.normB - Magnetic flux density norm.

6 On the 3D Plot Group 2 toolbar, click Arrow Volume.

Arrow Volume 1
1 In the Model Builder window, under Results>3D Plot Group 2 click Arrow Volume 1.

2 In the Settings window for Arrow Volume, click Replace Expression in the upper-right 
corner of the Expression section. From the menu, choose Component 1>

Electromagnetic Waves, Frequency Domain>Magnetic>emw.Bx,...,emw.Bz -

Magnetic flux density.

3 On the 3D Plot Group 2 toolbar, click Arrow Volume.

Arrow Volume 2
1 In the Model Builder window, under Results>3D Plot Group 2 click Arrow Volume 2.

2 In the Settings window for Arrow Volume, locate the Expression section.

3 In the X component text field, type imag(emw.Bx).

4 In the Y component text field, type imag(emw.By).

5 In the Z component text field, type imag(emw.Bz).

6 Locate the Coloring and Style section. From the Color list, choose Blue.

7 On the 3D Plot Group 2 toolbar, click Plot.

8 Click the Go to XY View button on the Graphics toolbar.

9 Click the Zoom Extents button on the Graphics toolbar.

The plot shows the homogeneous and circularly polarized magnetic field around the air 
phantom. It is plotted in Figure 2.

Global 1
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Model Builder window, right-click 1D Plot Group 3 and choose Global.

3 In the Settings window for Global, click Replace Expression in the upper-right corner of 
the y-axis data section. From the menu, choose Component 1>Definitions>Variables>

intBaxialratiodB - Integration of magnetic flux circularity around the phantom.

1D Plot Group 3
1 In the Model Builder window, under Results click 1D Plot Group 3.

2 On the 1D Plot Group 3 toolbar, click Plot.
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Global 1
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Model Builder window, right-click 1D Plot Group 4 and choose Global.

3 In the Settings window for Global, click Replace Expression in the upper-right corner of 
the y-axis data section. From the menu, choose Component 1>Definitions>Variables>

stdev - Standard deviation of E norm.

1D Plot Group 4
1 In the Model Builder window, under Results click 1D Plot Group 4.

2 On the 1D Plot Group 4 toolbar, click Plot.

It is obvious from the 1D plots that the optimum capacitance value for obtaining 
homogeneous magnetic field is around 28.5 pF. It is plotted in Figure 4 and Figure 5.

G L O B A L  D E F I N I T I O N S

Parameters
Now modify the capacitance of the lumped elements and rerun the model with the human 
head phantom.

1 In the Model Builder window, under Global Definitions click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

M A T E R I A L S

Material 2 (mat2)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 Select Domains 5 and 6 only.

3 In the Settings window for Material, locate the Material Contents section.

Name Expression Value Description

c_value 28.5[pF] 2.85E-11 F Capacitance used on the rungs
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4 In the table, enter the following settings:

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Preset Studies>

Frequency Domain.

4 Click Add Study in the window toolbar.

S T U D Y  2

Step 1: Frequency Domain
1 On the Home toolbar, click Add Study to close the Add Study window.

2 In the Model Builder window, under Study 2 click Step 1: Frequency Domain.

3 In the Settings window for Frequency Domain, locate the Study Settings section.

4 In the Frequencies text field, type 63.87[MHz].

5 On the Home toolbar, click Compute.

R E S U L T S

Study 2/Solution 2 (sol2)
In the Model Builder window, expand the Results>Data Sets node, then click Study 2/

Solution 2 (sol2).

Selection
1 On the Results toolbar, click Selection.

Add a selection for the domains around the phantom to visualize the fields.

2 In the Settings window for Selection, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Domain.

4 Select Domains 3–6 only.

Property Name Value Unit Property 
group

Relative permittivity epsilonr 40 1 Basic

Relative permeability mur 1 1 Basic

Electrical conductivity sigma 0.9 S/m Basic
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3D Plot Group 6
1 On the Results toolbar, click 3D Plot Group.

2 On the 3D Plot Group 6 toolbar, click Slice.

3D Plot Group 6
1 In the Model Builder window, under Results click 3D Plot Group 6.

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Data set list, choose Study 2/Solution 2 (sol2).

Slice 1
1 In the Model Builder window, under Results>3D Plot Group 6 click Slice 1.

2 In the Settings window for Slice, click Replace Expression in the upper-right corner of the 
Expression section. From the menu, choose Component 1>Electromagnetic Waves,

Frequency Domain>Magnetic>emw.normB - Magnetic flux density norm.

3 Locate the Plane Data section. From the Plane list, choose XY-planes.

4 In the Planes text field, type 1.

3D Plot Group 6
1 In the Model Builder window, under Results click 3D Plot Group 6.

2 On the 3D Plot Group 6 toolbar, click Arrow Volume.

Arrow Volume 1
1 In the Model Builder window, under Results>3D Plot Group 6 click Arrow Volume 1.

2 In the Settings window for Arrow Volume, click Replace Expression in the upper-right 
corner of the Expression section. From the menu, choose Component 1>

Electromagnetic Waves, Frequency Domain>Magnetic>emw.Bx,...,emw.Bz -

Magnetic flux density.

3D Plot Group 6
1 In the Model Builder window, under Results click 3D Plot Group 6.

2 On the 3D Plot Group 6 toolbar, click Arrow Volume.

Arrow Volume 2
1 In the Model Builder window, under Results>3D Plot Group 6 click Arrow Volume 2.

2 In the Settings window for Arrow Volume, locate the Expression section.

3 In the X component text field, type imag(emw.Bx).

4 In the Y component text field, type imag(emw.By).

5 In the Z component text field, type imag(emw.Bz).
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6 Locate the Coloring and Style section. From the Color list, choose Blue.

3D Plot Group 6
1 In the Model Builder window, under Results click 3D Plot Group 6.

2 On the 3D Plot Group 6 toolbar, click Plot.

The plot shows that the magnetic field is homogeneous and circularly polarized even 
when the coil is loaded with the human head phantom. It is plotted in Figure 3.

Global Evaluation 1
1 On the Results toolbar, click Global Evaluation.

Evaluate the axial ratio of the magnetic field and the standard deviation of the electric 
field with the human head phantom.

2 In the Settings window for Global Evaluation, locate the Data section.

3 From the Data set list, choose Study 2/Solution 2 (sol2).

4 Click Replace Expression in the upper-right corner of the Expressions section. From the 
menu, choose Component 1>Definitions>Variables>intBaxialratiodB -

Integration of magnetic flux circularity around the phantom.

5 Click Evaluate.

Global Evaluation 2
1 On the Results toolbar, click Global Evaluation.

2 In the Settings window for Global Evaluation, locate the Data section.

3 From the Data set list, choose Study 2/Solution 2 (sol2).

4 Click Replace Expression in the upper-right corner of the Expressions section. From the 
menu, choose Component 1>Definitions>Variables>stdev - Standard deviation of E norm.

5 Click Evaluate.

Appendix: Geometry Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 Click Done.
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G E O M E T R Y  1

Parameters
On the Home toolbar, click Parameters.

G L O B A L  D E F I N I T I O N S

Parameters
1 In the Settings window for Parameters, locate the Parameters section.

2 Click Load from File.

3 Browse to the model’s Application Libraries folder and double-click the file 
mri_coil_parameters.txt.

4 In the table, enter the following settings:

G E O M E T R Y  1

Cylinder 1 (cyl1)
1 On the Geometry toolbar, click Cylinder.

2 In the Settings window for Cylinder, locate the Size and Shape section.

3 In the Radius text field, type r_coil.

4 In the Height text field, type h_coil.

5 Locate the Position section. In the z text field, type -h_coil/2.

6 Click to expand the Layers section. In the table, enter the following settings:

7 Clear the Layers on side check box.

8 Select the Layers on bottom check box.

9 Select the Layers on top check box.

Work Plane 1 (wp1)
1 On the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 In the z-coordinate text field, type -h_coil/2+t_ring.

Name Expression Value Description

t_ring 0.015[m] 0.015 m

Layer name Thickness (m)

Layer 1 t_ring
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4 Click Show Work Plane.

Circle 1 (c1)
1 On the Work Plane toolbar, click Primitives and choose Circle.

2 In the Settings window for Circle, locate the Size and Shape section.

3 In the Radius text field, type r_coil.

4 In the Sector angle text field, type 6.

5 Locate the Rotation Angle section. In the Rotation text field, type -22.5.

Convert to Curve 1 (ccur1)
1 On the Work Plane toolbar, click Conversions and choose Convert to Curve.

2 Select the object c1 only.

3 Right-click Convert to Curve 1 (ccur1) and choose Build Selected.

4 On the Work Plane toolbar, click Delete.

Delete Entities 1 (del1)
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1>

Work Plane 1 (wp1)>Plane Geometry click Delete Entities 1 (del1).

2 In the Settings window for Delete Entities, locate the Entities or Objects to Delete section.

3 From the Geometric entity level list, choose Boundary.

4 Click the Zoom In button on the Graphics toolbar.

5 Click the Zoom In button on the Graphics toolbar.

6 On the object ccur1, select Boundaries 2 and 3 only.

7 In the Model Builder window, click Geometry 1.

Extrude 1 (ext1)
1 On the Geometry toolbar, click Extrude.

2 In the Settings window for Extrude, locate the General section.

3 From the Input object handling list, choose Keep.

4 Locate the Distances section. In the table, enter the following settings:

Extrude 2 (ext2)
1 On the Geometry toolbar, click Extrude.

2 In the Settings window for Extrude, locate the Distances section.

Distances (m)

h_coil-2*t_ring
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3 In the table, enter the following settings:

Move 1 (mov1)
1 On the Geometry toolbar, click Transforms and choose Move.

2 Select the object ext2 only.

3 In the Settings window for Move, locate the Displacement section.

4 In the z text field, type 0 (h_coil-2*t_ring)/2-l_element/2 (h_coil-2*
t_ring)-l_element.

Rotate 1 (rot1)
1 On the Geometry toolbar, click Transforms and choose Rotate.

2 Select the objects mov1(2), ext1, mov1(3), and mov1(1) only.

3 In the Settings window for Rotate, locate the Rotation Angle section.

4 In the Rotation text field, type 0 45 90 135 180 225 270 315.

5 On the Geometry toolbar, click Build All.

Convert to Surface 1 (csur1)
1 On the Geometry toolbar, click Conversions and choose Convert to Surface.

2 Click the Select Box button on the Graphics toolbar.

3 Click in the Graphics window and then press Ctrl+A to select all objects.

4 Right-click Convert to Surface 1 (csur1) and choose Build Selected.

5 On the Geometry toolbar, click Delete.

Delete Entities 1 (del1)
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 click 

Delete Entities 1 (del1).

2 In the Settings window for Delete Entities, locate the Entities or Objects to Delete section.

3 From the Geometric entity level list, choose Boundary.

4 Click the Wireframe Rendering button on the Graphics toolbar.

5 On the object csur1, select Boundaries 3–6, 9, 10, 21, 22, 33, 34, 36, 39, 51, 52, 63, 
and 64 only.

Cylinder 2 (cyl2)
1 On the Geometry toolbar, click Cylinder.

Distances (m)

l_element
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2 In the Settings window for Cylinder, locate the Size and Shape section.

3 In the Radius text field, type 0.15.

4 In the Height text field, type h_coil.

5 Locate the Position section. In the z text field, type -h_coil/2.

6 Click to expand the Layers section. In the table, enter the following settings:

7 Clear the Layers on side check box.

8 Select the Layers on top check box.

Cylinder 3 (cyl3)
1 On the Geometry toolbar, click Cylinder.

2 In the Settings window for Cylinder, locate the Size and Shape section.

3 In the Radius text field, type r_coil+0.1.

4 In the Height text field, type h_coil+0.1.

5 Locate the Position section. In the z text field, type -(h_coil+0.1)/2.

Sphere 1 (sph1)
1 On the Geometry toolbar, click Sphere.

2 In the Settings window for Sphere, locate the Size section.

3 In the Radius text field, type 0.5.

4 On the Geometry toolbar, click Build All.

Layer name Thickness (m)

Layer 1 h_coil/2
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This example analyzes the transfer function of a low-pass filter on a printed circuit board.

Introduction

Microstrip filters can be fabricated directly on a printed circuit board (PCB) with a 
microstrip line going from the input to the output. Along the microstrip line there are a 
number of stubs of certain lengths and widths. The design of the filter involves choosing 
the impedance of the microstrip line, the impedance of the stub microstrips, and the stub 
lengths. This particular filter is based on a textbook example from Ref. 2. It is also used as 
example in Ref. 1, which contains results from other simulation tools and methods and is 
freely available online. The filter has a seven-pole low-pass Chebyshev response with a 
cutoff frequency of 1 GHz.

Model Definition

The model uses the Electromagnetic Waves interface that solves the vector Helmholtz 
wave equation. The cutoff frequency of the filter is 1 GHz by design, and the dielectric 
layer of the PCB has a relative permittivity of 10.8. The metal layers are modeled as perfect 
electric conductors with zero thickness, thereby avoiding a dense meshing of thin 
conductive layers. The width of the microstrip line is 0.1 mm and the width of the stubs 
is 5 mm.

The characteristics of the filter are sensitive to the placement and length of the stubs; 
therefore this example also analyzes the change in filter characteristics as a function of 
mechanical deformation. This is done by adding Solid Mechanics and Moving Mesh 
interfaces. The Moving Mesh interface is necessary to enable the Electromagnetic Waves 
interface to account for the deformation of the PCB. The deformation comes from a 
uniform load across the board with fixed input and output faces.

Because the filter cutoff should be close to 1 GHz, the frequency is swept from 750 MHz 
up to 1.5 GHz. The first solution step performs this sweep for the Electromagnetic Waves 
interface without any mechanical deformation. Then a uniform load of 40 N is applied to 
the PCB, generating a large deformation of the board. The Solid Mechanics interface 
calculates the deformation, and the Moving Mesh interface applies this deformation to the 
coordinate system that the Electromagnetic Waves interface uses. After this step, the 
frequency sweep is performed again for the Electromagnetic Waves interface using the 
parametric solver.
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This example accounts for the structural deformation in the sense that it solves for the 
electromagnetic fields on the deformed geometry, as if the PCB was manufactured in the 
deformed shape—free of stress.

Results and Discussion

The purpose of this simulation is to analyze how the S-parameter curve changes when a 
force of 40 N is applied on the circuit board. This force bends the PCB significantly, as you 
can see in Figure 1.

Figure 1: The graph shows the total displacement of the PCB, due to the load.

Although the PCB deformation is fairly large the S-parameter curve does not change that 
much. The cutoff frequency is shifted less than 10 MHz when the force is applied. 
Figure 2 displays the difference between the S-parameter curves with and without an 
3 |  M I C R O W A V E  F I L T E R  O N  P C B



applied force.

Figure 2: A comparison between the S11 and S21 parameters before and after a force of 40 N 
has been applied on the PCB. The red and turquoise lines correspond to the S-parameter curves 
for the filter with an applied force.
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Application Library path: RF_Module/Filters/
pcb_microwave_filter_with_stress

Modeling Instructions

From the File menu, choose New.
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N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Radio Frequency>Electromagnetic Waves,

Frequency Domain (emw).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Frequency Domain.

6 Click Done.

G L O B A L  D E F I N I T I O N S

The following steps define the parameters for the frequency sweep.

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

G E O M E T R Y  1

Set mm as the default unit for length.

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose mm.

Block 1 (blk1)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, locate the Size and Shape section.

3 In the Width text field, type 89.49.

4 In the Depth text field, type 29.54.

Name Expression Value Description

fstart 750[MHz] 7.5E8 Hz Start frequency

fstop 1.5[GHz] 1.5E9 Hz Stop frequency

fstep 50[MHz] 5E7 Hz Frequency step
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5 In the Height text field, type 1.27.

6 Locate the Position section. In the y text field, type -10.

7 Click Build Selected.

8 Click the Wireframe Rendering button on the Graphics toolbar.

Work Plane 1 (wp1)
1 On the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 In the z-coordinate text field, type 1.27.

Plane Geometry
In the Model Builder window, under Component 1 (comp1)>Geometry 1>

Work Plane 1 (wp1) click Plane Geometry.

Rectangle 1 (r1)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 13.88.

4 In the Height text field, type 1.125.

Rectangle 2 (r2)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 5.

4 In the Height text field, type 5.86.

5 Locate the Position section. In the xw text field, type 13.88.

Rectangle 3 (r3)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 13.32.

4 In the Height text field, type 0.1.

5 Locate the Position section. In the xw text field, type 18.88.

Rectangle 4 (r4)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.
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3 In the Width text field, type 5.

4 In the Height text field, type 9.54.

5 Locate the Position section. In the xw text field, type 32.2.

Rectangle 5 (r5)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 15.09.

4 In the Height text field, type 0.1.

5 Locate the Position section. In the xw text field, type 37.2.

Mirror 1 (mir1)
1 On the Work Plane toolbar, click Transforms and choose Mirror.

2 Select the objects r2, r4, r1, and r3 only.

3 In the Settings window for Mirror, locate the Input section.

4 Select the Keep input objects check box.

5 Locate the Point on Line of Reflection section. In the xw text field, type 44.745.

Union 1 (uni1)
1 On the Work Plane toolbar, click Booleans and Partitions and choose Union.

2 Click in the Graphics window and then press Ctrl+A to select all objects.

3 In the Settings window for Union, locate the Union section.

4 Clear the Keep interior boundaries check box.

5 Click Build Selected.

6 In the Model Builder window, click Geometry 1.

Work Plane 2 (wp2)
1 On the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 In the z-coordinate text field, type 1.27.

Plane Geometry
In the Model Builder window, under Component 1 (comp1)>Geometry 1>

Work Plane 2 (wp2) click Plane Geometry.

Bézier Polygon 1 (b1)
1 On the Work Plane toolbar, click Primitives and choose Bézier Polygon.
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2 In the Settings window for Bézier Polygon, locate the Polygon Segments section.

3 Find the Added segments subsection. Click Add Linear.

4 Find the Control points subsection. In row 1, set yw to 1.125.

Mirror 1 (mir1)
1 On the Work Plane toolbar, click Transforms and choose Mirror.

2 Select the object b1 only.

3 In the Settings window for Mirror, locate the Input section.

4 Select the Keep input objects check box.

5 Locate the Point on Line of Reflection section. In the xw text field, type 44.745.

6 Click Build Selected.

The next step is to add boundary faces for the input and output ports by extruding the 
lines.

7 In the Model Builder window, click Geometry 1.

Extrude 1 (ext1)
1 On the Geometry toolbar, click Extrude.

2 In the Settings window for Extrude, locate the Distances section.

3 In the table, enter the following settings:

Block 2 (blk2)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, locate the Size and Shape section.

3 In the Width text field, type 100.

4 In the Depth text field, type 40.

5 In the Height text field, type 15.

6 Locate the Position section. In the x text field, type -5.

7 In the y text field, type -15.

8 In the z text field, type -10.

9 On the Geometry toolbar, click Build All.

Distances (mm)

-1.27
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A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Built-In>Air.

4 Click Add to Component in the window toolbar.

A D D  M A T E R I A L

1 Go to the Add Material window.

2 In the tree, select Built-In>FR4 (Circuit Board).

3 Click Add to Component in the window toolbar.

M A T E R I A L S

FR4 (Circuit Board) (mat2)
1 In the Model Builder window, under Component 1 (comp1)>Materials click 

FR4 (Circuit Board) (mat2).

2 Select Domain 2 only.

The relative permittivity is modified to agree with the value used in Ref. 1. The FR4 
material is selected to provide parameters for the solid mechanics simulation.

3 In the Settings window for Material, locate the Material Contents section.

4 In the table, enter the following settings:

5 On the Home toolbar, click Add Material to close the Add Material window.

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

Scattering Boundary Condition 1
1 In the Model Builder window, under Component 1 (comp1) right-click 

Electromagnetic Waves, Frequency Domain (emw) and choose 
Scattering Boundary Condition.

2 Select Boundaries 1–5 and 18 only.

Property Name Value Unit Property 
group

Relative permittivity epsilonr 10.8 1 Basic
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Lumped Port 1
1 In the Model Builder window, right-click Electromagnetic Waves,

Frequency Domain (emw) and choose Lumped Port.

2 Select Boundary 10 only.

For the first port, wave excitation is on by default. This port excites the microstrip line.

Lumped Port 2
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Lumped Port.

2 Select Boundary 16 only.

Perfect Electric Conductor 2
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Perfect Electric Conductor.

2 Select Boundaries 8 and 11 only.

These boundaries represent the microstrip line and the ground plane on the PCB.

M E S H  1

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.

2 In the Settings window for Mesh, click Build All.

D E F I N I T I O N S

Probe plotting is a convenient technique to plot while solving, which is very useful for 
parameter sweeps. It is possible to discover problems before the solution step has finished, 
and then stop the sweep to save time. It is also useful in situations when the solver does 
more steps than it stores in the output. The probe plot will contain all steps that the solver 
takes.

1 In the Model Builder window, under Component 1 (comp1) right-click Definitions and 
choose Global Variable Probe.

2 In the Settings window for Global Variable Probe, type S11 in the Variable name text field.

3 Locate the Expression section. Click emw.S11dB - S11 in the upper-right corner of the 
section. In the Model Builder window, right-click Definitions and choose 
Global Variable Probe.

4 In the Settings window for Global Variable Probe, type S21 in the Variable name text field.

5 Locate the Expression section. Click emw.S21dB - S21 in the upper-right corner of the 
section.
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S T U D Y  1

Step 1: Frequency Domain
1 In the Model Builder window, under Study 1 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, click to expand the Results while solving 
section.

3 Locate the Results While Solving section. Select the Plot check box.

4 Locate the Study Settings section. Click Range.

5 In the Range dialog box, type fstart in the Start text field.

6 In the Step text field, type fstep.

7 In the Stop text field, type fstop.

8 Click Replace.

9 On the Home toolbar, click Compute.

R E S U L T S

Electric Field (emw)
The Electric Field plot group under the Results node, shows the norm of the electric field. 
You can change the frequency by selecting another value from the Parameter value (freq) 
list box.

The Probe 1D Plot Group 2 displays the S11- and S21-parameters for the frequency sweep.

C O M P O N E N T  1  ( C O M P 1 )

The following instructions adds physics from the Solid Mechanics and the Moving Mesh 
interfaces for the simulations of the deformed PCB.

A D D  P H Y S I C S

1 On the Home toolbar, click Add Physics to open the Add Physics window.

2 Go to the Add Physics window.

3 In the tree, select Structural Mechanics>Solid Mechanics (solid).

4 Click Add to Component in the window toolbar.

A D D  P H Y S I C S

1 Go to the Add Physics window.

2 In the tree, select Mathematics>Deformed Mesh>Moving Mesh (ale).

3 Click Add to Component in the window toolbar.
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4 On the Home toolbar, click Add Physics to close the Add Physics window.

S O L I D  M E C H A N I C S  ( S O L I D )

1 In the Model Builder window, under Component 1 (comp1) click Solid Mechanics (solid).

2 Select Domain 2 only.

G L O B A L  D E F I N I T I O N S

Parameters
1 In the Model Builder window, under Global Definitions click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

The following steps describe how to measure the volume of the PCB and then copy and 
paste the value in a parameter definition.

G E O M E T R Y  1

1 Click the Select Domains button on the Graphics toolbar.

2 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

3 On the object fin, select Domain 2 only.

Name Expression Value Description

fload 40[N] 40 N Load on PCB
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4 On the Geometry toolbar, click Measure.

Click the Measure button from the toolbar. The volume of the PCB domain is displayed 
in the Messages window.

Copy the volume of the PCB from the Messages table.

G L O B A L  D E F I N I T I O N S

Parameters
(by pasting in the previously copied volume)

1 In the Model Builder window, under Global Definitions click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

M OV I N G  M E S H  ( A L E )

On the Physics toolbar, click Solid Mechanics (solid) and choose Moving Mesh (ale).

In the Model Builder window, expand the Component 1 (comp1)>Moving Mesh (ale) node.

Prescribed Deformation 1
1 Right-click Moving Mesh (ale) and choose Prescribed Deformation.

2 Select Domain 2 only.

3 In the Settings window for Prescribed Deformation, locate the 
Prescribed Mesh Displacement section.

4 In the dx text-field array, type u on the first row.

5 In the dy text-field array, type v on the second row.

6 In the dz text-field array, type w on the third row.

Free Deformation 1
1 Right-click Moving Mesh (ale) and choose Free Deformation.

2 Select Domain 1 only.

Prescribed Mesh Displacement 2
1 Right-click Moving Mesh (ale) and choose Prescribed Mesh Displacement.

2 In the Settings window for Prescribed Mesh Displacement, locate the Boundary Selection 
section.

Name Expression Value Description

V 3357.0[mm^3] 3.357E-6 m³ Volume of PCB
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3 From the Selection list, choose All boundaries.

4 Select Boundaries 6–17 only.

5 Locate the Prescribed Mesh Displacement section. In the dx text field, type u.

6 In the dy text field, type v.

7 In the dz text field, type w.

S O L I D  M E C H A N I C S  ( S O L I D )

Body Load 1
1 In the Model Builder window, under Component 1 (comp1) right-click 

Solid Mechanics (solid) and choose Volume Forces>Body Load.

2 Select Domain 2 only.

3 In the Settings window for Body Load, locate the Force section.

4 Specify the FV vector as

Fixed Constraint 1
1 In the Model Builder window, right-click Solid Mechanics (solid) and choose 

Fixed Constraint.

2 Select Boundaries 6, 10, 12, and 15–17 only.

S T U D Y  1

Step 1: Frequency Domain
1 In the Model Builder window, under Study 1 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Physics and Variables Selection 
section.

3 In the table, clear the Solve for check box for Solid Mechanics and Moving Mesh.

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Custom Studies>

Preset Studies for Some Physics Interfaces>Stationary.

0 x

0 y

-fload/V z
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4 Find the Physics interfaces in study subsection. In the table, clear the Solve check box for 
Electromagnetic Waves, Frequency Domain (emw).

5 Click Add Study in the window toolbar.

6 On the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  2

Step 2: Frequency Domain
1 On the Study toolbar, click Study Steps and choose Frequency Domain>

Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Physics and Variables Selection 
section.

3 In the table, clear the Solve for check box for Solid Mechanics and Moving Mesh.

4 Locate the Study Settings section. Click Range.

5 In the Range dialog box, type fstart in the Start text field.

6 In the Step text field, type fstep.

7 In the Stop text field, type fstop.

8 Click Replace.

9 In the Settings window for Frequency Domain, locate the Results While Solving section.

10 Select the Plot check box.

11 From the Plot group list, choose S-Parameter (emw).

12 On the Study toolbar, click Compute.

R E S U L T S

Electric Field (emw) 1
The default plot shows a Multislice plot of the norm of the electric field for the last 
frequency in the sweep. The plot can be updated for any of the frequencies used, by 
selecting another frequency from the Parameter value (freq) list box.

S-Parameter (emw) 1
To compare the S-parameters for the initial and the stressed PCB, add the S-parameter 
from the first different solutions.

Global 1
In the Model Builder window, expand the S-Parameter (emw) 1 node.
15 |  M I C R O W A V E  F I L T E R  O N  P C B



Global 2
1 Right-click Global 1 and choose Duplicate.

2 In the Settings window for Global, locate the Data section.

3 From the Data set list, choose Study 1/Solution 1 (sol1).

4 Locate the y-Axis Data section. In the table, enter the following settings:

5 On the S-Parameter (emw) 1 toolbar, click Plot.

You should now see the plot in Figure 2.

Stress (solid)
In the Model Builder window, expand the Results>Stress (solid) node.

Deformation
You may expand all subnodes under Results>Stress (solid) to reach Deformation.

1 In the Model Builder window, expand the Results>Stress (solid)>Surface 1 node.

2 Right-click Deformation and choose Disable.

Surface 1
1 In the Model Builder window, under Results>Stress (solid) click Surface 1.

2 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 1>Solid Mechanics>

Displacement>solid.disp - Total displacement.

Stress (solid)
1 In the Model Builder window, under Results click Stress (solid).

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Data set list, choose Study 2/Solution Store 1 (sol3).

4 Locate the Plot Settings section. From the Frame list, choose Spatial (x, y, z).

5 On the Stress (solid) toolbar, click Plot.

You should now see the plot in Figure 1.

Expression Unit Description

emw.S11dB dB S11 without deformation

emw.S21dB dB S21 without deformation
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Introduction

This example of a circular waveguide demonstrates how to excite and terminate ports with 
degenerate port modes. In particular it shows how to model and excite the TE11 mode of 
circular waveguides in 3D.

Model Definition

A straight piece of circular waveguide with perfect metallic walls is excited by a linearly 
polarized TE11 mode at one end and ideally terminated at the other end.

The TE11 mode of a circular waveguide is degenerate, meaning that there is an infinite 
number of possible variants of the TE11 mode that only differ in polarization. Any type of 
polarization (for example circular polarization) of the TE11 mode can be constructed by 
or decomposed into two linearly polarized modes. The direction of polarization of the first 
one can be chosen freely and the second one is obtained from the first one by a rotation 
of 90 degrees around the waveguide axis. 

As a general structure may change the polarization of the incident field as it is transmitted 
or reflected, ideal termination means that any circular waveguide port that operates in the 
TE11 mode need to have two port features which are tuned to mutually orthogonal, linear 
polarizations of the TE11 mode respectively. The reference directions for the two port 
features are subject to a manual choice but must differ by a rotation of 90 degrees around 
the waveguide axis.

The Port subfeature, Circular Port Reference Axis is used to determine the reference 
direction for the polarization of each mode/port by means of selecting two vertices 
(points) on the port circumference. In this example, extra vertices that are equally 
distributed along the port edge are added to the geometry to allow for the definition of 
the desired reference directions.

With the stipulated excitation using the two mutually orthogonal TE11 ports as boundary 
conditions, the following equation is solved for the electric field vector E inside the 
waveguide:

μr
1– E∇×( )∇× k0

2 εr
jσ

ωε0
---------– 

 E– 0=
2 |  P O L A R I Z E D  C I R C U L A R  P O R T S



Results and Discussion

The first TE11 mode of the inport is shown in Figure 1.

Figure 1: The first TE11 mode of the inport 

Note: Depending on the details of the mesh, which in turn may depend on the origin of 
the CAD geometry, a mode that is rotated 180 degrees may be found.
3 |  P O L A R I Z E D  C I R C U L A R  P O R T S



The first TE11 mode of the outport is shown in Figure 2.

Figure 2: The first TE11 mode of the outport.

Note: Depending on the details of the mesh, which in turn may depend on the origin of 
the CAD geometry, a mode that is rotated 180 degrees may be found.
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The transmission coefficients between the inport and outport modes are shown in 
Figure 3.

Figure 3: The transmission coefficients between inport modes and outport modes are plotted as 
a function of frequency. As the port modes are misaligned by 45 degrees the transmission 
coefficients approach the -3dB level.

Application Library path: RF_Module/Tutorials/polarized_circular_ports

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.
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2 In the Select Physics tree, select Radio Frequency>Electromagnetic Waves,

Frequency Domain (emw).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Frequency Domain.

6 Click Done.

G L O B A L  D E F I N I T I O N S

Add a parameter for the operating frequency.

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

S T U D Y  1

Step 1: Frequency Domain
1 In the Model Builder window, under Study 1 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 In the Frequencies text field, type range(0.9*frq,(1.5*frq-(0.9*frq))/10,1.5*
frq).

G E O M E T R Y  1

The geometry is essentially a cylinder.

Cylinder 1 (cyl1)
1 On the Geometry toolbar, click Cylinder.

2 In the Settings window for Cylinder, locate the Size and Shape section.

3 In the Radius text field, type 0.01.

4 In the Height text field, type 0.1.

Name Expression Value Description

frq c_const/0.03[m] 9.993E9 1/s Operating frequency
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5 Click Build Selected.

6 Click the Wireframe Rendering button on the Graphics toolbar.

You need to add a reference direction for the port polarization. Add a couple of lines on 
the cylinder end to generate extra vertices. This is done in a work plane.

Work Plane 1 (wp1)
1 On the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 In the z-coordinate text field, type 0.1.

Plane Geometry
In the Model Builder window, under Component 1 (comp1)>Geometry 1>

Work Plane 1 (wp1) click Plane Geometry.

Bézier Polygon 1 (b1)
1 On the Work Plane toolbar, click Primitives and choose Bézier Polygon.

2 In the Settings window for Bézier Polygon, locate the Polygon Segments section.

3 Find the Added segments subsection. Click Add Linear.

4 Find the Control points subsection. In row 1, set yw to 0.01.

5 In row 2, set yw to -0.01.

Rotate 1 (rot1)
1 On the Work Plane toolbar, click Transforms and choose Rotate.
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2 Select the object b1 only.

3 In the Settings window for Rotate, locate the Rotation Angle section.

4 In the Rotation text field, type 45 135.

5 Click Build Selected.

6 In the Model Builder window, click Geometry 1.

Ignore Edges 1 (ige1)
1 On the Geometry toolbar, click Virtual Operations and choose Ignore Edges.
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2 On the object fin, select Edges 7, 8, 13, and 14 only.

3 In the Settings window for Ignore Edges, locate the Input section.

4 Clear the Ignore adjacent vertices check box.

5 On the Geometry toolbar, click Build All.

M A T E R I A L S

Next, add a material for the interior (air) of the waveguide.

Material 1 (mat1)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, locate the Material Contents section.

3 In the table, enter the following settings:

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

Set up one inport and three outports.

Property Name Value Unit Property 
group

Relative permittivity epsilonr 1 1 Basic

Relative permeability mur 1 1 Basic

Electrical conductivity sigma 0 S/m Basic
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Port 1
1 In the Model Builder window, under Component 1 (comp1) right-click 

Electromagnetic Waves, Frequency Domain (emw) and choose Port.

2 Select Boundary 3 only.

3 In the Settings window for Port, locate the Port Properties section.

4 From the Type of port list, choose Circular.

Circular Port Reference Axis 1
1 Right-click Component 1 (comp1)>Electromagnetic Waves, Frequency Domain (emw)>

Port 1 and choose Circular Port Reference Axis.

2 In the Settings window for Circular Port Reference Axis, locate the Point Selection section.

3 Click Clear Selection.

4 Select Points 5 and 8 only.

Port 2
1 In the Model Builder window, right-click Electromagnetic Waves,

Frequency Domain (emw) and choose Port.

2 Select Boundary 3 only.

3 In the Settings window for Port, locate the Port Properties section.

4 From the Type of port list, choose Circular.
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Circular Port Reference Axis 1
1 Right-click Component 1 (comp1)>Electromagnetic Waves, Frequency Domain (emw)>

Port 2 and choose Circular Port Reference Axis.

2 In the Settings window for Circular Port Reference Axis, locate the Point Selection section.

3 Click Clear Selection.

4 Select Points 1 and 12 only.

Port 3
1 In the Model Builder window, right-click Electromagnetic Waves,

Frequency Domain (emw) and choose Port.

2 Select Boundary 4 only.

3 In the Settings window for Port, locate the Port Properties section.

4 From the Type of port list, choose Circular.

Circular Port Reference Axis 1
1 Right-click Component 1 (comp1)>Electromagnetic Waves, Frequency Domain (emw)>

Port 3 and choose Circular Port Reference Axis.

2 In the Settings window for Circular Port Reference Axis, locate the Point Selection section.

3 Click Clear Selection.
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4 Select Points 4 and 10 only.

Port 4
1 In the Model Builder window, right-click Electromagnetic Waves,

Frequency Domain (emw) and choose Port.

2 Select Boundary 4 only.

3 In the Settings window for Port, locate the Port Properties section.

4 From the Type of port list, choose Circular.

Circular Port Reference Axis 1
1 Right-click Component 1 (comp1)>Electromagnetic Waves, Frequency Domain (emw)>

Port 4 and choose Circular Port Reference Axis.

2 In the Settings window for Circular Port Reference Axis, locate the Point Selection section.

3 Click Clear Selection.
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4 Select Points 3 and 11 only.

M E S H  1

In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 
Build All.
13 |  P O L A R I Z E D  C I R C U L A R  P O R T S



S T U D Y  1

Step 1: Frequency Domain
On the Home toolbar, click Compute.

R E S U L T S

Electric Field (emw)
Inspect the electric field norm.

Next, inspect the S-parameters representing transmission.

S-Parameter (emw)
As expected, the transmitted energy is evenly divided between the outport modes 
(Figure 3).
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Smith Plot (emw)

3D Plot Group 4
1 On the Home toolbar, click Add Plot Group and choose 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Port 1 in the Label text field.

Surface 1
1 Right-click Port 1 and choose Surface.

2 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 1>Electromagnetic Waves,

Frequency Domain>Ports>emw.normtEmode_1 - Port tangential electric mode field norm.

Arrow Surface 1
1 In the Model Builder window, under Results right-click Port 1 and choose Arrow Surface.

2 In the Settings window for Arrow Surface, click Replace Expression in the upper-right 
corner of the Expression section. From the menu, choose Component 1>

Electromagnetic Waves, Frequency Domain>Ports>emw.tEmodex_1,...,emw.tEmodez_1 -

Port tangential electric mode field.

3 Locate the Coloring and Style section. In the Number of arrows text field, type 1000.

4 From the Color list, choose Black.

5 On the Port 1 toolbar, click Plot.
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6 Click Plot.

Port 1.1
1 Right-click Port 1 and choose Duplicate.

2 In the Settings window for 3D Plot Group, type Port 2 in the Label text field.

Surface 1
1 In the Model Builder window, expand the Results>Port 2 node, then click Surface 1.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type emw.normtEmode_2.

Arrow Surface 1
1 In the Model Builder window, under Results>Port 2 click Arrow Surface 1.

2 In the Settings window for Arrow Surface, locate the Expression section.

3 In the X component text field, type emw.tEmodex_2.

4 In the Y component text field, type emw.tEmodey_2.

5 In the Z component text field, type emw.tEmodez_2.
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6 On the Port 2 toolbar, click Plot.

Port 2.1
1 In the Model Builder window, under Results right-click Port 2 and choose Duplicate.

2 In the Settings window for 3D Plot Group, type Port 3 in the Label text field.

Surface 1
1 In the Model Builder window, expand the Results>Port 3 node, then click Surface 1.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type emw.normtEmode_3.

Arrow Surface 1
1 In the Model Builder window, under Results>Port 3 click Arrow Surface 1.

2 In the Settings window for Arrow Surface, locate the Expression section.

3 In the X component text field, type emw.tEmodex_3.

4 In the Y component text field, type emw.tEmodey_3.

5 In the Z component text field, type emw.tEmodez_3.
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6 On the Port 3 toolbar, click Plot.

Port 3.1
1 In the Model Builder window, under Results right-click Port 3 and choose Duplicate.

2 In the Settings window for 3D Plot Group, type Port 4 in the Label text field.

Surface 1
1 In the Model Builder window, expand the Results>Port 4 node, then click Surface 1.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type emw.normtEmode_4.

Arrow Surface 1
1 In the Model Builder window, under Results>Port 4 click Arrow Surface 1.

2 In the Settings window for Arrow Surface, locate the Expression section.

3 In the X component text field, type emw.tEmodex_4.

4 In the Y component text field, type emw.tEmodey_4.

5 In the Z component text field, type emw.tEmodez_4.
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6 On the Port 4 toolbar, click Plot.

Derived Values
Next, display numerical values for the transmission at the highest frequency.

Global Evaluation 1
1 On the Results toolbar, click Global Evaluation.

2 In the Settings window for Global Evaluation, locate the Data section.

3 From the Parameter selection (freq) list, choose Last.

4 Click Replace Expression in the upper-right corner of the Expressions section. From the 
menu, choose Component 1>Electromagnetic Waves, Frequency Domain>Ports>S-

parameter, dB>emw.S31dB - S31.

5 Click Evaluate.

Global Evaluation 2
1 On the Results toolbar, click Global Evaluation.

2 In the Settings window for Global Evaluation, locate the Data section.

3 From the Parameter selection (freq) list, choose Last.
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4 Click Replace Expression in the upper-right corner of the Expressions section. From the 
menu, choose Component 1>Electromagnetic Waves, Frequency Domain>Ports>S-

parameter, dB>emw.S41dB - S41.

5 Click Evaluate.

As expected, the result is about -3 dB for both modes.
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Introduction

This tutorial model demonstrates the use of a background field in an electromagnetic 
scattering problem. Although this example is a boat hit by a radar, this same technique can 
be used in any situation where an isolated object meets electromagnetic waves from a 
distant source. For example, several orders of magnitude smaller, an equally common 
application is plasmon resonant nanoparticles. Besides setting up the background field and 
sweeping it over a range of angles of incidence, this example also shows you how to 
compute the far-field and the radar cross section (RCS).

Model Definition

This example computes the interaction between a boat and the incident field from a radar 
transmitter. The transmitter is considered to be distant enough that this field can be 
treated as a plane wave. This makes it possible to exclude the transmitter from the model 
geometry and look only at the boat and its immediate surroundings.

Although the modeling procedure is similar in 3D, this example is in 2D to quickly set up 
and solve. In order to focus on the concepts, the geometry is intentionally kept very simple 
(see Figure 1).
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Figure 1: The model geometry. The boat has a length of 14 m and is surrounded by air - the 
cut plane lies above the water surface.

The inner circle in the geometry represents air surrounding the boat. The outer circle is a 
Perfectly Matched Layer (PML) which minimizes unphysical reflections of the scattered 
wave as it leaves the model domain. The radius of the inner circle is an important model 
consideration. To get good results, the inner circle needs to completely surround the boat. 
It also must extend to a considerable fraction of the wavelength, as well as the characteristic 
length of the evanescent wave outside it. However, in practice, and in order to minimize 
time and memory usage, do not make the circle too large. For the purpose of this example, 
the inner circle is bigger than necessary to provide a good view of the near field. The radius 
of the outer circle does not matter as long as it allows for the meshing needs of the PML, 
which is 5–6 mesh elements across. 

The background electromagnetic field from the radar is described by its out-of-plane 
electric field component:

In this equation:

• j is the imaginary unit;

Eb jk0 x φcos y φsin+( )( )ezexp=
3 |  R A D A R  C R O S S  S E C T I O N



• k0 = 2πf/c is the wave number in vacuum;

• c = 3·108 m/s is the speed of light; 

• f = 100 MHz is the frequency; 

•  is the angle of incidence; and

•  corresponds to a wave incident from the positive x direction (and hence 
propagating in the negative x direction, from the right to the left in the model). 

The time-harmonic wave equation is then solved for the relative field, Erel = E − Eb, 
where E is the total, measurable field.

The relative field is the difference between the measured field caused by the presence of 
the boat and the background field. It is utilized to describe how detectable the boat is with 
the radar - its RCS. The RCS of a 3D scatterer is defined as

For the 2D scatterer in this example, the RCS per unit length is used to address its 
monostatic scattering characteristics at the angle where the incident wave comes from, 
which is given by

where the relative field as a function of radius is calculated with the help of COMSOL’s 
built-in far-field computation, Efar. The RCS of a 3D model which has a constant 
geometrical cross-section of a 2D model can also be estimated from the RCS per unit 
length by

where l is the length of a scatterer and λ is the wavelength.

φ

φ 0=

∇ μr
1– ∇ Erel×( )× εr j σ

ωε0
---------– 

 k0
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2

-------------
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lim=
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Results and Discussion

Using a parametric solver, the results are for the full range of angles of incidence, from 0 
to 359 degrees in 1 degree steps. Figure 2 shows the norm of the total field caused by a 
background plane wave incident from a 30-degree angle. The reflections on the boat 
create a standing wave pattern. The boat casts a shadow on the lower left side. 

Figure 2: The total field norm for a 30 degree angle of incidence. The arrow represents the 
propagation direction of the incident background field.

You can also visualize the relative field sent out from the boat. Figure 3 shows both its 
instantaneous value at a zero phase and its norm. Note that the lack of standing waves in 
the latter indicates that the PML does its job of absorbing the outgoing field without any 
reflections.
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Figure 3: The instantaneous value (top) and magnitude (bottom) of the relative electric field 
sent out by the boat for a 30-degree angle of incidence.
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As shown in these near field plots, you can guess that a distant observer would see peaks 
in the relative field centered around 150 and 210 degrees. This is confirmed by the far-
field plot in Figure 4. The far-field computation uses the Stratton-Chu formula (see Radar 
Cross Section in the RF Module User’s Guide) with the relative electric field on the 
boundaries of the boat as the input. Note that the relative field is the only component for 
which it makes sense to evaluate the far field. While the relative field falls off with the 
distance from the boat, the incident field amplitude remains constant. Hence the total field 
is non-trivial only at finite distances from the boat.

Figure 4: Far-field radiation plot for a 30-degree angle of incidence. The distance to the center 
represents the far field in dB.

Figure 5 shows the RCS per unit length. Compared to the other plots, which show various 
aspects of the fields for a specific angle of incidence, this output is generally only possible 
by solving for the complete range of angles, from 0 to 360 degrees. In this example, one 
could have avoided solving for half of this range by noting that because of the geometry 
symmetry, the results in the upper and lower half-plane are identical.

Except for the symmetry, a main feature of the RCS per unit length plot is the prominent 
peak at 90 degrees, due to the flat side of the boat. If the radar is in this direction, much 
of the field that hits the boat reflects back towards it. The peak around 135 degrees is 
explained similarly, but the side of the bow replaces the side of the boat. This peak is lower 
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and wider because the boundary is shorter and slightly bent. There is a dip at 180 degrees 
because most of the field that hits the bow from a straight angle reflects to the sides.

Figure 5: Polar plot of the RCS per unit length as a function of the angle of incidence.

Application Library path: RF_Module/Scattering_and_RCS/radar_cross_section

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 2D.

2 In the Select Physics tree, select Radio Frequency>Electromagnetic Waves,

Frequency Domain (emw).

3 Click Add.
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4 Click Study.

5 In the Select Study tree, select Preset Studies>Frequency Domain.

6 Click Done.

S T U D Y  1

Step 1: Frequency Domain
1 In the Model Builder window, under Study 1 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 In the Frequencies text field, type 100[MHz].

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

G E O M E T R Y  1

Circle 1 (c1)
1 On the Geometry toolbar, click Primitives and choose Circle.

2 In the Settings window for Circle, locate the Size and Shape section.

3 In the Radius text field, type 15.

4 Click to expand the Layers section. In the table, enter the following settings:

Rectangle 1 (r1)
1 On the Geometry toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 8.

4 In the Height text field, type 4.

5 Locate the Position section. From the Base list, choose Center.

Name Expression Value Description

phi 0[deg] 0 rad Angle of incidence, degrees

Layer name Thickness (m)

Layer 1 3
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Circle 2 (c2)
1 On the Geometry toolbar, click Primitives and choose Circle.

2 In the Settings window for Circle, locate the Size and Shape section.

3 In the Radius text field, type 2.

4 Locate the Position section. In the x text field, type 4.

Bézier Polygon 1 (b1)
1 On the Geometry toolbar, click Primitives and choose Bézier Polygon.

2 In the Settings window for Bézier Polygon, locate the Polygon Segments section.

3 Find the Added segments subsection. Click Add Quadratic.

4 Find the Control points subsection. In row 1, set x to -4 and y to 2.

5 In row 2, set x to -6 and y to 2.>

6 In row 3, set x to -8.

7 Find the Added segments subsection. Click Add Quadratic.

8 Find the Control points subsection. In row 2, set x to -6 and y to -2.

9 In row 3, set x to -4 and y to -2.

10 Find the Added segments subsection. Click Add Linear.

11 Find the Control points subsection. Click Close Curve.

Union 1 (uni1)
1 On the Geometry toolbar, click Booleans and Partitions and choose Union.

2 Select the objects b1, r1, and c2 only.

3 In the Settings window for Union, locate the Union section.

4 Clear the Keep interior boundaries check box.
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5 Click Build All Objects.

D E F I N I T I O N S

General Extrusion 1 (genext1)
1 On the Definitions toolbar, click Component Couplings and choose General Extrusion.

2 In the Settings window for General Extrusion, type anglemap in the Operator name text 
field.

3 Select Domain 3 only.

4 Locate the Destination Map section. In the x-expression text field, type x*
cos(phi[deg]).

5 In the y-expression text field, type x*sin(phi[deg]).

The operator that you just defined, anglemap, will return the value of its argument as 
evaluated in the point (x*cos(phi[deg]),x*sin(phi[deg])). This point has the same angle 
from the origin as that of the incident field.

Explicit 1
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Boat Boundaries in the Label text field.

3 Select Domain 4 only.
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4 Locate the Output Entities section. From the Output entities list, choose 
Adjacent boundaries.

You will select the boundaries of the boat several times throughout this tutorial. The 
Named Selection you just defined makes this more convenient.

Perfectly Matched Layer 1 (pml1)
1 On the Definitions toolbar, click Perfectly Matched Layer.

2 Select Domains 1, 2, 5, and 6 only.

3 In the Settings window for Perfectly Matched Layer, locate the Geometry section.

4 From the Type list, choose Cylindrical.

The PML will make sure that the scattered field from the boat is almost completely 
absorbed before what remains of it reflects on the exterior boundaries of the model. 
Note that the background field is not affected by any of this - it is by definition what 
you are setting it to be.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Built-In>Air.

4 Click Add to Component in the window toolbar.

A D D  M A T E R I A L

1 Go to the Add Material window.

2 In the tree, select Built-In>Aluminum.

3 Click Add to Component in the window toolbar.

M A T E R I A L S

Aluminum (mat2)
1 In the Model Builder window, under Component 1 (comp1)>Materials click 

Aluminum (mat2).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Boundary.

4 From the Selection list, choose Boat Boundaries.

5 On the Home toolbar, click Add Material to close the Add Material window.
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E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

1 In the Model Builder window, under Component 1 (comp1) click Electromagnetic Waves,

Frequency Domain (emw).

2 Select Domains 1–3, 5, and 6 only.

Because you will be using a boundary condition to represent the boat, the field inside 
it will be identically zero and is not necessary to solve for. Removing the boat domain 
this way will save time and memory.

3 In the Settings window for Electromagnetic Waves, Frequency Domain, locate the Settings 
section.

4 From the Formulation list, choose Scattered field.

The option you just selected lets you enter a background field. The expression you will 
use, represents a plane wave coming in from an angle phi. In this expression, the wave 
propagation constant in vacuum, emw.k0, is automatically provided by the physics 
interface. Once you have solved the model, you can plot the background field to verify 
that you have set it up correctly.

5 Specify the Eb vector as

Impedance Boundary Condition 1
1 In the Model Builder window, right-click Electromagnetic Waves,

Frequency Domain (emw) and choose Impedance Boundary Condition.

2 In the Settings window for Impedance Boundary Condition, locate the Boundary Selection 
section.

3 From the Selection list, choose Boat Boundaries.

The use of an impedance boundary condition assumes that the skin depth in the 
material is much less than the material thickness. At 200 MHz, the skin depth in 
Aluminum is of the order of microns, so it is safe to say this is the case. You could even 
have used a perfect electric conductor condition instead, with largely unchanged results. 
In the case of scattering on a nanoparticle, the skin depth is often of the same order of 
magnitude as the particle itself. In such situations, you should not use the impedance 
boundary condition but rather keep the material domain active.

4 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Far-
Field Domain.

0 x

0 y

1[V/m]*exp(j*emw.k0*(x*cos(phi[deg])+y*sin(phi[deg]))) z
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M E S H  1

In the Settings window for Mesh, click Build All.

S T U D Y  1

Parametric Sweep
1 On the Study toolbar, click Parametric Sweep.

2 In the Settings window for Parametric Sweep, locate the Study Settings section.

3 Click Add.

4 In the table, enter the following settings:

You are solving this model for incidence angles from 0 to 360 degrees, in steps of 1 
degree. Smaller steps would give you more accurate RCS plots, but the total solution 
time as well as the size of the model file increases linearly with the number of angles.

5 On the Study toolbar, click Compute.

Parameter name Parameter value list Parameter unit

phi range(0,1,360)
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R E S U L T S

Electric Field (emw)

The default plot shows the norm of the total electric field for an angle of incidence equal 
to 360 degrees. The total electric field is the actual, measurable, physical field. The plot is 
dominated by a standing wave pattern caused by the reflections mainly on the stern and 
the sides of the boat. As you might expect with the wave coming in almost from the right, 
a wake is forming to the left of the boat, beyond the bow. To reproduce Figure 2, see what 
the field looks like with a 30 degree angle of incidence.

1 In the Model Builder window, click Electric Field (emw).

2 In the Settings window for 2D Plot Group, locate the Data section.

3 From the Parameter value (phi) list, choose 30.

4 On the Electric Field (emw) toolbar, click Plot.

At 30 degrees, the wake widens. It is also possible to discern an increased field above 
and to the left of the boat, due to the reflections on its upper side. Try also plotting the 
instantaneous value of the total and the relative field.

Surface
1 In the Model Builder window, expand the Electric Field (emw) node, then click Surface.
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2 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 1>Electromagnetic Waves,

Frequency Domain>Electric>Electric field>emw.Ez - Electric field, z component.

3 On the Electric Field (emw) toolbar, click Plot.

4 Click Replace Expression in the upper-right corner of the Expression section. From the 
menu, choose Component 1>Electromagnetic Waves, Frequency Domain>Electric>

Relative electric field>emw.relEz - Relative electric field, z component.

5 On the Electric Field (emw) toolbar, click Plot.

Because the relative field is the difference between the observed and the background 
field, its magnitude will increase both in the wake and where the total field is enhanced 
by reflections. This trend is even clearer if you plot the absolute value of the relative 
field.

6 Locate the Expression section. In the Expression text field, type 
abs(comp1.emw.relEz).

7 On the Electric Field (emw) toolbar, click Plot.

The plot should now resemble the bottom plot in Figure 3. You can get a quantitative 
measure of how the reflected field is radiating out in different directions from a plot of 
the far field as a function of the angle. A common way to do this is as a polar plot. You 
already have a default polar plot that you can make slight changes to.

2D Far Field (emw)
1 In the Model Builder window, under Results click 2D Far Field (emw).

2 In the Settings window for Polar Plot Group, locate the Data section.

3 From the Parameter selection (phi) list, choose From list.

4 In the Parameter values (phi) list, select 30.

Far Field 1
1 In the Model Builder window, expand the 2D Far Field (emw) node, then click Far Field 1.

2 In the Settings window for Far Field, locate the Evaluation section.

3 Find the Angles subsection. In the Number of angles text field, type 360.

4 On the 2D Far Field (emw) toolbar, click Plot.

To conclude, create a similar plot of the monostatic RCS per unit length. While the far-
field plot is for one specific angle of incidence at a time, this plot will visualize the back 
scattering as a function of the angle of incidence.
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Point Graph 1
1 On the Home toolbar, click Add Plot Group and choose Polar Plot Group.

2 In the Model Builder window, right-click Polar Plot Group 3 and choose Point Graph.

3 Select Point 13 only.

4 In the Settings window for Point Graph, locate the r-Axis Data section.

5 In the Expression text field, type 10*log10(anglemap(emw.bRCS2D)).

6 Click to expand the Title section. From the Title type list, choose Manual.

7 In the Title text area, type RCS per unit length in dB.

8 Locate the θ Angle Data section. From the Parameter list, choose Expression.

9 In the Expression text field, type phi[deg].

10 On the Polar Plot Group 3 toolbar, click Plot.
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General Description

This classic benchmark problem in computational electromagnetics is about computing 
the monostatic radar cross section (RCS) of a perfectly conducting sphere in free space, 
illuminated by a linearly polarized plane wave. The RCS is computed for sphere radius to 
free space wavelength ratios ranging from 0.1 to 0.8 and is compared to an exact analytical 
solution. This region represents the lower half of a transition zone between a long 
wavelength asymptotic solution, “Rayleigh scattering,” and a short wavelength asymptotic 
solution, “Geometrical Optics.” The transition zone is known as the “Mie region” after 
the originator of the exact solution. A mesh convergence study is performed for the first 
scattering resonance at a sphere radius to free space wavelength ratio of approximately 
0.16364.

Model Setup

G E O M E T R Y

Due to symmetry, it is sufficient to model only one quarter of the sphere. Figure 1 shows 
the geometry and boundary conditions.

Figure 1: The computational domain for computing the RCS of a PEC sphere in free space. 
Due to symmetry, it is sufficient to model one quarter of the sphere. 

k E

PMC symmetry plane

PEC symmetry plane

PEC sphere
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The geometry consists of two concentric spherical shells. The innermost shell, adjacent to 
the sphere, represents the free space domain, and the second shell represents a perfectly 
matched layer (PML) region that is used to provide an approximately reflection free 
termination of the, in reality unbounded, free space domain.

E Q U A T I O N

The model is set up and solved using a frequency domain formulation for the scattered 
electric field. The incident plane wave travels in the positive x direction, with the electric 
field polarized along the z-axis. The governing frequency domain equation can be written 
in the form

where the scattered electric field Esc is the dependent variable and the incident electric 
field Ei= (0,0,Ez), with

The equation is discretized using second order edge elements (also known as vector 
elements, Nedelec elements, or curl-conforming elements). It is well known that in order 
to resolve the wave field, one should strive for 10 or more discretization points per 
wavelength. The combination of using second-order elements and 8 elements per 
wavelength fulfills this criterion with some margin. To respect the geometry, a mesh that 
is somewhat finer for the longest wavelengths is required on the surface of the scatterer. A 
maximum element size of half the radius is used on those boundaries. The PML region 
requires special meshing as described under the section Perfectly Matched Layer below.

B O U N D A R Y  C O N D I T I O N S

The sphere has perfect electric conductor (PEC) boundaries. The PEC boundary 
condition

sets the tangential component of the electric field to zero. It is used for the modeling of 
lossless metallic surfaces or as a symmetry type boundary condition. It imposes symmetry 
for magnetic fields and “magnetic currents” and antisymmetry for electric fields and 
electric currents.

PEC boundary conditions and perfect magnetic conductor (PMC) boundary conditions 
apply on the symmetry planes used to subdivide the sphere model. 

∇ μr
1– ∇ Ei Esc+( )×( )× k0

2εrc Ei Esc+( )– 0=

Ez 1 V m⁄[ ]e jk0 x–
=

n E× 0=
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The PMC boundary condition

sets the tangential component of the magnetic field and thus also the surface current 
density to zero. On external boundaries, this can be interpreted as a “high surface 
impedance” boundary condition or used as a symmetry type boundary condition. It 
imposes symmetry for electric fields and electric currents and antisymmetry for magnetic 
fields and “magnetic currents.”

P E R F E C T L Y  M A T C H E D  L A Y E R

The PML region, the second concentric shell around the sphere, provides an 
approximately reflection free termination of the computational domain by applying a 
complex-valued coordinate stretching in the radial (outward) direction. For good 
accuracy, there should be at least five elements through the thickness of the PML. This 
condition is usually most efficiently met by using a swept mesh so that the effective 
element quality becomes insensitive to the scaling in the radial direction. The mesh used 
in this example is shown in Figure 2. It consists of a free tetrahedral mesh around the 
sphere and a swept mesh in the PML domain.

Figure 2: A free tetrahedral mesh is used in the free-space region around the sphere, and a 
swept mesh is used in the PML region.

n H× 0=
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The free space region around the sphere is defined to be the far-field domain. This specifies 
that a near-field to far-field calculation is done on the boundary of this domain, which 
takes the computed electric fields around the sphere and uses the Stratton-Chu equation 
to find the scattered electric field infinitely far away from the origin.

In 3D, this is:

For scattering problems, the far field in COMSOL is identical to what in physics is known 
as the “scattering amplitude.”

The radiating or scattering object is located in the vicinity of the origin, while the far-field 
point p is taken at infinity but with a well-defined angular position .

In the above formulas,

• E and H are the fields on the “aperture”—the surface S enclosing the sphere.

• r0 is the unit vector pointing from the origin to the field point p. If the field points lie 
on a spherical surface S', r0 is the unit normal to S'.

• n is the unit normal to the surface S.

• η is the wave impedance:

• k is the wave number.

• λ is the wavelength.

• r is the radius vector (not a unit vector) of the surface S.

• Ep is the calculated far field in the direction from the origin towards point p.

The unit vector r0 can be interpreted as the direction defined by the angular position 
 and Ep is the far field in this direction.

Results and Discussion

Figure 3 compares the simulation result for the RCS with the analytic solution computed 
using the scattered component of the electric field from this example and equation 11-247 
in Ref. 1. As the figure shows, there is good agreement between the analytic solution 

Ep
jk
4π
------r0 n E ηr0 n H×( )×–×[ ] jkr r0⋅( )exp Sd×=

θ ϕ,( )

η μ ε⁄=

θ ϕ,( )
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determined in this manner and the finite-element model.

Figure 3: Comparison of the analytic solution and the COMSOL Multiphysics model of the 
RCS of a PEC sphere in free space.

Mesh Convergence

For the wavelength corresponding to the first maximum in the RCS plot in Figure 3, a 
mesh convergence study is performed to validate that the model converges toward a 
unique solution when refining the mesh isotropically. The model is solved in a parametric 
sweep over the number of mesh elements per wavelength. In the PML, the mesh density 
is not changed in the radial outward direction (that is, in the sweep direction for the swept 
mesh). The PML is resolved by 5 element layers in this direction which is sufficient to 
resolve the exponential damping in the radial direction. Thus the error contribution from 
the PML is not expected to decrease by adding more element layers. The main error 
contribution from the PML is due to the fact that it is not perfectly absorbing because of 
finite thickness and damping rather than mesh density. Thus, it is expected to give a 
contribution to the error in the computed RCS that does not decrease when refining the 
mesh.

Figure 4 shows the mesh convergence. The displayed error is the difference between the 
RCS from the finite element model and the exact solution from equation 11-247 in Ref. 1. 
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As mentioned, the PML is expected to yield an error contribution which cannot be 
eliminated by refining the mesh. As there is no sign of stagnation in the convergence plot, 
this error contribution must be smaller than 0.1%. The RCS plot in Figure 3 corresponds 
to 8 elements per wavelength, that is a relative error of about 3% at the wavelength of the 
maximum in the RCS versus wavelength curve.

Figure 4: Mesh convergence for the difference in backscattering (monostatic) RCS between the 
COMSOL model and the exact solution.

Reference

1. C.A. Balanis, Advanced Engineering Electromagnetics, John Wiley & Sons, 1989.

Application Library path: RF_Module/Verification_Examples/rcs_sphere

Modeling Instructions

From the File menu, choose New.
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N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Radio Frequency>Electromagnetic Waves,

Frequency Domain (emw).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Frequency Domain.

6 Click Done.

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

G E O M E T R Y  1

First, create a sphere with two layer definitions. The outermost layer represents the PMLs 
and the core represents the PEC sphere for RCS analysis. The median layer is the air 
domain.

Name Expression Value Description

r_lda 0.5 0.5 Sphere radius in 
wavelengths

r0 5[cm] 0.05 m Sphere radius

lda r0/r_lda 0.1 m Wavelength

k0 2*pi/lda 62.83 1/m Wavenumber

f0 c_const/lda 2.998E9 1/s Frequency

t_air lda/2 0.05 m Thickness of air around 
sphere

t_pml lda/2 0.05 m Thickness of PML

h_size 8 8 Number of elements per 
wavelength

E0 1[V/m] 1 V/m Incident field magnitude
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Sphere 1 (sph1)
1 On the Geometry toolbar, click Sphere.

2 In the Settings window for Sphere, locate the Size section.

3 In the Radius text field, type r0+t_air+t_pml.

4 Click to expand the Layers section. In the table, enter the following settings:

5 Click Build All Objects.

D E F I N I T I O N S

Add a view with a different angle of perspective.

Camera
1 In the Model Builder window, under Component 1 (comp1) right-click Definitions and 

choose View.

Change only the sign of y in the Position and Up Vector sections:

2 In the Model Builder window, expand the View 2 node, then click Camera.

3 In the Settings window for Camera, locate the Position section.

4 In the y text field, type 1.871.

5 Locate the Up Vector section. In the y text field, type -0.412.

6 Click Update.

Choose wireframe rendering to get a better view of the interior parts.

Layer name Thickness (m)

Layer 1 t_pml

Layer 2 t_air
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7 Click the Wireframe Rendering button on the Graphics toolbar.

G E O M E T R Y  1

Due to the symmetry of the structure, it is sufficient to model only one quarter of the 
sphere. Delete the domains which are not part of the modeling domain.

Delete Entities 1 (del1)
1 In the Model Builder window, under Component 1 (comp1) right-click Geometry 1 and 

choose Delete Entities.

2 In the Settings window for Delete Entities, locate the Entities or Objects to Delete section.

3 From the Geometric entity level list, choose Domain.
10 |  C O M P U T I N G  T H E  R A D A R  C R O S S  S E C T I O N  O F  A  P E R F E C T L Y  C O N D U C T I N G  S P H E R E



4 On the object sph1, select Domains 1–3, 5–7, and 9–15 only.

5 Click Build All Objects.

D E F I N I T I O N S

View 1
After removing unnecessary domains, change the view to the first view definition which 
gives a better angle showing all layers.
11 |  C O M P U T I N G  T H E  R A D A R  C R O S S  S E C T I O N  O F  A  P E R F E C T L Y  C O N D U C T I N G  S P H E R E



1 Click the Zoom Extents button on the Graphics toolbar.

This is the modeling domain for RCS analysis.

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

Now set up the physics. You will solve the model for the scattered field, which requires 
background electric field (E-field) information. The background plane wave is traveling in 
the positive x direction, with the electric field polarized along the z-axis. The default 
boundary condition is perfect electric conductor, which applies to all exterior boundaries 
including the boundaries perpendicular to the background E-field polarization.

1 In the Model Builder window, under Component 1 (comp1) click Electromagnetic Waves,

Frequency Domain (emw).

2 In the Settings window for Electromagnetic Waves, Frequency Domain, locate the Settings 
section.

3 From the Formulation list, choose Scattered field.

4 Specify the Eb vector as

Choose wireframe rendering in the current view to get a better view of the interior 
parts.

0 x

0 y

E0*exp(-j*k0*x) z
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5 Click the Wireframe Rendering button on the Graphics toolbar.

6 Locate the Physics-Controlled Mesh section. Clear the Enable check box.

Scattering Boundary Condition 1
1 Right-click Component 1 (comp1)>Electromagnetic Waves, Frequency Domain (emw) and 

choose Scattering Boundary Condition.

2 Select Boundaries 3 and 14 only.

D E F I N I T I O N S

The outermost domains from the center of the sphere are the PMLs.

Perfectly Matched Layer 1 (pml1)
1 On the Definitions toolbar, click Perfectly Matched Layer.
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2 Select Domains 1 and 4 only.

3 In the Settings window for Perfectly Matched Layer, locate the Geometry section.

4 From the Type list, choose Spherical.

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

Set PMC on the boundaries parallel to the background E-field polarization.

Perfect Magnetic Conductor 1
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Perfect Magnetic Conductor.
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2 Select Boundaries 1, 4, 9, and 12 only.

Far-Field Calculation 1
1 In the Model Builder window, right-click Electromagnetic Waves,

Frequency Domain (emw) and choose Far-Field Domain.

2 In the Model Builder window, expand the Far-Field Domain 1 node, then click Far-
Field Calculation 1.

3 In the Settings window for Far-Field Calculation, locate the Far-Field Calculation section.

4 Select the Symmetry in the y=0 plane check box.

5 Select the Symmetry in the z=0 plane check box.

6 From the Symmetry type list, choose Symmetry in H (PEC).

M A T E R I A L S

Next, assign material properties. Use air for all domains.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Built-In>Air.

4 Click Add to Component in the window toolbar.
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M A T E R I A L S

On the Home toolbar, click Add Material to close the Add Material window.

M E S H  1

Use a tetrahedral mesh for the air domains.

Free Tetrahedral 1
1 In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 

Free Tetrahedral.

2 In the Settings window for Free Tetrahedral, locate the Domain Selection section.

3 From the Geometric entity level list, choose Domain.

4 Select Domains 2 and 3 only.

The maximum mesh size is at most 0.2 wavelengths in free space. In this model, use 0.125 
wavelengths.

Size
1 In the Model Builder window, under Component 1 (comp1)>Mesh 1 click Size.

2 In the Settings window for Size, locate the Element Size section.

3 Click the Custom button.

4 Locate the Element Size Parameters section. In the Maximum element size text field, type 
lda/h_size.
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5 In the Minimum element size text field, type lda/h_size.

Use a swept mesh for the PML domains.

Distribution 1
1 In the Model Builder window, right-click Mesh 1 and choose Swept.

2 Right-click Swept 1 and choose Distribution.

3 In the Settings window for Distribution, click Build All.

Compare the mesh with that shown in Figure 2.

S T U D Y  1

Parametric Sweep
1 On the Study toolbar, click Parametric Sweep.

2 In the Settings window for Parametric Sweep, locate the Study Settings section.

3 Click Add.

4 In the table, enter the following settings:

Step 1: Frequency Domain
1 In the Model Builder window, under Study 1 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 In the Frequencies text field, type f0.

4 In the Model Builder window, click Study 1.

5 In the Settings window for Study, locate the Study Settings section.

6 Clear the Generate default plots check box.

7 On the Study toolbar, click Compute.

R E S U L T S

Follow the instructions below to reproduce the plot in Figure 3. First, show the computed 
RCS values using square markers.

1D Plot Group 1
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, locate the Data section.

3 From the Data set list, choose Study 1/Parametric Solutions 1 (sol2).

Parameter name Parameter value list Parameter unit

r_lda range(0.1,0.025,0.8)
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4 Click to expand the Title section. From the Title type list, choose Custom.

5 Find the Type and data subsection. Clear the Unit check box.

6 Clear the Description check box.

7 Clear the Type check box.

8 Find the User subsection. In the Prefix text field, type RCS Calculation.

9 Locate the Plot Settings section. Select the x-axis label check box.

10 In the associated text field, type Sphere radius in wavelengths (a/\lambda<sub>
0</sub>).

11 Select the y-axis label check box.

12 In the associated text field, type Normalized monostatic RCS (\sigma<sub>3-D</
sub>/\pi a<sup>2</sup>).

13 Locate the Axis section. Select the y-axis log scale check box.

Point Graph 1
1 Right-click 1D Plot Group 1 and choose Point Graph.

2 Select Point 2 only.

3 In the Settings window for Point Graph, locate the y-Axis Data section.

4 In the Expression text field, type emw.bRCS3D/(pi*r0^2).

5 Locate the x-Axis Data section. From the Axis source data list, choose Outer solutions.

6 Click to expand the Coloring and style section. Locate the Coloring and Style section. 
Find the Line style subsection. From the Line list, choose None.

7 Find the Line markers subsection. From the Marker list, choose Square.

8 From the Positioning list, choose In data points.
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9 On the 1D Plot Group 1 toolbar, click Plot.

The observed RCS graph pattern is oscillatory in the Mie region.

Next, proceed to perform the mesh convergence study at the first resonance in the Mie 
region.

Start by extending the parameter list with the resonant radius and the associated 
theoretical RCS value.

G L O B A L  D E F I N I T I O N S

Parameters
Add the two rows at the end and change the first line according to.

1 In the Model Builder window, under Global Definitions click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

Name Expression Value Description

r_lda r1 0.1636 Sphere radius in 
wavelengths

r0 5[cm] 0.05 m Sphere radius
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M E S H  1

Add a new mesh with some tweaks to make sure that the curvature of the sphere is always 
resolved.

This is to avoid inverted mesh elements.

1 In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 
Duplicate.

M E S H  2

In the Model Builder window, expand the Component 1 (comp1)>Meshes node.

C O M P O N E N T  1  ( C O M P 1 )

In the Model Builder window, expand the Component 1 (comp1)>Meshes node.

M E S H  2

Size
1 In the Model Builder window, expand the Component 1 (comp1)>Meshes>Mesh 2 node, 

then click Size.

2 In the Settings window for Size, locate the Element Size Parameters section.

3 In the Minimum element size text field, type if(lda/h_size>r0/2,r0/2,lda/
h_size).

lda r0/r_lda 0.3056 m Wavelength

k0 2*pi/lda 20.56 1/m Wavenumber

f0 c_const/lda 9.811E8 1/s Frequency

t_air lda/2 0.1528 m Thickness of air 
around sphere

t_pml lda/2 0.1528 m Thickness of PML

h_size 8 8 Number of elements 
per wavelength

E0 1[V/m] 1 V/m Incident field 
magnitude

r1 0.16363636363636364 0.1636 Relative radius at 
1st resonance

RCS1 3.6549540474068576 3.655 RCS at 1st resonance

Name Expression Value Description
20 |  C O M P U T I N G  T H E  R A D A R  C R O S S  S E C T I O N  O F  A  P E R F E C T L Y  C O N D U C T I N G  S P H E R E



Size 1
1 In the Model Builder window, under Component 1 (comp1)>Meshes>Mesh 2 right-click 

Free Tetrahedral 1 and choose Size.

2 In the Settings window for Size, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Boundary.

4 Click Paste Selection.

5 In the Paste Selection dialog box, type 7,10 in the Selection text field.

6 Click OK.

7 In the Settings window for Size, locate the Element Size section.

8 Click the Custom button.

9 Locate the Element Size Parameters section. Select the Maximum element size check box.

10 In the associated text field, type if(lda/h_size>r0/2,r0/2,lda/h_size).

R O O T

Add a new frequency domain study for the mesh convergence analysis.

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Preset Studies>

Frequency Domain.

4 Click Add Study in the window toolbar.

5 On the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  2

A parametric sweep is needed to loop over the mesh sizes.

Parametric Sweep
1 On the Study toolbar, click Parametric Sweep.

2 In the Settings window for Parametric Sweep, locate the Study Settings section.

3 Click Add.

4 In the table, enter the following settings:

Parameter name Parameter value list Parameter unit

h_size 3 6 9 12 15 20
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Step 1: Frequency Domain
1 In the Model Builder window, under Study 2 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 In the Frequencies text field, type f0.

4 In the Model Builder window, click Study 2.

5 In the Settings window for Study, locate the Study Settings section.

6 Clear the Generate default plots check box.

7 On the Study toolbar, click Compute.

R E S U L T S

Continue to plot the relative error versus elements per wavelength.

1D Plot Group 2
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, locate the Data section.

3 From the Data set list, choose Study 2/Parametric Solutions 2 (sol33).

4 Locate the Plot Settings section. Select the x-axis label check box.

5 In the associated text field, type Number of elements / \lambda<sub>0</sub>.

6 Select the y-axis label check box.

7 In the associated text field, type Relative error.

Point Graph 1
1 Right-click 1D Plot Group 2 and choose Point Graph.

2 In the Settings window for Point Graph, locate the Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 2 in the Selection text field.

5 Click OK.

6 In the Settings window for Point Graph, locate the y-Axis Data section.

7 In the Expression text field, type (emw.bRCS3D/(pi*r0^2)-RCS1)/RCS1.

8 Locate the x-Axis Data section. From the Axis source data list, choose h_size.

9 From the Parameter list, choose Expression.

10 In the Expression text field, type h_size.

11 Click to expand the Coloring and style section. Locate the Coloring and Style section. In 
the Width text field, type 2.
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12 Find the Line markers subsection. From the Marker list, choose Square.

13 From the Positioning list, choose In data points.

14 Click the x-Axis Log Scale button on the Graphics toolbar.

15 Click the y-Axis Log Scale button on the Graphics toolbar.

16 On the 1D Plot Group 2 toolbar, click Plot.

Compare the convergence plot with that shown in Figure 4.
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Introduction

This is a model of an RF waveguide bend with a dielectric block inside. There are 
electromagnetic losses in the block as well as on the waveguide walls which cause the 
assembly to heat up over time. The material properties of the block are functions of 
temperature. The transient thermal behavior, as well as the steady-state solution, are 
computed.

Figure 1: A waveguide bend with a dielectric block inside. Top boundaries of the waveguide 
are removed only for visualization.

Model Definition

The waveguide bend shown in Figure 1 is connected to a 100 W power source, operating 
at 10 GHz, via a rectangular waveguide operating in the TE10 mode. The other end of the 
bend is also connected to a rectangular waveguide operating in the TE10 mode. The 
objective of such a bend is primarily to change the direction of propagation of the energy. 
Here, however, a block of dielectric is introduced as an example of a lossy material 
interacting with an electromagnetic field.

The waveguide is made of aluminum. To reduce surface losses, the inside walls are coated 
with copper, a high-conductivity metal. The dielectric block is modeled as having electrical 

Dielectric block

H-bend waveguide

Copper coating
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conductivity of σ = 0, relative permeability of μr = 1, and a relative permittivity of εr = 2.1, 
with a loss tangent that is a function of temperature, δ = 0.001(1 + T/300 K). The thermal 
conductivity of this block is also a function of temperature, k = 0.3(1 + T/300 K) W/m/K. 
Furthermore, the density is 2200 kg/m3 and the specific heat is 1050 J/kg/K. These are 
generic properties representative of a dielectric material.

At the operating frequency, the skin depth of the copper coating is much smaller than the 
dimensions of the waveguide, that is, the electromagnetic fields penetrate a negligible 
distance into the walls. This means that the electromagnetic losses can be localized entirely 
on the surface, and that there is no need to solve Maxwell’s equations inside of the walls 
themselves. Thus, Maxwell’s equations only need to be solved in the air domain inside of 
the waveguide, as well as inside of the block. The heat transfer equation is solved in the 
block as well as the waveguide walls.

The objective of the analysis is to observe how the assembly of the dielectric block and 
waveguide heat up over time, as well as to find the steady-state temperature. The 
waveguide is initially assumed to be at a constant temperature throughout. After the power 
source is turned on, the electromagnetic fields interact with the highly conductive interior 
boundaries of the waveguide, as well as the lossy dielectric block. The losses in the block 
and on the walls are sources of heat that raises the temperature. The block is assumed to 
be in perfect thermal contact with the walls of the waveguide, that is, any heat generated 
in the block is conducted away into the walls. The outside boundaries of the walls are 
assumed to be facing ambient air, which leads to free convective cooling off of these faces. 
This example uses an averaged heat transfer coefficient to represent this free convection to 
ambient air.

The model solves two governing equations: Maxwell’s equations, which describe the 
electromagnetic fields, and the heat transfer equation, which describes the temperature. It 
is assumed that the operating frequency is much higher than any thermal transients, and 
thus it is possible to solve the problem either in a frequency-transient or a frequency-
stationary sense.

A frequency-transient simulation solves Maxwell’s equations in the frequency domain. 
This implicitly assumes that all material properties used to solve Maxwell’s equations are 
constant over a single period of oscillation of the electromagnetic wave. The heat transfer 
equation is, on the other hand, is solved transiently. The electromagnetic fields are only 
recomputed when the material properties have changed significantly, as determined by a 
criterion involving the relative tolerance of the time-dependent solver. The objective of the 
analysis is to determine the change in temperature from given initial conditions and how 
long these changes take.
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A frequency-stationary simulation solves Maxwell’s equations in the frequency domain, 
but it solves the stationary heat transfer equation under the assumption that all initial 
transient variations have died out. Although no transient information is obtainable, this 
computation is significantly faster than a frequency-transient analysis and gives the steady-
state temperature distribution.

Results and Discussion

Figure 2 plots the peak temperature within the dielectric block over time, showing that it 
takes several minutes for the block to reach thermal equilibrium.

Figure 3 plots the fields inside of the waveguide, as well as the temperature of the assembly, 
for the steady-state temperature solution after all thermal transients have died out. The 
dielectric block shows a significant temperature variation, which affects the thermal 
conductivity and loss tangent, plotted in Figure 4.

Figure 2: The maximum temperature, evaluated over the volume of the block, is plotted as a 
function of temperature.
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Figure 3: The electric fields (red arrows) magnetic fields (green arrows) and power flow (blue 
arrows) are shown inside of the waveguide. The steady-state temperature is plotted on the block 
and waveguide walls.

Figure 4: The loss tangent within the dielectric block for the steady-state solution shows that the 
variation in temperature affects the material properties.
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Application Library path: RF_Module/Microwave_Heating/rf_heating

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Heat Transfer>Electromagnetic Heating>

Microwave Heating.

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies for Selected Multiphysics>Frequency-

Transient.

6 Click Done.

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

Here, c_const is a predefined COMSOL constant for the speed of light in vacuum.

Name Expression Value Description

f0 10[GHz] 1E10 Hz Current frequency

lda0 c_const/f0 0.02998 m Wavelength, air

h_max 0.2*lda0 0.005996 m Maximum mesh element size, air
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G E O M E T R Y  1

First, import the geometry of the waveguide including a dielectric block inside the 
waveguide.

Import 1 (imp1)
1 On the Home toolbar, click Import.

2 In the Settings window for Import, locate the Import section.

3 Click Browse.

4 Browse to the model’s Application Libraries folder and double-click the file 
rf_heating.mphbin.

5 Click Import.

Use the wireframe rendering to see the inner parts of the waveguide.

6 Click the Wireframe Rendering button on the Graphics toolbar.

D E F I N I T I O N S

Create a set of selections for use before setting up the physics. First, create a selection for 
the dielectric block.

Explicit 1
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Dielectric in the Label text field.
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3 Select Domain 3 only.

Add a selection for the air-filled region inside the waveguide.

Explicit 2
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Air in the Label text field.
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3 Select Domain 2 only.

Add a selection for the waveguide structure.

Explicit 3
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Waveguide in the Label text field.
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3 Select Domain 1 only.

Add a selection for the inner surface of the waveguide.

Explicit 4
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Waveguide inside surfaces in the Label text 
field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.
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4 Select Boundaries 16–18, 35, 53, 54, 72, 74, 75, 78, 96, and 97 only.

Add a selection for the outer surface of the waveguide.

Explicit 5
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Waveguide outside surfaces in the Label 
text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.
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4 Select Boundaries 48–52, 55, 69, and 98 only.

To get a better view, suppress some of the boundaries. Furthermore, by assigning the 
resulting settings to a View node, you can easily return to the same view later by clicking 
the Go to View 2 button on the Graphics toolbar.

View 2
1 In the Model Builder window, right-click Definitions and choose View.

2 Click the Wireframe Rendering button on the Graphics toolbar.

Hide for Physics 1
1 In the Model Builder window, under Component 1 (comp1)>Definitions right-click View 2 

and choose Hide for Physics.

2 In the Settings window for Hide for Physics, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Boundary.
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4 Select Boundaries 18 and 50 only.

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

1 In the Model Builder window, under Component 1 (comp1) click Electromagnetic Waves,

Frequency Domain (emw).

2 In the Settings window for Electromagnetic Waves, Frequency Domain, locate the 
Domain Selection section.

3 In the  list, select 1.

4 Click Remove from Selection.

5 Select Domains 2 and 3 only.

Wave Equation, Electric 1
1 In the Model Builder window, expand the Electromagnetic Waves,

Frequency Domain (emw) node, then click Wave Equation, Electric 1.

2 In the Settings window for Wave Equation, Electric, locate the Electric Displacement Field 
section.

3 From the Electric displacement field model list, choose Loss tangent, loss angle.

H E A T  TR A N S F E R  I N  S O L I D S  ( H T )

On the Physics toolbar, click Electromagnetic Waves, Frequency Domain (emw) and choose 
Heat Transfer in Solids (ht).
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1 In the Model Builder window, under Component 1 (comp1) click 
Heat Transfer in Solids (ht).

2 In the Settings window for Heat Transfer in Solids, locate the Domain Selection section.

3 In the  list, select 2.

4 Click Remove from Selection.

5 Select Domains 1 and 3 only.

Heat Flux 1
1 In the Model Builder window, right-click Heat Transfer in Solids (ht) and choose 

Heat Flux.

2 In the Settings window for Heat Flux, locate the Boundary Selection section.

3 From the Selection list, choose Waveguide outside surfaces.

4 Locate the Heat Flux section. Click the Convective heat flux button.

5 In the h text field, type 5.

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

1 In the Model Builder window, under Component 1 (comp1) click Electromagnetic Waves,

Frequency Domain (emw).

2 In the Settings window for Electromagnetic Waves, Frequency Domain, locate the Physics-

Controlled Mesh section.

3 Clear the Enable check box.

Wave Equation, Electric 2
1 Right-click Component 1 (comp1)>Electromagnetic Waves, Frequency Domain (emw) and 

choose Wave Equation, Electric.

2 In the Settings window for Wave Equation, Electric, locate the Domain Selection section.

3 From the Selection list, choose Air.

Impedance Boundary Condition 1
1 In the Model Builder window, right-click Electromagnetic Waves,

Frequency Domain (emw) and choose Impedance Boundary Condition.

2 In the Settings window for Impedance Boundary Condition, locate the Boundary Selection 
section.

3 From the Selection list, choose Waveguide inside surfaces.

Port 1
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Port.
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2 Select Boundary 15 only.

3 In the Settings window for Port, locate the Port Properties section.

4 From the Type of port list, choose Rectangular.

For the first port, wave excitation is on by default.

5 In the Pin text field, type 100.

Port 2
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Port.
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2 Select Boundary 79 only.

3 In the Settings window for Port, locate the Port Properties section.

4 From the Type of port list, choose Rectangular.

M A T E R I A L S

Next, assign material properties on the model. Begin by specifying Aluminum for the 
waveguide structure.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Built-In>Aluminum.

4 Click Add to Component in the window toolbar.

M A T E R I A L S

Aluminum (mat1)
1 In the Model Builder window, under Component 1 (comp1)>Materials click 

Aluminum (mat1).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Waveguide.
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A D D  M A T E R I A L

1 Go to the Add Material window.

2 In the tree, select Built-In>Air.

3 Click Add to Component in the window toolbar.

M A T E R I A L S

Air (mat2)
1 In the Model Builder window, under Component 1 (comp1)>Materials click Air (mat2).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Air.

Material 3 (mat3)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, type Dielectric in the Label text field.

3 Select Domain 3 only.

4 Locate the Material Contents section. In the table, enter the following settings:

A D D  M A T E R I A L

1 Go to the Add Material window.

2 In the tree, select Built-In>Copper.

3 Click Add to Component in the window toolbar.

Property Name Value Unit Property group

Relative permittivity 
(real part)

epsilonPrim 2.1 1 Dielectric losses

Loss tangent, loss angle delta 0.001*(T/
300[K])

rad Loss tangent, loss 
angle

Relative permeability mur 1 1 Basic

Thermal conductivity k 0.3[W/m/K]*
(T/300[K])

W/(m·K) Basic

Density rho 2200 kg/m³ Basic

Heat capacity at 
constant pressure

Cp 1050 J/(kg·K) Basic
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M A T E R I A L S

On the Home toolbar, click Add Material to close the Add Material window.

Copper (mat4)
1 In the Model Builder window, under Component 1 (comp1)>Materials click Copper (mat4).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Boundary.

4 From the Selection list, choose Waveguide inside surfaces.

M E S H  1

Choose the maximum mesh size in the air domain smaller than 0.2 wavelengths using the 
parameter h_max that you defined earlier. For the dielectric materials, scale the mesh size 
by the inverse of the square root of the relative dielectric constant.

Size 1
1 In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 

Size.

2 In the Settings window for Size, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Domain.

4 From the Selection list, choose Air.

5 Locate the Element Size section. Click the Custom button.

6 Locate the Element Size Parameters section. Select the Maximum element size check box.

7 In the associated text field, type h_max.

Size 2
1 In the Model Builder window, right-click Mesh 1 and choose Size.

2 In the Settings window for Size, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Domain.

4 From the Selection list, choose Dielectric.

5 Locate the Element Size section. Click the Custom button.

6 Locate the Element Size Parameters section. Select the Maximum element size check box.

7 In the associated text field, type h_max/sqrt(2.1).

Free Tetrahedral 1
1 Right-click Mesh 1 and choose Free Tetrahedral.
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2 In the Settings window for Free Tetrahedral, click Build All.

S T U D Y  1

Step 1: Frequency-Transient
1 In the Model Builder window, expand the Study 1 node, then click Step 1: Frequency-

Transient.

2 In the Settings window for Frequency-Transient, locate the Study Settings section.

3 In the Times text field, type range(0,15,300).

4 From the Tolerance list, choose User controlled.

5 In the Relative tolerance text field, type 0.001.

6 In the Frequency text field, type f0.

7 In the Model Builder window, click Study 1.

8 In the Settings window for Study, locate the Study Settings section.

9 Clear the Generate default plots check box.

10 On the Home toolbar, click Compute.
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R E S U L T S

Data Sets
Plot the transient response of the peak temperature.

1D Plot Group 1
1 On the Results toolbar, click More Data Sets and choose Evaluation>Maximum.

2 On the Results toolbar, click 1D Plot Group.

3 In the Settings window for 1D Plot Group, locate the Data section.

4 From the Data set list, choose Maximum 1.

Point Graph 1
1 Right-click 1D Plot Group 1 and choose Point Graph.

2 In the Settings window for Point Graph, click Replace Expression in the upper-right 
corner of the y-axis data section. From the menu, choose Component 1>

Heat Transfer in Solids>Temperature>T - Temperature.

3 Locate the y-Axis Data section. From the Unit list, choose degC.

4 On the 1D Plot Group 1 toolbar, click Plot.

Compare the resulting plot with that shown in Figure 2.

Next, add a Frequency-Stationary study to evaluate the peak temperature which can be 
observed with the Frequency-Transient study after applying a enough long time so the peak 
temperature is saturated.

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Empty Study.

4 Click Add Study in the window toolbar.

5 On the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  2

Step 1: Frequency-Stationary
1 On the Study toolbar, click Study Steps and choose Stationary>Frequency-Stationary.

2 In the Settings window for Frequency-Stationary, locate the Study Settings section.

3 In the Frequency text field, type f0.

4 On the Study toolbar, click Compute.
20 |  R F  H E A T I N G



R E S U L T S

Temperature (ht)
The default plots show the distribution of the electric field norm and the temperature. For 
the temperature plot, first change the unit to the degree Celsius and then, add arrow plots 
of the electric fields, magnetic fields, and power flow.

Surface
1 In the Model Builder window, expand the Temperature (ht) node, then click Surface.

2 In the Settings window for Surface, locate the Expression section.

3 From the Unit list, choose degC.

Arrow Volume 1
1 In the Model Builder window, under Results right-click Temperature (ht) and choose 

Arrow Volume.

2 In the Settings window for Arrow Volume, click Replace Expression in the upper-right 
corner of the Expression section. From the menu, choose Component 1>

Electromagnetic Waves, Frequency Domain>Electric>emw.Ex,emw.Ey,emw.Ez -

Electric field.

3 Locate the Arrow Positioning section. Find the X grid points subsection. In the Points text 
field, type 40.

4 Find the Y grid points subsection. In the Points text field, type 40.

5 Find the Z grid points subsection. In the Points text field, type 1.

6 On the Temperature (ht) toolbar, click Plot.

Arrow Volume 2
1 Right-click Results>Temperature (ht)>Arrow Volume 1 and choose Duplicate.

2 In the Settings window for Arrow Volume, click Replace Expression in the upper-right 
corner of the Expression section. From the menu, choose Component 1>

Electromagnetic Waves, Frequency Domain>Magnetic>emw.Hx,emw.Hy,emw.Hz -

Magnetic field.

3 Locate the Coloring and Style section. From the Color list, choose Green.

Arrow Volume 3
1 Right-click Results>Temperature (ht)>Arrow Volume 2 and choose Duplicate.

2 In the Settings window for Arrow Volume, click Replace Expression in the upper-right 
corner of the Expression section. From the menu, choose Component 1>
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Electromagnetic Waves, Frequency Domain>Energy and power>emw.Poavx,...,emw.Poavz -

Power flow, time average.

3 Locate the Coloring and Style section. From the Color list, choose Blue.

Compare the resulting plot with that shown in Figure 3.

Finally, reproduce the plot of the loss tangent on the dielectric block shown in Figure 4.

To create the plot, reuse the plot group named Isothermal Contours (ht).

Isothermal Contours (ht)
1 In the Model Builder window, under Results click Isothermal Contours (ht).

2 In the Settings window for 3D Plot Group, type Loss Tangent (emw) in the Label text 
field.

Isosurface
In the Model Builder window, expand the Results>Loss Tangent (emw) node.

Surface 1
1 Right-click Isosurface and choose Delete.

2 In the Model Builder window, under Results right-click Loss Tangent (emw) and choose 
Surface.

3 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 1>Electromagnetic Waves,

Frequency Domain>Material properties>emw.delta - Loss tangent, loss angle.

4 On the Loss Tangent (emw) toolbar, click Plot.

Click the Zoom Box button on the Graphics toolbar and then use the mouse to zoom 
in.
22 |  R F  H E A T I N G



Created in COMSOL Multiphysics 5.3
F a s t  P r o t o t y p i n g  o f  a  Bu t l e r  Ma t r i x  B e am f o rm i n g
Ne two r k
This model is licensed under the COMSOL Software License Agreement 5.3.
All trademarks are the property of their respective owners. See www.comsol.com/trademarks.

http://www.comsol.com/sla
http://www.comsol.com/trademarks/


Introduction

A Butler matrix is a passive beamforming feed network. It is a cost-effective feed network 
for phased array antennas because the circuit can be fabricated in the form of microstrip 
lines and it is viable to perform beam scanning without deploying expensive active devices. 
This example guides how to design such a circuit efficiently using the Transmission Line 
physics interface. The results show the logarithmic voltage on the Butler matrix 
beamforming circuit at 30 GHz and the arithmetic phase progression at each output port.

Figure 1: A microstrip 4×4 Butler matrix beamforming network for a phased array antenna

Model Definition

The butler matrix beamforming network consists of a few subsections: 90 degree hybrid, 
45 degree delay line, crossover, transition matching the output phase to that of crossover, 
and inner and outer front-ends. Since these subsections are repeatedly used in the entire 
structure, the geometry building process can be simplified by adding these subsections as 
the Geometry Parts under Global Definition node and reusing them as necessary.

Port 1

Port 2

Port 3

Port 4

Port 5

Port 6

Port 7

Port 8

90 degree hybrid

Crossover

45 degree delay line

0.48 wavelengths

0.25 wavelengths

Phase matching to crossover
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Figure 2: The part geometry of a 90 degree hybrid (branch-line coupler) 

The geometry of a 90 degree hybrid, also known as a branch-line coupler is shown in 
Figure 2. Ref. 1 discusses the design characteristics and its S-parameters calculated using 
even-odd model analysis. A full 3D COMSOL model is available in Ref. 2. The 90 degree 
hybrid splits the input power equally into two output ports (-3 dB) with a 90 degree phase 
difference. Because the geometry is symmetric, the response of the circuit is reciprocal 
regardless of the input port configuration. In this example, the input ports are located on 
the left side and there is no coupled power between the input ports that is also described 
by its S-parameter matrix:

Figure 3 describes a delay line geometry providing a 45 degrees phase lag than the output 
phase of the crossover. Figure 4 shows a transition part that matches the output phase to 
that of the crossover.

Port 1 (in)

Port 4 (in)

Port 2 (out)

Port 3 (out)

λg/4

λg/4

S
1–

2
-------

0 j 1 0
j 0 0 1
1 0 0 j
0 1 j 0
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3 |  F A S T  P R O T O T Y P I N G  O F  A  B U T L E R  M A T R I X  B E A M F O R M I N G  N E T W O R K



Figure 3: The part geometry of a 45 degree delay line that is 0.125 wavelengths longer than 
the crossover part.

Figure 4: The part geometry of a transition structure. The electrical length is same as that in 
the input signal path of the crossover part.

3λg/4

3λg/16

3λg/4

λg/8
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Figure 5: The part geometry of a crossover structure. The port definition is only for the 
subsection analysis.

The geometry of a crossover in Figure 5 is analogous of a two-section cascaded branch-
line coupler, but it consists of only 50 Ω lines. Its behavior can be analyzed with the same 
even-odd analysis method (Ref. 1) used for the branch-line coupler characterization. The 
even-odd analysis transforms the four-port network into two decoupled two-port 
networks. After the transformation, each cascaded two port-network can be described via 
ABCD parameters.

If the circuit is normalized by the 50 Ω reference impedance, the ABCD parameters for 
each section are

Port 1 (in)
Port 2 (out)

Port 3 (out)
Port 4 (in)

λg/4

λg/4 λg/4

A B
C D open shunt,

1 0
j 1
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A B
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j– 1
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A B
C D 50Ω λ

4
---line,

0 j
j 0

=
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The reflection and transmission coefficients from ABCD are defined as

The wave amplitude at each port is

Because it is a passive and reciprocal network, the S-parameters are

The two input ports are isolated from each other. The input signal from the upper left side 
flows to the output at the lower right side while the input signal from the lower left side 
flows to the output at the upper right side. The ladder-shape crossover structure works like 
X-shape crossover lines. 

Figure 6 and Figure 7 show the geometry of front-end parts that adjust the distance 
between output ports from a quarter-wave length to 0.48 wavelengths without distorting 
the output phase relation. The higher gain of an antenna array can be realized by 
increasing the distance between antenna elements, but this will result in an undesirable 
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higher sidelobe level and a grating lobe. The given spacing configuration for antenna array 
elements provides the antenna radiation pattern with a reasonable gain and sidelobe level.

Figure 6: The part geometry of an outer front-end structure.
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Figure 7: The part geometry of an inner front-end structure.

Figure 8: The finalized geometry of a butler matrix beamforming network.

Port 1 (in)

Port 2 (in)
Port 3 (in)

Port 4 (in)

Port 5 (out)

Port 6 (out)

Port 7 (out)

Port 8 (out)
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By combining four 90 degree hybrids (branch-line couplers), two 45 degree delay lines, 
two phase matching transitions, two inner front-ends, and two outer front-ends, the 
geometry for the butler matrix beamforming network is completed (Figure 8).

All transmission line distributed element parameters except for a few branch-lines are set 
based on a 50 Ω microstrip line built on a 20 mil lossless substrate with permittivity 
εr = 3.38 and 1 oz copper. The accurate values can be calculated accurately from Ref. 3.

The contribution of the distributed resistance on the insertion loss with the given substrate 
properties is less than 0.05 dB. To make the modeling steps simpler in this example, the 
approximated parameter values in Table 2 are used for a 50 Ω microstrip line.

The transmission line parameters with a different characteristic impedance value, Z0/√2 for 
the branch-lines, are adjusted using the normalized impedance. The distributed 
inductance is proportionally scaled and the distributed capacitance is inversely scaled by 
the normalized impedance of the microstrip line.

In order to excite ports one by one, the port sweep option in the transmission line physics 
interface is activated and combined with a parametric sweep in the study steps. Each port 
is terminated by a lumped port with 50 Ω reference characteristic impedance

Results and Discussion

The default plot show the real value of the voltage on the transmission lines. The default 
input expression is changed to plot the logarithmic value of the voltage (Figure 9). The 

TABLE 1:  CALCULATED TRANSMISSION LINE PARAMETERS OF A 50 Ω MICROSTRIP LINE.

R L G C

12.41 Ω/m 272.9 nH/m 0 S/m 107.1 pF/m

TABLE 2:  SIMPLIFIED TRANSMISSION LINE PARAMETERS OF A 50 Ω MICROSTRIP LINE.

R L G C

0 Ω/m 250 nH/m 0 S/m 100 pF/m
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plot shows that port 1, port 2 and port 3 have no coupled power (below -100 dB) from 
the excited port 4.

Figure 9: The dB-scaled voltage on the transmission lines when port 4 is excited. Port1, port 2 
and port 3 are isolated below -100 dB.

In Figure 10, the minimum range of the dB-scaled voltage plot is set to -10 dB to get a 
closer look at the level of each output port. The input voltage is equally distributed to all 
four output ports (- 6dB).
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Figure 10: The range of the dB-scaled voltage plot is adjusted to see the output voltage level.

Table 3 shows the evaluated phase at each output port.

By adjusting some of the evaluated angles, the phase at each port can be configured in an 
arithmetic order and the resulted phase progression is summarized in Table 4. If the butler 
matrix beamforming network is excited in the order of port 3 (-135 degrees), port 1 (-45 
degress), port 4 (45 degrees) and port 2 (135 degrees), and connected to a 4×1 antenna 
array, the antenna radiation pattern will be steered from one side to the other side 
(Figure 11). Note that the antenna array model in Figure 11 is not included in this 
example.

TABLE 3:  THE EVALUATED PHASE OF VOLTAGE AT EACH PORT

PORT 5 PORT 6 PORT 7 PORT 8

PORT 1 EXCITED -90° -135° -180° 135°

PORT 2 EXCITED -180° -45° 90° -135°

PORT 3 EXCITED -135° 90° -45° -180°

PORT 4 EXCITED 135° -180° -135° -90°
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Figure 11: The far-field radiation pattern of a 4×1 microstrip patch antenna array connected 
to the butler matrix beamforming network. The antenna model is not included in this 
example.
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TABLE 4:  THE EVALUATED PHASE OF VOLTAGE AT EACH PORT (PHASE ADJUSTED)

PORT 5 PORT 6 PORT 7 PORT 8 PHASE 
PROGRESSION

PORT 1 EXCITED -90° -135° -180° -225° -45°

PORT 2 EXCITED -180° -45° 90° 225° 135°

PORT 3 EXCITED 225° 90° -45° 180° -135°

PORT 4 EXCITED -225° -180° -135° -90° 45°

Port 3 excited Port 1 excited

Port 4 excited Port 2 excited
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3. COMSOL Application Gallery, “Transmission Line Parameter Calculator”, https://
www.comsol.com/model/transmission-line-parameter-calculator-22351

Application Library path: RF_Module/Couplers_and_Power_Dividers/
transmission_line_butler

Model Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 2D.

2 In the Select Physics tree, select Radio Frequency>Transmission Line (tl).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Frequency Domain.

6 Click Done.

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
transmission_line_butler_parameters.txt.

Here, c_const in the imported table is a predefined COMSOL constant for the speed 
of light in vacuum.

The 4x4 Butler matrix beamforming network in this example consists of a few parts that 
are repeatedly shown in the geometry. To make the modeling process more efficient, 
define these as Geometry Parts and reuse them as necessary.

5 In the Model Builder window, right-click Global Definitions and choose Geometry Parts.
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6 Right-click Global Definitions>Geometry Parts and choose 2D Part.

P A R T  1

1 In the Settings window for Part, type 90 Degree Hybrid in the Label text field.

2 Locate the Units section. From the Length unit list, choose mm.

Bézier Polygon 1 (b1)
On the Geometry toolbar, click Primitives and choose Bézier Polygon.

9 0  D E G R E E  H Y B R I D

Bézier Polygon 1 (b1)
1 In the Settings window for Bézier Polygon, locate the Polygon Segments section.

2 Find the Added segments subsection. Click Add Linear.

3 Find the Control points subsection. In row 2, set x to ul*2.

Bézier Polygon 2 (b2)
1 On the Geometry toolbar, click Primitives and choose Bézier Polygon.

2 In the Settings window for Bézier Polygon, locate the Polygon Segments section.

3 Find the Added segments subsection. Click Add Linear.

4 Find the Control points subsection. In row 1, set x to ul/2.

5 In row 2, set x to ul/2.

6 In row 2, set y to ul.

Rotate 1 (rot1)
1 On the Geometry toolbar, click Transforms and choose Rotate.

2 Click the Select All button on the Graphics toolbar.

3 In the Settings window for Rotate, locate the Rotation Angle section.

4 In the Rotation text field, type 0 180.

5 Locate the Center of Rotation section. In the x text field, type ul.

6 In the y text field, type ul/2.

7 Click Build Selected.
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8 Click the Zoom Extents button on the Graphics toolbar.

G L O B A L  D E F I N I T I O N S

Right-click Geometry Parts and choose 2D Part.

P A R T  2

1 In the Settings window for Part, type 45 Degree Delay in the Label text field.

2 Locate the Units section. From the Length unit list, choose mm.

Bézier Polygon 1 (b1)
On the Geometry toolbar, click Primitives and choose Bézier Polygon.

4 5  D E G R E E  D E L A Y

Bézier Polygon 1 (b1)
1 In the Settings window for Bézier Polygon, locate the General section.

2 From the Type list, choose Open curve.

3 Locate the Polygon Segments section. Find the Added segments subsection. Click 
Add Linear.

4 Find the Control points subsection. In row 2, set x to ul.

5 Find the Added segments subsection. Click Add Linear.

6 Find the Control points subsection. In row 2, set y to ul*0.75.
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7 Find the Added segments subsection. Click Add Linear.

8 Find the Control points subsection. In row 2, set x to ul*2.

9 Find the Added segments subsection. Click Add Linear.

10 Find the Control points subsection. In row 2, set y to 0.

11 Find the Added segments subsection. Click Add Linear.

12 Find the Control points subsection. In row 2, set x to ul*3.

13 Click Build Selected.

G L O B A L  D E F I N I T I O N S

Right-click Geometry Parts and choose 2D Part.

P A R T  3

1 In the Settings window for Part, type Transition in the Label text field.

2 Locate the Units section. From the Length unit list, choose mm.

3 On the Geometry toolbar, click Primitives and choose Bézier Polygon.

TR A N S I T I O N

Bézier Polygon 1 (b1)
1 In the Settings window for Bézier Polygon, locate the General section.

2 From the Type list, choose Open curve.
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3 Locate the Polygon Segments section. Find the Added segments subsection. Click 
Add Linear.

4 Find the Control points subsection. In row 2, set x to ul.

5 Find the Added segments subsection. Click Add Linear.

6 Find the Control points subsection. In row 2, set y to ul/2.

7 Find the Added segments subsection. Click Add Linear.

8 Find the Control points subsection. In row 2, set x to ul*2.

9 Find the Added segments subsection. Click Add Linear.

10 Find the Control points subsection. In row 2, set y to 0.

11 Find the Added segments subsection. Click Add Linear.

12 Find the Control points subsection. In row 2, set x to ul*3.

13 Click Build Selected.

G L O B A L  D E F I N I T I O N S

Right-click Geometry Parts and choose 2D Part.

P A R T  4

1 In the Settings window for Part, type Crossover in the Label text field.

2 Locate the Units section. From the Length unit list, choose mm.

3 On the Geometry toolbar, click Primitives and choose Bézier Polygon.
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C R O S S O V E R

Bézier Polygon 1 (b1)
1 In the Settings window for Bézier Polygon, locate the Polygon Segments section.

2 Find the Added segments subsection. Click Add Linear.

3 Find the Control points subsection. In row 2, set x to ul*3.

Bézier Polygon 2 (b2)
1 Right-click Global Definitions>Geometry Parts>Crossover>Bézier Polygon 1 (b1) and 

choose Duplicate.

2 In the Settings window for Bézier Polygon, locate the Polygon Segments section.

3 Find the Control points subsection. In row 1, set y to ul.

4 In row 2, set y to ul.

Bézier Polygon 3 (b3)
1 On the Geometry toolbar, click Primitives and choose Bézier Polygon.

2 In the Settings window for Bézier Polygon, locate the Polygon Segments section.

3 Find the Added segments subsection. Click Add Linear.

4 Find the Control points subsection. In row 1, set x to ul/2.

5 In row 2, set x to ul/2.

6 In row 2, set y to ul.

Array 1 (arr1)
1 On the Geometry toolbar, click Transforms and choose Array.

2 Select the object b3 only.

3 In the Settings window for Array, locate the Size section.

4 In the x size text field, type 3.

5 Locate the Displacement section. In the x text field, type ul.
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6 Click Build Selected.

G L O B A L  D E F I N I T I O N S

In the Model Builder window, under Global Definitions right-click Geometry Parts and 
choose 2D Part.

P A R T  5

1 In the Settings window for Part, type Front-end, outer in the Label text field.

2 Locate the Units section. From the Length unit list, choose mm.

Bézier Polygon 1 (b1)
On the Geometry toolbar, click Primitives and choose Bézier Polygon.

F R O N T - E N D ,  O U T E R

Bézier Polygon 1 (b1)
1 In the Settings window for Bézier Polygon, locate the General section.

2 From the Type list, choose Open curve.

3 Locate the Polygon Segments section. Find the Added segments subsection. Click 
Add Linear.

4 Find the Control points subsection. In row 2, set y to -1.5*(array_d-ul).

5 Find the Added segments subsection. Click Add Linear.
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6 Find the Control points subsection. In row 2, set x to -1.5*array_d+ul*6.

7 Click Build Selected.

G L O B A L  D E F I N I T I O N S

Right-click Geometry Parts and choose 2D Part.

P A R T  6

1 In the Settings window for Part, type Front-end, inner in the Label text field.

2 Locate the Units section. From the Length unit list, choose mm.

3 On the Geometry toolbar, click Primitives and choose Bézier Polygon.

F R O N T - E N D ,  I N N E R

Bézier Polygon 1 (b1)
1 In the Settings window for Bézier Polygon, locate the General section.

2 From the Type list, choose Open curve.

3 Locate the Polygon Segments section. Find the Added segments subsection. Click 
Add Linear.

4 Find the Control points subsection. In row 2, set x to ul*0.25.

5 Find the Added segments subsection. Click Add Linear.

6 Find the Control points subsection. In row 2, set y to -(array_d-ul)/2.
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7 Find the Added segments subsection. Click Add Linear.

8 Find the Control points subsection. In row 2, set x to ul*0.5.

9 Find the Added segments subsection. Click Add Linear.

10 Find the Control points subsection. In row 2, set y to 0.

11 Find the Added segments subsection. Click Add Linear.

12 Find the Control points subsection. In row 2, set x to ul*0.75.

13 Find the Added segments subsection. Click Add Linear.

14 Find the Control points subsection. In row 2, set y to -(array_d-ul)/2.

15 Find the Added segments subsection. Click Add Linear.

16 Find the Control points subsection. In row 2, set x to -1.5*array_d+ul*6.

17 Click Build Selected.

G E O M E T R Y  1

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose mm.

90 Degree Hybrid 2 (pi2)
1 On the Geometry toolbar, click Parts and choose 90 Degree Hybrid.

2 On the Geometry toolbar, click Parts and choose 90 Degree Hybrid.
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3 In the Settings window for Part Instance, locate the Position and Orientation of Output 
section.

4 In the x-displacement text field, type ul*5.

5 Click Build Selected.

6 Click the Zoom Extents button on the Graphics toolbar.

45 Degree Delay 1 (pi3)
1 On the Geometry toolbar, click Parts and choose 45 Degree Delay.

2 In the Settings window for Part Instance, locate the Position and Orientation of Output 
section.

3 In the x-displacement text field, type ul*2.

Transition 1 (pi4)
1 On the Geometry toolbar, click Parts and choose Transition.

2 In the Settings window for Part Instance, locate the Position and Orientation of Output 
section.

3 In the x-displacement text field, type ul*7.

4 Click Build Selected.

5 Click the Zoom Extents button on the Graphics toolbar.

Front-end, outer 1 (pi5)
1 On the Geometry toolbar, click Parts and choose Front-end, outer.

2 In the Settings window for Part Instance, locate the Position and Orientation of Output 
section.

3 In the x-displacement text field, type ul*10.

4 Click Build Selected.

5 Click the Zoom Extents button on the Graphics toolbar.

Front-end, inner 1 (pi6)
1 On the Geometry toolbar, click Parts and choose Front-end, inner.

2 In the Settings window for Part Instance, locate the Position and Orientation of Output 
section.

3 In the x-displacement text field, type ul*10.

4 In the y-displacement text field, type ul.

5 Click Build Selected.
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Mirror 1 (mir1)
1 On the Geometry toolbar, click Transforms and choose Mirror.

2 Click the Select All button on the Graphics toolbar.

3 In the Settings window for Mirror, locate the Input section.

4 Select the Keep input objects check box.

5 Locate the Point on Line of Reflection section. In the y text field, type ul*1.5.

6 Locate the Normal Vector to Line of Reflection section. In the x text field, type 0.

7 In the y text field, type 1.

8 Click Build Selected.

9 Click the Zoom Extents button on the Graphics toolbar.

Crossover 1 (pi7)
1 On the Geometry toolbar, click Parts and choose Crossover.

2 In the Settings window for Part Instance, locate the Position and Orientation of Output 
section.

3 In the x-displacement text field, type ul*2.

4 In the y-displacement text field, type ul.

Crossover 2 (pi8)
1 On the Geometry toolbar, click Parts and choose Crossover.

2 In the Settings window for Part Instance, locate the Position and Orientation of Output 
section.

3 In the x-displacement text field, type ul*7.

4 In the y-displacement text field, type ul.
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5 Click Build All Objects.

TR A N S M I S S I O N  L I N E  ( T L )

1 In the Model Builder window, under Component 1 (comp1) click Transmission Line (tl).

2 In the Settings window for Transmission Line, locate the Port Sweep Settings section.

3 Select the Activate port sweep check box.

Activate the port sweep option in the physics interface and combine with a parametric 
sweep. This will excite ports one by one.

Transmission Line Equation 1
1 In the Model Builder window, under Component 1 (comp1)>Transmission Line (tl) click 

Transmission Line Equation 1.

2 In the Settings window for Transmission Line Equation, locate the 
Transmission Line Equation section.

3 In the L text field, type L0.

4 In the C text field, type C0.

Transmission Line Equation 2
1 In the Model Builder window, right-click Transmission Line (tl) and choose 

Transmission Line Equation.
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2 Select Boundaries 6, 7, 9, 10, 43, 44, 46, and 47 only.

Set the impedance of the selected transmission lines (branch-lines in the 90 degree 
hybrid) to Z0/sqrt(2) by adjusting the distributed inductance and capacitance values.

3 In the Settings window for Transmission Line Equation, locate the 
Transmission Line Equation section.

4 In the L text field, type L0*z1.

5 In the C text field, type C0/z1.

Lumped Port 1
1 Right-click Transmission Line (tl) and choose Lumped Port.

2 Select Point 4 only.

See Figure 8 to confirm the lumped port configuration.

Lumped Port 2
1 Right-click Transmission Line (tl) and choose Lumped Port.

2 Select Point 3 only.

Lumped Port 3
1 Right-click Transmission Line (tl) and choose Lumped Port.

2 Select Point 2 only.

Lumped Port 4
1 Right-click Transmission Line (tl) and choose Lumped Port.
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2 Select Point 1 only.

Lumped Port 5
1 Right-click Transmission Line (tl) and choose Lumped Port.

2 Select Point 82 only.

Lumped Port 6
1 Right-click Transmission Line (tl) and choose Lumped Port.

2 Select Point 81 only.

Lumped Port 7
1 Right-click Transmission Line (tl) and choose Lumped Port.

2 Select Point 80 only.

Lumped Port 8
1 Right-click Transmission Line (tl) and choose Lumped Port.

2 Select Point 79 only.

M E S H  1

In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 
Edit Physics-Induced Sequence.

Size
1 In the Model Builder window, under Component 1 (comp1)>Mesh 1 click Size.

2 In the Settings window for Size, locate the Element Size section.

3 Click the Custom button.

4 Locate the Element Size Parameters section. In the Maximum element size text field, type 
ul/15.

5 Click the Select Boundaries button on the Graphics toolbar.
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6 Click Build All.

S T U D Y  1

Parametric Sweep
1 On the Study toolbar, click Parametric Sweep.

2 In the Settings window for Parametric Sweep, locate the Study Settings section.

3 Click Add.

4 Click to select row number 1 in the table.

5 In the table, enter the following settings:

Step 1: Frequency Domain
1 In the Model Builder window, under Study 1 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 In the Frequencies text field, type f0.

4 On the Study toolbar, click Compute.

Parameter name Parameter value list Parameter unit

PortName 1 2 3 4
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R E S U L T S

Line Graph
1 In the Model Builder window, expand the 2D Plot Group 1 node, then click Line Graph.

2 In the Settings window for Line, locate the Expression section.

3 In the Expression text field, type 20*log10(abs(V)).

4 On the 2D Plot Group 1 toolbar, click Plot.

Other input ports (port 1, port2 and port 3) are fully isolated from the excited port 4. 
See Figure 9.

5 Click to expand the Range section. Select the Manual color range check box.

6 In the Minimum text field, type -10.

7 In the Maximum text field, type 0.

8 On the 2D Plot Group 1 toolbar, click Plot.

Figure 10 shows that the input power to port 4 is equally split into all output ports (-6 
dB).

Global Evaluation 1
1 On the Results toolbar, click Global Evaluation.

2 In the Settings window for Global Evaluation, locate the Expressions section.

3 In the table, enter the following settings:

4 Click Evaluate.

Compare the evaluated values to those in Table 3.

Expression Unit Description

arg(tl.Vport_5) deg Port 5 phase

arg(tl.Vport_6) deg Port 6 phase

arg(tl.Vport_7) deg Port 7 phase

arg(tl.Vport_8) deg Port 8 phase
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Introduction

One way to design a filter is to utilize the element values of well-known filter prototypes 
such as maximally flat or equal-ripple low-pass filters. It is easier to fabricate a distributed 
element filter on a microwave substrate than a lumped element filter since it is 
cumbersome to find off-the-shelf capacitors and inductors exactly matched to the 
frequency-scaled element values of the filter prototype. This example demonstrates the 
design process of a distributed element filter using Richard’s transformation, Kuroda’s 
identity, and the Transmission Line physics interface. This approach is very fast compared 
to solving Maxwell’s equations in 3D. The model simulates a three-element 0.5 dB equal-
ripple low-pass filter that has a cutoff frequency at 4 GHz. The resulting S-parameter plot 
shows a low-pass frequency response that is also periodically observed at higher frequency 
range.

Figure 1: Microstrip low-pass filter circuit. The impedance for each unit length (0.125 
wavelengths) stub is calculated from the element values of a three element 0.5 dB equal-ripple 
low-pass filter.

Model Definition

The modeling process of a low-pass filter can be summarized as 

• Define a filter type such as maximally flat or equal-ripple. 

• Identify element values for the filter prototype.

• Convert the inductors and capacitors in the lumped element filter to series and shunt 
stubs by using Richard’s transformation.

• Apply Kuroda’s identity to convert short-circuited series stubs to open-circuited shunt 
stubs.

• Scale the impedance of stubs by the reference characteristic impedance (50 Ω) and set 
the length of stubs to 0.125 wavelengths defined by the cutoff frequency.

50 Ω 129.82 Ω 129.82 Ω 50 Ω

81.32 Ω 42.591 Ω 81.32 Ω

Port1 Port2
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Ref. 1 provides the element values for a 0.5 dB equal-ripple low-pass filter. The element 
values for a three element prototype are also shown in Table 1. 

These values are unscaled inductance and capacitance in a lumped element circuit that 
need to be converted to distributed elements. Richard’s transformation converts an 
inductor to a short-circuited stub and a capacitor to an open-circuited stub, respectively. 
The model is based on a three element prototype beginning with a series inductor. Two 
series inductors are transformed to series stubs and one shunt capacitor is transformed to 
a shunt stub. The normalized impedance of the open-circuited stub is the same as the 
lumped element value of the inductor (Equation 1) and that for the short-circuited stub 
is the inverse of the lumped element value of the capacitor (Equation 2).

 (1)

 (2)

The short-circuited series stub is not easily realizable as a microstrip circuit so it has to be 
transformed again using Kuroda’s identity that will convert a short-circuited series to an 
open-circuited shunt stub. A unit length (0.125 wavelengths) transmission line element 
must be added at each end of the input and output of the filter before applying Kuroda’s 
identity. During this transformation, the impedance of the stub and an additional unit 
length microstrip line element is scaled by n2 (Equation 3).

 (3)

 (4)

 (5)

The location of the converted open-circuited stub and the added unit length microstrip 
line element is swapped to complete the filter geometry. Finally, the impedance is scaled 
by the reference characteristic impedance, 50 Ω.

TABLE 1:  0.5 DECIBEL EQUAL-RIPPLE LOW-PASS FILTER ELEMENT VALUES, N = 3

g1 g2 g3 g4

1.5963 1.0967 1.5963 1

Zstubshort circuited– L=

Zstubopen circuited–
1
C
----=

n2 1 1
Zseries stub, short circuited–
-----------------------------------------------------------------------+=

Zshunt stub, open circuited– n2
=

Zunit 0,125λ, n2Zstubshort circuited–=
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Figure 2: The three element filter design using lumped element prototype element values.

The filter geometry is built with six lines (Bézier polygons) on a two-dimensional space. 
The properties of each line representing a microstrip line with a different characteristic 
impedance are configured by Transmission Line Equation features.

The transmission line parameters for a 50 Ω microstrip line built on a 20 mil lossless 
substrate with permittivity εr = 3.38 and 1 oz copper can be calculated accurately from 
Ref. 2.

The contribution of the distributed resistance on the insertion loss with the given substrate 
properties is less than 0.05 dB. To make the modeling steps simpler in this example, the 
approximated parameter values in Table 3 are used for a 50 Ω microstrip line.

Other transmission line parameters with different characteristic impedance values are 
adjusted using the normalized impedance. The distributed inductance is proportionally 
scaled and the distributed capacitance is inversely scaled by the normalized impedance of 
the microstrip line.

TABLE 2:  CALCULATED TRANSMISSION LINE PARAMETERS OF A 50 Ω MICROSTRIP LINE.

R L G C

12.41 Ω/m 272.9 nH/m 0 S/m 107.1 pF/m

TABLE 3:  SIMPLIFIED TRANSMISSION LINE PARAMETERS OF A 50 Ω MICROSTRIP LINE.

R L G C

0 Ω/m 250 nH/m 0 S/m 100 pF/m

50 Ω 50(g1+1) Ω 50(g1+1) Ω 50 Ω

50(1+1/g1) Ω 50/g2 Ω 50(1+1/g1) Ω

Port1 Port2
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Results and Discussion

The S-parameters, S11 and S21 of the low-pass filter is plotted in Figure 3. The cutoff is 
shown at the intended frequency 4 GHz. The ripple of S21 is 0.5 dB.

Figure 3: The frequency response of the 0.5dB equal-ripple low-pass filter.

The passband is observed again at the frequency hight 12 GHz. It is a distributed element 
filter so the frequency response is periodic.
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Model Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 2D.

2 In the Select Physics tree, select Radio Frequency>Transmission Line (tl).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Frequency Domain.

6 Click Done.

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
transmission_line_lpf_parameters.txt.

G E O M E T R Y  1

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose mm.

Bézier Polygon 1 (b1)
1 On the Geometry toolbar, click Primitives and choose Bézier Polygon.

2 In the Settings window for Bézier Polygon, locate the Polygon Segments section.

3 Find the Added segments subsection. Click Add Linear.

4 Find the Control points subsection. In row 1, set x to -ul-0.5.

Bézier Polygon 2 (b2)
1 On the Geometry toolbar, click Primitives and choose Bézier Polygon.
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2 In the Settings window for Bézier Polygon, locate the Polygon Segments section.

3 Find the Added segments subsection. Click Add Linear.

4 Find the Control points subsection. In row 1, set x to -ul.

5 In row 2, set x to ul.

Bézier Polygon 3 (b3)
1 On the Geometry toolbar, click Primitives and choose Bézier Polygon.

2 In the Settings window for Bézier Polygon, locate the Polygon Segments section.

3 Find the Added segments subsection. Click Add Linear.

4 Find the Control points subsection. In row 1, set x to ul.

5 In row 2, set x to ul+0.5.

Bézier Polygon 4 (b4)
1 On the Geometry toolbar, click Primitives and choose Bézier Polygon.

2 In the Settings window for Bézier Polygon, locate the Polygon Segments section.

3 Find the Added segments subsection. Click Add Linear.

4 Find the Control points subsection. In row 1, set x to -ul.

5 In row 2, set x to -ul.

6 In row 2, set y to ul.

Bézier Polygon 5 (b5)
1 On the Geometry toolbar, click Primitives and choose Bézier Polygon.

2 In the Settings window for Bézier Polygon, locate the Polygon Segments section.

3 Find the Added segments subsection. Click Add Linear.

4 Find the Control points subsection. In row 2, set y to ul.

Bézier Polygon 6 (b6)
1 On the Geometry toolbar, click Primitives and choose Bézier Polygon.

2 In the Settings window for Bézier Polygon, locate the Polygon Segments section.

3 Find the Added segments subsection. Click Add Linear.

4 Find the Control points subsection. In row 1, set x to ul.

5 In row 2, set x to ul.

6 In row 2, set y to ul.

7 On the Geometry toolbar, click Build All.
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8 Click the Zoom Extents button on the Graphics toolbar.

TR A N S M I S S I O N  L I N E  ( T L )

Lumped Port 1
1 In the Model Builder window, under Component 1 (comp1) right-click 

Transmission Line (tl) and choose Lumped Port.

2 Select Point 1 only.

3 In the Settings window for Lumped Port, locate the Port Properties section.

4 From the Wave excitation at this port list, choose On.

Lumped Port 2
1 In the Model Builder window, right-click Transmission Line (tl) and choose Lumped Port.

2 Select Point 8 only.

Transmission Line Equation 1
Set the input parameters of the transmission line that are configured for 50Ω.

1 In the Model Builder window, under Component 1 (comp1)>Transmission Line (tl) click 
Transmission Line Equation 1.

2 In the Settings window for Transmission Line Equation, locate the 
Transmission Line Equation section.

3 In the L text field, type L0.
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4 In the C text field, type C0.

Transmission Line Equation 2
1 In the Model Builder window, right-click Transmission Line (tl) and choose 

Transmission Line Equation.

2 Select Boundaries 3 and 5 only.

3 In the Settings window for Transmission Line Equation, locate the 
Transmission Line Equation section.

4 In the L text field, type L0*z1_1.

5 In the C text field, type C0/z1_1.

The input parameters are scaled by the normalized impedance for 129.82Ω.

Transmission Line Equation 3
1 Right-click Transmission Line (tl) and choose Transmission Line Equation.
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2 Select Boundaries 2 and 6 only.

3 In the Settings window for Transmission Line Equation, locate the 
Transmission Line Equation section.

4 In the L text field, type L0*z1_2.

5 In the C text field, type C0/z1_2.

The input parameters are scaled by the normalized impedance for 81.32Ω.

Transmission Line Equation 4
1 Right-click Transmission Line (tl) and choose Transmission Line Equation.
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2 Select Boundary 4 only.

3 In the Settings window for Transmission Line Equation, locate the 
Transmission Line Equation section.

4 In the L text field, type L0*z2.

5 In the C text field, type C0/z2.

The input parameters are scaled by the normalized impedance for 42.592Ω.

S T U D Y  1

Step 1: Frequency Domain
1 In the Model Builder window, under Study 1 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 In the Frequencies text field, type range(1[GHz],0.1[GHz],20[GHz]).

4 On the Home toolbar, click Compute.

R E S U L T S

Line Graph
1 In the Model Builder window, expand the 2D Plot Group 1 node, then click Line Graph.

2 In the Settings window for Line, locate the Coloring and Style section.

3 From the Line type list, choose Tube.
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4 On the 2D Plot Group 1 toolbar, click Plot.

2D Plot Group 1
1 In the Model Builder window, under Results click 2D Plot Group 1.

2 In the Settings window for 2D Plot Group, locate the Data section.

3 From the Parameter value (freq (GHz)) list, choose 3.5.

4 On the 2D Plot Group 1 toolbar, click Plot.

This is the voltage plot at 3.5 GHz that is inside the passband.

Global 1
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Model Builder window, right-click 1D Plot Group 2 and choose Global.

3 In the Settings window for Global, click Add Expression in the upper-right corner of the 
y-axis data section. From the menu, choose Component 1>Transmission Line>Ports>S-

parameter, dB>tl.S11dB - S11.

4 Click Add Expression in the upper-right corner of the y-axis data section. From the 
menu, choose Component 1>Transmission Line>Ports>S-parameter, dB>tl.S21dB - S21.

5 On the 1D Plot Group 2 toolbar, click Plot.
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1D Plot Group 2
1 In the Model Builder window, under Results click 1D Plot Group 2.

2 In the Settings window for 1D Plot Group, click to expand the Title section.

3 From the Title type list, choose Manual.

4 In the Title text area, type 0.5 dB Equal-Ripple Low-Pass Filter, Cutoff at 
4GHz.

5 Locate the Axis section. Select the Manual axis limits check box.

6 In the y minimum text field, type -50.

7 Locate the Legend section. From the Position list, choose Lower right.

Compare the resulting plot with that shown in Figure 3.
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Introduction

An evanescent mode cavity filter can be realized by adding a structure inside of the cavity. 
This structure changes the resonant frequency below that of the dominant mode of the 
unfilled cavity. A piezo actuator is used to control the size of a small air gap which provides 
the tunability of the resonant frequency.

Figure 1: A tunable evanescent mode cavity filter is composed of a rectangular cavity with a 
metallic post, a piezo actuator disk, and slot-coupled microstrip lines. There is a small gap 
between the top of the post and the bottom side of the piezo actuator. The front part of the cavity 
wall is removed for visualization purposes.

Note: In addition to the RF Module, this example requires one of the Acoustics Module, 
the MEMS Module, or the Structural Mechanics Module.

Model Definition

This example starts from a basic rectangular cavity filter, whose resonant frequencies are 
given by

Piezo actuator disk

Substrate 

Slot

Shorted

Lumped port

Metallic post

Microstrip 
line

Air-filled metallic cavity
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where a and b are the waveguide aperture dimensions and d is the length of the waveguide 
cavity. In this example, the cavity width, height, and length are a = 100 mm, b = 50 mm, 
and d = 50 mm, respectively. The resulting resonant frequency of the dominant mode, 
TE101, is 3.354 GHz.

By adding a metallic post and creating reactance inside the cavity, the resonance frequency 
can be lowered. The cavity is air filled and the height of the post is slightly smaller than b, 
which creates a small gap between the top of the post and the cavity where the electric 
fields are confined. Two shorted 50 Ω microstrip lines on a dielectric substrate, fed by a 
lumped port, are coupled into the cavity. The dimensions and locations of the slots can be 
adjusted to improve input matching properties and power transfer between input and 
output ports. The air box around the microstrip lines are enclosed by a scattering 
boundary condition representing the infinite air space. A circular aperture at the top of the 
cavity is closed with a piezo actuator and the bottom surface of the disk is finished with a 
layer of a highly conductive material that is several skin depths in thickness.

Model all metal parts—the cavity walls, post, substrate ground planes, microstrip lines, and 
the bottom surface of the piezo device—as perfect electric conductors (PECs). The 
material for the piezo actuator is Lead Zirconate Titanate (PZT-5H). It is z-polarized and 
generates mainly z-directional deflection of the device.

Mesh the model using a tetrahedral mesh with approximately five elements per wavelength 
in each material at the highest simulation frequency. When the piezo device deforms due 
to the input bias, the Moving Mesh interface is used to deform the mesh for the 
Electromagnetic Waves physics.

Results and Discussion

A +300 V potential is applied across the piezo actuator, which causes the device to deflect 
~90 μm toward the bottom; see Figure 2. This makes the reactance stronger and shifts the 
resonant frequency lower than the negative bias case. Figure 3 plots the electric field norm 
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at the resonance. At the center of the cavity as well as in the gap between the top of the 
post and the bottom of the piezo device, strong electric fields are observed.

Figure 2: This plot shows the total piezo displacement when 300 V is applied on the actuator. 
The visualization is exaggerated to emphasize the deflection.

The S-parameters plotted in Figure 4 show the effect of the piezo device deflection on the 
filter’s resonant frequency. The tunable frequency range of this example is ~40MHz. This 
range can be adjusted by different choices of the piezo disk size and the input bias voltage.
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Figure 3: The dominant mode inside the cavity is observed from the electric field distribution 
plot.

Figure 4: The deflection for the piezo device controlled by the input bias can shift the resonance 
frequency of the filter.
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Notes About the COMSOL Implementation

This example uses the built-in Piezoelectric Devices multiphysics interface which couples 
the Solid Mechanics and Electrostatics interfaces through the Piezoelectric Effect node 
located under the Multiphysics branch. Other physics interfaces used are Moving Mesh 
and Electromagnetic Waves, Frequency Domain. A Stationary study is used for the Solid 
Mechanics, Electrostatics and Moving Mesh interfaces, and a Frequency Domain study is 
used for the Electromagnetic Waves interface.

Application Library path: RF_Module/Filters/tunable_cavity_filter

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Structural Mechanics>Piezoelectric Devices.

3 Click Add.

4 In the Select Physics tree, select Mathematics>Deformed Mesh>Moving Mesh (ale).

5 Click Add.

6 In the Select Physics tree, select Radio Frequency>Electromagnetic Waves,

Frequency Domain (emw).

7 Click Add.

8 Click Study.

9 In the Select Study tree, select Empty Study.

10 Click Done.

S T U D Y  1

Step 1: Stationary
1 On the Study toolbar, click Study Steps and choose Stationary>Stationary.
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2 In the Settings window for Stationary, locate the Physics and Variables Selection section.

3 In the table, clear the Solve for check box for the Electromagnetic Waves, Frequency 

Domain (emw) interface.

Step 2: Frequency Domain
1 On the Study toolbar, click Study Steps and choose Frequency Domain>

Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 In the Frequencies text field, type range(3[GHz],2.5[MHz],3.06[GHz]).

4 Locate the Physics and Variables Selection section. In the table, clear the Solve for check 
box for following interfaces:

G E O M E T R Y  1

The model geometry is available as a parameterized geometry sequence in a separate 
MPH-file. If you want to build it from scratch, follow the instructions in the section 
Appendix: Geometry Modeling Instructions. Otherwise load it from file with the 
following steps.

1 On the Geometry toolbar, click Insert Sequence.

2 Browse to the model’s Application Libraries folder and double-click the file 
tunable_cavity_filter_geom_sequence.mph.

Cavity (blk1)
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 click 

Cavity (blk1).

2 In the Settings window for Block, click Build All Objects.

3 Click the Zoom Extents button on the Graphics toolbar.

Physics interface

Solid Mechanics (solid)

Electrostatics (es)

Moving Mesh (ale)
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4 Click the Wireframe Rendering button on the Graphics toolbar.

G L O B A L  D E F I N I T I O N S

Parameters
Add parameters that are not related to geometry.

1 In the Model Builder window, expand the Global Definitions node, then click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

Here, c_const is a predefined COMSOL constant for the speed of light in vacuum.

D E F I N I T I O N S

Create a set of selections for use when setting up the physics. First, create a selection for 
the microstrip feed line.

Explicit 1
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Feed line in the Label text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.

Name Expression Value Description

V0 300[V] 300 V Piezo actuator bias
8 |  TU N A B L E  E V A N E S C E N T  M O D E  C A V I T Y  F I L T E R  U S I N G  A  P I E Z O  A C T U A T O R



4 Select Boundaries 17, 22, 47, and 50 only.

Add a selection for the ground.

Explicit 2
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Ground in the Label text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.
9 |  TU N A B L E  E V A N E S C E N T  M O D E  C A V I T Y  F I L T E R  U S I N G  A  P I E Z O  A C T U A T O R



4 Select Boundaries 6, 16, 28, 39, and 53 only.

Add a selection for the substrate.

Explicit 3
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Substrate in the Label text field.
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3 Select Domains 2, 4, 6, and 8 only.

Add a selection for the piezo actuator disk.

Explicit 4
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Piezo actuator in the Label text field.
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3 Select Domain 5 only.

Add a selection for fixed edges of the piezo disk.

Explicit 5
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Piezo fixed edges in the Label text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Edge.
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4 Select Edges 50, 51, 63, and 66 only.

Add a selection for the open boundaries of RF domain.

Explicit 6
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Open boundaries in the Label text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.
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4 Select Boundaries 4, 5, 7, 8, 10, 12, 13, 23, 25, 37, 38, 40, 41, 43–45, 56, and 57 only.

Before defining materials, specify domains for each physics.

S O L I D  M E C H A N I C S  ( S O L I D )

1 In the Model Builder window, under Component 1 (comp1) click Solid Mechanics (solid).

2 In the Settings window for Solid Mechanics, locate the Domain Selection section.

3 From the Selection list, choose Piezo actuator.

E L E C T R O S T A T I C S  ( E S )

On the Physics toolbar, click Solid Mechanics (solid) and choose Electrostatics (es).

1 In the Model Builder window, under Component 1 (comp1) click Electrostatics (es).

2 In the Settings window for Electrostatics, locate the Domain Selection section.

3 From the Selection list, choose Piezo actuator.

Set up the Moving Mesh interface. Because the substrate and air domains are deflection 
free regions, do not include them in this physics.

M OV I N G  M E S H  ( A L E )

On the Physics toolbar, click Electrostatics (es) and choose Moving Mesh (ale).

1 In the Model Builder window, under Component 1 (comp1) click Moving Mesh (ale).

2 In the Settings window for Moving Mesh, locate the Domain Selection section.
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3 Click Clear Selection.

4 Select Domain 1 only.

Set up the Electromagnetic Waves, Frequency Domain interface. Suppress the piezo actuator 
disk domain.

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

On the Physics toolbar, click Moving Mesh (ale) and choose Electromagnetic Waves,

Frequency Domain (emw).

1 In the Model Builder window, under Component 1 (comp1) click Electromagnetic Waves,

Frequency Domain (emw).
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2 Select Domains 1–4 and 6–8 only.

Assign material properties. Use three materials for this model: PZT-5H, air, and a user-
defined substrate.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Piezoelectric>Lead Zirconate Titanate (PZT-5H).

4 Click Add to Component in the window toolbar.

M A T E R I A L S

Lead Zirconate Titanate (PZT-5H) (mat1)
1 In the Model Builder window, under Component 1 (comp1)>Materials click 

Lead Zirconate Titanate (PZT-5H) (mat1).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Piezo actuator.

A D D  M A T E R I A L

1 Go to the Add Material window.

2 In the tree, select Built-In>Air.
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3 Click Add to Component in the window toolbar.

M A T E R I A L S

Air (mat2)
1 On the Home toolbar, click Add Material to close the Add Material window.

2 In the Model Builder window, under Component 1 (comp1)>Materials click Air (mat2).

3 Select Domains 1, 3, and 7 only.

Material 3 (mat3)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Substrate.

4 Locate the Material Contents section. In the table, enter the following settings:

Property Name Value Unit Property 
group

Relative permittivity epsilonr 3.38 1 Basic

Relative permeability mur 1 1 Basic

Electrical conductivity sigma 0 S/m Basic
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S O L I D  M E C H A N I C S  ( S O L I D )

Now, set up the physics constraints. Start by assuming the bottom rim of piezo actuator 
part is attached on the same size circular aperture of the cavity top and no deflection is 
expected.

1 In the Model Builder window, expand the Component 1 (comp1)>Solid Mechanics (solid) 
node.

Fixed Constraint 1
1 Right-click Solid Mechanics (solid) and choose Edges>Fixed Constraint.

2 In the Settings window for Fixed Constraint, locate the Edge Selection section.

3 From the Selection list, choose Piezo fixed edges.

E L E C T R O S T A T I C S  ( E S )

Next, define the Electrostatics constraints.

Electric Potential 1
1 In the Model Builder window, under Component 1 (comp1) right-click Electrostatics (es) 

and choose Electric Potential.

2 Select Boundary 29 only.

3 In the Settings window for Electric Potential, locate the Electric Potential section.

4 In the V0 text field, type -V0.
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Ground 1
1 In the Model Builder window, right-click Electrostatics (es) and choose Ground.

2 In the Settings window for Ground, locate the Boundary Selection section.

3 From the Selection list, choose Ground.

M OV I N G  M E S H  ( A L E )

Prescribed Mesh Displacement 1
1 In the Model Builder window, expand the Moving Mesh (ale) node, then click 

Prescribed Mesh Displacement 1.

2 In the Settings window for Prescribed Mesh Displacement, locate the 
Prescribed Mesh Displacement section.

3 In the dx text field, type u.

4 In the dy text field, type v.

5 In the dz text field, type w.

Free Deformation 1
1 In the Model Builder window, right-click Moving Mesh (ale) and choose Free Deformation.

2 Select Domain 1 only.

Prescribed Mesh Displacement 2
1 Right-click Moving Mesh (ale) and choose Prescribed Mesh Displacement.

2 In the Settings window for Prescribed Mesh Displacement, locate the Boundary Selection 
section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 1-27,29-57 in the Selection text field.

5 Click OK.

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

Perfect Electric Conductor 2
1 In the Model Builder window, under Component 1 (comp1) right-click 

Electromagnetic Waves, Frequency Domain (emw) and choose Perfect Electric Conductor.

2 In the Settings window for Perfect Electric Conductor, locate the Boundary Selection 
section.

3 From the Selection list, choose Feed line.
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Perfect Electric Conductor 3
1 In the Model Builder window, right-click Electromagnetic Waves,

Frequency Domain (emw) and choose Perfect Electric Conductor.

2 In the Settings window for Perfect Electric Conductor, locate the Boundary Selection 
section.

3 From the Selection list, choose Ground.

Scattering Boundary Condition 1
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Scattering Boundary Condition.

2 In the Settings window for Scattering Boundary Condition, locate the Boundary Selection 
section.

3 From the Selection list, choose Open boundaries.

Lumped Port 1
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Lumped Port.

2 Select Boundary 14 only.

For the first port, wave excitation is on by default.

Lumped Port 2
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Lumped Port.
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2 Select Boundary 54 only.

M E S H  1

Adjust the maximum and minimum element size manually on the piezo actuator to reduce 
the memory cost of running the study without compromising the accuracy. Then, use 
swept mesh for the piezo actuator to handle the structural deformation more efficiently.

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.

2 In the Settings window for Mesh, locate the Mesh Settings section.

3 From the Sequence type list, choose User-controlled mesh.

Size 1
1 In the Model Builder window, under Component 1 (comp1)>Mesh 1 click Size 1.

2 In the Settings window for Size, locate the Element Size Parameters section.

3 In the Maximum element size text field, type 10.

4 In the Minimum element size text field, type 1.

Free Tetrahedral 1
1 In the Model Builder window, under Component 1 (comp1)>Mesh 1 click 

Free Tetrahedral 1.

2 In the Settings window for Free Tetrahedral, locate the Domain Selection section.

3 From the Geometric entity level list, choose Domain.
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4 Select Domains 1–4 and 6–8 only.

Select all domains except for the piezo actuator.

Distribution 1
1 In the Model Builder window, right-click Mesh 1 and choose Swept.

2 Right-click Swept 1 and choose Distribution.

3 In the Settings window for Distribution, locate the Distribution section.

4 In the Number of elements text field, type 2.

5 Click Build All.

S T U D Y  1

Parametric Sweep
1 On the Study toolbar, click Parametric Sweep.

2 In the Settings window for Parametric Sweep, locate the Study Settings section.

3 Click Add.

4 In the table, enter the following settings:

Parameter name Parameter value list Parameter unit

V0 -300,300
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5 On the Study toolbar, click Compute.

R E S U L T S

Stress (solid)
Replace the default stress plot by displacement plot.

1 In the Model Builder window, under Results click Stress (solid).

2 In the Settings window for 3D Plot Group, type Displacement in the Label text field.

Surface 1
1 In the Model Builder window, expand the Results>Displacement node, then click 

Surface 1.

2 In the Settings window for Surface, click Replace Expression in the upper-right corner of 
the Expression section. From the menu, choose Component 1>Solid Mechanics>

Displacement>solid.disp - Total displacement.

3 On the Displacement toolbar, click Plot.

4 Click the Zoom Extents button on the Graphics toolbar.

This plot shows the deflected piezo actuator disk; compare with Figure 2.

Electric Potential (es)

The electric potential inside the piezo actuator disk.
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Electric Field (emw)
1 In the Model Builder window, under Results click Electric Field (emw).

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Parameter value (freq (GHz)) list, choose 3.008.

4 On the Electric Field (emw) toolbar, click Plot.

Multislice
1 In the Model Builder window, expand the Electric Field (emw) node, then click Multislice.

2 In the Settings window for Multislice, click to expand the Range section.

3 Select the Manual color range check box.

4 In the Maximum text field, type 1000.

5 On the Electric Field (emw) toolbar, click Plot.

The resulting plot shows strong electric fields resulting from the dominant resonance at 
the center of the cavity as well as in the gap between the metallic post and the ceiling of 
the cavity.Compare the plot with that shown in Figure 3.

S-Parameter (emw)
1 In the Settings window for 1D Plot Group, click to expand the Legend section.

2 From the Position list, choose Lower left.

Global 1
1 In the Model Builder window, expand the S-Parameter (emw) node, then click Global 1.

2 In the Settings window for Global, locate the x-Axis Data section.

3 From the Unit list, choose GHz.

4 On the S-Parameter (emw) toolbar, click Plot.

The plotted S-parameters show the frequency shift as a function of the input bias on the 
piezo actuator; compare with Figure 4.
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Smith Plot (emw)

Appendix: Geometry Modeling Instructions

R O O T

On the Home toolbar, click Component and choose Add Component>3D.

G L O B A L  D E F I N I T I O N S

Load geometrical parameters from a file.

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
tunable_cavity_filter_parameters.txt.

G E O M E T R Y  1

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.
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3 From the Length unit list, choose mm.

First, create a block for the cavity.

Block 1 (blk1)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, type Cavity in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type 100.

4 In the Depth text field, type 50.

5 In the Height text field, type 50.

6 Locate the Position section. From the Base list, choose Center.

Add a substrate block.

Block 2 (blk2)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, type Substrate in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type 25.

4 In the Depth text field, type 50.

5 In the Height text field, type thickness.

6 Locate the Position section. From the Base list, choose Center.

7 In the x text field, type -37.5.

8 In the z text field, type 25+thickness/2.

Add a block for the air domain.

Block 3 (blk3)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, type Air block in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type 25.

4 In the Depth text field, type 50.

5 In the Height text field, type 10.

6 Locate the Position section. From the Base list, choose Center.

7 In the x text field, type -37.5.

8 In the z text field, type 30.

9 Right-click Air block and choose Build Selected.
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10 Click the Wireframe Rendering button on the Graphics toolbar.

Add a block for the microstrip line feed.

Block 4 (blk4)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, type Feed_line in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type l_feed+w_slot.

4 In the Depth text field, type 3.2.

5 In the Height text field, type thickness.

6 Locate the Position section. From the Base list, choose Center.

7 In the x text field, type -x_slot-l_feed/2.

8 In the z text field, type 25+thickness/2.

Add a work plane where you will draw a slot.

Work Plane 1 (wp1)
1 On the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 In the z-coordinate text field, type 25.

4 Click Show Work Plane.
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Plane Geometry
Add a rectangle for the slot.

Rectangle 1 (r1)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type w_slot.

4 In the Height text field, type l_slot.

5 Locate the Position section. From the Base list, choose Center.

6 In the xw text field, type -x_slot.

7 Right-click Rectangle 1 (r1) and choose Build Selected.

8 Click the Zoom Extents button on the Graphics toolbar.

9 In the Model Builder window, click Geometry 1.

Generate the 2nd slot coupled microstrip line by mirroring some geometries.

Mirror 1 (mir1)
1 On the Geometry toolbar, click Transforms and choose Mirror.

2 Select the objects wp1, blk3, blk2, and blk4 only.

3 In the Settings window for Mirror, locate the Input section.

4 Select the Keep input objects check box.

5 Locate the Normal Vector to Plane of Reflection section. In the x text field, type 1.
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6 In the z text field, type 0.

7 Click Build All Objects.

Add a block for the metal post in the middle of the cavity.

Block 5 (blk5)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, type Post in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type 15.

4 In the Depth text field, type 15.

5 In the Height text field, type 50-gap_post.

6 Locate the Position section. In the x text field, type -7.5.

7 In the y text field, type -7.5.

8 In the z text field, type -25.

9 Right-click Post and choose Build Selected.

Add a cylinder for the piezo actuator disk.

Cylinder 1 (cyl1)
1 On the Geometry toolbar, click Cylinder.

2 In the Settings window for Cylinder, type Piezo actuator in the Label text field.

3 Locate the Size and Shape section. In the Radius text field, type 21.

4 In the Height text field, type 0.5.

5 Locate the Position section. In the z text field, type 25.

6 Right-click Piezo actuator and choose Build Selected.

The inside of the metal post is not part of the modeling domain. Therefore, subtract it 
from the cavity.

Difference 1 (dif1)
1 On the Geometry toolbar, click Booleans and Partitions and choose Difference.

2 Select the object blk1 only.

3 In the Settings window for Difference, locate the Difference section.

4 Find the Objects to subtract subsection. Select the Active toggle button.

5 Select the object blk5 only.

6 Click Build All Objects.

7 Click the Zoom Extents button on the Graphics toolbar.
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Introduction

UHF RFID tags are widely used for identifying and tracking animals. This example 
simulates a passive radio-frequency identification (RFID) tag for the UHF frequency 
range.

With respect to the chip transponder’s complex impedance, a reflection coefficient is 
computed. This is done using an approach that differs from the conventional scattering 
parameter analysis method by a real reference impedance value.

Figure 1: The RFID tag’s geometry consists of copper traces patterned on an FR4 board that 
is enclosed by a low dielectric PTFE case. The surrounding air domain and perfectly matched 
layers, which are required for the simulation, are not included in this figure.

Model Definition

In this example, the RFID tag’s operating frequency is 915 MHz. At this frequency, the 
metal part of the RFID tag can be modeled as a perfect electrical conductor (PEC), 
because while the copper traces patterned on the FR4 board are geometrically very thin, 
they are much thicker than the skin depth.

The entire circuit board is inserted inside a lossless PTFE casing. The tag is modeled in a 
spherical air domain, which is enclosed by perfectly matched layers (PML) that absorb all 
outgoing radiation from the tag. 

Lumped port

PTFE casing

FR4 boardPerfect electric conductor
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A lumped port with a reference impedance of 50 Ω is used on the location of an RFID 
chip. This is done to excite the tag and evaluate the input impedance of the tag’s antenna 
part, which is modeled as a meander line. An additional copper strip is placed adjacent to 
the meander line to control the impedance. 

The conventional S-parameter works well only with a real reference impedance. However, 
the RFID chip's impedance is complex and the calculated S-parameter is not physical when 
a complex port reference impedance is used.

In Ref. 1, the power wave reflection coefficient term is introduced. It is applicable for 
evaluating the matching properties of an RFID tag: 

where Zl is the complex load impedance and Zref is the complex reference impedance. 

Results and Discussion 

Figure 2 shows the default E-field norm on the xy-plane. The field distribution plot 
indicates that the electric field is symmetrically confined along the meander line, as well as 
in the area between the meander line and impedance matching strip. 

The far-field radiation pattern of the tag is shown in Figure 3. Noticeably, the tag's 
radiation pattern looks very similar to the radiation pattern of a half-wave dipole antenna. 

The evaluated impedance of the tag is around 18+j124 Ω and the power wave reflection 
coefficient, in dB, is below −15 dB. 

Γ
Zl Zref∗–

Zl Zref+
------------------------=
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Figure 2: The E-field norm plot shows where the field is strongly confined in the tag.

Figure 3: The far-field radiation pattern resembles that of a half-wave dipole antenna.
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Model Library path: RF_Module/Antennas/uhf_rfid_tag

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Radio Frequency>Electromagnetic Waves,

Frequency Domain (emw).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Frequency Domain.

6 Click Done.

S T U D Y  1

Step 1: Frequency Domain
1 In the Model Builder window, under Study 1 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 In the Frequencies text field, type 915[MHz].

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.
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3 In the table, enter the following settings:

G E O M E T R Y  1

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose mm.

Import 1 (imp1)
1 On the Home toolbar, click Import.

2 In the Settings window for Import, locate the Import section.

3 Click Browse.

4 Browse to the model’s Application Libraries folder and double-click the file 
uhf_rfid_tag.mphbin.

5 Click Import.

6 Click the Wireframe Rendering button on the Graphics toolbar.

Add a sphere for the air domain surrounding the RFID tag and perfectly matched layers 
that will be configured later on.

Name Expression Value Description

Zc 15-j*125[ohm] (15-125i) Ω Chip impedance
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Sphere 1 (sph1)
1 On the Geometry toolbar, click Sphere.

2 In the Settings window for Sphere, locate the Size section.

3 In the Radius text field, type 150.

4 Click to expand the Layers section. In the table, enter the following settings:

5 Click Build All Objects.

6 Click the Zoom Extents button on the Graphics toolbar.

D E F I N I T I O N S

In the Model Builder window, under Component 1 (comp1) right-click Definitions and 
choose Variables.

Define a variable for calculating the reflection coefficient between two complex 
impedances.

Variables 1
1 In the Settings window for Variables, locate the Variables section.

Layer name Thickness (mm)

Layer 1 30
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2 In the table, enter the following settings:

Perfectly Matched Layer 1 (pml1)
1 On the Definitions toolbar, click Perfectly Matched Layer.

2 Select Domains 1–4 and 9–12 only.

These are all of the outermost domains of the sphere.

3 In the Settings window for Perfectly Matched Layer, locate the Geometry section.

4 From the Type list, choose Spherical.

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

Perfect Electric Conductor 2
1 In the Model Builder window, under Component 1 (comp1) right-click 

Electromagnetic Waves, Frequency Domain (emw) and choose Perfect Electric Conductor.

2 Click the Zoom In button on the Graphics toolbar, a couple of times to get a clear view 
of the RFID tag.

3 Select Boundaries 25, 27, and 54 only.

Name Expression Unit Description

Gamma (emw.Zport_1-conj(Zc))/
(emw.Zport_1+Zc)

Reflection coefficient 
for complex impedance 
matching
8 |  N U M E R I C A L  M O D E L I N G  O F  A  U H F  R F I D  TA G



Lumped Port 1
1 In the Model Builder window, right-click Electromagnetic Waves,

Frequency Domain (emw) and choose Lumped Port.

2 Select Boundary 35 only.

For the first port, wave excitation is on by default.

3 Click the Zoom Extents button on the Graphics toolbar.

4 Click the Zoom In button on the Graphics toolbar.

5 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Far-
Field Domain.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Built-In>Air.

4 Click Add to Component in the window toolbar.

A D D  M A T E R I A L

1 Go to the Add Material window.

2 In the tree, select Built-In>FR4 (Circuit Board).

3 Click Add to Component in the window toolbar.

M A T E R I A L S

FR4 (Circuit Board) (mat2)
1 In the Model Builder window, under Component 1 (comp1)>Materials click 

FR4 (Circuit Board) (mat2).

2 Select Domain 7 only.

3 On the Home toolbar, click Add Material to close the Add Material window.

Material 3 (mat3)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 Select Domain 6 only.

3 In the Settings window for Material, locate the Material Contents section.
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4 In the table, enter the following settings:

M E S H  1

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.

2 In the Settings window for Mesh, click Build All.

To see the meshed structure of the device, remove some boundaries from the view.

D E F I N I T I O N S

Hide for Physics 1
1 In the Model Builder window, under Component 1 (comp1)>Definitions right-click View 1 

and choose Hide for Physics.

2 In the Settings window for Hide for Physics, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Boundary.

4 Select Boundaries 6, 10, 16, 37, 40, and 42 only.

Property Name Value Unit Property 
group

Relative permittivity epsilonr 2.1 1 Basic

Relative permeability mur 1 1 Basic

Electrical conductivity sigma 0 S/m Basic
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M E S H  1

S T U D Y  1

Step 1: Frequency Domain
On the Home toolbar, click Compute.

R E S U L T S

Multislice
1 In the Model Builder window, expand the Electric Field (emw) node, then click Multislice.

2 In the Settings window for Multislice, locate the Multiplane Data section.

3 Find the X-planes subsection. In the Planes text field, type 0.

4 Find the Y-planes subsection. In the Planes text field, type 0.

5 Locate the Coloring and Style section. From the Color table list, choose RainbowLight.

6 On the Electric Field (emw) toolbar, click Plot.

7 Click the Go to XY View button on the Graphics toolbar.

Zoom in a couple of time to get a good view of the RFID tag.

Compare the reproduced plot with Figure 2.
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2D Far Field (emw)

The E-plane radiation pattern resembles that of a dipole antenna.

Far Field 1
1 In the Model Builder window, expand the 3D Far Field (emw) node, then click Far Field 1.

2 In the Settings window for Far Field, locate the Evaluation section.

3 Find the Angles subsection. In the Number of azimuth angles text field, type 40.

4 On the 3D Far Field (emw) toolbar, click Plot.

Reproduce Figure 3.

Global Evaluation 2
1 On the Results toolbar, click Global Evaluation.

2 In the Settings window for Global Evaluation, click Replace Expression in the upper-right 
corner of the Expressions section. From the menu, choose Component 1>

Electromagnetic Waves, Frequency Domain>Ports>emw.Zport_1 -

Lumped port impedance.

3 Click Evaluate.

Global Evaluation 3
1 On the Results toolbar, click Global Evaluation.
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2 In the Settings window for Global Evaluation, locate the Expressions section.

3 In the table, enter the following settings:

4 Click Evaluate.

Expression Unit Description

20*log10(abs(Gamma))
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Introduction

A tapered slot antenna, also known as a Vivaldi antenna, is useful for wide-band 
applications. Here, an exponential function is used for the taper profile. The objective of 
this example is to compute the far-field pattern and to compute the impedance of the 
structure. Good matching is observed over a wide frequency band.

Figure 1: The Vivaldi antenna is realized on a thin dielectric substrate. The entire domain is 
bounded by a perfectly matched layer.

Model Definition

In this Vivaldi antenna model, the tapered slot is patterned with a perfect electric 
conductor (PEC) ground plane on the top of the dielectric substrate. A simple exponential 
function, e0.044x is used to create the tapered slot curves. One end of the slot is open to 
air and the other end is finished with a circular slot. On the bottom of the substrate, the 
shorted 50 Ω microstrip feed line is modeled as PEC surfaces. The entire modeling 
domain is bounded by a perfectly matched layer (PML) which acts like an anechoic 
chamber absorbing all radiated energy. To excite the antenna, a lumped port is used. The 
model is meshed using a tetrahedral mesh with approximately five elements per wavelength 
in each material and simulation frequency.

Shorted

Lumped port on a 
microstrip line

Substrate with 
PEC ground

Perfectly matched layer
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Results and Discussion

The simulated SWR plot, Figure 2, shows good wide-band matching properties. A Vivaldi 
antenna utilizes traveling waves generating a directive radiation pattern toward the open 
end of the tapered slot. The 3D far-field pattern in Figure 3 shows a directive radiation 
pattern.

Figure 2: The frequency response SWR of the Vivaldi antenna shows wide-band impedance 
matching, better than 2:1 in most of the simulated frequency range.
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Figure 3: 3D far-field pattern at 5.5 GHz shows a directional radiation pattern.

References
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Application Library path: RF_Module/Antennas/vivaldi_antenna

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.
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M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Radio Frequency>Electromagnetic Waves,

Frequency Domain (emw).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Frequency Domain.

6 Click Done.

S T U D Y  1

Step 1: Frequency Domain
1 In the Model Builder window, under Study 1 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 In the Frequencies text field, type range(2[GHz],0.5[GHz],6.5[GHz]).

G E O M E T R Y  1

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose mm.

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

Here, mil refers to the unit milliinch.

G E O M E T R Y  1

Create a block for the antenna substrate.

Name Expression Value Description

thickness 60[mil] 0.001524 m Substrate thickness

w_slot 0.5[mm] 5E-4 m Slot with
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Block 1 (blk1)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, type Substrate in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type 110.

4 In the Depth text field, type 80.

5 In the Height text field, type thickness.

6 Locate the Position section. From the Base list, choose Center.

Next, add a block for the 50Ω microstrip feed line.

Block 2 (blk2)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, type Feed line in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type 3.2.

4 In the Depth text field, type 40+w_slot/2.

5 In the Height text field, type thickness.

6 Locate the Position section. From the Base list, choose Center.

7 In the x text field, type -26.

8 In the y text field, type -20+w_slot/4.

Next, create a work plane where you will draw the Vivaldi antenna pattern. Use two 
parametric curves for the tapered slot.

Work Plane 1 (wp1)
1 On the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 In the z-coordinate text field, type thickness/2.

4 Click Show Work Plane.

Plane Geometry
Click the Zoom Extents button on the Graphics toolbar.

Add a parametric curve using the exponential profile.

Parametric Curve 1 (pc1)
1 On the Work Plane toolbar, click Primitives and choose Parametric Curve.

2 In the Settings window for Parametric Curve, locate the Parameter section.

3 In the Maximum text field, type 70.
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4 Locate the Expressions section. In the xw text field, type s-15.

5 In the yw text field, type exp(0.044*s)-1+w_slot/2.

Generate the other parametric curve by mirroring the first one.

Mirror 1 (mir1)
1 On the Work Plane toolbar, click Transforms and choose Mirror.

2 In the Settings window for Mirror, locate the Normal Vector to Line of Reflection section.

3 In the yw text field, type 1.

4 In the xw text field, type 0.

5 Locate the Input section. Select the Keep input objects check box.

6 Select the object pc1 only.

7 Right-click Mirror 1 (mir1) and choose Build Selected.

Add a rectangle describing the thin slot connected to the tapered slot.

Rectangle 1 (r1)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 20.

4 In the Height text field, type w_slot.

5 Locate the Position section. In the xw text field, type -35.
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6 In the yw text field, type -w_slot/2.

Add a circle attached to the end of the slot.

Circle 1 (c1)
1 On the Work Plane toolbar, click Primitives and choose Circle.

2 In the Settings window for Circle, locate the Size and Shape section.

3 In the Radius text field, type 12.

4 Locate the Position section. In the xw text field, type -40.5.

Create a union of the circle and the rectangle to remove unnecessary boundaries.

Union 1 (uni1)
1 On the Work Plane toolbar, click Booleans and Partitions and choose Union.

2 Select the objects r1 and c1 only.

3 In the Settings window for Union, locate the Union section.

4 Clear the Keep interior boundaries check box.

5 On the Work Plane toolbar, click Build All.

6 In the Model Builder window, click Geometry 1.

Add a sphere for the PMLs. Use a layer definition to create a shell-type structure.

Sphere 1 (sph1)
1 On the Geometry toolbar, click Sphere.
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2 In the Settings window for Sphere, type PML in the Label text field.

3 Locate the Size section. In the Radius text field, type 110.

4 Click to expand the Layers section. In the table, enter the following settings:

5 Click Build All Objects.

6 Click the Zoom Extents button on the Graphics toolbar.

Choose wireframe rendering to get a better view of the interior parts.

7 Click the Wireframe Rendering button on the Graphics toolbar.

D E F I N I T I O N S

Add a perfectly matched layer.

Perfectly Matched Layer 1 (pml1)
1 On the Definitions toolbar, click Perfectly Matched Layer.

2 Select Domains 1–4 and 8–11 only.

3 In the Settings window for Perfectly Matched Layer, locate the Geometry section.

4 From the Type list, choose Spherical.

Layer name Thickness (mm)

Layer 1 30
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View 1
Hide some domains to get a better view of the interior parts when setting up the physics 
and reviewing the mesh.

Hide for Physics 1
1 In the Model Builder window, under Component 1 (comp1)>Definitions right-click View 1 

and choose Hide for Physics.

2 Select Domains 2 and 9 only.

Hide for Physics 2
1 Right-click View 1 and choose Hide for Physics.

2 In the Settings window for Hide for Physics, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Boundary.
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4 Select Boundaries 10 and 36 only.

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

Now set up the physics. Use the selections already defined when assigning boundary 
conditions.

Perfect Electric Conductor 2
1 In the Model Builder window, under Component 1 (comp1) right-click 

Electromagnetic Waves, Frequency Domain (emw) and choose Perfect Electric Conductor.

2 Select Boundaries 16, 21, 22, 24, and 27 only.

Lumped Port 1
1 In the Model Builder window, right-click Electromagnetic Waves,

Frequency Domain (emw) and choose Far-Field Domain.

2 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Lumped Port.

3 Click the Zoom In button on the Graphics toolbar.

4 Click the Zoom In button on the Graphics toolbar.
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5 Select Boundary 20 only.

For the first port, wave excitation is on by default.

M A T E R I A L S

Assign material properties for the model. First, use air for all domains.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Built-In>Air.

4 Click Add to Component in the window toolbar.

M A T E R I A L S

On the Home toolbar, click Add Material to close the Add Material window.

Air (mat1)
Override the substrate with a dielectric material of εr = 3.38.

Material 2 (mat2)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, type Substrate in the Label text field.
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3 Select Domains 6 and 7 only.

4 Locate the Material Contents section. In the table, enter the following settings:

M E S H  1

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.

2 In the Settings window for Mesh, locate the Mesh Settings section.

3 From the Element size list, choose Coarse.

4 Click Build All.

S T U D Y  1

On the Home toolbar, click Compute.

Property Name Value Unit Property 
group

Relative permittivity epsilonr 3.38 1 Basic

Relative permeability mur 1 1 Basic

Electrical conductivity sigma 0 S/m Basic
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R E S U L T S

Multislice
1 In the Model Builder window, expand the Electric Field (emw) node, then click Multislice.

2 In the Settings window for Multislice, locate the Expression section.

3 In the Expression text field, type 20*log10(emw.normE).

4 Locate the Multiplane Data section. Find the X-planes subsection. In the Planes text field, 
type 0.

5 Find the Y-planes subsection. In the Planes text field, type 0.

6 On the Electric Field (emw) toolbar, click Plot.

Strong electric fields are observed in the slot and microstrip line.
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S-Parameter (emw)

Smith Plot (emw)
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Far Field 1
1 In the Model Builder window, expand the Results>2D Far Field (emw) node, then click 

Far Field 1.

2 In the Settings window for Far Field, locate the Evaluation section.

3 Find the Angles subsection. In the Number of angles text field, type 100.

4 On the 2D Far Field (emw) toolbar, click Plot.

2D far-field radiation patterns in the /[xy/]-plane plotted for all frequencies.

3D Far Field (emw)
1 In the Model Builder window, under Results click 3D Far Field (emw).

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Parameter value (freq (GHz)) list, choose 5.5.

Far Field 1
1 In the Model Builder window, expand the 3D Far Field (emw) node, then click Far Field 1.

2 In the Settings window for Far Field, locate the Evaluation section.

3 Find the Angles subsection. In the Number of elevation angles text field, type 90.

4 In the Number of azimuth angles text field, type 90.
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5 On the 3D Far Field (emw) toolbar, click Plot.

Compare the resulting 3D radiation pattern plot with Figure 3.

Global 1
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Model Builder window, right-click 1D Plot Group 6 and choose Global.

3 In the Settings window for Global, click Add Expression in the upper-right corner of the 
y-axis data section. From the menu, choose Component 1>Electromagnetic Waves,

Frequency Domain>Ports>emw.VSWR_1 - Voltage standing wave ratio.

4 Click to expand the Legends section. Clear the Show legends check box.

5 On the 1D Plot Group 6 toolbar, click Plot.

This VSWR plot replicates the wide-band frequency response shown in Figure 2.
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Introduction

This is a model of an adapter for microwave propagation in the transition between a 
rectangular and an elliptical waveguide. Such waveguide adapters are designed to keep 
energy losses due to reflections at a minimum for the operating frequencies. To investigate 
the characteristics of the adapter, the simulation includes a wave traveling from a 
rectangular waveguide through the adapter and into an elliptical waveguide. The S-
parameters are calculated as functions of the frequency. The involved frequencies are all in 
the single-mode range of the waveguide, that is, the frequency range where only one mode 
is propagating in the waveguide.

Model Definition

The waveguide adapter consists of a rectangular part smoothly transcending into an 
elliptical part as seen in Figure 1.

Figure 1: The geometry of the waveguide adapter.

The walls of manufactured waveguides are typically plated with a good conductor such as 
silver. The model approximates the walls by perfect conductors. This is represented by the 
boundary condition n × E = 0.

The rectangular port is excited by a transverse electric (TE) wave, which is a wave that has 
no electric field component in the direction of propagation. This is what an incoming wave 
would look like after traveling through a straight rectangular waveguide with the same 
cross section as the rectangular part of the adapter. The excitation frequencies are selected 
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so that the TE10 mode is the only propagating mode through the rectangular waveguide. 
The cutoff frequencies for the different modes can be achieved analytically from the 
relation

where m and n are the mode numbers, and c is the speed of light. For the TE10 mode, 
m = 1 and n = 0. With the dimensions of the rectangular cross section (a = 2.286 cm and 
b = 1.016 cm), the TE10 mode is the only propagating mode for frequencies between 
6.6 GHz and 14.7 GHz.

Although the shape of the TE10 mode is known analytically, this example lets you compute 
it using a numerical port. This technique is very general, in that it allows the port boundary 
to have any shape. The solved equation is

Here Hn is the component of the magnetic field perpendicular to the boundary, n the 
refractive index, β the propagation constant in the direction perpendicular to the 
boundary, and k0 the free space wave number. The eigenvalues are λ = −jβ.

The same equation is solved separately at the elliptical end of the waveguide. The elliptical 
port is passive, but the eigenmode is still used in the boundary condition of the 3D 
propagating wave simulation. The dimensions of the elliptical end of the waveguide are 
such that the frequency range for the lowest propagating mode overlaps that of the 
rectangular port.

With the stipulated excitation at the rectangular port and the numerically established 
mode shapes as boundary conditions, the following equation is solved for the electric field 
vector E inside the waveguide adapter:

where μr denotes the relative permeability, j the imaginary unit, σ the conductivity, ω the 
angular frequency, εr the relative permittivity, and ε0 the permittivity of free space. The 
model uses the following material properties for free space: σ = 0 and μr = εr = 1.
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Results

Figure 2 shows a single-mode wave propagating through the waveguide.

Figure 2: The x component of the propagating wave inside the waveguide adapter at the 
frequency 10 GHz.

Naming the rectangular port Port 1 and the elliptical port Port 2, the S-parameters 
describing the reflection and transmission of the wave are defined as follows:

Here Ec is the calculated total field. E1 is the analytical field for the port excitation, and 
E2 is the eigenmode calculated from the boundary mode analysis and normalized with 

S11

Ec E1–( ) E1
*⋅( ) A1d

Port 1


E1 E1∗⋅( ) A1d
Port 1


-----------------------------------------------------------------=

S21

Ec E2
*⋅( ) A2d

Port 2


E2 E2
*⋅( ) A2d

Port 2


-----------------------------------------------=
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respect to the outgoing power flow. Figure 3 shows the S11 and S21 parameters as 
functions of the frequency. 

Figure 3: The S11 parameter and S21 parameter (in dB) as a function of the frequency. This 
parameter describes the reflections when the waveguide adapter is excited at the rectangular 
port and a measure of the part of the wave that is transmitted through the elliptical port when 
the waveguide adapter is excited at the rectangular port, respectively.

Application Library path: RF_Module/Transmission_Lines_and_Waveguides/
waveguide_adapter

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.
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2 In the Select Physics tree, select Radio Frequency>Electromagnetic Waves,

Frequency Domain (emw).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Empty Study.

6 Click Done.

S T U D Y  1

Step 1: Boundary Mode Analysis
1 On the Study toolbar, click Study Steps and choose Other>Boundary Mode Analysis.

2 In the Settings window for Boundary Mode Analysis, locate the Study Settings section.

3 In the Mode analysis frequency text field, type 7[GHz].

The exact value of this frequency is not important. What matters is that it should be 
above the cutoff frequency for the fundamental mode, but below that for the next 
mode. This setting ensures that the boundary mode analysis finds the fundamental 
mode.

Add another boundary mode analysis, for the second port.

Step 2: Boundary Mode Analysis 2
1 On the Study toolbar, click Study Steps and choose Other>Boundary Mode Analysis.

2 In the Settings window for Boundary Mode Analysis, locate the Study Settings section.

3 In the Port name text field, type 2.

4 In the Mode analysis frequency text field, type 7[GHz].

Finally, add the 3D equation for the propagating wave in the waveguide.

Step 3: Frequency Domain
1 On the Study toolbar, click Study Steps and choose Frequency Domain>

Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 In the Frequencies text field, type range(6.6[GHz],3.4[GHz]/49,10[GHz]).

Proceed to import the geometry.
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G E O M E T R Y  1

Import 1 (imp1)
1 On the Home toolbar, click Import.

2 In the Settings window for Import, locate the Import section.

3 Click Browse.

4 Browse to the model’s Application Libraries folder and double-click the file 
waveguide_adapter.mphbin.

5 Click Import.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Built-In>Air.

4 Click Add to Component in the window toolbar.

M A T E R I A L S

On the Home toolbar, click Add Material to close the Add Material window.

Air (mat1)
By default, the first material you add applies on all domains so you need not alter any 
settings.

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

Port 1
1 In the Model Builder window, under Component 1 (comp1) right-click 

Electromagnetic Waves, Frequency Domain (emw) and choose Port.

2 In the Settings window for Port, locate the Port Properties section.

3 From the Type of port list, choose Numeric.

For the first port, wave excitation is on by default.

4 Select Boundary 13 only.

The wave enters the adapter through the port with a rectangular cross section.

Port 2
1 In the Model Builder window, right-click Electromagnetic Waves,

Frequency Domain (emw) and choose Port.
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2 In the Settings window for Port, locate the Port Properties section.

3 From the Type of port list, choose Numeric.

4 In the Port name text field, type 2.

5 Select Boundary 6 only.

This is the exit port, the one with an elliptical cross-section.

M E S H  1

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.

2 In the Settings window for Mesh, click Build All.

S T U D Y  1

Now set up the study to find the boundary modes and use them when computing the field 
distribution over a range of frequencies.

Step 1: Boundary Mode Analysis
1 In the Model Builder window, expand the Study 1 node, then click 

Step 1: Boundary Mode Analysis.

2 In the Settings window for Boundary Mode Analysis, locate the Study Settings section.

3 Select the Search for modes around check box.

4 In the associated text field, type 50.

This value should be in the vicinity of the value that you expect the fundamental mode 
to have. If you do not know this in advance, you can experiment with some different 
values or estimate one from analytical formulas valid for cross-sections resembling 
yours.

5 From the Transform list, choose Out-of-plane wave number.

Step 2: Boundary Mode Analysis 2
1 In the Model Builder window, under Study 1 click Step 2: Boundary Mode Analysis 2.

2 In the Settings window for Boundary Mode Analysis, locate the Study Settings section.

3 Select the Search for modes around check box.

4 In the associated text field, type 50.

5 From the Transform list, choose Out-of-plane wave number.

6 On the Home toolbar, click Compute.
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R E S U L T S

Electric Field (emw)
1 Click the Zoom Extents button on the Graphics toolbar.

The default plot shows the norm of the electric field on slices through the waveguide; 
you can simplify and improve this plot.

Delete the Multislice plot.

Multislice
In the Model Builder window, expand the Electric Field (emw) node.

Slice 1
1 Right-click Multislice and choose Delete.

2 In the Model Builder window, under Results right-click Electric Field (emw) and choose 
Slice.

3 In the Settings window for Slice, click Replace Expression in the upper-right corner of the 
Expression section. From the menu, choose Component 1>Electromagnetic Waves,

Frequency Domain>Electric>Electric field>emw.Ex - Electric field, x component.

4 Locate the Coloring and Style section. From the Color table list, choose WaveLight.

5 Locate the Plane Data section. In the Planes text field, type 1.
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6 On the Electric Field (emw) toolbar, click Plot.

The plot now shows the x component of the electric field at the highest frequency, 10 
GHz (compare with Figure 2). If you would like to see the field for other frequencies, 
you can select them by clicking on the Electric Field (emw) plot group.

Proceed by checking the plot of the S-parameters as functions of the frequency.

S-Parameter (emw)
Select the S-Parameter (emw) plot group under Results in Model Builder. The plot should 
closely resemble that in Figure 3.

Smith Plot (emw)
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Introduction

A conductive diaphragm, an iris, placed transverse to a waveguide aperture causes a 
discontinuity and generates shunt reactance. Bandpass frequency response can be achieved 
from cascaded cavity resonators combined with such reactive elements, which can be 
created by inserting a series of iris elements inside the waveguide. This example consists of 
a WR-90 X-band waveguide and symmetrical inductive diaphragms (irises). The calculated 
S-parameters show good bandpass response and out-of-band rejection.

Figure 1: Symmetrical irises inside the waveguide generate shunt inductance. The top surface 
is removed to show the inside.

Model Definition

This example uses a WR-90 waveguide for X-band applications. The waveguide and iris 
parts are modeled as perfect electric conductors (PECs) and the inside of the waveguide is 
filled with air. On each end of the waveguide, a port boundary condition is applied with 
the predefined rectangular TE10 mode. Only one port is excited to observe the S-
parameters of the example. The upper cut-off frequency can be approximately estimated 
using the resonant frequency of the biggest cavity located in the middle of the filter via

Irises

PEC WR-90 waveguide

Port1

Port2
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where a and b are the dimensions of the waveguide’s aperture and d is the length of the 
cavity. For this example, the values a = 2.286 cm, b = 1.016 cm, and d = 1.73 cm give a 
resonant frequency at the dominant mode, TE101, of 10.87 GHz. Because the cavities are 
not completely closed but formed with the open irises, this estimation gives only an 
approximated value.

Results and Discussion

The default plot shows the norm of the electric fields in the waveguide; see Figure 2. At 
10 GHz, the shape of the field distribution in each section of cavities looks like that of the 
dominant mode of a cavity.

Figure 2: The E-field norm plot at the passband frequency shows the dominant mode resonance 
in each cavity formed by the irises.

fnml
c

2π εrμr

---------------------- mπ
a

-------- 
  2 nπ

b
------- 
  2 lπ

d
----- 
  2

+ +=
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Figure 3 shows the calculated S-parameters. The passband is around 10 GHz and good 
out-of-band rejection frequency response is observed.

Figure 3: The calculated S-parameters show good matching characteristics as well as out-of-
band rejection.

In Figure 4, the calculated S-parameters from the Frequency-Domain Modal method are 
plotted together with those of the discrete frequency sweep. While the frequency 
resolution of the Frequency-Domain Modal is five times finer than that of the discrete 
frequency sweep, the simulation time is four times faster to analyze the same filter.
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Figure 4: The calculated S-parameters from the Frequency-Domain Modal method are plotted 
with those of the discrete frequency sweep (dashed lines with circle makers).
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Application Library path: RF_Module/Filters/waveguide_iris_filter

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.
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M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Radio Frequency>Electromagnetic Waves,

Frequency Domain (emw).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Frequency Domain.

6 Click Done.

S T U D Y  1

Step 1: Frequency Domain
1 In the Model Builder window, under Study 1 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 Click Range.

4 In the Range dialog box, type 8.5[GHz] in the Start text field.

5 In the Step text field, type 0.05[GHz].

6 In the Stop text field, type 11.5[GHz].

7 Click Replace.

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
waveguide_iris_filter_parameters.txt.

G E O M E T R Y  1

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose cm.

Create a block for the WR-90 waveguide.
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Block 1 (blk1)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, type WR-90 in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type 12.

4 In the Depth text field, type w_wg.

5 In the Height text field, type h_wg.

6 Locate the Position section. From the Base list, choose Center.

7 Click Build All Objects.

Choose wireframe rendering to get a view inside the waveguide when adding the irises.

8 Click the Wireframe Rendering button on the Graphics toolbar.

Next, add a block for generating the inner irises, which form the center cavity.

Block 2 (blk2)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, type Iris1 in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type d_iris.

4 In the Depth text field, type l_iris1.

5 In the Height text field, type h_wg.

6 Locate the Position section. From the Base list, choose Center.

7 In the x text field, type spacing/2.

8 In the y text field, type (w_wg-l_iris1)/2.

Add another block for generating the outer irises, which enclose the first and last cavities.

Block 3 (blk3)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, type Iris2 in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type d_iris.

4 In the Depth text field, type l_iris2.

5 In the Height text field, type h_wg.

6 Locate the Position section. From the Base list, choose Center.

7 In the x text field, type spacing*1.42.

8 In the y text field, type (w_wg-l_iris2)/2.
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9 Click Build All Objects.

Create symmetrical inductive diaphragms by mirroring the iris blocks a couple of times.

Mirror 1 (mir1)
1 On the Geometry toolbar, click Transforms and choose Mirror.

2 Select the objects blk2 and blk3 only.

3 In the Settings window for Mirror, locate the Input section.

4 Select the Keep input objects check box.

5 Locate the Normal Vector to Plane of Reflection section. In the x text field, type 1.

6 In the z text field, type 0.

Mirror 2 (mir2)
1 On the Geometry toolbar, click Transforms and choose Mirror.

2 Select the objects mir1(1), mir1(2), blk2, and blk3 only.

3 In the Settings window for Mirror, locate the Input section.

4 Select the Keep input objects check box.

5 Locate the Normal Vector to Plane of Reflection section. In the y text field, type 1.

6 In the z text field, type 0.

Difference 1 (dif1)
1 On the Geometry toolbar, click Booleans and Partitions and choose Difference.
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2 Select the object blk1 only.

3 In the Settings window for Difference, locate the Difference section.

4 Find the Objects to subtract subsection. Select the Active toggle button.

5 Select the objects mir1(1), mir2(2), mir2(3), mir1(2), mir2(1), blk2, blk3, and mir2(4) only.

6 Click Build All Objects.

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

Now, set up the physics. The default boundary condition, Perfect Electric Conductor, 
applies to all exterior boundaries.

Port 1
1 In the Model Builder window, under Component 1 (comp1) right-click 

Electromagnetic Waves, Frequency Domain (emw) and choose Port.
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2 Select Boundary 1 only.

The excitation port

3 In the Settings window for Port, locate the Port Properties section.

4 From the Type of port list, choose Rectangular.

For the first port, wave excitation is on by default.

Port 2
1 In the Model Builder window, right-click Electromagnetic Waves,

Frequency Domain (emw) and choose Port.
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2 Select Boundary 38 only.

The observation port

3 In the Settings window for Port, locate the Port Properties section.

4 From the Type of port list, choose Rectangular.

M A T E R I A L S

Assign material properties on the model. Use air for all domains.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Built-In>Air.

4 Click Add to Component in the window toolbar.

M A T E R I A L S

On the Home toolbar, click Add Material to close the Add Material window.

M E S H  1

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.
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2 In the Settings window for Mesh, click Build All.

S T U D Y  1

On the Home toolbar, click Compute.

R E S U L T S

Electric Field (emw)
The default plot shows the distribution of the norm of the electric field. Choose the center 
frequency of the passband.

1 In the Model Builder window, under Results click Electric Field (emw).

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Parameter value (freq (GHz)) list, choose 10.

4 On the Electric Field (emw) toolbar, click Plot.

The resonant E-field should be observed in the cavities. Compare with Figure 2.

S-Parameter (emw)
1 In the Model Builder window, under Results click S-Parameter (emw).

2 In the Settings window for 1D Plot Group, click to expand the Legend section.

3 From the Position list, choose Lower right.
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4 On the S-Parameter (emw) toolbar, click Plot.

The resulting plot shows the S-parameters of the filter. Compare the plot with Figure 3.

Smith Plot (emw)

Analyze the same model with a Frequency-Domain Modal method. When a device 
presents resonances, the Frequency-Domain Modal method combined with an 
Eigenfrequency analysis provides a faster solution time.

R O O T

On the Home toolbar, click Windows and choose Add Study.

A D D  S T U D Y

1 Go to the Add Study window.

2 Find the Studies subsection. In the Select Study tree, select Preset Studies>Frequency-

Domain Modal.

3 Click Add Study in the window toolbar.

S T U D Y  2

Step 1: Eigenfrequency
1 On the Home toolbar, click Add Study to close the Add Study window.
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2 In the Model Builder window, under Study 2 click Step 1: Eigenfrequency.

3 In the Settings window for Eigenfrequency, locate the Study Settings section.

4 In the Search for eigenfrequencies around text field, type 9.5[GHz].

Step 2: Frequency-Domain Modal
1 In the Model Builder window, under Study 2 click Step 2: Frequency-Domain Modal.

2 In the Settings window for Frequency-Domain Modal, locate the Study Settings section.

3 In the Frequencies text field, type range(8.5[GHz],0.01[GHz],11.5[GHz]).

With a very fine frequency step simulation, the solutions contain a lot of data. As a result, 
the model file size will increase tremendously when it is saved. By selecting the Store fields 
in output check box in the Values of Dependent Variables section of the Frequency 
Domain study step settings, it is possible to define for what part of the model the 
computed solution should be saved. When only S-parameters are of interest, it is not 
necessary to store all of the field solutions. Instead, only store the field on the selections 
for the port boundaries, as those will be used for the S-parameter calculations.

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

Port 1
1 In the Model Builder window, under Component 1 (comp1)>Electromagnetic Waves,

Frequency Domain (emw) click Port 1.

2 In the Settings window for Port, locate the Boundary Selection section.

3 Click Create Selection.

4 In the Create Selection dialog box, click OK.

Port 2
1 In the Model Builder window, under Component 1 (comp1)>Electromagnetic Waves,

Frequency Domain (emw) click Port 2.

2 In the Settings window for Port, locate the Boundary Selection section.

3 Click Create Selection.

4 In the Create Selection dialog box, click OK.

S T U D Y  2

Step 2: Frequency-Domain Modal
1 In the Model Builder window, under Study 2 click Step 2: Frequency-Domain Modal.
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2 In the Settings window for Frequency-Domain Modal, click to expand the 
Values of dependent variables section.

3 Locate the Values of Dependent Variables section. Find the Store fields in output 
subsection. From the Settings list, choose For selections.

4 Under Selections, click Add.

5 In the Add dialog box, In the Selections list, choose Explicit 1 and Explicit 2.

6 Click OK.

7 On the Home toolbar, click Compute.

R E S U L T S

Multislice
1 In the Model Builder window, expand the Electric Field (emw) 1 node, then click 

Multislice.

2 In the Settings window for Multislice, locate the Multiplane Data section.

3 Find the X-planes subsection. From the Entry method list, choose Coordinates.

4 In the Coordinates text field, type -6 6.

5 Find the Y-planes subsection. From the Entry method list, choose Number of planes.

6 In the Planes text field, type 0.

7 Find the Z-planes subsection. In the Planes text field, type 0.
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8 On the Electric Field (emw) 1 toolbar, click Plot.

Since 11.5 GHz is not within the pass-band, the input power at the excitation port is 
not delivered to the observation port.

Electric Field (emw) 1
1 In the Model Builder window, under Results click Electric Field (emw) 1.

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Parameter value (freq (GHz)) list, choose 10.
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4 On the Electric Field (emw) 1 toolbar, click Plot.

When the frequency of the plot is within the pass-band, the input power at the 
excitation port is delivered to the observation port.

Next, plot the calculated S-parameters from the Frequency-Domain Modal method 
together with those of the discrete frequency sweep.

Global 2
1 In the Model Builder window, under Results right-click S-Parameter (emw) 1 and choose 

Global.

2 In the Settings window for Global, locate the Data section.

3 From the Data set list, choose Study 1/Solution 1 (sol1).

4 Click Add Expression in the upper-right corner of the y-axis data section. From the 
menu, choose Component 1>Electromagnetic Waves, Frequency Domain>Ports>S-

parameter, dB>emw.S11dB - S11.

5 Click Add Expression in the upper-right corner of the y-axis data section. From the 
menu, choose Component 1>Electromagnetic Waves, Frequency Domain>Ports>S-

parameter, dB>emw.S21dB - S21.

6 Click to expand the Coloring and style section. Locate the Coloring and Style section. 
Find the Line style subsection. From the Line list, choose Dashed.
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7 Find the Line markers subsection. From the Marker list, choose Circle.

8 From the Positioning list, choose In data points.

9 On the S-Parameter (emw) 1 toolbar, click Plot.

S-Parameter (emw) 1
1 In the Model Builder window, under Results click S-Parameter (emw) 1.

2 In the Settings window for 1D Plot Group, click to expand the Title section.

3 From the Title type list, choose Manual.

4 In the Title text area, type S-parameter Comparison between Frequency-Domain 
Modal and Discrete Sweep.

5 Click to expand the Legend section. From the Position list, choose Lower right.

Compare the plot with Figure 4.

Smith Plot (emw) 1
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Introduction

Resistive power dividers and T-junction power dividers are two conventional types of 
three-port power dividers. Such dividers are either lossy or not matched to the system 
reference impedance at all ports. In addition, isolation between two coupled ports is not 
guaranteed. The Wilkinson power divider outperforms both the lossless T-junction divider 
and the resistive divider and does not have the issues mentioned above. This example 
shows how to model such a device.

Figure 1: A Wilkinson power divider is fabricated on a 60 mil substrate. An SMA receptacle 
is added on each port and the circuit board is suspended in the metal package using screws.

Model Definition

The Wilkinson power divider is a three-port device composed of 50 Ω and 70.7 Ω 
microstrip lines on a dielectric substrate with a ground plane and a 100 Ω resistor mounted 
between two ports. The model also includes a metal enclosure, screws, and SMA 
receptacles connected to each port representing a complete package of a power divider 
shown in Figure 1. Except for the microstrip lines and ground plane, model all the SMA 
receptacles, screws, and the metal package using perfect electric conductor (PEC) 
boundaries. The SMA receptacle and screw domains enclosed by these PEC boundaries 
are not part of the example analysis, so they are set to PEC by default. The microstrip lines 

Coaxial lumped port

Coaxial lumped port

Metal package

SMA receptacle

Metal screw
100 Ω resistor
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and ground plane made of 1 oz copper layers are modeled using a transition boundary 
condition with 35 μm thickness to address lossy conductive surfaces due to finite copper 
conductivity. The relative dielectric constant, εr, of the 60 mil substrate is 3.38. The 
boundaries facing the dielectric-filled coaxial connector of the SMA receptacles are 
specified as coaxial lumped ports. The 100 Ω resistor is realized via a uniform lumped port 
with100 Ω characteristic impedance.

Results and Discussion

Figure 2 shows the symmetric E-field norm distribution on the top of the substrate. The 
input energy is equally coupled to each output port.

Figure 2: The E-field norm plot shows that the input is evenly split between the two output ports.
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The S-parameters plotted in Figure 3 show the frequency response of the Wilkinson power 
divider. Good input impedance matching characteristics are observed and the coupled 
power at each output port is about −3 dB around 3 GHz.

Figure 3: The S-parameters show very good input matching at 3 GHz and evenly divided 
power at the two output ports.
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Application Library path: RF_Module/Couplers_and_Power_Dividers/
wilkinson_power_divider

Modeling Instructions

From the File menu, choose New.
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N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Radio Frequency>Electromagnetic Waves,

Frequency Domain (emw).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies>Frequency Domain.

6 Click Done.

S T U D Y  1

Step 1: Frequency Domain
1 In the Model Builder window, under Study 1 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 In the Frequencies text field, type range(2[GHz],0.1[GHz],4[GHz]).

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
wilkinson_power_divider_parameters.txt.

G E O M E T R Y  1

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose mm.

First, create the substrate.

Block 1 (blk1)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, type Substrate in the Label text field.
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3 Locate the Size and Shape section. In the Width text field, type w_subs.

4 In the Depth text field, type l_subs.

5 In the Height text field, type 1.524.

6 Locate the Position section. From the Base list, choose Center.

7 In the z text field, type -0.762.

Add a block for the metal package.

Block 2 (blk2)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, type Package in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type w_subs.

4 In the Depth text field, type l_subs.

5 In the Height text field, type 20.

6 Locate the Position section. From the Base list, choose Center.

7 In the z text field, type 2.

8 Right-click Package and choose Build Selected.

9 Click the Wireframe Rendering button on the Graphics toolbar.

Add a work plane for drawing the layout of the power divider.
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Work Plane 1 (wp1)
1 On the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, click Show Work Plane.

Plane Geometry
Add two circles to create the ring strip part.

Circle 1 (c1)
1 On the Work Plane toolbar, click Primitives and choose Circle.

2 In the Settings window for Circle, type Ring outer in the Label text field.

3 Click the Zoom Extents button on the Graphics toolbar.

4 Locate the Size and Shape section. In the Radius text field, type r_ring.

Circle 2 (c2)
1 On the Work Plane toolbar, click Primitives and choose Circle.

2 In the Settings window for Circle, type Ring inner in the Label text field.

3 Locate the Size and Shape section. In the Radius text field, type r_ring-1.87.

Rectangle 1 (r1)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, type Ring cut in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type 2.

4 In the Height text field, type 3.

5 Locate the Position section. In the xw text field, type -1.

6 In the yw text field, type -9.

Difference 1 (dif1)
1 On the Work Plane toolbar, click Booleans and Partitions and choose Difference.

2 Select the object c1 only.

3 In the Settings window for Difference, locate the Difference section.

4 Find the Objects to subtract subsection. Select the Active toggle button.

5 Select the objects r1 and c2 only.
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6 Right-click Difference 1 (dif1) and choose Build Selected.

Add a rectangle for the 100 ohm resistor.

Rectangle 2 (r2)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, type Lumped element in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type 2.

4 Locate the Position section. In the xw text field, type -1.

5 In the yw text field, type -8.

Add rectangles for the 50 ohm microstrip feed lines.

Rectangle 3 (r3)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 3.2.

4 In the Height text field, type 5.

5 Locate the Position section. From the Base list, choose Center.

6 In the yw text field, type 10.5.

Rectangle 4 (r4)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.
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2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 3.2.

4 In the Height text field, type 2.

5 Locate the Position section. In the xw text field, type -7.

6 From the Base list, choose Center.

7 In the yw text field, type -12.

Rectangle 5 (r5)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 3.2.

4 In the Height text field, type 6.

5 Locate the Position section. In the xw text field, type -8.6.

6 In the yw text field, type -11.

7 Locate the Rotation Angle section. In the Rotation text field, type -28.

Mirror 1 (mir1)
1 On the Work Plane toolbar, click Transforms and choose Mirror.

2 Select the objects r4 and r5 only.

3 In the Settings window for Mirror, locate the Input section.

4 Select the Keep input objects check box.

Create a union of all objects except the small rectangle for the resistor (r2) to remove 
unnecessary boundaries.

Union 1 (uni1)
1 On the Work Plane toolbar, click Booleans and Partitions and choose Union.

2 Select the objects mir1(1), dif1, mir1(2), r3, r4, and r5 only.

3 In the Settings window for Union, locate the Union section.

4 Clear the Keep interior boundaries check box.
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5 On the Work Plane toolbar, click Build All.

The power divider layout drawn on the substrate.

6 In the Model Builder window, click Geometry 1.

Create the coax SMA receptacle composed of the coax inner and outer conductors, the 
SMA connector part, and the flange.

Cylinder 1 (cyl1)
1 On the Geometry toolbar, click Cylinder.

2 In the Settings window for Cylinder, type Coax inner in the Label text field.

3 Locate the Size and Shape section. In the Radius text field, type r_inner.

4 In the Height text field, type l_sma+2.

5 Locate the Position section. In the x text field, type -7.

6 In the y text field, type -l_subs/2-l_sma.

7 Locate the Axis section. From the Axis type list, choose y-axis.

Cylinder 2 (cyl2)
1 On the Geometry toolbar, click Cylinder.

2 In the Settings window for Cylinder, type SMA in the Label text field.

3 Locate the Size and Shape section. In the Radius text field, type r_outer+0.6.

4 In the Height text field, type l_sma.
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5 Locate the Position section. In the x text field, type -7.

6 In the y text field, type -l_subs/2-l_sma.

7 Locate the Axis section. From the Axis type list, choose y-axis.

Block 3 (blk3)
1 On the Geometry toolbar, click Block.

2 In the Settings window for Block, type Flange in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type 12.7.

4 In the Depth text field, type 12.7.

5 In the Height text field, type 1.65.

6 Locate the Position section. From the Base list, choose Center.

7 In the x text field, type -7.

8 In the y text field, type -(l_subs+1.65)/2.

9 Locate the Axis section. From the Axis type list, choose y-axis.

Create a union of a couple of objects, the SMA connector, and the flange to remove 
unnecessary boundaries.

Union 1 (uni1)
1 On the Geometry toolbar, click Booleans and Partitions and choose Union.

2 Select the objects cyl2 and blk3 only.

3 In the Settings window for Union, locate the Union section.

4 Clear the Keep interior boundaries check box.

Cylinder 3 (cyl3)
1 On the Geometry toolbar, click Cylinder.

2 In the Settings window for Cylinder, type Coax dielectric in the Label text field.

3 Locate the Size and Shape section. In the Radius text field, type r_outer.

4 In the Height text field, type l_sma.

5 Locate the Position section. In the x text field, type -7.

6 In the y text field, type -l_subs/2-l_sma.

7 Locate the Axis section. From the Axis type list, choose y-axis.
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8 Right-click Coax dielectric and choose Build Selected.

Create two more SMA receptacles.

Copy 1 (copy1)
1 On the Geometry toolbar, click Transforms and choose Copy.

2 Select the objects uni1, cyl1, and cyl3 only.

3 In the Settings window for Copy, locate the Displacement section.

4 In the x text field, type 7,14.

Rotate 1 (rot1)
1 On the Geometry toolbar, click Transforms and choose Rotate.

2 Select the objects copy1(1), copy1(3), and copy1(5) only.

3 In the Settings window for Rotate, locate the Rotation Angle section.

4 In the Rotation text field, type 180.

Add a cylinder for the metal screw.

Cylinder 4 (cyl4)
1 On the Geometry toolbar, click Cylinder.

2 In the Settings window for Cylinder, type Screw in the Label text field.

3 Locate the Size and Shape section. In the Height text field, type 8.

4 Locate the Position section. In the x text field, type -12.
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5 In the y text field, type -10.

6 In the z text field, type -8.

Array 1 (arr1)
1 On the Geometry toolbar, click Transforms and choose Array.

2 Select the object cyl4 only.

3 In the Settings window for Array, locate the Size section.

4 In the x size text field, type 2.

5 In the y size text field, type 2.

6 Locate the Displacement section. In the x text field, type 24.

7 In the y text field, type 20.

8 Click Build All Objects.

D E F I N I T I O N S

Create a set of selections to use when setting up the physics. Begin with the microstrip line 
boundaries including the substrate ground plane.

Explicit 1
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Microstrip line in the Label text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.
13 |  S M A  C O N N E C T O R I Z E D  W I L K I N S O N  P O W E R  D I V I D E R



4 Select Boundaries 6, 54, 61, 102, and 147 only.

Add a selection for the substrate.

Explicit 2
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Substrate in the Label text field.
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3 Select Domains 2, 11, 15, and 21 only.

Add a selection for the coax dielectric (PTFE).

Explicit 3
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Coax dielectric in the Label text field.

3 Select Domains 9, 14, and 19 only.

Add a selection for the domains consisting of metal. These domains are not part of the 
model analysis.

Explicit 4
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Metal volume in the Label text field.
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3 Select Domains 4–8, 10, 12, 13, 16–18, 20, and 22–26 only.

Define the model domain, which is the complement of the metal volume selection.

Complement 1
1 On the Definitions toolbar, click Complement.

2 In the Settings window for Complement, type Model domain in the Label text field.

3 Locate the Input Entities section. Under Selections to invert, click Add.

4 In the Add dialog box, select Metal volume in the Selections to invert list.

5 Click OK.

View 1
Suppress some boundaries to get a view of the interior while setting the physics and mesh.

Hide for Physics 1
1 In the Model Builder window, under Component 1 (comp1)>Definitions right-click View 1 

and choose Hide for Physics.

2 In the Settings window for Hide for Physics, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Boundary.
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4 Select Boundaries 7, 8, and 10 only.

Now, set up the physics.

E L E C T R O M A G N E T I C  WA V E S ,  F R E Q U E N C Y  D O M A I N  ( E M W )

1 In the Model Builder window, under Component 1 (comp1) click Electromagnetic Waves,

Frequency Domain (emw).

2 In the Settings window for Electromagnetic Waves, Frequency Domain, locate the 
Domain Selection section.

3 From the Selection list, choose Model domain.

Perfect Electric Conductor 1
The Perfect Electric Conductor applies by default to all exterior boundaries. After 
restricting the Electromagnetics Waves, Frequency Domain interface to the model 
domain, these outer boundaries include the coax SMA receptacles and the metal screws. 
Add a Transition Boundary Condition to the microstrip line and the substrate ground 
plane.

Transition Boundary Condition 1
1 In the Model Builder window, right-click Electromagnetic Waves,

Frequency Domain (emw) and choose Transition Boundary Condition.

2 In the Settings window for Transition Boundary Condition, locate the Boundary Selection 
section.
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3 From the Selection list, choose Microstrip line.

4 Locate the Transition Boundary Condition section. In the d text field, type 35[um].

Proceed with the Lumped Port conditions.

Lumped Port 1
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Lumped Port.

2 Select Boundary 95 only.

3 In the Settings window for Lumped Port, locate the Lumped Port Properties section.

4 From the Type of lumped port list, choose Coaxial.

For the first port, wave excitation is on by default.

Lumped Port 2
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Lumped Port.
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2 Select Boundary 51 only.

3 In the Settings window for Lumped Port, locate the Lumped Port Properties section.

4 From the Type of lumped port list, choose Coaxial.

Lumped Port 3
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose Lumped Port.

2 Select Boundary 136 only.
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3 In the Settings window for Lumped Port, locate the Lumped Port Properties section.

4 From the Type of lumped port list, choose Coaxial.

Add a lumped element for the 100Ω resistor.

Lumped Element 1
1 Right-click Electromagnetic Waves, Frequency Domain (emw) and choose 

Lumped Element.

2 Select Boundary 97 only.

3 In the Settings window for Lumped Element, locate the Settings section.

4 In the Zelement text field, type 100[ohm].

M A T E R I A L S

Next, assign material properties. First, specify air for all domains.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Built-In>Air.

4 Click Add to Component in the window toolbar.

5 Go to the Add Material window.

6 In the tree, select Built-In>Copper.
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7 Click Add to Component in the window toolbar.

M A T E R I A L S

Copper (mat2)
1 In the Model Builder window, under Component 1 (comp1)>Materials click Copper (mat2).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Boundary.

4 From the Selection list, choose Microstrip line.

5 On the Home toolbar, click Add Material to close the Add Material window.

Override the material for the substrate domains with a dielectric material of εr = 3.38.

Material 3 (mat3)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, type Substrate in the Label text field.

3 Locate the Geometric Entity Selection section. From the Selection list, choose Substrate.

4 Locate the Material Contents section. In the table, enter the following settings:

Similarly, override the coax dielectric domains with a material of εr = 2.1.

Material 4 (mat4)
1 Right-click Materials and choose Blank Material.

2 In the Settings window for Material, type PTFE in the Label text field.

3 Locate the Geometric Entity Selection section. From the Selection list, choose 
Coax dielectric.

4 Locate the Material Contents section. In the table, enter the following settings:

Property Name Value Unit Property 
group

Relative permittivity epsilonr 3.38 1 Basic

Relative permeability mur 1 1 Basic

Electrical conductivity sigma 0 S/m Basic

Property Name Value Unit Property 
group

Relative permittivity epsilonr 2.1 1 Basic
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M E S H  1

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.

2 In the Settings window for Mesh, click Build All.

S T U D Y  1

On the Home toolbar, click Compute.

R E S U L T S

Electric Field (emw)
The default plot shows the E-field norm distribution. Change the settings to plot the E-
field norm on the substrate.

1 In the Model Builder window, under Results click Electric Field (emw).

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Parameter value (freq (GHz)) list, choose 3.

Relative permeability mur 1 1 Basic

Electrical conductivity sigma 0 S/m Basic

Property Name Value Unit Property 
group
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Multislice
1 In the Model Builder window, expand the Electric Field (emw) node, then click Multislice.

2 In the Settings window for Multislice, locate the Multiplane Data section.

3 Find the X-planes subsection. In the Planes text field, type 0.

4 Find the Y-planes subsection. In the Planes text field, type 0.

5 Find the Z-planes subsection. From the Entry method list, choose Coordinates.

6 In the Coordinates text field, type -0.1.

7 Click to expand the Range section. Select the Manual color range check box.

8 In the Maximum text field, type 1000.

The resulting plot shows the E-field equally split between Port 2 and Port 3. Compare 
with Figure 2.

S-Parameter (emw)
The reproduced plot shows the calculated S-parameters. Compare with Figure 3.

Smith Plot (emw)
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